
คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น 

 

 

 

 

หน่วยภูมิสารสนเทศ งานสารสนเทศ 

คณะสิ่งแวดล้อมและทรัพยากรศาสตร์ มหาวิทยาลัยมหิดล 

พฤศจิกายน 2556 

MAHID
OL



ก 

 

ค ำน ำ 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้นนี้ พัฒนาขึ้นเพื่อให้นักศึกษา คณาจารย์ 

นักวิจัย หรือผู้ที่สนใจ สามารถเรียนรู้และประยุกต์ใช้งานโปรแกรม QGIS ซึ่งเป็นโปรแกรมระบบสารสนเทศ

ภูมิศาสตร์รหัสเปิด (Open Source Geographic Information System) ที่อยู่ภายใต้ GNU General 

Public License ส าหรับการเรียนการสอน การวิจัย การบริการวิชาการ หรือการปฏิบัติงานต่าง ๆ โดยเนื้อหา

ในบทที่ 1 และ 2 จะมีทฤษฎีหรือแนวคิดพื้นฐานด้านเทคโนโลยีภูมิสารสนเทศและแผนที่ที่มีความส าคัญต่อ

การใช้งานโปรแกรมระบบสารสนเทศภูมิศาสตร์ ในบทที่ 3 – 9 จะเป็นการอธิบายและสาธิตการใช้งานค าสั่ง

โปรแกรมระดับพื้นฐานที่มีการใช้งานบ่อย ๆ ซึ่งผู้เขียนหวังว่าผู้อ่านจะสามารถน าไปประยุกต์ใช้กับงานด้านต่าง ๆ 

ได้เป็นอย่างด ี

ถึงแม้ว่าผู้เขียนมีความตั้งใจเรียบเรียงเนื้อหาในเอกสารฉบับนี้ให้มีความถูกต้องสมบูรณ์มากที่สุด แต่

ความผิดพลาดที่อาจพบในเอกสาร หรือประเด็นเนื้อหาที่ยังไม่ครอบคลุม ตลอดจนข้อบกพร่องต่าง ๆ อาจจะ

ยังคงมีมาก ด้วยเหตุนี้ ผู้เขียนจึงหวังเป็นอย่างยิ่งว่าจะได้รับข้อเสนอแนะที่เป็นประโยชน์ต่าง ๆ จากผู้อ่าน โดย

ส่งมาที่อีเมล theerawut.chi@mahidol.ac.th เพื่อน าไปใช้ในการพัฒนาปรับปรุงเอกสารให้มีความถูกต้อง

สมบูรณ์มากยิ่งขึ้น 

สุดท้ายนี้ ผู้เขียนขอขอบคุณและขอยกความดีอันเกิดจากการใช้ประโยชน์ของเอกสารฉบับนี้ ให้แก่    

ครูบาอาจารย์ เพื่อนร่วมงาน ครอบครัวของผู้เขียน ตลอดจน นักศึกษาและคณาจารย์ของคณะสิ่งแวดล้อมและ

ทรัพยากรศาสตร์ มหาวิทยาลัยมหิดล ที่เป็นแรงบันดาลใจและมีส่วนช่วยผลักดันให้เกิดการเขียนคู่มือฉบับนี้ 
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บทที่ 1 ความรู้เบื้องต้นเทคโนโลยีภูมิสารสนเทศ 

 หลักการพื้นฐานของเทคโนโลยีภูมิสารสนเทศมีความส าคัญอย่างยิ่งต่อการประยุกต์ใช้งานเทคโนโลยี
ภูมิสารสนเทศในด้านต่าง ๆ ได้อย่างถูกต้อง เหมาะสม และมีประสิทธิภาพ ในบทนี้จะกล่าวถึงหลักการส าคัญ
ต่าง ๆ ที่เกี่ยวข้องกับเทคโนโลยีภูมิสารสนเทศในระดับเบื้องต้น และจะให้ความส าคัญกับระบบสารสนเทศ
ภูมิศาสตร์เป็นหลัก เพื่อที่จะให้ผู้อ่านมีความเข้าใจและสามารถใช้งานซอฟต์แวร์ Quantum GIS ได้อย่าง
ถูกต้อง 

1. ความหมายของเทคโนโลยีภูมิสารสนเทศ 
 เทคโนโลยีภูมิสารสนเทศ (Geo-Informatics technology) ในความหมายกว้าง ๆ คือ เทคโนโลยีที่
ท างานเกี่ยวข้องกับข้อมูลเชิงพื้นที่ ได้แก่ การส ารวจ รวบรวม จัดเก็บ ประมวลผลวิเคราะห์ และน าเสนอข้อมูล
เชิงพื้นที่ โดยมีองค์ประกอบแกนหลักของเทคโนโลยี ได้แก่ ระบบสารสนเทศภูมิศาสตร์  (Geographic 
Information System: GIS)  การรับรู้จากระยะไกล  (Remote Sensing: RS)  และระบบก าหนดต าแหน่ง
บนโลก  (Global Positioning System: GPS) (รูปที่ 1.1) ทั้งนี้ แต่ละองค์ประกอบของเทคโนโลยีสามารถ
ท างานอิสระต่อกัน  หรือท างานร่วมกันแบบบูรณาการ 
 

 
รูปที่ 1.1 องค์ประกอบของเทคโนโลยีภูมิสารสนเทศ (Geo-Informatics technology) 

 
 เนื่องจากศาสตร์ทางด้านเทคโนโลยีภูมิสารสนเทศยังอยู่ในระยะเริ่มต้น จึงท าให้มีการเรียกชื่อ
เทคโนโลยีดังกล่าวในภาษาอังกฤษที่หลากหลาย เช่น “Geoinformatics” “Geospatial Information 
Science”  “Geomatics” “Spatial Information Science” “Geoinformation Engineering” หรือ 
“Geospatial Technology” และยังไม่มีศัพท์บัญญัติในภาษาไทยอย่างเป็นทางการ ดังนั้น ในเอกสารฉบับนี้

Geo-Informatics Technology 

Remote 
Sensing: RS 

Geographic 
Informaction 
System: GIS 

Global 
Positioning 

System: GPS 
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จึงจะอ้างอิงการใช้ค าจากส านักงานพัฒนาเทคโนโลยีอวกาศและภูมิสารสนเทศ (องค์การมหาชน) หรือ สทอภ. 
ที่เป็นหน่วยงานหลักของประเทศที่ด าเนินงานทางด้านเทคโนโลยีภูมิสารสนเทศ ซึ่งใช้ค าว่า Geo-Informatics 

2. ระบบสารสนเทศภูมิศาสตร์ 
ระบบสารสนเทศภูมิศาสตร์ หรือ จีไอเอส (GIS) คือ ระบบฐานข้อมูลคอมพิวเตอร์ที่ถูกน ามาใช้น าเข้า 

จัดเก็บ ประมวลผล วิเคราะห์ และแสดงผลข้อมูลเชิงพื้นที่ โดยมีจุดมุ่งหมายเพื่อผลิตสารสนเทศเชิงพื้นที่เพื่อ
ใช้ประโยชน์ในด้านต่าง ๆ 

2.1 องค์ประกอบของระบบสารสนเทศภูมิศาสตร์ 
ระบบสารสนเทศภูมิศาสตร์ มีองค์ประกอบ 5 ส่วน คือ ฮาร์ดแวร์ (Hardware) ซอฟต์แวร์ 

(Software) ข้อมูลหรือฐานข้อมูล (Data/Database) กระบวนงาน (Procedure) และบุคลากร (People) (รูป
ที่ 1.2) 

 

 
 

รูปที่ 1.2 องคป์ระกอบของระบบสารสนเทศภูมิศาสตร์ 
 

1)  ฮาร์ดแวร์ (Hardware) ได้แก่ คอมพิวเตอร์และอุปกรณ์ต่อพ่วงต่าง ๆ เช่น เครื่อง
คอมพิวเตอร์ จอมอนิเตอร์ แผงแป้นอักขระ เมาส์ เครื่องกราดภาพ เครื่องอ่านพิกัด พล็อตเตอร์ ฯลฯ ซึ่ง เป็น
ฮาร์ดแวร์ที่ใช้ในการน าเข้า จัดเก็บ ประมวลผล และแสดงผลข้อมูล สามารถรองรับการท างานร่วมกับ
ซอฟต์แวร์ระบบสารสนเทศภูมิศาสตร์ และมีสมรรถนะเพียงพอส าหรับการปฏิบัติงานเพ่ือให้บรรลุวัตถุประสงค์
ของการประยุกต์ใช้ระบบสารสนเทศภูมิศาสตร์  

Hardware 

Software 

People Data/Database 

Procedure 
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2) ซอฟต์แวร์ระบบสารสนเทศภูมิศาสตร์ (GIS software) คือ ชุดค าสั่งหรือโปรแกรม
ส าเร็จรูปที่พัฒนาขึ้นมาท างานกับข้อมูลเชิงพื้นที่ มีหน้าที่หลัก คือ น าเข้า จัดเก็บ ประมวลผล วิเคราะห์ และ
แสดงผลข้อมูล ปัจจุบัน มีซอฟต์แวร์ระบบสารสนเทศภูมิศาสตร์เชิงพาณิชย์ที่ได้รับความนิยมใช้กันอย่าง
แพร่หลาย ได้แก่ ArcGIS, MapInfo, AutoCAD Map, IDRISI GIS และ Geomedia เป็นต้น นอกจากนี้ ยังมี
ซอฟต์แวร์รหัสเปิดที่มีการพัฒนาขึ้นเพื่อใช้งานด้านศึกษาวิจัย และไม่คิดค่าใช้จ่ายในการใช้งานซอฟต์แวร์ เช่น 
GRASS GIS, Quantum GIS, MapWindow GIS, User-friendly Desktop Internet GIS (uDig) และ 
SAGA GIS เป็นต้น 

3)   ข้อมูลหรือฐานข้อมูล (Data/Database) ข้อมูลในระบบสารสนเทศภูมิศาสตร์ แบ่ง
ออกเป็น 2 ประเภท ได้แก่ ข้อมูลเชิงพื้นที่ (Spatial data) และข้อมูลลักษณะประจ า (Attribute data) ข้อมูล
หรือฐานข้อมูลในระบบสารสนเทศภูมิศาสตร์ควรมีความถูกต้อง ครบถ้วน และทันสมัยเพียงพอต่อการน าไป
ประยุกต์ใช้งานในด้านต่าง ๆ ได้ตรงตามวัตถุประสงค์ของการพัฒนาระบบ 

4)   กระบวนการด าเนินงาน เป็นขั้นตอนที่ผู้ใช้งานระบบเป็นผู้ก าหนดขึ้น เพื่อให้ระบบ
ท างานบรรลุตามวัตถุประสงค์ที่ต้องการ โดยทั่วไปแล้ว วิธีการด าเนินการของระบบสารสนเทศภูมิศาสตร์ 
ประกอบด้วยขั้นตอนที่ส าคัญ ได้แก่ การก าหนดวัตถุประสงค์หรือเป้าหมายของการพัฒนาระบบ การส ารวจ 
รวบรวมและน าเข้าข้อมูล การจัดการและประมวลผลข้อมูล การวิเคราะห์ข้อมูล และการแสดงผลลัพธ์ของ
ข้อมูลในรูปต่าง ๆ ซึ่งอาจอยู่ในรูปของส าเนาถาวร (Hard copy) เช่น แผนที่ รายงาน หรือส าเนา
อิเล็กทรอนิกส์ (Soft copy) เช่น แฟ้มข้อมูลคอมพิวเตอร์ 

5)   บุคลากรที่เกี่ยวข้องกับการท างานของระบบสารสนเทศภูมิศาสตร์ ได้แก่ ผู้ปฏิบัติงาน
ด้านระบบคอมพิวเตอร์ที่ท าหน้าที่ดูแลฮาร์ดแวร์และซอฟต์แวร์ของระบบ เพื่อให้ระบบสามารถท างานได้ 
บุคลากรด้านระบบสารสนเทศภูมิศาสตร์ที่ท าหน้าที่ออกแบบ จัดท า วิเคราะห์ และน าเสนอข้อมูลตามที่ผู้ใช้ 
(End user) ต้องการ ซึ่งอาจจะเป็นผู้บริหารหรือผู้ที่จะน าสารสนเทศไปใช้ประโยชน์ เพื่อการวางแผน หรือการ
ตัดสินใจด าเนินการขององค์กร 

2.2 ข้อมูลระบบสารสนเทศภูมิศาสตร ์
ระบบสารสนเทศภูมิศาสตร์ ประกอบด้วยข้อมูล 2 ประเภท คือ ข้อมูลเชิงพื้นที่ (Spatial 

data) และข้อมูลลักษณะประจ า หรือข้อมูลเชิงบรรยาย (Attribute data หรือ Non-spatial data) (รูปที่ 
1.3) แหล่งข้อมูลส าหรับระบบสารสนเทศภูมิศาสตร์ แบ่งได้เป็น 2 ประเภท คือ แหล่งข้อมูลปฐมภูมิ เช่น 
ข้อมูลการส ารวจรังวัดภาคสนาม ข้อมูลการรับรู้จากระยะไกล ข้อมูลการส ารวจทางวิทยาศาสตร์ และข้อมูล
การส ารวจโดยใช้แบบสอบถามหรือการสัมภาษณ์ เป็นต้น และแหล่งข้อมูลทุติยภูมิ เช่น แผนที่ เอกสาร และ
รายงาน เป็นต้น 
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รูปที่ 1.3 ข้อมูลเชิงพื้นที่และข้อมูลลักษณะประจ าในระบบสารสนเทศภูมิศาสตร ์
 
ข้อมูลหรือฐานข้อมูลเป็นองค์ประกอบส าคัญของระบบสารสนเทศภูมิศาสตร์ คุณประโยชน์ที่

เกิดจากการน าผลการวิเคราะห์ข้อมูลไปใช้งานจะขึ้นอยู่กับคุณภาพของข้อมูล การวิเคราะห์ข้อมูลจาก
ฐานข้อมูลที่ขาดคุณภาพ จะท าให้ผลการวิเคราะห์ไม่มีความถูกต้อง ขาดความน่าเชื่อถือ และไม่สามารถ
น าไปใช้ประโยชน์ได้ตามที่คาดหมายไว้ ดังนั้น การเก็บรวบรวมและน าเข้าข้อมูล ควรค านึ งถึงความต้องการ
การใช้งาน งบประมาณ ความเหมาะสมของระยะเวลาการจัดท า ฯลฯ เพื่อให้ ได้ข้อมูลหรือฐานข้อมูลที่มี
คุณภาพเหมาะสมเพียงพอต่อการประยุกต์ใช้งานได้อย่างมีประสิทธิภาพ 

1) ข้อมูลเชิงพื้นที่ (Spatial data) หรืออาจเรียกว่า ข้อมูลกราฟิก (Graphic data) เป็น
ข้อมูลแผนที่ที่แสดงต าแหน่งที่ตั้งของสิ่งต่าง ๆ ซึ่งสามารถตอบค าถามว่าสิ่งใดอยู่ที่ไหน ข้อมูลเชิงพื้นที่ในระบบ
สารสนเทศภูมิศาสตร์ต้องมีการอ้างอิงกับระบบพิกัด (Coordinate system) อย่างใดอย่างหนึ่ง ซึ่งระบบพิกัด
ที่ใช้ส าหรับก าหนดต าแหน่งที่ตั้งของสิ่งต่าง ๆ บนโลกที่ได้รับการใช้งานอย่างแพร่หลาย ได้แก่ ระบบพิกัด
ภูมิศาสตร์ (Geographic coordinate system) และระบบพิกัดฉาก (Rectangular coordinate system) 
เช่น ระบบพิกัด UTM เป็นต้น  

 2) ข้อมูลลักษณะประจ า (Attribute data หรือ Non-spatial data) เป็นข้อมูลที่อธิบาย
ลักษณะหรือสภาพของข้อมูลเชิงพื้นที่ เช่น ข้อมูลการถือครองที่ดิน ข้อมูลปริมาณธาตุอาหารในดิน หรือข้อมูล
เกี่ยวกับสภาวะเศรษฐกิจและสังคม เป็นต้น ข้อมูลลักษณะประจ าที่จัดเก็บในซอฟต์แวร์ระบบสารสนเทศ
ภูมิศาสตร์นิยมเก็บแบบฐานข้อมูลเชิงสัมพันธ์ (Relational database) ข้อมูลเชิงพื้นที่และข้อมูลลักษณะ
ประจ ามีความสัมพันธ์เช่ือมโยงกัน โดยมีตัวระบ ุ(Identifier) ท าหน้าที่เช่ือมโยงข้อมูล 
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2.3 แบบจ าลองข้อมูลเชิงพ้ืนที่ 
ข้อมูลเชิงพื้นที่เป็นข้อมูลเกี่ยวกับวัตถุ พื้นที่ หรือปรากฏการณ์ ทั้งที่เป็นนามธรรมและ

รูปธรรม ทั้งที่เกิดขึ้นเองตามธรรมชาติหรือที่มนุษย์สร้างขึ้น เช่น หมู่บ้าน หมุดหลักฐาน แปลงที่ดิน เส้นชั้น
ความสูง ขอบเขตจังหวัด ขอบเขตอ าเภอ แม่น้ า ถนน ทะเลสาบ พื้นที่ป่า เป็นต้น ซึ่งสามารถอ้างอิงต าแหน่งได้ 
ข้อมูลเชิงพื้นที่จึงเป็นข้อมูลที่สามารถแสดงในรูปของแผนที่ได ้

กระบวนการน าข้อมูลเชิงพื้นที่หรือข้อมูลสิ่งเป็นจริงบนโลก (Real world) มาจัดเก็บใน
ระบบคอมพิวเตอร์ เรียกว่า การท าแบบจ าลองข้อมูล (Data modeling) ในปัจจุบัน ซอฟต์แวร์ระบบ
สารสนเทศภูมิศาสตร์ส่วนใหญ่จัดเก็บข้อมูลเชิงพื้นที่โดยใช้แบบจ าลองข้อมูล 2 ประเภท ได้แก่ แบบจ าลอง
ข้อมูลเวกเตอร์ และแบบจ าลองข้อมูลแรสเตอร์ (รูปที่ 1.4) 

 

 
 

รูปที่ 1.4 แบบจ าลองข้อมูลเวกเตอร์ และแบบจ าลองข้อมูลแรสเตอร.์ จาก The GIS primer: An 
introduction to geographic information systems, โดย D. J. Buckey, 1997, 
ค้นเมื่อ 10 มกราคม 2556, จาก http://bgis.sanbi.org/GIS-primer/index.htm. 

 
 1) แบบจ าลองข้อมูลเวกเตอร ์(Vector data model) 

แบบจ าลองข้อมูลเวกเตอร์ นิยมใช้จัดเก็บข้อมูลเชิงพื้นที่ที่มีลักษณะไม่ต่อเนื่อง 
(Discrete data) เช่น จุดยอดเขา ถนน แม่น้ า ฯลฯ 

การจัดเก็บข้อมูลเชิงพื้นที่แบบเวกเตอร์ใช้รูปเรขาคณิตพื้นฐาน 3 ประเภท  ได้แก่ 
จุด (Point) เส้น (Line) และพื้นที่หรือรูปหลายเหลี่ยม (Area หรือ Polygon) ซึ่งต าแหน่งของจุด เส้น และ
พื้นที่ ถูกจัดเก็บเป็นค่าพิกัด X,Y ที่มีการอ้างอิงกับระบบพิกัดระบบใดระบบหนึ่ง 
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ข้อมูลจุดมีค่าพิกัด X,Y หนึ่งคู่ และมี 0 มิติ ข้อมูลเส้นประกอบด้วยจุดมากกว่าหนึ่ง
จุด และมีเส้นตรงเชื่อมระหว่างจุด ข้อมูลเส้นมี 1 มิติ คือ ความยาว ข้อมูลพื้นที่หรือรูปหลายเหลี่ยม เกิดจาก
เส้นล้อมรอบพื้นที่ ซึ่งเป็นเส้นที่มีจุดเริ่มต้นและจุดสิ้นสุดเป็นจุดเดียวกัน ข้อมูลพื้นที่มี 2 มิติ คือ ความกว้าง
และความยาว (รูปที่ 1.5) 

 
 

รูปที่ 1.5 การจัดเก็บข้อมูลเชิงพื้นที่แบบเวกเตอร์โดยใช้จุด เส้น และรูปหลายเหลี่ยม 
 
การจัดเก็บข้อมูลเชิงพื้นที่เป็นข้อมูลประเภทจุด เส้น หรือพื้นที่ จะขึ้นอยู่กับระดับ

มาตราส่วน (Scale) ของข้อมูลที่ต้องการจัดเก็บและวัตถุประสงค์ของการใช้งานข้อมูล ยกตัวอย่างเช่น การ
จัดเก็บข้อมูลแม่น้ าหรือถนนที่มีระดับมาตราส่วนเล็ก (ในการแผนที่ แผนที่มาตราส่วนเล็กครอบคลุมพื้นที่
ขนาดใหญ่ แผนที่มาตราส่วนใหญ่ครอบคลุมพื้นที่ขนาดเล็ก) อาจจะจัดเก็บข้อมูลแม่น้ าหรือถนนเป็นข้อมูล
ประเภทเส้น ซึ่งสามารถน าข้อมูลมาตราส่วนเล็กไปประยุกต์ใช้งานด้านการวางแผนในระดับเบื้องต้นได้ 
อย่างไรก็ตาม เมื่อต้องการน าข้อมูลไปประยุกต์ใช้งานด้านวิศวกรรม อาจจะต้องจัดเก็บข้อมูลให้มีมาตราส่วน
ใหญ่ขึ้น ซึ่งจะเป็นข้อมูลประเภทพื้นที่ (Polygon) เป็นต้น (รูปที่ 1.6) 

ด้วยเหตุนี้ ผู้พัฒนาและผู้ใช้งานระบบสารสนเทศภูมิศาสตร์จะต้องมีวัตถุประสงค์
ของการประยุกต์ใช้งานข้อมูลที่ชัดเจน จึงจะท าให้การส ารวจและการรวบรวมข้อมูลต่าง ๆ มาจัดเก็บมีความ
ถูกต้องและเหมาะสม 
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                                 มาตราส่วนเล็ก                  ข้อมูลประเภทเส้น 

 

                                 มาตราส่วนใหญ ่          ข้อมูลประเภทพื้นที่ 
 

รูปที่ 1.6 อิทธิพลของมาตราส่วน (Scale) กับการจัดเก็บข้อมูล 
 
ในซอฟต์แวร์ระบบสารสนเทศภูมิศาสตร์ที่จัดเก็บข้อมูลแบบเวกเตอร์ ข้อมูลที่

จัดเก็บด้วยรูปเรขาคณิตประเภทจุด เส้น และพื้นที่ สามารถแสดงผลโดยใช้สัญลักษณ์ (Symbol) ประเภทต่าง 
ๆ เช่น จุด อาจแทนด้วยสัญลักษณ์วงกลม สามเหลี่ยม สี่เหลี่ยม กากบาท หรือรูปกราฟิก เช่น บ้าน เครื่องบิน 
ฯลฯ เป็นต้น โดยที่มีข้อมูลค่าพิกัด X,Y คงเดิม ส าหรับข้อมูลเส้น และพื้นที่ ก็สามารถแสดงข้อมูลด้วย
สัญลักษณ์ที่มีทิศทาง และลักษณะเส้น สี แบบรูป หรือขนาด ได้แตกต่างกันเช่นเดียวกับข้อมูลจุด 

โครงสร้างการจัดเก็บข้อมูลเชิงพื้นที่แบบเวกเตอร์ของซอฟต์แวร์ระบบสารสนเทศ
ภูมิศาสตร์ ที่ส าคัญมีดังนี ้1) โครงสร้างแบบสปาเก็ตตี้ และ 2) โครงสร้างแบบทอพอโลยี ซึ่งมีรายละเอียดดังนี ้

1.1) โครงสร้างข้อมูลแบบสปาเก็ตตี้ (Spaghetti data structure) 
เป็นการจัดเก็บข้อมูลที่มีการบันทึกข้อมูลเป็นค่าของคู่พิกัด X,Y ข้อมูลจุด 

บันทึกค่าพิกัด X,Y จ านวนหนึ่งคู่ ข้อมูลเส้น บันทึกเป็นชุดของค่าพิกัด X,Y และข้อมูลพื้นที่ บันทึกเป็นชุดของ
ค่าพิกัด X,Y ซึ่งมีจุดเริ่มต้นของเส้นและจุดสิ้นสุดของเส้นเป็นจุดเดียวกัน ดังนั้น ส่วนของเส้นรอบรูปของพื้นที่ที่
อยู่ประชิดติดกัน จะต้องบันทึกข้อมูลซ้ ากัน 2 ครั้ง (รูปที่ 1.7) 
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รูปที่ 1.7 โครงสร้างการจัดเก็บข้อมูลเชิงพื้นที่แบบสปาเก็ตต้ี 
 

โครงสร้างข้อมูลแบบสปาเก็ตตี้ เป็นโครงสร้างข้อมูลที่ไม่ซับซ้อน ฟีเจอร์ 
(หมายถึง วัตถุ พื้นที่ หรือปรากฏการณ์ที่แสดงบนแผนที่ เช่น ในแผนที่ที่แสดงจุดต าแหน่งเมืองหลวงของแต่ละ
ประเทศ  แต่ละฟีเจอร์ จะหมายถึง ที่ตั้งเมืองหลวงแต่ละประเทศ หรือในแผนที่แสดงเส้นแม่น้ า แต่ละฟีเจอร์ 
จะหมายถึง แม่น้ าแต่ละสาย เป็นต้น) แต่ละหน่วยถูกจัดเก็บเพียงค่าหรือชุดของค่าพิกัด X,Y ไม่มีการจัดเก็บ
ข้อมูลอื่น ๆ ที่ไม่จ าเป็น ท าให้การประมวลผลข้อมูลท าได้รวดเร็ว และมีประสิทธิภาพในแง่ของการผลิตแผนที่ 
อย่างไรก็ตาม เนื่องจากไม่มีการจัดเก็บข้อมูลเกี่ยวกับความสัมพันธ์เชิงพื้นที่ หรือทอพอโลยี ท าให้ไม่สามารถ
วิเคราะห์ข้อมูลเชิงพื้นที่ได้อย่างมีประสิทธิภาพ (สรรค์ใจ กลิ่นดาว, 2542, น. 74-75) 

1.2) โครงสร้างข้อมูลแบบทอพอโลยี (Topological data structure) 
 ทอพอโลยีของข้อมูลเชิงพื้นที่ในระบบสารสนเทศภูมิศาสตร์จะแสดง

ความสัมพันธ์เชิงพื้นที่ของข้อมูล เช่น ความยาวและทิศทางของเส้น การเชื่อมต่อของเส้น การนิยามขอบเขต 
และความต่อเนื่องของพ้ืนที่ โครงสร้างข้อมูลแบบทอพอโลยมีีดังน้ี 

 ทอพอโลยีของจุดกับเส้น (Arc-node topology) เป็นความสัมพันธ์
ระหว่างจุดกับเส้น ซึ่งเกี่ยวข้องกับความยาว ทิศทาง และภาวะเชื่อมโยงของเส้น ทอพอโลยีของจุดกับเส้น 
ได้แก่ จุดเริ่มต้น (FNODE#) จุดสิ้นสุด (TNODE#) และความยาวของเส้น (LENGTH) (รูปที่ 1.8) MAHID
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รูปที่ 1.8 ทอพอโลยีของจุดกับเส้น (Arc-node topology) 
 

 ทอพอโลยีของเส้นกับพื้นที่ (Polygon-arc topology) เป็น
ความสัมพันธ์ระหว่างเส้นกับพื้นที่ ซึ่งเกิดจากเส้นเชื่อมต่อกันเป็นเส้นรอบรูปของพื้นที่หรือรูปหลายเหลี่ยม ท า
ให้สามารถบอกขอบเขตและความต่อเน่ืองของพ้ืนที่ที่อยู่ติดกันได้ พื้นที่ที่ต่อเนื่องกันหรืออยู่ประชิดติดกัน จะมี
เส้นร่วมกัน แต่ละพื้นที่มีเลขประจ า (ID) ของพื้นที่ เพื่อใช้ส าหรับอ้างอิง เส้นแต่ละเส้นเป็นส่วนหนึ่งของเส้น
รอบรูป (Perimeter) ของพื้นที่ และเมื่อพิจารณาจากจุดเริ่มต้นและจุดสิ้นสุดของเส้น ท าให้สามารถระบุได้ว่า 
พื้นที่ใดอยู่ทางซ้าย (LPOLY#) หรือทางขวา (RPOLY#) ของเส้น พื้นที่หนึ่ง ๆ อาจเป็นพื้นที่ด้านซ้ายของเส้น
หนึ่ง ขณะเดียวกัน สามารถเป็นพื้นที่ด้านขวาของเส้นอีกเส้นหนึ่ง (รูปที่ 1.9) MAHID
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รูปที่ 1.9 ทอพอโลยีของเส้นกับพื้นที่ (Polygon-arc topology) 
 

 2) แบบจ าลองข้อมูลแรสเตอร์ (Raster data model) 
   การจัดเก็บข้อมูลเชิงพื้นที่แบบแรสเตอร์ จะแบ่งข้อมูลของพื้นที่ที่ต้องการจัดเก็บ

ออกเป็นตารางสี่เหลี่ยมจัตุรัสขนาดเท่า ๆ กัน ซึ่งเรียกว่า เซลล์ (Cell) หรือจุดภาพ (Pixel) เซลล์แต่ละเซลล์มี
ค่าตัวเลขประจ าสดมภ์ (Column) และแถว (Row) ที่ใช้บอกต าแหน่งของเซลล์ โดยมีจุดก าเนิด (Origin) อยู่ที่
ด้านบนซ้าย แต่ละเซลล์เก็บค่าข้อมูลได้หนึ่งค่า ชนิดของข้อมูลที่จัดเก็บเป็นได้ทั้งตัวเลขหรือตัวอักษร ค่าของ
เซลล์จะเป็นข้อมูลที่เป็นตัวแทนของพื้นที่เซลล์นั้น ๆ อาจเป็นค่าข้อมูลลักษณะประจ า เช่น ประเภทการใช้
ที่ดิน ค่าความสูงของพื้นผิวโลก ปริมาณการปนเปื้อนของสารพิษ หรือ อุณหภูมิ ฯลฯ หรืออาจเป็นค่าของรหัส
สมมุติที่ก าหนดขึ้นเพื่อใช้เชื่อมโยงกับฐานข้อมูลลักษณะประจ า เช่น ชั้นข้อมูลดินที่เซลล์มีค่า 3 อาจจะ
เชื่อมโยงไปยังข้อมูลลักษณ์ประจ าที่เก็บข้อมูลเกี่ยวกับช่ือชุดดิน เนื้อดิน สีดิน และค่า pH เป็นต้น (รูปที่ 1.10) 
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รูปที่ 1.10 แบบจ าลองข้อมูลแรสเตอร ์
 
แบบจ าลองข้อมูลแรสเตอร์จัดเก็บข้อมูลแยกออกเป็นชั้นข้อมูล ข้อมูลที่จัดเก็บแบบ

แรสเตอร์ สามารถแบ่งออกเป็น 2 ประเภท คือ 1) ข้อมูลไม่ต่อเนื่อง (Discrete data หรือ Thematic data) 
เช่น ข้อมูลการใช้ที่ดิน หรือข้อมูลชนิดดิน เป็นต้น และ 2) ข้อมูลต่อเนื่อง (Continuous data) เช่น ข้อมูล
อุณหภูมิ ข้อมูลความสูง และข้อมูลการรับรู้จากระยะไกล ทั้งภาพดาวเทียม และรูปถ่ายทางอากาศ เป็นต้น 

แฟ้มข้อมูลแบบแรสเตอร์อาจเป็นแฟ้มข้อมูลที่มีเพียงชั้นข้อมูลเดียว (Single layer 
หรือ Single band) หรืออาจประกอบด้วยหลายชั้นข้อมูล (Multiple layer หรือ Multiple band)         
(รูปที่ 1.11) แฟ้มข้อมูลแรสเตอร์แบบชั้นข้อมูลเดี่ยว มักใช้เก็บข้อมูลแบบเฉพาะเรื่อง (Thematic data) ซึ่ง
อาจเป็นข้อมูลไม่ต่อเนื่อง เช่น การใช้ที่ดิน ชนิดดิน หรือข้อมูลต่อเนื่อง เช่น ข้อมูลระดับความสูง ส าหรับ
แฟ้มข้อมูลแรสเตอร์แบบหลายชั้น ส่วนใหญ่ใช้จัดเก็บข้อมูลรูปถ่ายทางอากาศสี หรือภาพดาวเทียมแบบหลาย
ช่วงคลื่น แต่ละชั้นหรือแบนด์ของแฟ้มข้อมูลจะเก็บบันทึกข้อมูลค่าสะท้อนหรือเปล่งพลังงานช่วงคลื่น
แม่เหล็กไฟฟ้า ตัวอย่างแฟ้มข้อมูลแบบนี้ ได้แก่ ข้อมูลภาพดาวเทียม LANDSAT หรือข้อมูลภาพดาวเทียม 
SPOT เป็นต้น 
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รูปที่ 1.11 แฟม้ข้อมูลแรสเตอร์แบบหลายช้ันข้อมูล 
 
การจัดเก็บข้อมูลเชิงพื้นที่แบบแรสเตอร์ เซลล์แต่ละเซลล์มีค่าข้อมูลที่บันทึกเอาไว้ 

และเป็นค่าที่ เป็นตัวแทนของพื้นที่บนพื้นผิวโลก ขนาดของเซลล์บ่งบอกถึงความละเอียดของข้อมูล 
(Resolution) และมีผลต่อขนาดของแฟ้มข้อมูล ถ้าเซลล์มีขนาดเล็ก (ขนาดความครอบคลุมพื้นที่บนผิวโลกจะ
น้อย) ท าให้ข้อมูลที่จัดเก็บมีระดับรายละเอียดมากขึ้น แต่จ านวนเซลล์ของชั้นข้อมูลจะเพิ่มมากขึ้น และท าให้
แฟ้มข้อมูลมีขนาดใหญ่ขึ้นตามไปด้วย (รูปที่ 1.12) ในทางปฏิบัต ิขนาดของเซลล์ควรจะมีขนาดเล็กเพียงพอต่อ
การน าไปประยุกต์ใช้งานให้บรรลุวัตถุประสงค์ตามที่ต้องการ แต่ไม่ควรมีขนาดเล็กเกินไป เนื่องจากจะท าให้
สิ้นเปลืองเนื้อที่การจัดเก็บ และท าให้การประมวลผลข้อมูลมีประสิทธิภาพลดลง 

 

 
 

รูปที่ 1.12 ขนาดของเซลล์กับระดับรายละเอียดการจัดเก็บข้อมูลแบบแรสเตอร.์ จาก ArcGIS Desktop 9.3 
Help, โดย ESRI, Inc., 2009, ค้นเมื่อ 14 มกราคม 2556, จาก 

http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Cell%20size%20of%20raster%20data. 
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ข้อดีของแบบจ าลองข้อมูลแรสเตอร์ คือ โครงสร้างข้อมูลไม่ซับซ้อน ง่ายต่อการ
จัดเก็บและประมวลผลข้อมูล  และมีความเหมาะสมในการจัดเก็บข้อมูลเชิงพื้นที่ที่มีความต่อเนื่อง 
(Continuous data) เช่น ข้อมูลลักษณะพื้นผิวภูมิประเทศ แต่ข้อมูลแบบแรสเตอร์ก็มีข้อด้อย คือ ข้อมูลซึ่งมี
รายละเอียดสูงจะใช้เนื้อที่การจัดเก็บข้อมูลค่อนข้างมาก และไม่เหมาะกับการจัดเก็บข้อมูลประเภทโครงข่าย 
เช่น โครงข่ายถนน ตัวอย่างข้อมูลที่มีการจัดเก็บแบบแรสเตอร์ ได้แก่ ข้อมูลภาพจากดาวเทียม  

2.4 ข้อมูลลักษณะประจ า 
 ข้อมูลลักษณะประจ า เป็นข้อมูลที่อธิบายลักษณะหรือสภาพของข้อมูลเชิงพื้นที่ ณ เวลาใด

เวลาหน่ึง ข้อมูลลักษณะประจ าสามารถแบ่งตามระดับการวัดข้อมูลไดอ้อกเป็น 4 ประเภท คือ 
1) ข้อมูลแบบนามก าหนด (Nominal scale) เป็นการวัดและแบ่งข้อมูลออกเป็นประเภท

หรือกลุ่ม (Category) ตัวอย่างข้อมูลแบบนามก าหนด ได้แก่ ชื่อจังหวัด อ าเภอ ต าบล ประเภทป่า เช่น ป่า
ผลัดใบ ป่าไม่ผลัดใบ เป็นต้น อย่างไรก็ตาม เพื่อให้การจัดเก็บและประมวลข้อมูลมีประสิทธิภาพมากขึ้น 
ผู้จัดท าฐานข้อมูลระบบสารสนเทศภูมิศาสตร์ส่วนใหญ่ จะนิยมจัดเก็บข้อมูลโดยการใช้ค่าตัวเลขแทนค่าของ
ข้อมูลจริงแต่ละประเภท เช่น 1 มีค่าเท่ากับ เพศชาย และ 2 มีค่าเท่ากับเพศหญิง เป็นต้น ซึ่งค่าตัวเลขเหล่านี้
ไม่มีความหมายทางคณิตศาสตร์ และไม่สามารถใช้ค านวณได้ ข้อมูลแบบนามก าหนด สามารถค านวณ
ค่าความถี่ และค่าร้อยละ และสามารถน าค่าความถี่มาใช้ค านวณค่าฐานนิยม การทดสอบไคก าลังสอง การ
ทดสอบทวินาม แต่ไม่สามารถค านวณค่าเฉลี่ยเลขคณิต และค่าเบี่ยงเบนมาตรฐานได้  

2) การวัดแบบจัดอันดับ (Ordinal scale) เป็นการวัดข้อมูลแบบแบ่งกลุ่ม และจัดอันดับ
ความแตกต่างระหว่างกลุ่ม ท าให้สามารถระบุได้ว่ากลุ่มใดดีกว่ากลุ่มอื่น หรือกลุ่มใดมากหรือน้อยกว่ากลุ่มอื่น 
แต่ไม่สามารถระบุได้ว่ามีปริมาณมากหรือน้อยกว่าเท่าใด เช่น ความเหมาะสมของดินต่อการเพาะปลูกพืชเป็น
ข้อมูลแบบจัดอันดับ อาจแบ่งอันดับเป็น เหมาะสมมาก เหมาะสมน้อย และไม่เหมาะสม หรือพื้นที่เสี่ยงต่อการ
เกิดดินถล่มและอุทกภัย อาจแบ่งระดับความเสี่ยงออกเป็น เสี่ยงมาก เสี่ยงปานกลาง เสี่ยงน้อย เป็นต้น ข้อมูล
แบบจัดอันดับ สามารถค านวณค่าความถี่ ร้อยละ ควอร์ไทล์ ค่ามัธยฐาน และการทดสอบไคก าลังสอง เป็นต้น   

3) การวัดแบบอันตรภาค (Interval scale) เป็นข้อมูลแบบจัดอันดับ ที่สามารถบอกปริมาณ
ความแตกต่างระหว่างกลุ่มได้ แต่จุดเริ่มต้นของการวัดไม่ได้เริ่มจากค่าศูนย์สัมบูรณ์ ตัวอย่างข้อมูลแบบอันตร
ภาค ได้แก่ การวัดอุณหภูมิด้วยมาตราฟาเรนไฮต์ ข้อมูลแบบอันตรภาค สามารถค านวณค่าความถี่ ร้อยละ ค่า
ฐานนิยม ค่าเฉลี่ยเลขคณิต และค่าเบี่ยงเบนมาตรฐาน และการทดสอบไคก าลังสอง เป็นต้น แต่ไม่สามารถ
ค านวณค่าเฉลี่ยเรขาคณิต ค่าเฉลี่ยฮาร์มอนิก และสัมประสิทธิ์การแปรผันได ้

4) การวัดแบบอัตราส่วน (Ratio scale) เป็นข้อมูลแบบอันตรภาคที่มีจุดเริ่มต้นของการวัด
เป็นค่าศูนย์สัมบูรณ์ และเป็นค่าที่มีความหมาย ท าให้สามารถบอกความแตกต่าง และเปรียบเทียบความ
แตกต่างได้ ตัวอย่างข้อมูลแบบอัตราส่วน ได้แก่ ขนาดพื้นที่ ระยะทาง จ านวนประชากร จ านวนรายได้ 
ปริมาณสารเคมีที่พบในดิน เป็นต้น ข้อมูลแบบอัตราส่วนสามารถวิเคราะห์ข้อมูลทางสถิติได้ทั้งหมด 
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การแบ่งประเภทข้อมูลลักษณะประจ าตามระดับการวัดข้อมูลมีความสัมพันธ์กับการแสดงผล
ข้อมูลเชิงพื้นที่ ข้อมูลแบบนามก าหนดเป็นข้อมูลเชิงคุณภาพที่แบ่งข้อมูลออกเป็นกลุ่มหรือประเภท ข้อมูล
ประเภทจุดที่จัดเก็บแบบนามก าหนดสามารถใช้สัญลักษณ์ประเภทต่าง ๆ  เช่น จุดกลมทึบแสดงต าแหน่งจุด
ที่ตั้งของเมือง สัญลักษณ์รูปค้อนไขว้แสดงที่ตั้งของเหมือง หรือสัญลักษณ์รูปกากบาทแสดงจุดที่ตั้งของหมุด
ระดับ เป็นต้น ส าหรับข้อมูลจุดที่จัดเก็บแบบจัดอันดับ สามารถใช้สัญลักษณ์ขนาดต่าง ๆ หรือระดับความ
อ่อน-แก่ของสี เพื่อแสดงความแตกต่างของล าดับข้อมูล ข้อมูลประเภทจุดที่จัดเก็บข้อมูลแบบอันตรภาคและ
แบบอัตราส่วนสามารถใช้สัญลักษณ์ขนาดต่าง ๆ หรือจ านวนจุด เพื่อแสดงขนาดหรือปริมาณของข้อมูล
ลักษณะประจ าได้ เช่น การแสดงข้อมูลจ านวนประชากรโดยใช้ขนาดของจุดแทนจ านวนประชากร เป็นต้น 
ส าหรับข้อมูลประเภทเส้น และพื้นที่จะมีลักษณะของความสัมพันธ์ระหว่างการแสดงผลข้อมูลเชิงพื้นที่กับการ
แบ่งประเภทข้อมูลลักษณะประจ าตามระดับการวัดข้อมูลคล้ายคลึงกันกับข้อมูลประเภทจุด (รูปที่ 1.13) 

 

 
 

รูปที่ 1.13 ความสัมพันธ์ระหว่างข้อมูลเชิงพ้ืนที่ ประเภทจดุ เส้น และพ้ืนที่ กับข้อมูลลักษณะประจ าที่แบ่ง
ประเภทตามระดับการวัดข้อมูล. จาก GIS for dummies (p. 42), 

โดย M. N. Demers, 2009, Hoboken, New Jersey: Wiley Publishing, Inc. 

2.5 การน าเข้าข้อมูลสู่ระบบสารสนเทศภูมิศาสตร ์
การน าเข้าข้อมูล เป็นการบันทึกรหัสข้อมูลเข้าสู่คอมพิวเตอร์ในรูปแบบที่สามารถอ่านและ

เขียนข้อมูลลงสู่ฐานข้อมูลระบบสารสนเทศภูมิศาสตร์ เป็นกระบวนการที่ต้องใช้งบประมาณและระยะเวลาใน
การด าเนินงานสูง ข้อมูลที่มีคุณภาพต้องทันสมัย มีความถูกต้องเชิงต าแหน่งเหมาะสมกับการประยุกต์ใช้งาน มี
การจ าแนกข้อมูลที่มีความถูกต้องสมบูรณ์ และข้อมูลได้รับการรวบรวมและน าเข้าอย่างถูกต้องตาม
วัตถุประสงค์ของการประยุกต์ใช้งานหรือตามมาตรฐานทีไ่ดก้ าหนดไว ้การน าเข้าข้อมูลมีข้อควรพิจารณาดังนี ้
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1) แหล่งข้อมลู (Source of data) 
 แหล่งข้อมูลที่ใช้ในระบบสารสนเทศภูมิศาสตร์แบ่งออกกว้าง ๆ เป็น 2 ประเภท คือ 

แหล่งข้อมูลปฐมภูมิ (Primary data source) และแหล่งข้อมูลทุติยภูมิ (Secondary data source) ซึ่งแต่ละ
ประเภทมีลักษณะดังนี ้

1.1) แหล่งข้อมูลปฐมภูมิ หมายถึง ข้อมูลที่ได้จากการวัดหรือส ารวจโดยตรงจาก
ผู้จัดท าข้อมูลหรือฐานข้อมูลระบบสารสนเทศภูมิศาสตร์ ส่วนใหญ่จะเป็นข้อมูลเฉพาะ (Specific data) ที่
จัดท าขึ้นเพื่อตอบสนองวัตถุประสงค์ของการประยุกต์ใช้งานระบบสารสนเทศภูมิศาสตร์อย่างหนึ่ง 

1.2 ) แหล่งข้อมูลทุติภูมิ หมายถึง ข้อมูลแอนะล็อกหรือดิจิทัลได้จากการใช้งาน
ข้อมูลที่จัดท าขึ้นโดยบุคคลหรือองค์กรอื่น ๆ ซึ่งมักจะมีวัตถุประสงค์ของการจัดท าข้อมูลแตกต่างจาก
วัตถุประสงค์ของการประยุกต์ใช้งานที่ต้องการ จึงอาจจะต้องผ่านกระบวนการแปลงข้อมูลหรือจัดการข้อมูล
ก่อนจะสามารถน าข้อมูลมาใช้ประโยชน์ได้ 

แหล่งข้อมูลปฐมภูมิและทุติภูมิของข้อมูลเชิงพ้ืนที่และข้อมูลลักษณะประจ า สามารถ
สรุปได้ดังตารางที่ 1.1 

 
ตารางที่ 1.1 แหล่งข้อมูลปฐมภูมิและทุติภูมิของข้อมูลเชิงพ้ืนที่และข้อมูลลักษณะประจ า 

แหล่งข้อมูล ข้อมูลเชิงพื้นที่ ข้อมูลลักษณะประจ า 
แหล่งข้อมูลปฐมภูมิ  การส ารวจด้วยเครื่องส ารวจ

ภาคพื้นดิน (Ground survey) 

 การส ารวจทางโฟโตแกรมเมตรี 
(Photogrammetric survey) 

 การส ารวจด้วยเครื่องจีพีเอส (GPS 
survey) 

 การรับรู้จากระยะไกล (Remote 
sensing) 

 การส ารวจข้อมูลภาคสนามโดยใช้
เครื่องมือทางวิทยาศาสตร์ เช่น 
เครื่องทดสอบ pH หรือ DO เป็นต้น 

 การส ารวจข้อมูลภาคสนามโดยใช้
เครื่องมือทางสังคมศาสตร์ เช่น 
แบบสอบถามหรือแบบส ารวจ 

แหล่งข้อมูลทตุิยภูมิ  แผนที ่

 รูปถ่ายทางอากาศ 

 เอกสาร 

 รายงาน 
 

2) วิธีการน าเข้าข้อมูล 
 การน าเข้าข้อมูลเชิงพื้นที่และข้อมูลลักษณะประจ าจากแหล่งข้อมูลปฐมภูมิและทุติ

ภูมิต่าง ๆ มีดังน้ี 
2.1) การดิจิไทซ์ (Digitizing) เป็นการน าเข้าข้อมูลเชิงพื้นที่แบบแอนะล็อกจาก

แหล่งข้อมูลทุติภูมิ เช่น แผนที่ เพื่อจัดเก็บเป็นข้อมูลดิจิทัลในรูปของข้อมูลเวกเตอร์ การดิจิไทซ์อาจจะใช้
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เครื่องดิจิไทซ์ (Digitizer) หรืออาจจะใช้การดิจิไทซ์ด้วยเมาส์ผ่านหน้าจอคอมพิวเตอร์ ที่เรียกว่า Heads-up 
digitizing (รูปที่ 1.14) 

 

 
 

รูปที่ 1.14 การน าเข้าข้อมูลด้วยการดิจิไทซ.์ จาก A comparison of digitizing: FastCAD, FreeHand, and 
PC ARC/INFO, โดย R. A. Ore, 2001, ค้นเมื่อ 16 มกราคม 2556, จาก 

http://proceedings.esri.com/library/userconf/proc01/professional/papers/pap894/p894.htm. 
 
2.2) การกราดภาพ (Scanning) เป็นการน าเข้าข้อมูลเชิงพื้นที่หรือข้อมูลลักษณะ

ประจ าแบบแอนะล็อกจากแหล่งข้อมูลทุติยภูมิ เช่น แผนที่ รูปถ่ายทางอากาศ แผนผัง หรือเอกสารต่าง ๆ โดย
ใช้อุปกรณ์ที่เรียกว่า เครื่องกราดภาพ (Scanner) ซึ่งท าหน้าที่กราดภาพข้อมูล เพื่อจัดเก็บข้อมูลเป็นข้อมูล
แบบแรสเตอร์ (รูปที่ 1.15) ข้อมูลเชิงพื้นที่ที่ได้จากการกราดภาพอาจจะน าไปใช้ในกระบวนการดิจิไทซ์ หรือ
กระบวนการแปลงเป็นเวกเตอร์ (Vectorization) เพื่อจัดท าข้อมูลเชิงพื้นที่แบบเวกเตอร์ต่อไป หรือข้อมูล
ลักษณะประจ าที่ได้จากการกราดภาพเอกสาร (Scanned document) อาจจะน าไปใช้ในกระบวนการรู้จ า
อักขระด้วยแสง (Optical character recognition: OCR) เพื่อจัดท าข้อมูลลักษณะประจ าได้เช่นเดียวกัน 

 

 

รูปที่ 1.15 การน าเข้าข้อมูลด้วยการกราดภาพไทซ์. จาก HP Designjet HD Scanner, โดย Hewlett-
Packard Development Company, L.P., 2013, ค้นเมือ่ 18 มกราคม 2556, จาก 

http://www8.hp.com/us/en/large-format-printers/designjet-printers/HDScanner.html. 
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2.3) การน าเข้าข้อมูลด้วยแผงแป้นอักขระ (Keyboard entry) เป็นการน าเข้าข้อมูล
เชิงพื้นที่หรือข้อมูลลักษณะประจ าแบบแอนะล็อกจากแหล่งข้อมูลปฐมภูมิหรือทุติยภูมิ เช่น ข้อมูลค่าพิกัดจุดที่
แสดงในรูปของตารางข้อมูลในเอกสารหรือรายงาน หรือข้อมูลจากแบบส ารวจข้อมูลภาคสนาม เป็นต้น เพื่อ
จัดเก็บเป็นข้อมูลดิจิทัล ซึ่งสามารถน าไปใช้งานได้ทันที หรืออาจจะน าไปผ่านกระบวนการจัดการข้อมูลต่าง ๆ 
เพื่อใช้ประโยชน์ต่อไป   

2.4) การถ่ายโอนข้อมูล (Data transfer) เป็นการน าข้อมูลเชิงพื้นที่หรือข้อมูล
ลักษณะประจ าจากแหล่งข้อมูลปฐมภูมิหรือทุติยภูมิที่เป็นข้อมูลดิจิทัลซึ่งอาจจะอยู่ในสื่อหรือรูปแบบที่ต้องมี
การน าเข้าสู่ระบบสารสนเทศภูมิศาสตร์ จึงจะต้องมีการจัดเก็บหรือแปลงให้อยู่ในรูปที่เหมาะสมจึงจะใช้งานได้ 
ตัวอย่างของข้อมูลลักษณะนี้ ได้แก่ แฟ้มข้อมูลที่บันทึกอยู่ในซีดีรอม หรือข้อมูลจากตัวลงบันทึกข้อมูล (Data 
logger) เป็นตน้ 

2.6 การแก้ไข และจัดการข้อมูลของระบบสารสนเทศภูมิศาสตร์ 
การแก้ไขและจัดการข้อมูล เป็นกระบวนการเพิ่ม ลบ แก้ไข หรือเปลี่ยนแปลงข้อมูลเพื่อปรับ

ข้อมูลให้ถูกต้องและทันสมัย (Update and maintenance) หรือเพื่อให้ข้อมูลมีความเหมาะสมส าหรับการ
สืบค้นและการวิเคราะห์ข้อมูล 

การด าเนินการการแก้ไขและจัดการข้อมูลของระบบสารสนเทศภูมิศาสตร์ที่มักพบได้บ่อย ๆ 
มีดังน้ี 

1) การแก้ไขและจัดการข้อมูลเชิงพ้ืนที่ 

 การแปลงรูปแบบข้อมูล (Format conversion) ซอฟต์แวร์ระบบสารสนเทศ
ภูมิศาสตร์มักจะมีฟังก์ชันที่ใช้ในการแปลงรูปแบบข้อมูล เนื่องจากข้อมูลที่ต้องการน ามาใช้ในการท างานอาจจะ
มีโครงสร้างรูปแบบข้อมูล (Data format) ที่ซอฟต์แวร์ไม่สามารถใช้งานข้อมูลได้โดยตรง จึงมีความจ าเป็นต้อง
แปลงรูปแบบข้อมูลให้เหมาะสมกับความต้องการของซอฟต์แวร์ ซึ่งซอฟต์แวร์ที่ดีควรจะรองรับการแปลง
รูปแบบข้อมูลที่หลากหลาย เพื่อที่จะรองรับการใช้งานข้อมูลที่อยู่ในรูปแบบต่าง ๆ ได้ 

 การแปลงเชิงเรขาคณิต (Geometric transformation) ใช้ส าหรับแปลงระบบ
พิกัดหรือใช้ปรับยึด (Registration) ให้ต าแหน่งของชั้นข้อมูลแผนที่สองชั้นซึ่งเป็นพื้นที่เดียวกันให้วางซ้อน
ตรงกัน 

 การแปลงระบบการแผนที่ (Projection conversion) ใช้ส าหรับการแปลงระบบ
การแผนที่แต่ละช้ันข้อมูลให้อยู่ในระบบพิกัดเดียวกัน เพราะการแสดงผลหรือการวิเคราะห์ข้อมูลของชั้นข้อมูล
แผนที่ต่าง ๆ ร่วมกัน ควรใช้เส้นโครงแผนที่เดียวกัน 

 การเกลี่ย (Conflation) เป็นการปรับรายละเอียดที่ปรากฏบนชั้นข้อมูลแผนที่
สองช้ันให้สอดคล้องตรงกัน และซ้อนกันสนิทเมื่อน าช้ันข้อมูลแผนที่สองชั้นวางซ้อนกัน 
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 การเทียบขอบ (Edge matching) ใช้ส าหรับปรับต าแหน่งรายละเอียดของชั้น
ข้อมูลแผนที่สองชั้นที่อยู่ติดกันให้มีรายละเอียดสอดคล้องตรงกัน กล่าวอีกนัยหนึ่ง เป็นการปรับรายละเอียด
บริเวณขอบระวางช้ันข้อมูลแผนที่สองชั้นให้ตรงกัน 

 การแก้ไของค์ประกอบกราฟิก (Editing of graphic element) ใช้ส าหรับการ
เพิ่ม ลบ และเปลี่ยนต าแหน่งของฟีเจอร์บนชั้นข้อมูลแผนที่  ซึ่งจัดเป็นค าสั่งพื้นฐานของซอฟต์แวร์ระบบ
สารสนเทศภูมิศาสตร์ เพื่อใช้ปรับข้อมูลเชิงต าแหน่งให้มีความถูกต้องและทันสมัย  

 การลดจ านวนจุดพิกัดข้อมูล (Thinning coordinates หรือ Line smoothing) 
ใช้ส าหรับลดจ านวนข้อมูลจุดพิกัดที่ เกินความจ าเป็นของข้อมูลเส้น ส่งผลให้การประมวลผลข้อมูลมี
ประสิทธิภาพดีขึ้น รวมถึงการลดรายละเอียดข้อมูลให้เหมาะสมกับการใช้งาน 

2) การแก้ไขและจัดการข้อมูลคุณลักษณะประจ า 

 การแปลงรูปแบบข้อมูล (Format conversion) ใช้แปลงรูปแบบข้อมูล
คุณลักษณะประจ าต่าง ๆ ให้เหมาะสมกับการท างานของซอฟต์แวร ์

 การแก้ไขฐานข้อมูล (Database editing) เป็นการแก้ไขข้อมูลลักษณะประจ า ซึ่ง
อาจจะเป็นการไขตารางข้อมูล เช่น การเพิ่มหรือลบเขตข้อมูล หรืออาจจะเป็นการแก้ไขข้อมูลในเขตข้อมูล 
การน าเข้าหรือแก้ไขฐานข้อมูลส่วนใหญ่จะต้องด าเนินการควบคู่ไปกับการการตรวจสอบความถูกต้องของ
ข้อมูล 

 การตรวจสอบความถูกต้องของข้อมูล (Database error checking) เป็นกลไก
หรือเครื่องมือที่ซอฟต์แวร์ออกแบบมาเพื่อใช้ในการควบคุมคุณภาพของข้อมูล เช่น ชนิดของข้อมูล ( Data 
type) ค่าข้อมูลที่เป็นไปได้ (Possible value) หรือช่วงของค่าข้อมูล (Data range) รูปแบบของข้อมูล (Data 
format) เป็นต้น การตรวจสอบลักษณะนี้ จะช่วยลดความผิดพลาดจากกระบวนการน าเข้าหรือแก้ไขข้อมูลลง 
ท าให้ฐานข้อมูลมีคุณภาพมากขึ้น 

2.7 การวิเคราะห์ข้อมูลของระบบสารสนเทศภูมิศาสตร์ 
ระบบสารสนเทศภูมิศาสตร์ มีความแตกต่างจากระบบสารสนเทศประเภทอื่น  ๆ เพราะ

ความสามารถในการท างานกับข้อมูลภูมิศาสตร์หรือข้อมูลเชิงพื้นที ่และเป็นระบบที่แตกต่างจากซอฟต์แวร์การ
ท าแผนที่ด้วยเครื่องคอมพิวเตอร์ทั่ว ๆ ไป เพราะมีความสามารถในการวิเคราะห์ข้อมูลเชิงพื้นที่ ซึ่งนับว่าเป็น
หัวใจส าคัญของระบบสารสนเทศภูมิศาสตร์ การวิเคราะห์ข้อมูลเชิงพื้นที่จัดเป็นกระบวนการน าข้อมูลมา
จัดการ ประมวลผลวิเคราะห์เพื่อผลิตสารสนเทศที่อยู่ในรูปที่เหมาะสมต่อการน าไปใช้ประโยชน์ 

ซอฟต์แวร์ระบบสารสนเทศภูมิศาสตร์แต่ละซอฟต์แวร์มีสมรรถนะการวิเคราะห์ข้อมูล
แตกต่างกัน ตั้งแต่ฟังก์ชันที่ง่ายไม่ซับซ้อนไปจนถึงฟังก์ชันที่ใช้ในการท าแบบจ าลองลักษณะต่าง ๆ จึงเป็นการ
ยากที่จะอธิบายรายละเอียดทั้งหมดได้อย่างครบถ้วน ในที่นี้จะกล่าวถึงเฉพาะฟังก์ชันพื้นฐานที่ซอฟต์แวร์ระบบ
สารสนเทศภูมิศาสตร์มีใช้กันทั่วไป และมีการใช้งานบ่อย ๆ ซึ่งมีรายละเอียดดังนี ้
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1) การสอบถามข้อมูล (Querying) 
การสอบถามข้อมูลในระบบสารสนเทศภูมิศาสตร์สามารถด าเนินการได้จากทั้งข้อมูล

เชิงพื้นที่และข้อมูลลักษณะประจ า และสามารถสืบค้นได้หลายลักษณะ เช่น การค้นหาข้อมูลจากฐานข้อมูล
โดยตรงโดยก าหนดค าหรือข้อความที่ต้องการค้นหาหรือการคลิกที่ฟีเจอร์ที่ต้องการทราบข้อมูล (Simple 
search) การค้นหาข้อมูลลักษณะประจ าแบบก าหนดเงื่อนไขโดยใช้ตัวด าเนินการประเภทต่าง ๆ 
(Conditional search) หรือการค้นหาข้อมูลเชิงพื้นที่โดยใช้ตัวด าเนินการเชิงพื้นที่ประเภทต่าง ๆ (Spatial 
search) (รูปที่ 1.16) 

 

 
 

รูปที่ 1.16 ตัวอย่างของตัวด าเนินการเชิงพื้นที่ (Spatial operator) ทีใ่ช้ในการสอบถามข้อมูลเชิงพื้นที่. จาก Oracle 
spatial user's guide and reference, release 9.0.1, โดย Oracle Corporation, 2001, 

ค้นเมื่อ 23 มกราคม 2556, จาก http://docs.oracle.com/html/A88805_01/sdo_intr.htm. 
 
จากค าอธิบายที่กล่าวไว้ข้างต้น การค้นหาข้อมูลจากฐานข้อมูลโดยตรงอาจจะถูก

มองว่าไม่ใช่การวิเคราะห์ข้อมูล อย่างไรก็ตาม การค้นหาแบบก าหนดเงื่อนไขและการค้นหาเชิงพื้นที่ จะท าให้
ได้ผลลัพธ์ที่เป็นสารสนเทศที่เป็นประโยชน์ต่อผู้ใช้ และสามารถน าผลลัพธ์มาแสดงผลในรูปของตาราง กราฟ 
หรือรายงานได้ จึงจัดให้การสอบถามข้อมูลเป็นการวิเคราะห์ข้อมูลลักษณะหนึ่ง 

2) การจ าแนกใหม่ (Reclassification) 
การจ าแนกใหม่เป็นกระบวนการก าหนดค่าใหม่ให้กับข้อมูลลักษณะประจ า (รูปที่ 

1.17) มักจะใช้ส าหรับการจัดประเภทหรือจัดกลุ่มข้อมูลใหม่ ซึ่งอาจจะใช้ส าหรับการ มีผลท าให้ได้รับข้อมูล
ใหม่ที่มักจะมีรายละเอียดลดลง (simplification) เช่น การใช้ที่ดินประเภทป่า อาจจะมีการจ าแนกประเภทป่า
เป็นป่าดิบชื้น ป่าดิบแล้ง ป่าชายเลน ป่าเบญจพรรณ ป่าแดงหรือป่าเต็งรั ง การจ าแนกใหม่จะจ าแนกข้อมูล
ออกเป็นเพียงป่าผลัดใบ และป่าไม่ผลัดใบ เป็นต้น 
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รูปที่ 1.17 การจ าแนกใหม.่ จาก GIS modeling and analysis, โดย J. K. Berry, & W. M. Keck, 2005, 
ค้นเมื่อ 25 มกราคม 2556, จาก http://www.innovativegis.com/basis/papers/other/asprschapter/. 

 
  3) การวัด (Measurement) 

การวัดเป็นค าสั่งที่ใช้ส าหรับการวัดข้อมูลเชิงพื้นที่ เช่น การค านวณระยะทาง
ระหว่างจุด ความยาวของเส้น ความยาวของเส้นรอบรูป ขนาดพื้นที่ รูปร่าง ปริมาตร ความชัน และทิศลาด 
เป็นต้น 

 4) การสร้างพื้นทีก่ันชน (Buffering)  
การสร้างแนวพื้นที่รอบสิ่งใดสิ่งหนึ่งเป็นระยะทางตามที่ก าหนด เช่น การสร้างพื้นที่

กันชนรอบโรงงานอุตสาหกรรมเป็นระยะ 1 กิโลเมตร หรือการสร้างพื้นที่กันชนริมสองฝั่งแม่น้ าเป็นระยะทาง 
500 เมตร เป็นต้น 

การสร้างพื้นที่แนวกันชน สามารถด าเนินการได้กับข้อมูลแบบเวกเตอร์ (จุด เส้น 
และพื้นที่) และแรสเตอร์ (กริดเซลล์) (รูปที่ 1.18) 

 

 
 

 

การสร้างพื้นที่กันชนกับข้อมูลเวกเตอร์ การสร้างพื้นที่กันชนกับข้อมูลแรสเตอร ์
 

รูปที่ 1.18 การสร้างพื้นที่กันชน. จาก Geographic information system basics v. 1.0, 2011, 
ค้นเมื่อ 29 มกราคม 2556, จาก 

http://2012books.lardbucket.org/pdfs/geographic-information-system-basics.pdf. 
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การสร้างพื้นที่กันชนกับข้อมูลกริด โดยเฉพาะอย่างยิ่งถ้าเซลล์มีขนาดใหญ่ อาจจะ
ท าให้เกิดความคลาดเคลื่อนเชิงต าแหน่งมาก ดังนั้น การสร้างพื้นที่แนวกันชน จึงมักจะใช้ส าหรับข้อมูลแบบ
เวกเตอร์ นอกจากนี้ ค าสั่งสร้างพื้นที่กันชนของซอฟต์แวร์อาจจะสามารถก าหนดสร้างให้พื้นที่กันชนแบบ
สมมาตร (เช่น ฟีเจอร์แบบเส้นจะมีพื้นที่กันชนด้านซ้ายและด้านขวาของเส้น หรือฟีเจอร์แบบพื้นทีจ่ะมีพื้นที่กัน
ชนด้านนอกและด้านในของพื้นที่) หรือแบบไม่สมมาตร (เช่น มีพื้นที่กันชนเพียงด้านใดด้านหนึ่ง) หรือพื้นที่กัน
ชนที่สร้างขึ้นรอบฟีเจอร์อาจจะมีขนาดไม่เท่ากันในแต่ละฟีเจอร์ (มักจะมีขนาดแตกต่างกันไปตามข้อมูล
ลักษณะประจ า เช่น แหล่งก าเนิดมลพิษที่มีระดับความรุนแรงของกลิ่นหรือเสียงมากจะมีพื้นที่กันชนใหญ่กว่า
แหล่งก าเนิดมลพิษที่มีระดับความรุนแรงน้อย เป็นต้น) หรือพื้นที่แนวกันชนที่สร้างขึ้นจะมีระยะห่างหลาย ๆ 
ระยะ ซึ่งแต่ละระยะอาจจะเท่าหรือไม่เท่ากัน แต่เป็นพื้นทีต่่อเนื่องกันเป็น (รูปที่ 1.19) 

 

 
 

รูปที่ 1.19 การสร้างพื้นที่กันชนแบบหลายระยะ (Multiple Ring Buffer). จาก ArcGIS Desktop 9.3 Help, 
โดย ESRI, Inc., 2009, ค้นเมือ่ 31 มกราคม 2556, จาก 

http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?id=1351&pid=1347&topicname=Multiple_Ring_Buffer_%28Analysis%29. 
 

  5) การวางซ้อน (Overlay) 
การวางซ้อนเป็นการวิเคราะห์ด้วยการน าชั้นข้อมูลแผนที่ 2 ชั้นหรือมากกว่า วาง

ซ้อนกัน แล้วด าเนินการค านวณ (Arithmetic operation) เช่น +, -, x, / หรือด าเนินการทางตรรกะ (Logical 
operation) เช่น  AND, OR, NOT, XOR หรือด าเนินการเปรียบเทียบ (Comparison operation) เช่น =, >, 
< เป็นต้น เพื่อให้ได้ชั้นข้อมูลแผนที่ใหม่ขึ้นมา 1 ชั้น การวางซ้อนสามารถท าได้ทั้งข้อมูลแบบเวกเตอร์ และ
แบบแรสเตอร์ ซึ่งมีรายละเอียดดังนี ้

5.1) แบบเวกเตอร์ 
เป็นการวิเคราะห์ข้อมูลโดยอาศัยสมบัติทางเรขาคณิตและความสัมพันธ์เชิง

พื้นที่หรือทอพอโลยี (Topology) โดยใชพ้ีชคณิตบูลีน (Boolean algebra) (รูปที่ 1.20) 
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รูปที่ 1.20 ตัวด าเนินการพีชคณิตบูลีน. จาก Key concepts & techniques in GIS (p. 40), โดย             
J. Albrecht, 2007, Los Angeles, California: SAGE Publications. 

 
การวิเคราะห์ด้วยการวางซ้อนแบบเวกเตอร์ จะท าให้ได้ชั้นข้อมูลใหม่ที่มี

ฟีเจอร์เกิดขึ้นใหม่และเป็นฟีเจอร์ที่มีการผนวกข้อมูลลักษณะประจ าของแต่ละชั้นข้อมูลรวมเข้าด้วยกัน (รูปที่ 
1.21)  
    

 
 

รูปที่ 1.21 ลักษณะการวิเคราะห์ด้วยการวางซ้อนแบบเวกเตอร์. จาก Key concepts & techniques in GIS 
(p. 38), โดย J. Albrecht, 2007, Los Angeles, California: SAGE Publications. 
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ซอฟต์แวร์ระบบสารสนเทศภูมิศาสตร์ส่วนใหญ่จะมีค าสั่งการวิเคราะห์ด้วย
การวางซ้อนแบบเวกเตอร์พื้นฐาน เช่น , Intersect, Union, Clip, Symmetrical Difference, Erase หรือ 
Difference เป็นต้น 

5.2) แบบแรสเตอรห์รือแบบกริด 
เป็นการวางซ้อนชั้นข้อมูลแรสเตอรจ์ านวน 2 ชั้นข้อมูลหรือมากกว่า และใช้

ตัวด าเนินการค านวณค่าผลลัพธ์เป็นชั้นข้อมูลแรสเตอร์ใหม่ การด าเนินการค านวณนี้สามารถเขียนในรูปนิพจน์
พีชคณิต (Algebraic expression) เช่น A+B+C โดยที่ A, B, C คือ ชั้นข้อมูลแรสเตอร์ จึงเรียกการด าเนินการ
ค านวณลักษณะนี้ว่า พีชคณิตแผนที่ (Map algebra) (พีชคณิตแผนที่ สามารถด าเนินการได้กับชั้นข้อมูลเดี่ยว 
ๆ ได้เช่นกัน ซึ่งจะกล่าวถึงต่อไป)  

การวิเคราะห์การวางซ้อนแบบกริดสามารถใช้วิ เคราะห์สมการทาง
คณิตศาสตร์เพื่อท าแบบจ าลองที่มีความสลับซับซ้อนได้เป็นอย่างดี 

การด าเนินการวิเคราะห์วางซ้อนแบบแรสเตอร์ สามารถแบ่งออกเป็น 4 
ลักษณะ ดังนี ้

 แบบแต่ละเซลล์ (Individual grid cells หรือ Cell-by-cell หรือ 
Local operation) เป็นการค านวณค่าของเซลล์ผลลัพธ์ (Output cell) จากค่าของเซลล์น าเข้า (Input cell) 
ที่มีต าแหน่งของเซลล์ตรงกัน (รูปที่ 1.22) 

 

 

 

 
รูปที่ 1.22 ลักษณะด าเนินการวิเคราะห์วางซ้อนแบบแต่ละเซลล.์ จาก Key concepts & techniques in GIS 

(p. 54), โดย J. Albrecht, 2007, Los Angeles, California: SAGE Publications. 
 

 แบบกลุ่มเซลล์ (Blocks of grid cells หรือ Focal or 
neighborhood operation) เป็นการค านวณค่าของเซลล์ผลลัพธ์ (Output cell) จากค่าของย่านเซลล์น าเข้า 
(User-defined neighborhood) โดยทั่ว ๆ ไป กลุ่มเซลล์จะมีขนาด 3 x 3 อย่างไรก็ตาม บางซอฟต์แวร์
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อาจจะสามารถให้ผู้ใช้หรือผู้วิเคราะห์เป็นผู้ก าหนดขนาดและรูปร่างของเซลล์น าเข้าที่ใช้ในการค านวณได้ (รูปที่ 
1.23) 

 

 

 

 
รูปที่ 1.23 ลักษณะด าเนินการวิเคราะห์วางซ้อนแบบกลุ่มเซลล์ด้วยค่าเฉลี่ย (Average) ที่มีย่านเซลล์น าเข้า 

ขนาด 3 x 3. จาก Key concepts & techniques in GIS (p. 55), 
โดย J. Albrecht, 2007, Los Angeles, California: SAGE Publications. 

 

 แบบโซน (Zonal operation) เป็นการค านวณค่าของเซลล์ผลลัพธ์ 
(Output cell) จากค่าของเซลล์น าเข้าที่อยู่ภายในโซน (Zone) (โซน หมายถึง กลุ่มเซลล์ที่มีค่าของเซลล์
เหมือนกัน เช่น ชั้นข้อมูลอ าเภอ) การค านวณค่าลักษณะนี้ จะต้องมีชั้นข้อมูลอย่างน้อย 2 ชั้น ประกอบด้วย 
ชั้นข้อมูลที่ใช้ก าหนดโซน (Zone layer) และชั้นข้อมูลที่มีค่าข้อมูลที่ใช้ในการค านวณ (Value layer) (รูปที่ 
1.24)  

 

 

 

 
รูปที่ 1.24 ลักษณะด าเนินการวิเคราะห์วางซ้อนแบบโซนด้วยค่าสูงสุด (Max). จาก Key concepts & 

techniques in GIS (p. 57), โดย J. Albrecht, 2007, Los Angeles, California: SAGE Publications. 
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 แบบทั้งชั้นข้อมูล (Entire grid layer หรือ Global operation) 
เป็นการค านวณค่าของเซลล์ผลลัพธ์ (Output cell) จากเซลล์ทุก ๆ เซลล์ของชั้นข้อมูลน าเข้า เช่น การ
ค านวณหาระยะทางที่จากเซลล์ที่ก าหนดไปยังเซลล์อื่น ๆ ในชั้นข้อมูล หรือการค านวณระยะทางที่สั้นที่สุด 
(Shortest path) ที่มีการพิจารณาปัจจัยต่าง ๆ (Cost or friction surface) ที่มีผลต่อการก าหนดระยะทางที่
สั้นที่สุด เป็นต้น 

6) การวิเคราะห์โครงข่าย (Network analysis) 
โครงข่าย หมายถึง สิ่งที่มีลักษณะเป็นเส้นหรือแนวที่มีการเชื่อมโยงกันเป็นโครงข่าย 

และมีวัตถุหรือสิ่งต่าง ๆ เช่น วัตถุดิบ สินค้า คน ฯลฯ ถูกขนส่งหรือเคลื่อนย้ายกันในโครงข่าย เช่น โครงข่าย
คมนาคมขนส่ง (Transport network) เช่น ถนน รถไฟ หรือโครงข่ายสาธารณูปโภค (Utility network) เช่น 
ท่อ สายไฟ สายเคเบิลการ หรือโครงข่ายแม่น้ า ล าธาร (Hydrological network) เป็นต้น 

ตัวอย่างการวิเคราะห์ข้อมูลโครงข่ายที่มักจะมีการประยุกต์ใช้อย่างกว้างขวาง ได้แก่  
การค้นหาเส้นทาง (Route) สิ่งอ านวยความสะดวก เช่น ร้านค้า โรงพยาบาล ที่อยู่ใกล้ที่สุด (Closest facility) 
พื้นที่บริการ (Service area) หรือการขนส่งสินค้า (Vehicle routing) หรือการจัดสรรทรัพยากร เป็นต้น (รูปที่ 
1.25) 

 

  

การค้นหาสิ่งอ านวยความสะดวกที่อยู่ใกล้ทีสุ่ด การค้นหาพื้นที่บริการ 
 

รูปที่ 1.25 ตัวอย่างการวิเคราะห์ข้อมูลโครงข่าย. จาก ArcGIS Desktop 9.3 Help, 
โดย ESRI, Inc., 2009, ค้นเมือ่ 5 กุมภาพันธ ์2556, จาก 

http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Types_of_network_analyses. 
 

7) การวิเคราะห์พื้นผิว 3 มิต ิ(3D Surface analysis) 
แบบจ าลองพื้นผิว 3 มิติ (3D surface model)  เป็นแบบจ าลองข้อมูลที่มีการ

จัดเก็บค่า Z ร่วมกับค่า X และ ค่า Y โดยที่ค่า Z เป็นค่าข้อมูลที่ใช้แสดงความสูงต่ าของพ้ืนผิว ข้อมูลที่สามารถ
น ามาแสดงเป็นพื้นผิวอาจจะเป็นความสูงต่ าของพื้นผิวภูมิประเทศ ความลึกของชั้นน้ าใต้ดิน ปริมาณน้ าฝน 
หรือปริมาณความเข้มข้นของสารเคมี เป็นต้น (รูปที่ 1.26) 
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รูปที่ 1.26 แบบจ าลองพื้นผิว 3 มิต.ิ จาก ArcGIS Desktop 9.3 Help, 
โดย ESRI, Inc., 2009, ค้นเมือ่ 7 กุมภาพันธ์ 2556, จาก 

http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=About_3D_surfaces. 
 
การจ าลองและจัดเก็บข้อมูลพื้นผิว 3 มิติ สามารถได้หลายลักษณะ ในที่นี้ จะ

กล่าวถึงเฉพาะแบบจ าลองที่ซอฟต์แวร์ระบบสารสนเทศภูมิศาสตร์ส่วนใหญ่ใช้ในการจัดเก็บและวิเคราะห์
ข้อมูล ซึ่งมี 2 ลักษณะ คือ 1) การจัดเก็บแบบเวกเตอร์โดยใช้โครงข่ายสามเหลี่ยมไม่สม่ าเสมอ (Triangulated 
Irregular Network: TIN) ซึ่งเป็นพื้นผิวที่เกิดจากการใช้รูปสามเหลี่ยมหลายรูปที่มีด้านประชิดกันและมีจุด
ยอดร่วมกันเรียงต่อเนื่องกัน และ 2) การจัดเก็บแบบแรสเตอร์ (Raster surface) ซึ่งแสดงพื้นผิวโดยใช้เซลล์
ขนาดเท่ากันเรียงต่อเนื่องกันครอบคลุมพื้นที่ที่ต้องการจดัเก็บข้อมูล (รูปที่ 1.27) 

 

 
 

รูปที่ 1.27 การจัดเก็บข้อมูลแบบจ าลองพื้นผิว 3 มิต ิแบบ TIN และ Raster surface. จาก Key concepts & 
techniques in GIS (p. 59), โดย J. Albrecht, 2007, Los Angeles, California: SAGE Publications. 
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   การวิเคราะห์ข้อมูลพื้นผิว 3 มิติ ในซอฟต์แวร์ระบบสารสนเทศภูมิศาสตร์ที่มีการ
ประยุกต์ใช้งานอย่างกว้างขวาง ได้แก่ การประมาณค่าในช่วง (Interpolation) เช่น Inverse Distance 
Weighted (IDW), Kriging เพื่อสร้างแบบจ าลองพื้นผิว 3 มิติ  การแสดงข้อมูลพื้นผิวแบบ 3 มิติ เช่น การ
แสดงลักษณะภูมิประเทศ  การวิเคราะห์ภูมิประเทศ (Terrain analysis) เช่น ความลาดชัน (Slope), ทิศทาง
ความลาดชัน (Aspect), การสร้างแผนที่ทรวดทรงแรเงา (Shaded relief), การวิเคราะห์ความสามารถในการ
มองเห็น (Visibility), การวิเคราะห์ภาคตัดขวาง (Cross section), การวิเคราะห์ภาพด้านข้าง (Profile), หรือ
การค านวณปริมาตร (Volume calculation) เป็นต้น (รูปที่ 1.28)  
 

 
 

 

การประมาณค่าในช่วง การแสดงลักษณะภูมิประเทศ 

  

ความลาดชัน ทิศทางความลาดชัน 
  

 

 

การสร้างแผนที่ทรวดทรงแรเงา การวิเคราะห์ความสามารถในการมองเห็น 
 

รูปที่ 1.28 ตัวอย่างการวิเคราะห์ข้อมูลพื้นผิว 3 มิต.ิ จาก ArcGIS Desktop 9.3 Help, 
โดย ESRI, Inc., 2009, ค้นเมือ่ 13 กุมภาพันธ์ 2556, จาก 

http://webhelp.esri.com/arcgisdesktop/9.3/index.cfm?TopicName=Surface_creation_and_analysis. 
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2.8 การแสดงผลข้อมูล 
การแสดงผลข้อสนเทศ เป็นขั้นตอนการน าเสนอข้อมูล หรือผลการประมวลผลข้อมูลให้แก่

ผู้ใช้งาน เพื่อใช้ประกอบการตัดสินใจหรือการปฏิบัติงานใด ๆ ข้อสนเทศอาจน าเสนอให้อยู่ในรูปของแผนที่ 
รายงาน กราฟ ตารางสถิติ และภาพสามมิติ เป็นต้น 

การแสดงผลข้อมูลด้วยระบบสารสนเทศภูมิศาสตร์ สามารถแบ่งออกได้เป็น 2 ลักษณะ คือ 
   1) แบบส าเนาถาวร หรือแบบฉบับพิมพ์ (Hardcopy) เป็นการแสดงผลบนกระดาษ 
แผ่นฟิล์ม หรือวัสดุอื่น ๆ โดยใช้เครื่องพิมพ์แบบต่าง ๆ เช่น เครื่องพิมพ์แบบฉีดหมึก หรือเครื่องพิมพ์เลเซอร์ 
ข้อดีของการแสดงผลแบบส าเนาถาวร ได้แก่ สามารถดูข้อมูลได้สะดวก และง่ายต่อการการเคลื่อนย้ายขณะ
ปฏิบัติงานภาคสนาม ข้อเสีย คือ มีค่าใช้จ่ายเก่ียวกับวัสดุงานพิมพ์สูง  
   2) แบบส าเนาชั่วคราว หรือส าเนาอิเล็กทรอนิกส์ (Softcopy) เป็นการแสดงผลบน
จอมอนิเตอร์ขณะก าลังปฏิบัติงาน และไม่นิยมใช้เป็นสื่อส าหรับการแสดงผลในขั้นตอนสุดท้าย ข้อดีของการ
แสดงผลแบบส าเนาช่ัวคราว คือ สามารถแสดงผลการวิเคราะห์ข้อมูลได้ทันที ข้อเสีย คือ การแสดงภาพอาจไม่
สะดวกถ้าจอมอนิเตอร์มีขนาดเล็ก ส าหรับการน าข้อสนเทศแบบส าเนาอิเล็กทรอนิกส์ไปใช้ในซอฟต์แวร์
คอมพิวเตอร์อื่น ๆ สามารถท าได้โดยการบันทึก หรือส่งออกเป็นแฟ้มข้อมูลคอมพิวเตอร์รูปแบบต่าง ๆ เพื่อใช้
ประกอบการท ารายงาน หรือภาพนิ่ง ส าหรับน าเสนอในรูปแบบต่าง ๆ ต่อไป   
 การแสดงผลข้อมูลในรูปของแผนที่จ าเป็นต้องค านึงมาตราส่วนของแผนที่ที่ใช้ในการน าเข้าและใช้ใน
แสดงผล มาตราส่วนในการแสดงผลข้อมูลแผนที่ควรเป็นมาตราส่วนเดียวกับมาตราส่วนแผนที่ที่ใช้ในการ
น าเข้าข้อมูล เช่น การน าเข้าข้อมูลแผนที่มาตราส่วน 1:250,000 ควรแสดงผลข้อมูลในมาตราส่วน 1:250,000 
หรือเล็กกว่า การแสดงผลข้อมูลด้วยมาตราส่วนใหญ่กว่า ไม่มีผลท าให้ข้อมูลมีความถูกต้องเชิงต าแหน่งสูงขึ้น 
และถ้าไม่มีการระบุแหล่งที่มาของข้อมูลอย่างละเอียดเพียงพอ อาจท าให้ผู้ใช้แปลความข้อมูลจากแผนที่
คลาดเคลื่อน  

นอกจากนี้ การแสดงผลข้อมูลด้วยมาตราส่วนน าเข้าและมาตราส่วนแสดงผลแตกต่างจากกันมาก จะ
ท าให้การแสดงรายละเอียดข้อมูลบนแผนที่มีมากหรือน้อยเกินไป เช่น การน าเข้าข้อมูลมาตราส่วน 1:50,000 
และแสดงผลที่มาตราส่วน 1:250,000 จะท าให้แผนที่มีรายละเอียดมากเกินไป อย่างไรก็ตาม อาจใช้การวาง
นัยทั่วไป (Generalization) เพื่อลดรายละเอียดข้อมูล เพื่อให้การแสดงผลเป็นไปอย่างมีประสิทธิภาพและ
สวยงาม แต่ผู้ใช้ต้องเสียเวลาและค่าใช้จ่ายในการประมวลผลข้อมูลเพิ่มเตมิเช่นเดียวกัน 

3. การรับรู้จากระยะไกล (Remote sensing) 

3.1 ความหมายของการรับรู้จากระยะไกล 
  โดยทั่ว ๆ ไป การรับรู้จากระยะไกล ความหมายถึงการได้มาของสารสนเทศเกี่ยวกับวัตถุ 
หรือปรากฏการณ์ โดยการใช้ระบบอุปกรณ์รับรู้ (Sensing device) ที่บันทึกข้อมูลโดยปราศจากการสัมผัสกับ
วัตถุ จากความหมายนี้ การถ่ายรูปวิวทิวทัศน์ การสร้างภาพด้วยเรโซแนนซ์แม่เหล็กหรือเอ็มอาร์ไอ (Magnetic 
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Resonance Imaging: MRI) หรือการกราดภาพโดยใช้รังสีเอกซ์ (X-ray scan) จึงเป็นการรับรู้จากระยะไกล
ทั้งสิ้น   
  ส าหรับการรับรู้จากระยะไกลในบริบทที่ เกี่ยวข้องกับเทคโนโลยีภูมิสารสนเทศจะมี
ความหมายที่เฉพาะมากขึ้น โดยมีความหมายถึง  วิทยาศาสตร์และศิลปะของการได้มาซึ่งข้อมูลที่เกี่ยวกับวัตถุ 
พื้นที่ หรือปรากฏการณต์่าง ๆ บนพื้นโลกโดยใช้ระบบอุปกรณ์รับรู้ (Sensor system) บันทึกพลังงานของคลื่น
แม่เหล็กไฟฟ้าที่ปราศจากการเข้าไปสัมผัสวัตถุเป้าหมายนั้น ๆ ข้อมูลที่ได้มาจะมีลักษณะ 3 ประการ คือ 
ลักษณะการสะท้อนช่วงคลื่นแม่เหล็กไฟฟ้า (Spectral characteristics) ลักษณะเชิงพื้นที่ของวัตถุบน
พื้นผิวโลก (Spatial characteristics) และลักษณะการเปลี่ยนแปลงของวัตถุตามช่วงเวลา (Temporal 
characteristics)  

ข้อมูลการรับรู้จากระยะไกล ในที่นี้หมายรวมถึง รูปถ่ายทางอากาศ  (Aerial photograph) 
ซึ่งเป็นข้อมูลที่ได้จากการถ่ายรูปบนเครื่องบิน และข้อมูลภาพดาวเทียม (Satellite image) ซึ่งเป็นข้อมูลที่ได้
จากการบันทึกภาพจากดาวเทียมขณะโคจรอยู่ในอวกาศ ซึ่งสามารถน ามาใช้แปลตีความหรือประมวลผลด้วย
เครื่องคอมพิวเตอร์เพื่อให้ได้สารสนเทศเกี่ยวกับวัตถุ พื้นที่ หรือปรากฏการณต์่าง ๆ ตามที่ผู้ใช้ต้องการ   

3.2 กระบวนการและองค์ประกอบของการรับรู้จากระยะไกล (Processes and elements of 
remote sensing) (Lillesand & Kiefer, 1994, 1-3) 

โดยทั่ว ๆ ไป กระบวนการรับรู้จากระยะไกล ประกอบด้วย 2 ขั้นตอนหลัก ได้แก่ 
กระบวนการได้มาของข้อมูล และกระบวนการวิเคราะห์ข้อมูล โดยที่แต่ละกระบวนการมีองค์ประกอบต่าง ๆ 
ดังนี้ (รูปที่ 1.29) 

1) กระบวนการการได้มาของข้อมูลการรับรู้จากระยะไกล (Data acquisition) มี
องค์ประกอบดังนี ้

(a) แหล่งพลังงาน (Sources of energy) 
(b) การแผ่พลังงานแม่เหล็กไฟฟ้าผ่านชั้นบรรยากาศ (Propagation through the 
atmosphere)  
(c) วัตถุ พื้นที่ หรือปรากฏการณ์ต่าง ๆ บนพื้นโลก (Earth surface features) 
(d) การส่งผ่านพลังงานกลับสู่ชั้นบรรยากาศ (Re-transmission through the 

atmosphere) 
(e) ระบบอุปกรณ์รับรู้ (Sensing systems) 
(f) ผลิตภัณฑ์ข้อมูล (Data product)  

2) กระบวนการวิเคราะห์ข้อมูล (Data analysis) มีองค์ประกอบดังนี้ 
(g) การแปลตีความและการวิเคราะห์ข้อมูล (Interpretation and analysis) 
(h) สารสนเทศ (Information products) 
(h) ผู้ใช้สารสนเทศ (Users) 
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รูปที่ 1.29 กระบวนการและองค์ประกอบของการรับรู้จากระยะไกล. จาก Remote sensing and image 
interpretation 3rd ed. (p. 2), โดย T. M. Lillesand and R. W. Kiefer, 1994, New York: Wiley & Sons. 

 
จากรูปที่ 1.29 กระบวนการของการรับรู้จากระยะไกล ประกอบด้วยกระบวนการที่ส าคัญ 2 

ส่วน คือ การได้มาของข้อมูล และการวิเคราะห์ข้อมูล ซึ่งกระบวนการได้มาของข้อมูลเริ่มจากพลังงานคลื่น
แม่เหล็กไฟฟ้า (Electromagnetic Wave) แผ่หรือส่งออกมาจากแหล่งพลังงาน ซึ่งอาจเป็นแหล่งพลังงานจาก
ธรรมชาติ หรือมนุษย์สร้างขึ้น เมื่อพลังงานคลื่นแม่เหล็กไฟฟ้าเดินทางจากแหล่งพลังงานผ่านชั้นบรรยากาศ 
จะเกิดปฏิสัมพันธ์ในชั้นบรรยากาศ จากนั้นจึงตกกระทบสู่วัตถุหรือพื้นโลก พลังงานที่ตกกระทบจะสะท้อน
กลับสู่ชั้นบรรยากาศ  ซึ่งจะมีปฏิสัมพันธ์ในชั้นบรรยากาศ ก่อนจะถูกบันทึกโดยระบบอุปกรณ์รับรู้ เช่น กล้อง
ถ่ายรูป หรือเครื่องกราดภาพ (Scanner) ซึ่งติดตั้งอยู่กับยานส ารวจ (Platform) เช่น เครื่องบิน ยานอวกาศ 
หรือดาวเทียม นอกจากนี้ ระบบอุปกรณ์รับรู้อาจจะสามารถบันทึกพลังงานที่เปล่งหรือปล่อยออกจากวัตถุหรือ
พื้นผิวโลกโดยตรงได้เช่นกัน ข้อมูลการสะท้อนหรือเปล่งพลังงานคลื่นแม่เหล็กไฟฟ้าของวัตถุหรือพื้นผิวโลกที่ที่
บันทึกได้โดยระบบอุปกรณ์รับรู้จะถูกส่งกลับมายังสถานีรับสัญญาณข้อมูลดาวเทียม เพื่อประมวลผลและจัดท า
เป็นผลิตภัณฑ์ข้อมูลส าหรับน าไปใช้วิเคราะห์ข้อมูลต่อไป 

ในส่วนของการวิเคราะห์ข้อมูลการรับรู้จากระยะไกล เริ่มจากการจัดหาข้อมูลที่เหมาะสมกับ
การประยุกต์ใช้งาน ซึ่งอาจจะเป็นผลิตภัณฑ์ข้อมูลประเภทภาพพิมพ์ หรือข้อมูลเชิงเลข ที่สามารถน ามาใช้
วิเคราะห์เพื่อให้ได้สารสนเทศตามที่ผู้ใช้ต้องการ การวิเคราะห์อาจเป็นการวิเคราะห์แบบการแปลตีความด้วย
สายตา หรือการประมวลผลด้วยคอมพิวเตอร์ ผลลัพธ์ที่ไดจ้ากการวิเคราะห์เป็นสารสนเทศที่อาจน าเสนอในรูป
ของแผนที่ หรือตารางสถิติ หรือแฟ้มข้อมูลคอมพิวเตอร์ที่ผู้ใช้สามารถน าไปใช้ประโยชน์ได ้
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3.3 คลื่นแม่เหล็กไฟฟ้า 
คลื่นแม่เหล็กไฟฟ้าเป็นสื่อที่ระบบอุปกรณ์รับรู้ใช้ในการตรวจวัดหรือบันทึกข้อมูลเกี่ยวกับ

วัตถุ พื้นที่ หรือปรากฏการณ์ต่าง ๆ บนพื้นโลก จึงมีความส าคัญต่อกระบวนการได้มาของข้อมูล คลื่น
แม่เหล็กไฟฟ้ามีความยาวคลื่นตั้งแต่ระดับนาโนเมตรไปจนถึงหลายร้อยเมตร สามารถน ามาแบ่งออกเป็นช่วง ๆ 
ตามความยาวของคลื่น ในแต่ละช่วงคลื่นหรือแบนด์ (Band) จะมีชื่อเรียกต่าง ๆ กัน เช่น รังสีแกมมา รังสีเอกซ์ 
อัลตราไวโอเลต ช่วงคลื่นตามองเห็น อินฟราเรด ไมโครเวฟ และวิทยุ (รูปที่ 1.30)  

  

 
 

รูปที่ 1.30 ช่วงคลื่นของคลื่นแม่เหล็กไฟฟ้า 

 
จากรูปที่ 1.30 ช่วงคลื่นตามองเห็น (Visible light) เป็นช่วงคลื่นแคบ ๆ ซึ่งตอบสนองต่อตา

มนุษย์ มีความยาวช่วงคลื่นตั้งแต่ 0.3 - 0.7 ไมโครเมตร แบ่งกว้าง ๆ ออกเป็น 3 ช่วง คือ สีน้ าเงิน สีเขียว และ
สีแดง ช่วงคลื่นถัดไปเป็นช่วงคลื่นอินฟราเรด สามารถแบ่งกว้าง ๆ เป็น 2 ช่วง คือ อินฟราเรดใกล้หรือ
อินฟราเรดสะท้อน มีความยาวคลื่นระหว่าง 0.7 - 3 ไมโครเมตร และช่วงคลื่นอินฟราเรดความร้อน ซึ่งมีความ
ยาวคลื่นระหว่าง 3 - 15 ไมโครเมตร 

โดยทั่ว ๆ ไป ช่วงคลื่นที่มีความยาวเท่ากับหรือต่ ากว่า 15 ไมโครเมตร (ตั้งแต่ช่วงคลื่น
อินฟราเรดลงมา) มักจะใช้หน่วยเรียกเป็นความยาวคลื่น ส่วนช่วงคลื่นที่มีความยาวมากกว่า 15 ไมโครเมตร 
เช่น คลื่นไมโครเวฟ เรดาร์ และคลื่นวิทยุ นิยมเรียกช่วงคลื่นมีหน่วยเป็นความถี่ และนิยมใช้ตัวอักษรเรียกช่วง
คลื่น เช่น X แบนด์ เป็นช่วงคลื่นที่มีความถี่อยู่ระหว่าง 8 – 12.5 กิกะเฮิรตซ์ (2.4 – 3.8 เซนติเมตร) C แบนด์ 
เป็นช่วงคลื่นที่มีความถี่อยู่ระหว่าง 4 – 8 กิกะเฮิรตซ์ (3.8 – 7.5 เซนติเมตร) และ L แบนด์ เป็นช่วงคลื่นที่มี
ความถี่อยู่ระหว่าง 1 – 2 กิกะเฮิรตซ์ (15-30 เซนติเมตร) เป็นต้น ลักษณะของช่วงคลื่นแม่เหล็กไฟฟ้าในช่วง
คลื่นต่าง ๆ มีรายละเอียดดังตารางที่ 1.2 
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ตารางที่ 1.2 แสดงช่วงคลื่น และลักษณะของช่วงคลื่นตามความยาวช่วงคลื่นแม่เหลก็ไฟฟ้าในช่วงต่าง ๆ 
ช่วงคลื่น ความยาวช่วงคลื่น รายละเอียด 

รังสีแกมมา (Gamma ray) < 0.03  ไมโครเมตร 
รังสีแกมมาถูกดูดซึมทั้งหมดโดยบรรยากาศชั้นบน 
จึงไม่ได้ใช้ในการส ารวจระยะไกล 

รังสีเอกซ์ (X-ray) 0.03 - 3.1 ไมโครเมตร รังสีเอกซ์ถูกดดูซึมทั้งหมดโดยชั้นบรรยากาศเช่นกัน 
รังสีเหนือม่วงหรือรังสี
อัลตราไวโอเลต 
(Ultraviolet) 

0.03 - 0.4 ไมโครเมตร 
ช่วงคลื่นสั้นกว่า 0.3 ไมครอน ถูกดูดซึมทั้งหมดโดย
โอโซน (O3) ในบรรยากาศชั้นบน 

ช่วงคลื่นไวโอเลตภาพถ่าย
(Photographic UV band) 

0.3 - 0.4  ไมโครเมตร 

ช่วงคลื่นสามารถผ่านช้ันบรรยากาศ สามารถ
ถ่ายภาพด้วยฟิล์มถ่ายรูปแต่มกีารกระเจิงในชั้น
บรรยากาศ ซึ่งเป็นอุปสรรคต่อการรับรู้จาก
ระยะไกลมาก 

ช่ว
งค
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ที่ต
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เห
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สีน้ าเงิน 0.4 - 0.5 ไมโครเมตร 
เป็นช่วงคลื่นที่ตามนุษย์ตอบสนอง สามารถ
บันทึกภาพด้วยฟิล์มและกล้องถ่ายรูปทั่วไป และ
เป็นช่วงคลื่นที่โลกมีการสะท้อนพลังงานได้มากที่สุด  

สีเขียว 0.5 - 0.6 ไมโครเมตร 

สีแดง 0.6 - 0.7 ไมโครเมตร 

อิน
ฟร

าเร
ด 

(In
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ช่วงคลื่นอินฟราเรด
สะท้อน 
(Reflected 
infrared) 

0.7 - 1.4 ไมโครเมตร 
เรียกว่า ช่วงคลื่น
อินฟราเรดใกล้ (Near-
infrared: NIR) 

เป็นช่วงคลื่นที่เกิดจากการสะท้อนคลื่น
แม่เหล็กไฟฟ้าจากดวงอาทิตย์ สามารถตรวจหาและ
บันทึกพลังงานด้วยฟิล์มถ่ายรูป 

1.4 - 3.0 ไมโครเมตร 
เรียกว่า ช่วงคลื่น
อินฟราเรดคลื่นสั้น 
(Short-wavelength 
infrared: SWIR) MAHID
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ช่วงคลื่น ความยาวช่วงคลื่น รายละเอียด 

ช่วงคลื่นอินฟราเรด
ความร้อน 
(Thermal Infrared) 

3.0 – 8.0 ไมโครเมตร 
เรียกว่า ช่วงคลื่น
อินฟราเรดคลื่นกลาง 
(Mid-wavelength 
infrared: MWIR) 

เป็นช่วงคลื่นที่เกิดจากการแผ่รังสีความร้อนของวัตถุ 
การบันทึกภาพต้องใช้อุปกรณ์พิเศษ เช่น เครื่อง
กราดภาพ (scanners) สามารถบันทึกภาพได้ทั้ง
ระบบแอ็กทิฟ และแพสซิฟ 

8.0 – 15.0 ไมโครเมตร 
เรียกว่า ช่วงคลื่น
อินฟราเรดคลื่นยาว 
(Long-wavelength 
infrared: LWIR) 

ช่วงคลื่นอินฟราเรด
ไกล (Far infrared: 
FIR) 

15 – 1,000 ไมโครเมตร เป็นช่วงคลื่นซึ่งมีการประยุกต์ใช้ในทางดาราศาสตร์ 

คลื่นไมโครเวฟ (Microwave) 0.1-30 เซนติเมตร 
ช่วงคลื่นยาว สามารถทะลุผ่านหมอกและฝนได้ 
บันทึกภาพได้ทั้งระบบแอ็กทิฟ และแพสซิฟ 

เรดาร์ (Radar) 0.1-30 เซนติเมตร 
เป็นระบบแอ็กทิฟ มีความยาวช่วงคลื่นต่างๆ เช่น 
Ka band (10 มิลลิเมตร), X band (30 มิลลิเมตร) 
และ L band (25 เซนติเมตร) 

วิทยุ (Radio) > 30 เซนติเมตร 
ช่วงคลื่นที่ยาวที่สุด บางครั้งมีการใช้ระบบเรดาร์
ในช่วงนี้ด้วย 

 
 ถึงแม้ว่าคลื่นแม่เหล็กไฟฟ้าเป็นสเปกตรัมที่มีความต่อเนื่องเป็นช่วงกว้าง แต่มีเพียงบางช่วง

คลื่นเท่านั้นที่นิยมน ามาใช้ในการรับรู้จากระยะไกล สามารถแบ่งออกเป็น 2 กลุ่ม คือ ช่วงคลื่นแสง เป็นช่วง
คลื่นที่มีความยาวคลื่นอยู่ระหว่าง 0.3 – 14 ไมโครเมตร สามารถถ่าย หรือบันทึกภาพด้วยฟิล์มถ่ายรูป หรือ
อุปกรณ์รับรู้ (Sensor) และช่วงคลื่นไมโครเวฟ เป็นช่วงคลื่นที่มีความยาวคลื่นประมาณ 1 - 100 กิกะเฮิรตซ์ 
(3 มิลลิเมตร – 30 เซนติเมตร) 

3.4 ประเภทของระบบการรับรู้จากระยะไกล (Type of remote sensing system) 
การแบ่งประเภทระบบการรับรู้จากระยะไกลโดยใช้แหล่งพลังงานเป็นเกณฑ์ สามารถแบ่ง

ออกเป็น 2 ประเภท คือ 
1) ระบบแพสซิฟ (Passive system) เป็นระบบการรับรู้จากระยะไกลที่บันทึกพลังงานคลื่น

แม่เหล็กไฟฟ้าจากแหล่งพลังงานตามธรรมชาติ โดยปกติแล้ว ระบบแพสซิฟจะอาศัยดวงอาทิตย์เป็นแหล่ง
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พลังงาน ด้วยเหตุนี้ ระบบนี้จึงรับและบันทึกข้อมูลได้ในเวลากลางวัน นอกจากนี้ ช่วงคลื่นส่วนใหญ่ที่ใช้ใน
ระบบนี้เป็นช่วงคลื่นที่อยู่ในช่วงตามองเห็น หรืออยู่ในช่วงคลื่นอินฟราเรด ซึ่งเป็นช่วงคลื่นที่ถูกดูดกลืนโดยน้ า
ในชั้นบรรยากาศ เช่น เมฆ หรือหมอก ท าให้เป็นอุปสรรคต่อคุณภาพของข้อมูลส าหรับการประยุกต์ใช้งานบาง
ลักษณะ (รูปที่ 1.31) 

 
 

รูปที่ 1.31 การรับรู้จากระยะไกลระบบแพสซิฟ. จาก Tutorial: Fundamentals of Remote Sensing, 
โดย Canada Centre for Remote Sensing, 2013, ค้นเมื่อ 19 กุมภาพันธ์ 2556, จาก 

http://www.nrcan.gc.ca/earth-sciences/geomatics/satellite-imagery-air-photos/satellite-
imagery-products/educational-resources/14639. 

 
2) ระบบแอ็กทิฟ (Active system) เช่น ระบบเรดาร์ เป็นระบบการรับรู้จากระยะไกลที่

ระบบอุปกรณ์รับรู้ท าหน้าที่เป็นแหล่งพลังงาน ซึ่งสามารถสร้างและส่งพลังงานคลื่นแม่เหล็กไฟฟ้าที่สร้างขึ้นนั้น
ไปยังวัตถุเป้าหมาย และบันทึกพลังงานที่สะท้อนกลับมา เนื่องจากการมีแหล่งก าเนิดพลังงานที่สร้างขึ้นเอง จึง
ท าให้สามารถบันทึกข้อมูลได้ตลอดเวลา ทั้งกลางวันและกลางคืน นอกจากนี้ ช่วงคลื่นส่วนใหญ่ที่ใช้ในระบบนี้
เป็นช่วงคลื่นที่อยู่ในย่านไมโครเวฟ ซึ่งสามารถทะลุผ่านน้ าในชั้นบรรยากาศได้เป็นอย่างดี จึงท าให้ไม่มีข้อจ ากัด
ด้านสภาพอากาศ สามารถส ารวจข้อมูลได้ตลอดทุกฤดูกาล ดังนั้น จึงสามารถน าไปประยุกต์ใช้กับการส ารวจ
ข้อมูลบริเวณประเทศเขตร้อนซึ่งมีเมฆปกคลุมอยู่เป็นประจ าได้อย่างดี (รูปที่ 1.32) 
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รูปที่ 1.32 การรับรู้จากระยะไกลระบบแอ็กทิฟ. จาก Tutorial: Fundamentals of Remote Sensing, 
โดย Canada Centre for Remote Sensing, 2013, ค้นเมื่อ 19 กุมภาพันธ์ 2556, จาก 

http://www.nrcan.gc.ca/earth-sciences/geomatics/satellite-imagery-air-photos/satellite-
imagery-products/educational-resources/14639. 

 

3.5 ลักษณะของข้อมูลการรับรู้จากระยะไกลแบบเชิงเลข (Digital remotely sensed data) 
 ข้อมูลภาพเชิงเลข (Digital image data) เป็นข้อมูลที่จัดเก็บโดยใช้แบบจ าลองแรสเตอร์ 

ข้อมูลภาพประกอบด้วยจุดภาพ (Picture element หรือ Pixel) ที่จัดเก็บค่าเชิงเลข (Numeric value หรือ 
digital number: DN) เป็นตัวแทนค่าสะท้อนหรือเปล่งพลังงานแม่เหล็กไฟฟ้าของวัตถุหรือพื้นที่ จุดภาพแต่ละ
จุดมีรูปสี่เหลี่ยมจัตุรัสที่เรียงต่อเนื่องกันในรูปของตารางกริด ขนาดพื้นที่ที่จุดภาพครอบคลุมวัตถุ พื้นที่ หรือ
ปรากฏการณ์บ่งบอกความละเอียดเชิงพื้นที่ของข้อมูล (Spatial resolution) โดยทั่ว ๆ ไป ระบบอุปกรณ์รับรู้
ที่บันทึกข้อมูลจุดภาพที่ครอบคลุมพื้นที่ขนาดเล็กจะมีความละเอียดเชิงพื้นที่ของข้อมูลสูง 

ข้อมูลภาพมีระบบพิกัดเพื่อใช้อ้างอิงต าแหน่งของจุดภาพแบบสดมภ์ (Column) และแถว 
(Row) โดยมีจุดก าเนิดเริ่มจากจุดภาพซ้ายบนของข้อมูลภาพ ข้อมูลภาพที่ได้จากการบันทึกข้อมูลโดยระบบ
อุปกรณ์รับรู้อาจเป็นข้อมูลแบบแบนด์เดียวหรือหลายแบนด์ (รูปที่ 1.33) ในกรณีที่เป็นข้อมูลหลายแบนด์ แต่
ละแบนด์จะเป็นค่าการสะท้อนหรือเปล่งพลังงานแม่เหล็กไฟฟ้าในแต่ละช่วงคลื่น เช่น ข้อมูลภาพดาวเทียม 
Landsat 7 มีจ านวน 8 แบนด์ เป็นต้น จ านวนช่วงคลื่นที่บันทึกได้จากระบบอุปกรณ์รับรู้บ่งบอกความละเอียด
เชิงคลื่นของข้อมูล (Spectral resolution) ข้อมูลที่มีจ านวนแบนด์ข้อมูลมาก และแต่ละแบนด์บันทึกข้อมูล
ในช่วงคลื่นแคบ ๆ แสดงว่าข้อมูลมีความละเอียดเชิงคลื่นสูง 
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รูปที่ 1.33 จุดภาพและแบนด์ของข้อมูลภาพเชิงเลข 
 

 ค่าเชิงเลขในแต่ละจุดภาพจะมีช่วงหรือค่าความแตกต่าง (range) ได้หลายระดับ เช่น  64 
ระดับ (ค่าเชิงเลขอยู่ระหว่าง 0 – 63 หรือ 26 บิต) หรือ 128 ระดับ (ค่าเชิงเลขอยู่ระหว่าง 0 – 127 หรือ 27 
บิต) หรือ 256 ระดับ (ค่าเชิงเลขอยู่ระหว่าง 0 – 255 หรือ 28 บิต) โดย 0 จะแทนค่าความด า และค่า 63 หรือ 
127 หรือ 255 จะแทนค่าความสว่างขาว ค่าเชิงเลขที่สูงขึ้นจะมีความสว่างมากขึ้น ช่วงหรือความแตกต่างของ
ค่าเชิงเลขที่ระบบอุปกรณ์รับรู้สามารถบันทึกข้อมูลได้จะบ่งบอกถึงความละเอียดเชิงคลื่นรังสีของข้อมูล 
(Radiometric resolution) ช่วงของค่าเชิงเลขมากแสดงว่าข้อมูลมีความแยกต่างเชิงคลื่นรังสสีูง 

 ข้อมูลภาพบางพื้นที่มีการบันทึกภาพซ้ าในช่วงเวลาต่าง ๆ ท าให้สามารถน ามาใช้ศึกษา
เปรียบเทียบ หรือติดตามการเปลี่ยนแปลงของพื้นที่ หรือปรากฏการณ์ต่าง ๆ ได้เป็นอย่างดี  ความถี่ในการ
บันทึกภาพซ้ าบริเวณเดิมบ่งบอกความละเอียดเชิงช่วงเวลาของข้อมูล (Temporal resolution) ข้อมูลที่มีการ
บันทึกภาพซ้ าบ่อย ๆ แสดงว่ามีความละเอียดเชิงช่วงเวลามาก 

3.6 การแสดงข้อมูลภาพเชิงเลขในระบบคอมพิวเตอร์ 
ข้อมูลภาพเชิงเลขสามารถแสดงในระบบคอมพิวเตอร์ได้ 2 ลักษณะ คือ 1) ภาพขาว-ด า ซึ่ง

เป็นการแสดงข้อมูลภาพครั้งละแบนด์ และ 2) ภาพสี ซึ่งในระบบคอมพิวเตอร์ใช้ระบบแม่สีบวก (Additive 
Primary Color) ซึ่งประกอบด้วย สีน้ าเงิน (Blue) สีเขียว (Green) และสีแดง (Red) เมื่อน าข้อมูล 3 ช่วงคลื่น
หรือแบนด์แสดงผ่านแม่สีน้ าเงิน สีเขียว และสีแดงของจอแสดงผลพร้อมกัน จะท าให้เกิดจุดภาพที่มีสีสัน
แตกต่างกันไปตามสัดส่วนของค่าความสว่างของข้อมูลในแต่ละแบนด์ (รูปที่ 1.34) การคัดเลือกและก าหนดให้
แบนด์ข้อมูลแต่ละแบนด์แสดงผ่านแม่สีต่าง ๆ ในระบบคอมพิวเตอร์จะมีผลต่อการแสดงข้อมูลภาพ และการ
แปลตีความหรือการวิเคราะห์ข้อมูล 
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รูปที่ 1.34 การแสดงข้อมูลภาพสีในระบบคอมพิวเตอร์. จาก Essential image processing and GIS for remote 
sensing (p. 6), โดย J.-G. Liu, & P. J. Mason, 2009, Chichester, West Sussex, UK: Wiley-Blackwell. 

3.7 การปรับแก้ความคลาดเคลื่อนเชิงเรขาคณิต 
การบิดเบี้ยวทางเรขาคณิต หมายถึง ลักษณะทางเรขาคณิตของวัตถุ พื้นที่ หรือปรากฏการณ์

ต่าง ๆ ที่ปรากฏบนภาพ ได้แก่ ต าแหน่ง รูปร่าง ขนาด และทิศทางการวางตัวของภาพ มีการบิดเบี้ยวหรือ
ผิดเพี้ยนไปจากลักษณะทางเรขาคณิตของวัตถุ พื้นที่ หรือปรากฏการณ์ในสภาพจริง หรือระบบพิกัดแผนที่ที่
ผู้ใช้งานข้อมูลต้องการ การปรับแก้ความบิดเบี้ยวของข้อมูลภาพให้มีลักษณะทางเรขาคณิตถูกต้องตามตาม
สภาพจริงและระบบพิกัดแผนที่ เรียกว่า การตรวจแก้เชิงเรขาคณิต 

 1) สาเหตุของการบิดเบี้ยวเชิงเรขาคณิตของภาพ 
ข้อมูลภาพการรับรู้จากระยะไกลที่ได้มาจากกระบวนการตรวจวัดด้วยระบบอุปกรณ์

รับรู้ประเภทต่าง ๆ ล้วนมีการบิดเบี้ยวเชิงเรขาคณิตของภาพ ลักษณะการบิดเบี้ยวเชิงเรขาคณิตของภาพแต่ละ
ภาพจะแตกต่างกันขึ้นอยู่กับกระบวนการการได้มาของข้อมูล สาเหตุของการบิดเบี้ยวเชิงเรขาคณิตของภาพ 
แบ่งออกเป็น 2 ประเภท คือ 

1.1) ความบิดเบี้ยวภายใน (Internal distortion) เกิดจากความบกพร่องของระบบ
อุปกรณ์รับรู้ ดังตารางที่ 1.3 และรูปที่ 1.35 
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ตารางที่ 1.3 สาเหตุของความบิดเบี้ยวภายใน  

สาเหตุของความบิดเบี้ยวภายใน 

ระบบอุปกรณ์รับรู้ 
แบบฉายภาพแนวดิ่ง แบบฉายภาพแนวเฉียง 

ไมโครเวฟ 
(4) 

ชนิดกรอบ(1) 
ชนิดเส้น 

(2) 
ชนิดจุด 

(3) 
ความบิดเบี้ยวในแนวรัศมีของเลนส์ A A A - 
ความบิดเบี้ยวในแนวสัมผัสของเลนส์ B B B - 
ความคลาดเคลื่อนของความยาวโฟกัส C C C - 
การเอียงของระนาบภาพ D D D - 
ความไม่คงที่ของระนาบภาพ ไม่เป็นเชิงเส้น ไม่เป็นเชิงเส้น ไม่เป็นเชิงเส้น - 
ความคลาดเคลื่อนของการจัดแนวของแผง
รับ 

- E G - 

ความไม่คงที่ของอัตราสุ่มตัวอย่าง - F H F/H 
ความคลาดเคลื่อนของเวลาสุ่มตัวอย่าง - - G - 
ความไม่คงที่ของความเร็วของกระจกกราด - - H - 
หมายเหตุ: (1) กล้องถ่ายรูป (2) ข้อมูล SPOT ระบบ HRV (3) ข้อมูล LANDSAT ระบบ TM และ (4) ข้อมูล RADARSAT. 
จาก ค ำบรรยำยเรื่องกำรส ำรวจจำกระยะไกล (น. 174), โดย ส านักงานคณะกรรมการวิจัยแห่งชาติ, 2540, กรุงเทพฯ: โรง
พิมพ์คุรุสภาลาดพร้าว. 

 

 
 

รูปที่ 1.35 ลักษณะของความบิดเบี้ยวภายใน (เส้นประคือภาพที่เกิดความบิดเบี้ยว). จาก ค ำบรรยำยเรื่องกำรส ำรวจ
จำกระยะไกล (น. 175),โดย ส านักงานคณะกรรมการวิจัยแห่งชาติ, 2540, กรุงเทพฯ: โรงพิมพ์คุรุสภาลาดพร้าว. 

  
1.2) ความบิดเบี้ยวภายนอก (External distortion) เกิดจากหลายสาเหตุ เช่น การ

ทรงตัวของยานส ารวจ ความโค้งและการหมุนของโลก สภาพชั้นบรรยากาศของโลก สภาพภูมิประเทศ เป็นต้น 
ดังตารางที่ 1.4 และรูปที่ 1.36 
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ตารางที่ 1.4 สาเหตุของความบิดเบี้ยวภายนอก 

สาเหตุของความบิดเบี้ยวภายนอก 

ระบบอุปกรณ์รับรู้ 
แบบฉายภาพแนวดิ่ง แบบฉายภาพแนวเฉียง 

ไมโครเวฟ 
(4) 

ชนิดกรอบ(1) 
ชนิดเส้น 

(2) 
ชนิดจุด 

(3) 
ความคลาดเคลื่อนของระนาบยานส ารวจ I I I I 
ความคลาดเคลื่อนของระดับความสูงยาน
ส ารวจ 

J J J J 

การเคลื่อนที่ของต าแหน่งวงโคจร - K/L K/L//M K/L/M 
ระดับความสูงของยานส ารวจ N N N N 
ความไม่คงที่ของการทรงตัว - N N N 
การหมุนของโลก - L L L 
ความโค้งของผิวโลก - P P P 
ความสูง/ต่ าของภูมิประเทศ - P P P 
การหักเหของชั้นบรรยากาศ ไม่เป็นเชิงเส้น ไม่เป็นเชิงเส้น ไม่เป็นเชิงเส้น ไม่เป็นเชิงเส้น 
หมายเหตุ: (1) กล้องถ่ายรูป (2) ข้อมูล SPOT ระบบ HRV (3) ข้อมูล LANDSAT ระบบ TM และ (4) ข้อมูล RADARSAT. 
จาก ค ำบรรยำยเรื่องกำรส ำรวจจำกระยะไกล (น. 174), โดย ส านักงานคณะกรรมการวิจัยแห่งชาติ, 2540, กรุงเทพฯ: โรง
พิมพ์คุรุสภาลาดพร้าว. 

 

 
 

รูปที ่1.36 ลักษณะของความบิดเบี้ยวภายนอก (เส้นประคอืภาพที่เกิดความบดิเบี้ยว). จาก ค ำบรรยำยเรื่องกำรส ำรวจ
จำกระยะไกล (น. 175), โดย ส านักงานคณะกรรมการวิจัยแหง่ชาต,ิ 2540, กรุงเทพฯ: โรงพิมพ์คุรุสภาลาดพร้าว. 

 
2) การปรับแก้ความคลาดเคลื่อนเชิงเรขาคณิต 

การปรับแก้ความคลาดเคลื่อนเชิงเรขาคณิตสามารถท าได้ 2 ลักษณะ คือ 1) การ
ปรับแก้แบบมีระบบ (Systematic correction) เป็นการปรับแก้ความบิดเบี้ยวโดยการจ าลองกระบวนการ
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หรือกลไกที่ท าให้เกิดความบิดเบี้ยวของข้อมูลภาพ และน าแบบจ าลองของกระบวนการดังกล่าวมาสร้างสูตร
ทางคณิตศาสตร์เพื่อใช้ปรับแก้ความบิดเบี้ยวของข้อมูลภาพ ความบิดเบี้ยวที่สามารถน ามาสร้างเป็น
แบบจ าลองส่วนใหญ่เป็นความบิดเบี้ยวแบบมีระบบที่สามารถคาดผลของความบิดเบี้ยวที่เกิดขึ้นได้ และ 2) 
การปรับแก้แบบไม่มีระบบ (Non-systematic correction) เป็นการปรับแก้ความบิดเบี้ยวแบบสุ่มและความ
บิดเบี้ยวแบบมีระบบที่ไม่สามารถตรวจแก้ได้ซึ่งยังคงเหลืออยู่ในข้อมูลภาพ การตรวจแก้แบบไม่มีระบบจะ
อาศัยการสร้างความสัมพันธ์ระหว่างระบบพิกัดภาพและระบบพิกัดอ้างอิง โดยใช้จุดควบคุมพื้นดิน เพื่อ
ค านวณค่าสัมประสิทธิ์ของสมการการแปลงพิกัด (Coordinate transformation equation) และน าสมการที่
ได้ไปใช้ปรับแก้ความบิดเบ้ียวของข้อมูลภาพและแปลงค่าพิกัดของภาพให้อยู่ในระบบพิกัดอ้างอิง 

3) การปรับแก้ความคลาดเคลื่อนเชิงเรขาคณิตแบบไม่มีระบบ 
การปรับแก้ความคลาดเคลื่อนเชิงเรขาคณิตแบบไม่มีระบบ ประกอบด้วย 4 ขั้นตอน 

คือ 
  3.1) การก าหนดจุดควบคุมพื้นดิน 

 จุดควบคุมพื้นดิน  (Ground control point: GCP) คือ จุดที่ปรากฏบน
ข้อมูลภาพที่ต้องการจะปรับแก้ และเป็นจุดที่ทราบค่าพิกัดของระบบพิกัดอ้างอิง (ระบบพิกัดอ้างอิงที่นิยมใช้ใน
ประเทศไทย ได้แก่ ระบบพิกัดภูมิศาสตร์ หรือระบบพิกัด UTM) การเลือกจุดควบคุมพื้นดินควรเลือกจุดที่
สังเกตเห็นได้ง่าย โดดเด่น และสามารถก าหนดได้อย่างชัดเจนบนข้อมูลภาพ เช่น จุดตัดของถนน จุดตัดของ
ถนนกับรถไฟ เป็นต้น จ านวนจุดควบคุมพื้นดินควรจะมีมากเพียงพอ และกระจายสม่ าเสมอทั่วข้อมูลภาพ 

 ผลลัพธ์จากการก าหนดจุดควบคุมพื้นดินจะได้ชุดข้อมูลที่อยู่ในรูปตารางที่
เป็นค่าพิกัดในระบบพิกัดภาพ (Image coordinates) และระบบพิกัดอ้างอิง (Reference coordinates) ของ
จุดควบคุมพื้นดิน ดังตารางที่ 1.5 

 
ตารางที่ 1.5 ตัวอย่างตารางชุดข้อมูลของจุดควบคุมพื้นดิน 

จุดควบคุมพื้นดิน 
ระบบพิกัดภาพ 

(Image coordinates) 
ระบบพิกัดอ้างอิง 

(Reference coordinates) 
x y X Y 

1 25 23 583258 1725368 
2 69 78 585256 1729000 
. . . . . 
. . . . . 
n . . . . 
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  3.2) การค านวณค่าสัมประสทิธิข์องสมการการแปลงพิกัด 
เป็นการค านวณค่าพิกัดของจุดควบคุมพื้นดินโดยใช้วิธีก าลังสองน้อยสุด 

(Least square method) เพื่อหาค่าสัมประสิทธิ์ของสมการการแปลงพิกัด ค่าสัมประสิทธิ์ของสมการการ
แปลงพิกัดที่ค านวณได้จะน าไปใช้แปลงค่าพิกัดภาพของจุดควบคุมพื้นดิน (x,y) ไปเป็นค่าพิกัดในระบบพิกัด
อ้างอิง (Computed X’,Y’) ค่าพิกัดที่ได้จากค านวณจะถูกน าไปทดสอบกับค่าพิกัดของจุดควบคุมพื้นดิน
อ้างอิง  (X,Y) เพื่อใช้ตรวจสอบความถูกต้องของการแปลงพิกัด การทดสอบผลความถูกต้องจะแสดงด้วย ค่า
คลาดเคลื่อนรากก าลังสองเฉลี่ย (Root mean square error: RMS error) ซึ่งเป็นค่าที่บ่งบอกว่าค่าพิกัดของ
จุดควบคุมพื้นดินทีค่ านวณได้จากสมการการแปลงพิกัดมีความถูกต้องใกล้เคียงกับค่าพิกัดของจุดควบคุมพื้นดิน

อ้างอิงเพียงใด โดยทั่วไป ค่าคลาดเคลื่อนรากก าลังสองเฉลี่ยที่ยอมรับได้มีค่า  1 ถ้าค่าคลาดเคลื่อนรากก าลัง
สองเฉลี่ยยังคงมีค่าเกินกว่าค่าที่ยอมรับได้ อาจจะต้องก าหนดจุดควบคุมพื้นดินเพิ่มเติม และขจัดจุดควบคุม
พื้นดินที่ท าให้เกิดความคลาดเคลื่อนมากออกไป ผลลัพธ์จาการค านวณค่าสัมประสิทธิ์จะท าให้ได้สมการการ
แปลงพิกัด เพื่อใช้ในการแปลงพิกัดระหว่างระบบพิกัดภาพกับระบบพิกัดอ้างอิง 

  3.3) การแปลงพิกัด 
เป็นการใช้สมการการแปลงพิกัดที่ได้จากขั้นตอนที่ผ่านมา เพื่อแปลงค่า

พิกัดของข้อมูลภาพต้นฉบับจากระบบพิกัดภาพไปเป็นระบบพิกัดอ้างอิง ผลลัพธ์จากการแปลงพิกัดจะท าให้
ได้กริดของข้อมูลภาพที่มีลักษณะทางเรขาคณิตถูกต้องตรงกับระบบพิกัดอ้างอิง 

  3.4) การก าหนดค่าเชิงเลขให้กับจุดภาพ (Resampling) 
หลังจากกระบวนการแปลงพิกัด จะได้ผลลัพธ์ของการแปลงพิกัดเป็นกริดที่

ยังไม่มีค่าเชิงเลข จึงจ าเป็นต้องก าหนดค่าเชิงเลขให้กับจุดภาพของกริดใหม่ กระบวนการก าหนดค่าเชิงเลข 
ให้กับจุดภาพของกริดใหม่ โดยอาศัยการประมาณค่าในช่วง (Interpolation) ซึ่งมี 3 วิธี คือ 

 การประมาณค่าจุดภาพแบบ Nearest neighbor interpolation 
เป็นการก าหนดค่าให้กับจุดภาพของกริดใหม่โดยใช้ค่าจุดภาพของภาพต้นฉบับที่อยู่ใกล้ที่สุด การประมาณค่า
แบบนี้มีการค านวณง่าย และไม่เปลี่ยนแปลงค่าเชิงเลขของข้อมูลภาพต้นฉบับ แต่มีข้อเสีย คือ ข้อมูลภาพ
อาจจะมีเนื้อภาพไม่เรียบสม่ าเสมอ  

 การประมาณค่าจุดภาพแบบ Bilinear interpolation เป็นการ
ก าหนดค่าให้กับจุดภาพของกริดใหม่โดยใช้ค่าจุดภาพของภาพต้นฉบับจ านวน 4 จุดที่อยู่บริเวณโดยรอบ ข้อดี
ของการประมาณค่าแบบนี้ คือ ข้อมูลภาพมีเนื้อภาพเรียบและสม่ าเสมอมากขึ้น แต่จะมีการเปลี่ยนแปลงค่า
เชิงเลขของข้อมูลภาพต้นฉบับ 

 การประมาณค่าจุดภาพแบบ Cubic convolution interpolation 
เป็นการก าหนดค่าให้กับจุดภาพของกริดใหม่โดยใช้ค่าจุดภาพของภาพต้นฉบับจ านวน 16 จุดที่อยู่บริเวณ
โดยรอบ ข้อดีของการประมาณค่าแบบนี้ คือ ข้อมูลภาพมีความคมชัด เนื้อภาพเรียบและสม่ าเสมอ ข้อเสีย คือ 
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ค่าเชิงเลขของข้อมูลภาพต้นฉบับมีการเปลี่ยนแปลงไป และใช้เวลาในการค านวณมากกว่าการประมาณค่า
จุดภาพด้วยวิธีอื่น 

3.8 การเน้นข้อมูลภาพ (Image enhancement) 
การเน้นข้อมูลภาพเป็นกระบวรการปรับปรุงข้อมูลภาพเชิงเลขให้มองเห็นข้อมูลภาพได้ดีขึ้น 

เช่น การมองเห็นรายละเอียด ขอบเขต หรือรูปร่างของวัตถุหรือสิ่งต่าง ๆ ในภาพได้ชัดเจนมากขึ้น หรือลด
หรือขจัดสัญญาณรบกวนในข้อมูลภาพ ส่งผลให้การแปลตีความด้วยสายตา (Visual interpretation) เพื่อ
จ าแนกประเภทวัตถุหรือสิ่งต่าง ๆ มีความง่ายมากขึ้น 

เทคนิคการเน้นข้อมูลภาพมีหลากหลายวิธี การเลือกใช้วิธีใดจะขึ้นอยู่กับลักษณะและคุณภาพ
ของข้อมูลภาพ (Image characteristics and quality) วัตถุประสงค ์ภูมิหลัง และผลที่ผู้วิเคราะห์ข้อมูลคาด
ว่าจะน าไปใช ้บางวิธีอาจจะท าให้ค่าเชิงเลขของจุดภาพเปลี่ยนแปลงไป ดังนั้น จึงไม่ควรน าผลลัพธ์ดังกล่าวที่
ได้ไปใช้ในกระบวนการวิเคราะห์ข้อมูลที่มีการประมวลผลค่าเชิงเลข 

ในที่นี้ จะกล่าวถึงการเน้นข้อมูลภาพพื้นฐานเพียง 2 ลักษณะ ได้แก่ 1) การเน้นข้อมูลเชิง
คลื่นรังส ีและ 2) การเน้นข้อมูลเชิงพื้นที่ ซึ่งมีรายละเอียดดังนี ้

1) การเน้นข้อมูลเชิงคลื่นรังส ี(Radiometric enhancement) 
การเน้นข้อมูลเชิงคลื่นรังสีเป็นการเน้นข้อมูลภาพที่พิจารณาค่าของจุดภาพแต่ละจุด

โดยไม่พิจารณาค่าของจุดภาพข้างเคียง ดังนั้น จึงอาจเรียกการเน้นภาพด้วยวิธีนี้ว่า เทคนิคแบบจุด (Point 
technique) การเน้นข้อมูลเชิงคลื่นจ าเป็นต้องมีความเข้าใจเกี่ยวกับฮิสโทแกรม (Histogram)  ของข้อมูลภาพ 
ในการรับรู้จากระยะไกล ฮิสโทแกรมเป็นกราฟที่แสดงการกระจายของค่าข้อมูลของจุดภาพในแต่ละแบนด์ 
โดยแกน X แสดงค่าของข้อมูลเชิงเลข และแกน Y แสดงจ านวนของจุดภาพหรือความถี่ของข้อมูลเชิงเลข ณ 
ค่าต่าง ๆ ในแกน X (รูปที่ 1.37) 

 

   

รูปที่ 1.37 ตัวอย่างฮิสโทแกรมของข้อมูลภาพจากดาวเทียม SPOT. จาก Principles of remote sensing, 
โดย S. C. Liew, 2011, ค้นเมื่อ 21 กุมภาพันธ์ 2556, จาก 

http://www.crisp.nus.edu.sg/~research/tutorial/process.htm 
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โดยทั่ว ๆ ไปแล้ว ข้อมูลมูลภาพที่ยังไม่ผ่านการประมวลผล (Raw data) มักจะมีการ
กระจายของข้อมูลภาพไม่ครอบคลุมช่วงของค่าข้อมูลที่เป็นไปได้ ยกตัวอย่างเช่น ตัวอย่างฮิสโทแกรมของ
ข้อมูลภาพจากดาวเทียม SPOT ในรูปที่ 1.37 แสดงให้เห็นว่า ค่าเชิงเลข (DN) ของข้อมูลมีการกระจายไม่
ครอบคลุมค่า 0 - 255 (ค่าเชิงเลขที่มีค่าต่ ามาก ๆ หรือมีค่าสูงมาก ๆ มักจะไม่มีหรือมีจ านวนจุดภาพน้อย) 
ในทางปฏิบัติ การเน้นข้อมูลเชิงคลื่นรังสีจะอาศัยใช้ฟังก์ชันทางคณิตศาสตร์เพื่อสร้างตารางค้นหา (Look-up 
table) ส าหรับแปลงค่าเชิงเลขเดิมเป็นค่าใหม่ ผลของการแปลงค่าจะท าให้การกระจายของข้อมูลภาพดีขึ้น 
ส่งผลให้ความเปรียบต่างหรือรายละเอียดของวัตถุหรือสิ่งต่าง ๆ ในภาพเด่นชัดมากขึ้น วิธีการเน้นข้อมูลเชิง
คลื่นรังสทีี่นิยมใช้กันอย่างกว้างขวางมีดังน้ี 

 Linear contrast stretch เป็นการใช้ฟังก์ชันแบบเชิงเส้น (Linear function) 
เพื่อปรับยืดหรือขยายช่วงของค่าเชิงเลขของข้อมูลภาพให้กว้างขึ้นจนมีช่วงเท่ากับช่วงของค่าเชิงเลขที่เป็นไปได้
ของแบนด์ข้อมูล การเน้นข้อมูลภาพในกลุ่มนี้ ได้แก่ Minimum-maximum contrast stretch, Percentage 
linear contrast stretch, Standard deviation contrast stretch, และ Piecewise linear contrast 
stretch (รูปที่ 1.38) ผลลัพธ์ของการเน้นข้อมูลเชิงคลื่นรังสีแบบ Linear contrast stretch จะท าให้บริเวณ
ภาพที่มีความสว่างจะสว่างมากขึ้น ส่วนบริเวณภาพที่มีความมืดจะมืดมากขึ้น และบริเวณภาพที่มีความ
แตกต่างของค่าเชิงเลขเพียงเล็กน้อยจะเห็นความแตกต่างได้อย่างชัดเจน (รูปที่ 1.39) 
 

 

 

 
รูปที่ 1.38 ตัวอย่างการเน้นข้อมูลภาพแบบ Linear contrast stretch. จาก Computer processing of 

remotely-sensed images: An introduction 3rd ed. (pp. 123-124), 
โดย P. M. Mather, 2004, Chichester, West Sussex, UK: John Wiley & Sons. 
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ภาพก่อนการเน้นความเปรียบต่าง ภาพหลังการเน้นความเปรียบต่าง 
 

รูปที่ 1.39 ตัวอย่างข้อมูลภาพก่อนและหลังการเน้นความเปรียบต่างของภาพแบบ Linear contrast stretch 
 

 Histogram equalization เป็นการใช้ฟังก์ชันแบบไม่เชิงเส้น (Non - linear 
function) เพื่อแปลงค่าเชิงเลขของข้อมูลภาพเดิมให้เป็นค่าใหม่ และท าให้การกระจายของค่าข้อมูลใหม่ในฮิส
โทแกรมมีความใกล้เคียงกับการกระจายแบบเอกรูป (Uniform distribution) ผลลัพธ์ของการเน้นภาพแบบ 
Histogram equalization จะท าให้ช่วงของค่าเชิงเลข (Range) ที่มีจ านวนจุดภาพมาก ๆ หรือมีความถี่สูงของ
ข้อมูลภาพเดิม จะได้รับการปรับหรือยืดช่วงของค่าเชิงเลขในการแสดงข้อมูลให้กว้างมากขึ้น ส่วนช่วงของค่า
เชิงเลขที่มีจ านวนจุดภาพน้อย จะได้รับการปรับยืดช่วงการแสดงผลให้แคบหรือน้อยลง ถ้าข้อมูลภาพมีการ
กระจายแบบปกติ การเน้นภาพแบบ Histogram equalization จะท าให้บริเวณภาพโดยรวมจะมีความเปรียบ
ต่างสูงขึ้น แต่บริเวณภาพที่มืดหรือสว่างมาก ๆ (ปลายของฮิสโทแกรมทั้งสองฝั่ง) จะมีความเปรียบต่างต่ าลง 
(รูปที่ 1.40) 

 
 

รูปที่ 1.40 ตัวอย่างการเน้นข้อมูลภาพแบบ Histogram equalization. จาก ค ำบรรยำยเรื่องกำรส ำรวจจำก
ระยะไกล (น. 191), โดย ส านักงานคณะกรรมการวิจัยแห่งชาติ, 2540, กรุงเทพฯ: โรงพิมพ์คุรุสภาลาดพร้าว. 
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 Density slicing เป็นกระบวนการเน้นข้อมูลเชิงคลื่นรังสีที่แปลงค่าเชิงเลขจาก
ข้อมูลภาพเดิม ให้เป็นค่าเชิงเลขใหม่ด้วยการแบ่งค่าเชิงเลขของข้อมูลมูลเดิมออกเป็นส่วน (slice) หรือช่วง 
(Interval) จากนั้นก าหนดค่าใหม่ให้กับช่วงของข้อมูล ผลลัพธ์ของการเน้นภาพแบบ Density slicing จะท าให้
สามารถก าหนดสัญลักษณ์สีให้กับค่าข้อมูลแต่ละกลุ่มหรือประเภท เพื่อให้การแสดงข้อมูลสื่อความหมายมาก
ขึ้น  (รูปที่ 1.41) 

 

 

 
 

รูปที่ 1.41 ตัวอย่างการเน้นข้อมูลภาพแบบ Density slicing. จาก Introduction to remote sensing    
5th ed. (p. 121), โดย J. B. Campbell, & R. H. Wynne, 2011, New York: Guilford Press. 

 
2) การเน้นข้อมูลเชิงพื้นที่ (Spatial enhancement) 

การเน้นข้อมูลภาพเชิงพื้นที่ เป็นกระบวนการการเน้นข้อมูลที่พิจารณาค่าของ
จุดภาพที่สนใจและจุดภาพข้างเคียงที่อยู่ติดกัน ดังนั้น จึงอาจเรียกการเน้นภาพด้วยวิธีนี้ว่า เทคนิคแบบบริเวณ
ข้างเคียง (Neighborhood technique) ในที่นี้จะกล่าวถึงเฉพาะเทคนิคการเน้นข้อมูลภาพเชิงพื้นที่แบบ 2-D 
convolution filtering    เพื่อตรวจหาและเน้นข้อมูลภาพในส่วนที่เป็นขอบเขตหรือรูปร่างของวัตถุหรือสิ่ง
ต่าง ๆ ให้เด่นชัดขึ้น หรือลดหรือขจัดสัญญาณรบกวนในข้อมูลภาพ เพื่อท าให้ภาพมีคุณภาพดีขึ้น 
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การเน้นข้อมูลเชิงพื้นที่แบบ 2-D convolution filtering จะใช้เมทริกซ์ของตัวเลขที่
เรียกว่า Convolution kernel หรือเรียกว่า เพื่อค านวณค่าเชิงเลขของข้อมูลภาพใหม่ในแต่ละจุดภาพจากการ
หาค่าเฉลี่ยแบบถ่วงน้ าหนักด้วยค่าตัวเลขภายในเมทริกซ์กับข้อมูลภาพเดิม โดยเริ่มค านวณจากจุดภาพแรก 
จากนั้นเลื่อนไปยังจุดภาพถัดไปจนกระทั่งครบทุก ๆ จุดภาพ ท าให้ได้ผลลัพธ์เป็นข้อมูลภาพใหม่ (รูปที่ 1.42) 

 

 
 

รูปที่ 1.42 วิธีการเน้นข้อมูลเชิงพื้นทีแ่บบ 2-D convolution filtering. จาก Tips and tutorials for Java 
4k games, โดย A. Hristov, 2007, ค้นเมือ่ 26 กุมภาพันธ์ 2556, จาก 

http://www.ahristov.com/tutorial/java4k-tips/procedural-grass.html 
 
โดยปกติแล้ว เมทริกซ์มักจะมีขนาด 3 x 3 หรือ 5 x 5 หรือ 7 x 7 หรือ 9 x 9 และ 

นิยมเรียกค่าตัวเลขภายในเมทริกซ์ว่า ค่าสัมประสิทธิ์ (Coefficient) ค่านี้ท าหน้าที่เสมือนเป็นตัวกรอง (Filter) 
ลักษณะของข้อมูลภาพที่ไม่ต้องการออกไป หรือใช้เน้นลักษณะหรือแบบรูป (Pattern) ของวัตถุหรือสิ่งต่าง ๆ 
ที่ปรากฏบนข้อมูลภาพ 

ตัวกรองพื้นฐานที่นิยมใช้ในการเน้นข้อมูลภาพสามารถแบ่งกว้าง ๆ ออกเป็น 2 
ประเภท คือ 1) ตัวกรองความถี่สูง (High-pass filter) ที่ใช้เพิ่มความเด่นชัดของเส้นขอบ (Edge 
enhancement) เช่น Gradient filter, Laplacian filter, หรือ Edge-sharpening filter เป็นต้น 2) ตัวกรอง
ความถี่ต่ า (Low-pass filter) ที่จะท าให้ได้ข้อมูลภาพผลลัพธ์ราบเรียบ (Smoothing) หรือพร่ามัว (Blurring) 
มากขึ้น เช่น Gaussian filter, Median filter, หรือ Adaptive median filter เป็นต้น (รูปที่ 1.43) 
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ตัวกรองแบบ Gradient East 

1 0 -1 

2 0 -2 

1 0 -1 
 

ข้อมูลภาพต้นฉบับ ข้อมูลภาพผลลัพธ์ 

  

 
 
 

ตัวกรองแบบ Laplacian 3x3 

0 -1 0 

-1 4 -1 

0 -1 0 
 

ข้อมูลภาพต้นฉบับ ข้อมูลภาพผลลัพธ์ 
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ตัวกรองแบบ Smooth Arithmetic Mean 

0.111 0.111 0.111 

0.111 0.111 0.111 

0.111 0.111 0.111 
 

ข้อมูลภาพต้นฉบับ ข้อมูลภาพผลลัพธ์ 

  
 

รูปที่ 1.43 ตัวอย่างของการใชต้ัวกรองเพื่อเน้นข้อมูลเชิงพื้นที่. จาก ArcGIS help library, 
โดย ESRI, Inc., 2012, ค้นเมือ่ 3 กันยายน 2556, จาก 

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//009t0000004s000000. 

3.9 การวิเคราะห์ข้อมูล 
 การวิเคราะห์ข้อมูลการรับรู้จากระยะไกลสามารถแบ่งกว้าง ๆ ได้ออกเป็น 2 ประเภท คือ 

การแปลตีความด้วยสายตา และการวิเคราะห์ด้วยคอมพิวเตอร์ การวิเคราะห์ข้อมูลมีจุดมุ่งหมายเพื่อจ าแนก  
หรือวิเคราะห์คุณลักษณะของวัตถุต่าง ๆ โดยอาศัยหลักการสะท้อนหรือการแผ่พลังงานแม่เหล็กไฟฟ้าจากวัตถุ  
ซึ่งวัตถุแต่ละชนิดมีลักษณะการสะท้อนหรือการแผ่รังสีแตกต่างกัน ผลลัพธ์ที่ได้จากการวิเคราะห์จะเป็น
สารสนเทศ ซึ่งอาจอยู่ในรูปข้อมูลเชิงปริมาณ เช่น จ านวนของสิ่งที่สนใจ ระยะทาง ขนาดพื้นที่ หรือปริมาณ
การเปลี่ยนแปลง เป็นต้น หรืออาจอยู่ในรูปข้อมูลเชิงคุณภาพ เช่น ลักษณะภูมิประเทศ แบบรูปของล าน้ า 
โครงสร้างทางธรณีวิทยา หรือ ความเสียหายที่เกิดจากภัยธรรมชาติ ที่สามารถน าไปจัดเก็บในระบบสารสนเทศ
ภูมิศาสตร์เพื่อจะประโยชน์ต่อไป 

4. ระบบก าหนดต าแหน่งบนโลก (Global Positioning System: GPS) 

4.1 ระบบก าหนดต าแหน่งบนโลกคืออะไร 
  ระบบก าหนดต าแหน่งบนโลกหรือจีพีเอสเป็นระบบที่ใช้ในการบอกต าแหน่ง มาจากค าว่า 
“Global Positioning System” หรือ “GPS” ซึ่งศัพท์บัญญัติฉบับราชบัณฑิตยสถาน ได้นิยามเป็น “ระบบ
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ก าหนดต าแหน่งบนโลก” จีพีเอสมีชื่อทางการว่า “NAVigation Satellite Timing And Ranging Global 
Positioning System” หรือ “NAVSTAR GPS” จีพีเอสจัดเป็นระบบดาวเทียมน าหนบนโลก (Global 
Navigation Satellite System : GNSS) ที่ได้รับการใช้งานอย่างแพร่หลายทั่วโลก และไม่มีค่าธรรมเนียมการ
ใช้บริการ โดยมีกระทรวงกลาโหมของประเทศสหรัฐอเมริกาเป็นหน่วยงานที่ควบคุมดูแลการท างานของระบบ 

4.2 องค์ประกอบของระบบก าหนดต าแหน่งบนโลก 
  จีพีเอสท างานได้โดยอาศัยองค์ประกอบ 3 ส่วน ได้แก่ 
  1) ส่วนอวกาศ (Space segment) เป็นกลุ่มดาวเทียมที่มีหน้าที่ส่งสัญญาณวิทยุไปยังส่วน
ผู้ใช้ ประกอบด้วยดาวเทียมหลักอย่างน้อย 24 ดวง (Core constellation) โคจรรอบโลกที่ระดับความสูง 
20,200 กิโลเมตร เหนือพื้นผิวโลก ระนาบวงโคจรดาวเทียมจีพีเอสมี 6 ระนาบ แต่ละระนาบมีดาวเทียมโคจร
อย่างน้อย 4 ดวง (รูปที่ 1.44) เพื่อจะให้ทุก ๆ พื้นที่บนโลกสามารถรับสัญญาณวิทยุจากดาวเทียมจีพีเอสได้ 
อย่างน้อย 4 ดวง ตลอดเวลา 24 ชั่วโมง ในเดือนมิถุนายน 2554 กองทัพอากาศของประเทศสหรัฐอเมริกาได้มี
การปรับปรุงกลุ่มดาวเทียมจีพีเอส โดยการเพิ่มดาวเทียมหลักอีก 3 ดวง และปรับวงโคจรดาวเทียมจ านวน 6 
ดวง จึงท าให้มีดาวเทียมหลักจ านวน 27 ดวง (National Coordination Office for Space-Based 
Positioning, Navigation, and Timing, 2013) ทั้งนี้ กลุ่มดาวเทียมจีพีเอสที่โคจรและปฏิบัติภารกิจจริง ๆ 
จะมีมากกว่า 24 ดวง (ณ วันที่ 20 เดือนพฤศจิกายน 2555 มีทั้งหมด 31 ดวง) ดาวเทียมเหล่านี้เป็นดาวเทียม
ส ารอง และยังมีประโยชน์ในแง่ของการเพ่ิมประสิทธิภาพของระบบให้ดีมากยิ่งขึ้น 
 

 
 

รูปที่ 1.44 กลุ่มดาวเทียมจีพีเอส. จาก GPS systems, โดย National Coordination Office for Space-
Based Positioning, Navigation, and Timing, 2013, ค้นเมื่อ 6 กันยายน 2556, จาก 

http://www.gps.gov/systems/gps/space/. 
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  2) ส่วนควบคุม (Control segment) เป็นสถานีควบคุมดาวเทียมภาคพื้นดินที่ตั้งอยู่ตามจุด
ต่าง ๆ ทั่วโลก ท าหน้าที่ติดตามและควบคุมการท างานของดาวเทียม (รูปที่ 1.45) 
 

 
 

รูปที่ 1.45 ส่วนควบคุมของจีพีเอส. จาก GPS systems, โดย National Coordination Office for Space-
Based Positioning, Navigation, and Timing, 2013, ค้นเมื่อ 6 กันยายน 2556, จาก 

http://www.gps.gov/systems/gps/control/. 
 

  3) ส่วนผู้ใช้ (User segment) คือ ผู้ใช้งานที่ใช้เครื่องรับสัญญาณวิทยุจากดาวเทียมจีพีเอส 
(นิยมเรียกกันว่า เครื่องจีพีเอส) (รูปที่ 1.46) เครื่องจีพีเอสจะรับข้อมูลสัญญาณวิทยุจากดาวเทียมจีพีเอส และ
น ามาค านวณเพื่อให้ไดผ้ลลัพธ์เป็นค่าพิกัดต าแหน่งของเครื่องจีพีเอสหรือของผู้ใช้ 

รูปที่ 1.46 เครือ่งจีพีเอส 
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4.3 หลักการท างานของระบบก าหนดต าแหน่งบนโลก 
  การท างานของระบบจีพีเอสจะอาศัยหลักการสามเหลี่ยมระยะ (Trilateration) โดยการ
ค านวณระยะทางระหว่างดาวเทียมกับเครื่องจีพีเอส ซึ่งระยะทางนี้ค านวณได้จากการเปรียบเทียบเวลาที่
ดาวเทียมจีพีเอสส่งสัญญาณวิทยุออกมากับเวลาที่เครื่องจีพีเอสรับสัญญาณวิทยุน้ัน (รูปที่ 1.47) ความแตกต่าง
ของระยะเวลาดังกล่าวจะท าให้เครื่องจีพีเอสสามารถค านวณระยะทางระหว่างเครื่องจีพีเอสกับดาวเทียมแต่ละ
ดวงได้ โดยใช้ความสัมพันธ ์คือ ระยะทางเท่ากับอัตราเร็วของแสงคูณด้วยระยะเวลา 
 

 
 

รูปที่ 1.47 การค านวณระยะทางระหว่างดาวเทียมกับเครื่องจีพีเอส. จาก GPS: Essentials of satellite 
navigation compendium (p. 15), โดย U-Blox Holding AG, 2009, ค้นเมื่อ 6 กันยายน 2556, จาก 

https://www.u-blox.com/sites/default/files/products/documents/GPS-
Compendium_Book_%28GPS-X-02007%29.pdf. 

 
เมื่อเครื่องจีพีเอสสามารถรับสัญญาณจากดาวเทียมได้อย่างน้อย 4 ดวง จะท าให้สามารถ

ค านวณต าแหน่งของเครื่องจีพีเอสได้ (ในทางทฤษฎี สัญญาณจากดาวเทียม 3 ดวง สามารถค านวณต าแหน่งได้ 
อย่างไรก็ตาม เนื่องจากความคลาดเคลื่อนของการค านวณเวลา จึงจ าเป็นต้องใช้สัญญาณจากดาวเทียม 4 ดวง) 
(รูปที่ 1.48) ทั้งนี้ จ านวนดาวเทียมที่เครื่องจีพีเอสรับสัญญาณได้มากจะท าให้ผลลัพธ์ของการค านวณต าแหน่ง
มีความถูกต้องมากขึ้น MAHID
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รูปที่ 1.48 การหาต าแหน่งเครื่องจีพีเอสด้วยหลักการสามเหลี่ยมระยะ 

5. การประยุกต์ใช้เทคโนโลยีภูมิสารสนเทศ 
ในปัจจุบัน กิจกรรมต่าง ๆ ที่เกี่ยวข้องกับการวางแผน การบริหาร การประเมิน การติดตามเฝ้าระวัง 

หรือการตัดสินใจในประเด็นปัญหาด้านต่าง ๆ ได้ให้การยอมรับและให้ความส าคัญกับมิติเชิงพ้ืนที่เป็นอย่างมาก 
เทคโนโลยีภูมิสารสนเทศจึงกลายเป็นเทคโนโลยีที่มีความส าคัญและเข้ามามีบทบาทต่อนักวางแผนหรือผู้
ตัดสินใจในในทุกระดับและทุกภาคส่วนอย่างหลีกเลี่ยงไม่ได้ ด้วยเหตุนี้ จึงมีการน าเทคโนโลยีภูมิสารสนเทศไป
ประยุกต์ใช้ในระดับท้องถิ่น ระดับประเทศ หรือระดับโลก ทั้งภาครัฐและเอกชน อย่างกว้างขวาง เช่น ด้านภัย
พิบัติ ด้านสาธารณสุขและระบาดวิทยา ด้านผังเมือง ด้านสถาปัตยกรรม ด้านโบราณคดี ด้านการท่องเที่ยว 
ด้านการเกษตร ด้านการจัดการการใช้ที่ดิน ด้านการจัดการสิ่งแวดล้อมและทรัพยากร ด้านนิเวศวิทยา ด้าน
การส ารวจรังวัดและการท าแผนที่ ด้านสมุทรศาสตร์ ด้านอุตุนิยมวิทยาและภูมิอากาศ ด้านการน าทาง ทั้งทาง
บก เรือ อากาศ ด้านการทหาร ด้านอาชญาวิทยา ด้านสาธารณูปโภค ด้านการขนส่ง ด้านโทรคมนาคม ด้าน
ธุรกิจ ฯลฯ 

อย่างไรก็ตาม ข้อมูลเชิงพื้นที่ของหน่วยงานต่าง ๆ ที่มีการรวบรวมและจัดเก็บมากขึ้นอย่างต่อเนื่อง 
แต่ยังขาดการท าให้เป็นมาตรฐาน (Standardization) ท าให้ผู้ผลิตหรือผู้ใช้จากหน่วยงานหรือองค์กรต่าง ๆ 
ประสบอุปสรรคต่อการเข้าถึง เผยแพร่ และการแลกเปลี่ยนข้อมูล และมีโอกาสที่จะเกิดความซ้ าซ้อนของข้อมลู 
และความสิ้นเปลืองงบประมาณ ด้วยเหตุนี้ องค์การระหว่างประเทศว่าด้วยการมาตรฐาน ( International 
Organization for Standardization) หรือเรียกย่อว่า ISO ได้ร่วมมือกับภาคส่วนต่าง ๆ พัฒนามาตรฐาน
สารสนเทศภูมิศาสตร/์ภูมิสารสนเทศ (ISO/TC 211 Geographic information/Geomatics) โดยมุ่งหวังที่จะ
ขจัดปัญหาและอุปสรรคดังกล่าวข้างต้น และใช้เป็นกรอบส าหรับการพัฒนาและประยุกต์ใช้ภูมิสารสนเทศ 
เพื่อให้การผลิต การประมวลผลวิเคราะห์ การเผยแพร่และแลกเปลี่ยนภูมิสารสนเทศระหว่างผู้ใช้หรือระบบ
เป็นไปอย่างมีมาตรฐาน สามารถปฏิบัติงานร่วมกันได ้
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ในประเทศไทย ส านักงานพัฒนาเทคโนโลยีอวกาศและภูมิสารสนเทศ คณะกรรมการภูมิสารสนเทศ
แห่งชาติ ส านักงานมาตรฐานผลิตภัณฑ์อุตสาหกรรม (สมอ.) ร่วมกับสถาบันการศึกษา และการมีส่วนร่วมจาก
หน่วยงานภาครัฐและเอกชน ได้พยายามพัฒนามาตรฐานสารสนเทศภูมิศาสตร์/ภูมิสารสนเทศ เพื่อใช้ใน
ประเทศไทย ปัจจุบัน ได้มีการประกาศมาตรฐานผลิตภัณฑ์อุตสาหกรรม สารสนเทศภูมิศาสตร์ - ค าอธิบาย
ข้อมูล (มอก.19115 - 2548 Geographic Information – Metadata) และมาตรฐานส่งเสริมภูมิสารสนเทศ 
พ.ศ. 2555  แล้ว และยังคงมีการด าเนินการพัฒนามาตรฐานต่าง ๆ ที่เกี่ยวข้องอย่างต่อเนื่อง ซึ่งในอนาคต 
คาดว่าจะมีมาตรฐานต่าง ๆ เพิ่มมากขึ้น และจะมีหน่วยงานภาครัฐและเอกชนน ามาตรฐานไปปฏิบัติให้เป็น
รูปธรรมมากขึ้น 

นอกจากประเด็นด้านข้อมูลแล้ว ซอฟต์แวร์เชิงพาณิชย์ที่ปัจจุบันยังคงมีราคาค่อนข้างสูง จนท าให้ผู้ใช้
บางกลุ่มไม่สามารถจัดหามาใช้งานได้ หรืออาจจะพิจารณาแล้วเห็นว่าไม่สามารถใช้งานได้อย่างคุ้มค่าเพียงพอ 
จึงหันมาเลือกใช้งานซอฟต์แวร์เสรี (Free software) หรือซอฟต์แวร์รหัสเปิด (Open source software) 
แทน ซึ่งในปัจจุบัน มีซอฟต์แวร์ด้านภูมิสารสนเทศให้เลือกใช้งานเป็นจ านวนมาก และสามารถตอบสนองการ
ใช้งานได้ค่อนข้างเป็นที่น่าพอใจ เช่น Quantum GIS, GRASS GIS, หรือ MapWindow GIS เป็นต้น จึง
จัดเป็นอีกทางเลือกในด้านซอฟต์แวร์ที่น่าสนใจ 

ในอนาคต มีแนวโน้มว่าจะมีการน าเทคโนโลยีภูมิสารสนเทศไปประยุกต์ใช้งานกันมากยิ่งขึ้นกว่าใน
ปัจจุบัน และอาจจะกลายเป็นส่วนหนึ่งในการท างานและการด าเนินชีวิตในแต่ละวัน นอกจากนี้ ความก้าวหน้า
ของเทคโนโลยีระบบสารสนเทศภูมิศาสตร์ การรับรู้จากระยะไกล ระบบก าหนดต าแหน่งบนโลก และ
เทคโนโลยีสารสนเทศอื่น ๆ ที่มีอยู่อย่างต่อเนื่องและรวดเร็ว จะท าให้การเข้าถึงและใช้ประโยชน์ข้อมูลเชิงพื้นที่
มีความสะดวก ง่าย รวดเร็ว และมีค่าใช้จ่ายที่ลดลง 
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บทที่ 2 แผนที่และระบบพิกัด 

 ข้อมูลเชิงพื้นที่ที่ถูกจัดเก็บและแสดงในรูปของแผนที่ถือเป็นองค์ประกอบส ำคัญของระบบสำรสนเทศ
ภูมิศำสตร์ ด้วยเหตุนี้ กำรท ำควำมเข้ำใจเกี่ยวกับหลักกำรทำงด้ำนแผนที่จึงมีควำมจ ำเป็นอย่ำงยิ่งส ำหรับกำร
ใช้งำนเทคโนโลยีภูมิสำรสนเทศ  ในบทนี้ จะกล่ำวถึง แนวคิดพื้นฐำนทำงแผนที่และระบบพิกัดที่ส ำคัญ รวมถึง
กำรใช้งำนแผนที่ เพื่อที่จะให้ผู้อ่ำนสำมำรถประยุกต์ใช้เทคโนโลยีภูมิสำรสนเทศได้อย่ำงถูกต้องและเหมำะสม 

1. ความหมายของแผนที่ 
 แผนที่ หมำยถึง สิ่งที่มนุษย์สร้ำงขึ้นเพื่อแสดงลักษณะของพื้นผิวโลก หรือสิ่งที่ปรำกฏบนพื้นผิวโลก 
ทั้งที่เกิดขึ้นเองตำมธรรมชำติ และที่มนุษย์สร้ำงขึ้น หรือแสดงต ำแหน่งวัตถุบนท้องฟ้ำ (Celestial sphere) 
ทั้งหมดหรือบำงส่วน โดยน ำมำย่อส่วนให้มีขนำดเล็กลงตำมอัตรำส่วนที่ต้องกำร และใช้สี เส้น หรือรูปต่ำง ๆ ที่
ก ำหนดขึ้นเป็นเครื่องหมำย หรือสัญลักษณ์แทนสิ่งเหล่ำนั้น และน ำมำแสดงบนแผ่นวัสดุพื้นรำบที่เลือกสรรแล้ว 
โดยพยำยำมรักษำลักษณะของสิ่งต่ำง ๆ ที่แสดงบนแผนที่ให้คล้ำยจริงมำกที่สุด 

2. ลักษณะเฉพาะของแผนที่ 
 แผนที่มีคุณสมบัติหรือลักษณะเฉพำะที่ผู้จัดท ำหรือผู้อ่ำนแผนที่จ ำเป็นต้องตระหนักดังนี้ 

 แผนที่แสดงต ำแหน่งและควำมสัมพันธ์ของวัตถุหรือสิ่งต่ำง ๆ บนพื้นโลกโดยอำศัยระบบ
พิกัดอ้ำงอิง (Coordinate reference system) 

 แผนที่มีมำตรำส่วน (Scale) ที่บ่งบอกถึงขนำดของวัตถุจริงบนพื้นโลก 

 แผนที่เกิดจำกกำรฉำย (Projection) รำยละเอียดของวัตถุหรือสิ่งต่ำง ๆ บนพื้นโลก ที่เป็น
พื้นผิว 3 มิติลงบนวัสดุพ้ืนผิวรำบ 2 มิต ิ

 แผนที่ไม่ได้แสดงรำยละเอียดของวัตถุหรือสิ่งต่ำง ๆ ทั้งหมดที่ปรำกฏบนพื้นโลก เนื่องจำก
ข้อจ ำกัดของกำรแสดงข้อมูลบนแผนที่ (Generalization) หรือวัตถุประสงค์ของกำรท ำแผนที่ที่ต้องกำรเน้น
ข้อมูลเฉพำะ (Purpose) 

 แผนที่ใช้สัญลักษณ์ (Symbol) แทนวัตถุหรือสิ่งต่ำง ๆ ที่ปรำกฏบนพื้นโลก เพื่อแสดงลง
บนแผนที่ 

3. ประเภทของแผนที่ 
ในปัจจุบัน มีกำรผลิตแผนที่เพื่อใช้ประโยชน์ในงำนด้ำนต่ำง ๆ มำกมำย เพื่อให้เกิดควำมสะดวกต่อ

กำรใช้งำน หรือควำมเป็นมำตรฐำนในกำรผลิตแผนที่ จึงได้มีกำรจ ำแนกชนิดแผนที่ออกเป็นระบบต่ำง ๆ ซึ่งมี
รำยละเอียดดังนี ้(ทว ีทองสว่ำง, ไพฑูรย์ ปิยะปกรณ์, วันทนีย์ ศรีรัฐ, และ วินิตำ เผ่ำนำค, 2545, น. 9 – 21) 
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 กำรจ ำแนกชนิดแผนที่แบบทั่ว ๆ ไป จ ำแนกออกเป็น 3 ชนิด 
o แผนที่แบบรำบ (Planimetric map) คือ แผนที่ที่แสดงพื้นผิวของโลกในทำงรำบ 

และไม่มีรำยละเอียดแสดงควำมสูงต่ ำ แผนที่ชนิดนี้ใช้แสดงต ำแหน่งของสิ่งต่ำง ๆ และสำมำรถใช้หำระยะทำง
รำบได้  

o แผนที่ภูมิประเทศ (Topographic map) เป็นแผนที่ที่แสดงรำยะละเอียด
เช่นเดียวกับแผนที่แบนรำบ และมีกำรเพิ่มรำยละเอียดควำมสูงต่ ำของภูมิประเทศลงในแผนที่ 

o แผนที่ภำพถ่ำย (Photomap) คือ แผนที่ที่ท ำจำกภำพถ่ำยทำงอำกำศ ซึ่งมีระบบ
พิกัดอ้ำงอิง รำยละเอียดภำยในและภำยนอกขอบระวำงแผนที่ โดยปกติ จะไม่มีกำรแสดงรำยละเอียดควำมสูง
ต่ ำ  

 กำรจ ำแนกชนิดแผนที่ตำมกำรใช้ประโยชน์ ซึ่งสำมำรถจ ำแนกออกไปได้มำกมำยหลำย
ประเภท แต่ชนิดที่ส ำคัญมีดังนี้  

o แผนที่ทั่วไป (General map) 
o แผนที่ทรวดทรง (Relief map) 
o ผังเมืองหรือแผนที่ตัวเมือง (Town plan or City map) 
o แผนที่ถนน (Road map) 
o แผนที่ทำงหลวง (Highway map) 
o แผนที่เดินอำกำศ (Aeronautical chart) 
o แผนที่เดินเรือ (Nautical chart) 
o แผนที่โฉนด (Cadastral map) 
o แผนที่เดินเรือ (Nautical chart) 
o แผนที่เฉพำะเรื่อง (Thematic map) สำมำรถแบ่งออกเป็น 2 ประเภท คือ 

1) ประเภทแสดงคุณลักษณะ (Qualitative map) เช่น แผนที่กำรใช้ที่ดนิ 
(Land use map) แผนที่ดิน (Soil map) แผนที่ธรณีวิทยำ (Geological map) เป็นต้น 

2) ประเภทแสดงปริมำณ (Quantitative map) เช่น แผนที่ปริมำณน้ ำฝน 
แผนที่ประชำกร แผนที่แสดงอุณหภูมิ เป็นต้น 

o แผนที่สถิติ (Statistic map) จัดเป็นแผนที่เฉพำะเรื่อง (Thematic map) ที่ใช้
แสดงข้อมูลสถิติ สำมำรถแบ่งออกเป็น 5 ชนิด คือ 

1) แผนที่จุด (Dot map หรือ Dot density map) ใช้จุดเป็นตัวแทนข้อมูล
ที่แสดงในแผนที่ เช่น 1 จุด แทนเหตุกำรณ์กำรเกิดอุบัติเหตุ 1 ครั้ง หรือ 1 จุด แทนจ ำนวนผู้มีสิทธิ์ลงคะแนน
เลือกตั้ง 5,000 คน เป็นต้น  
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2) แผนที่เส้นค่ำเท่ำ (Isopleth map หรือ Isarithmic map) ใช้เส้นเป็น
ตัวแทนข้อมูลที่แสดงในแผนที่ มักใช้กับข้อมูลที่มีควำมต่อเนื่องเชิงพ้ืนที่ เช่น ควำมสูง ควำมกดอำกำศ ปริมำณ
น้ ำฝน เป็นต้น 

3) แผนที่โคโรเพลท (Choropleth map หรือ Graduated color map) 
ใช้ระดับสี (Tint) แสดงควำมสัมพันธ์ของปริมำณของข้อมูลต่อหน่วยพื้นที่ เช่น ต้องกำรแสดงควำมหนำแน่น
ของประชำกรในแต่ละจังหวัดของประเทศไทย สำมำรถใช้สีแสดงข้อมูลควำมหนำแน่นในแต่ละจังหวัด โดย
อำจก ำหนดให้สีเข้มแทนค่ำควำมหนำแน่นสูง และสีอ่อนแทนค่ำควำมหนำแน่นต่ ำ เป็นต้น  

4) แผนที่ขนำดสัญลักษณ์ลดหลั่น (Graduated symbol map หรือ 
Proportional symbol map) เป็นกำรแสดงควำมสัมพันธ์ของข้อมูลกับขนำดของสัญลักษณ์ที่ปรำกฏบนแผน
ที่ ใช้แสดงรำยละเอียดข้อมูลที่เป็นจุด หรือเส้นบนแผนที่ เช่น ขนำดของประชำกรของเมืองหลวง เป็นต้น 

5) แผนที่เดซิเมตริก (Dasymetric map) เป็นแผนที่ที่มีควำมคล้ำยคลึงกับ
แผนที่โคโรเพลท ซึ่งใช้สัญลักษณ์เชิงพ้ืนที่ในกำรแสดงข้อมูล แต่สำมำรถแสดงข้อมูลได้ใกล้เคียงกับสภำพควำม
เป็นจริงมำกกว่ำ 

4. องค์ประกอบของแผนที่ 
แผนที่แต่ละระวำงจะมีข้อมูลต่ำง ๆ ที่จ ำเป็นเพื่อให้ผู้ใช้แผนที่สำมำรถอ่ำนและใช้งำนแผนที่ได้อย่ำง

ถูกต้อง ข้อมูลพื้นฐำนที่ส ำคัญและจัดเป็นองค์ประกอบของแผนที่ทั่ว ๆ ไป มีดังนี้ 

 ชื่อแผนที่ (Title) เป็นข้อควำมที่บ่งบอกชื่อหัวเรื่องของแผนที่ และใช้ส ำหรับสื่อควำมหมำยให้ผู้ใช้
แผนที่ทรำบว่ำเป็นแผนที่เกี่ยวกับอะไร 

 พื้นที่บริเวณที่เป็นแผนที่ (Map area หรือ Map face) เป็นส่วนที่ใช้ส ำหรับแสดงสัญลักษณ์ 
(Symbol) ที่เป็นตัวแทนวัตถุ หรือปรำกฏกำรณ์ใด ๆ ที่ปรำกฏบนบนพื้นโลก พื้นที่ส่วนนี้อำจจะมีข้อควำมที่ใช้
อธิบำยหรือบ่งบอกรำยละเอียดต่ำง ๆ เช่น ชื่อสถำนที่ (Place name) ชื่อแม่น้ ำ ภูเขำ ค่ำควำมสูง หรือเลข
ก ำกับเส้นชั้นควำมสูง เป็นต้น นอกจำกนี้ ในแผนที่บำงระวำงอำจจะมีเส้นที่เรียกว่ำ เส้นขอบระวำงแผนที่ 
(Neat line หรือ Sheet line) ที่ใช้ส ำหรับกั้นขอบเขตระหว่ำงพื้นที่บริเวณที่เป็นแผนที่ (Map area) กับพื้นที่
อื่น ๆ ออกจำกกัน  

 ค ำอธิบำยสัญลักษณ์ (Legend) เป็นข้อมูลที่อธิบำยถึงสัญลักษณ์ต่ำง ๆ ที่ใช้แทนวัตถุ หรือ
ปรำกฏกำรณ์ใด ๆ บนพื้นโลกที่ปรำกฏในแผนที่ ค ำอธิบำยสัญลักษณ์ประกอบด้วยตัวอย่ำงของสัญลักษณ์และ
ข้อควำมบ่งบอกควำมหมำยของสัญลักษณ์ 

 มำตรำส่วน (Scale) เป็นข้อมูลที่บ่งบอกว่ำแผนที่มีอัตรำกำรย่อส่วนเท่ำใด มำตรำส่วนของแผนที่ 
จึงหมำยถึง อัตรำส่วนระหว่ำงระยะทำงบนแผนที่กับระยะทำงบนภูมิประเทศจริง  และสำมำรถแสดง
ควำมสัมพันธ์เป็นสูตรได้ดังนี ้
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มำตรำส่วนที่ใช้แสดงบนแผนที่แบ่งออกเป็น 3 ประเภท คือ 
o มำตรำส่วนแบบเศษส่วน (Fractional scale หรือ Representative fraction) เป็นกำร

แสดงมำตรำส่วนของแผนที่โดยกำรใช้อัตรำส่วนหรือสัดส่วนเปรียบเทียบ "ระว่ำงระยะทำงบนแผนที่กับ
ระยะทำงบนภูมิประเทศจริง และไม่มีหน่วยวัดระยะก ำกับ เช่น 

1 : 4,000 หรือ  
4,000

1  

1 : 50,000 หรือ  
50,000

1  

1 : 250,000 หรือ  
250,000

1  

มำตรำส่วนแบบเศษส่วนจำกตัวอย่ำงข้ำงต้น มีควำมหมำยว่ำ เมื่อวัดระยะบนแผนที่ได้ 1 
หน่วย จะเท่ำกับระยะทำงบนภูมิประเทศจริง 4,000 หรือ 50,000 หรือ 250,000 หน่วย ตำมล ำดับ ดังนั้น ถ้ำ
วัดระยะทำงระหว่ำงจุด 2 จุด บนแผนที่มำตรำส่วน 1:50,00 ได้ 1 เซนติเมตร จุด 2 จุดนี้ จะมีระยะทำงจริง
บนพื้นโลกเท่ำกับ 50,000 เซนติเมตร หรือ 500 เมตร เป็นต้น 

o มำตรำส่วนกรำฟิก (Graphic scale หรือ Bar scale) เป็นกำรแสดงมำตรำส่วนโดยกำร
น ำเส้นตรงมำแบ่งออกเป็นส่วน ๆ แต่ละส่วนมีตัวเลขระยะบนภูมิประเทศของหน่วยวัดระยะก ำกับ เช่น ไมล์ 
(Statute miles) เมตร (Meters) หลำ (Yards) และไมล์ทะเล (Nautical miles) ตัวเลขก ำกับนิยมใช้เลข
จ ำนวนเต็มหลักสิบ หรือหลักร้อย เพื่อควำมสะดวกในกำรอ่ำนและใช้วัดระยะ 

มำตรำส่วนกรำฟิกประกอบด้วย 2 ส่วน คือ ส่วนที่เป็นขีดแบ่งส่วนเต็ม (Primary scale) 
และส่วนที่เป็นขีดส่วนแบ่งย่อย (Extension scale) ซึ่งเกิดจำกกำรน ำขีดแบ่งส่วนเต็ม 1 ช่อง มำแบ่งออกเป็น
ส่วนย่อย ตำมปกตินิยมแบ่งออกเป็น 10 ส่วนย่อยมำตรำส่วนเส้นบรรทัด (รูปที่ 2.1) 

 

 
รูปที่ 2.1 มำตรำส่วนกรำฟิก 

 
กำรใช้มำตรำส่วนกรำฟิกท ำได้โดยกำรใช้ไม้บรรทัดวัดระยะทำงบนแผนที่ น ำระยะทำงที่

วัดไดว้ำงทำบที่มำตรำส่วนกรำฟิกที่มีหน่วยวัดระยะทำงตำมต้องกำร จำกนั้นอ่ำนระยะทำงบนมำตรำส่วนส่วน
กรำฟิก จะท ำให้ทรำบระยะทำงจริงบนพื้นโลก 
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o มำตรำส่วนค ำพูด (Verbal scale หรือ Equivalent scale) เป็นกำรแสดงมำตรำส่วนของ
แผนที่ที่ใช้หน่วยวัดระยะทำงบนภูมิประเทศจริงเป็นหน่วยที่ใหญ่กว่ำหน่วยวัดระยะบนแผนที่ เช่น 

 
 
1 นิ้ว  ต่อ 1 ไมล ์
1 เซ็นติเมตร ต่อ 5 กิโลเมตร 
2 เซ็นติเมตร ต่อ 1 กิโลเมตร 
 

โดยปกติแล้ว มักจะใชม้ำตรำส่วนแบบและเศษส่วนมำตรำส่วนกรำฟิกแสดงบนแผนที่ 

 ทิศเหนือ (North arrow) เป็นข้อมูลที่ใช้บ่งบอกทิศทำงของแผนที่ มักจะใช้กรำฟิกรูปลูกศรและ
อำจจะมีตัวอักษร N ก ำกับเพื่อแสดงทิศเหนือ 

 ระบบพิกัดอ้ำงอิง (Coordinate reference system) เป็นข้อมูลที่บ่งบอกว่ำสิ่งที่ปรำกฏบนแผนที่
มีต ำแหน่งอยู่ที่ใดบนพ้ืนโลก โดยใช้เส้นตำมแนวนอนและแนวต้ังที่มีค่ำตัวเลขและ/หรือตัวอักษรก ำกับไว้ เส้นนี้
อำจจะแสดงในรูปขีดแบ่งที่ขอบของพื้นที่บริเวณที่เป็นแผนที่ (Map area) หรืออำจจะแสดงเป็นเครื่องหมำย
หรือเส้นในพื้นทีท่ี่เป็นแผนที่ หรืออำจจะแสดงทั้งสองลักษณะพร้อมกัน 

 ข้อมูลเสริมประกอบอื่น ๆ (Note) เช่น ผู้ผลิต วันที่ผลิต แหล่งข้อมูล กรรมวิธีผลิต ตรำสัญลักษณ์
ของหน่วยงำน ตำรำงข้อมูลและรูปภำพต่ำง ๆ ที่เกี่ยวข้อง ซึ่งใช้เป็นข้อมูลเสริมประกอบหรืออ้ำงอิงให้กับผู้ใช้
แผนที่ 

5. ประโยชน์ของแผนที่ 
 ผู้อ่ำนแผนทีส่ำมำรถใช้ประโยชน์จำกแผนที่เพื่อตอบค ำถำมต่ำง ๆ ได้ดังนี้ 

 เพื่อตอบค ำถำม “อะไร” เช่น สถำนที่นี้ คือ วัด โรงเรียน สนำมบิน พื้นป่ำ หรือแหล่งน้ ำ? ผู้ใช้แผน
ที่สำมำรถตอบค ำถำมนี้ได้จำกกำรอ่ำนค ำอธิบำยสัญลักษณ์บนแผนที่  

 เพื่อตอบค ำถำม “ที่ใด” เช่น โรงเรียน ก. อยู่ที่ใดหรือต ำแหน่งใด? หรือ แหล่งน้ ำผิวดินมีอยู่ที่ใด
หรือต ำแหน่งใด? ผู้ใช้แผนที่สำมำรถตอบค ำถำมนี้ได้จำกกำรอ่ำนสัญลักษณ์ประกอบกับข้อควำมรำยละเอียด
บนแผนที่โดยตรง และ/หรือกำรอ่ำนค่ำพิกัดของสิ่งนั้น เพื่อให้สำมำรถระบุต ำแหน่งในระบบพิกัดใด ๆ ที่แน่ชัด
ได้ นอกจำกนี้ ผู้ใช้แผนที่ยังสำมำรถใช้ข้อมูลต ำแหน่งในกำรค ำนวณระยะทำง ทิศทำง ขนำดและพื้นที่ ควำม
หนำแน่นและกำรกระจำย หรือควำมลำดชัน รวมทั้งใช้ในกำรน ำทำงไปยังสถำนที่ต่ำง ๆ ไดต้ำมต้องกำร    

 เพื่อตอบค ำถำม “ท ำไมและอย่ำงไร” เช่น ท ำไมจึงพบป่ำดิบชื้นกับพื้นที่เฉพำะบำงแห่งเท่ำนั้น 
เพรำะเหตุใด?   ผู้ใช้แผนที่สำมำรถตอบค ำถำมนี้ได้จำกกำรใช้แผนที่หลำย ๆ ประเภทประกอบกำรพิจำรณำ 
เพื่อสังเกต ท ำควำมเข้ำใจ ตีควำม และวิเครำะห์ข้อมูลเกี่ยวกับกำรกระจำย (Distribution) ควำมคล้ำยคลึง
หรือควำมแตกต่ำง (Similarity and difference) ควำมสัมพันธ์ (Relationship) หรือแบบรูป (Pattern) ของ

MAHID
OL



บทที่ 2 แผนที่และระบบพิกัด  หน้า 59 

 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

สิ่งต่ำง ๆ หรือปรำกฏกำรณ์ที่เกิดขึ้นในพื้นที่  เช่น ลักษณะกำรเพำะปลูกพืช ลักษณะกำรตั้งถิ่นฐำน หรือ
ลักษณะภูมิอำกำศ ฯลฯ จนท ำให้ทรำบถึงสำเหตุและกระบวนกำรต่ำง ๆ ที่เกี่ยวข้อง และสำมำรถน ำควำมรู้
ควำมเข้ำใจดังกล่ำวไปใช้ในกำรวำงแผน กำรบริหำรจัดกำร หรือกำรพยำกรณ์ปรำกฏกำรณ์ที่สนใจได้อย่ำง
เหมำะสม ดังน้ัน กำรใช้แผนที่ลักษณะนี้ ผู้ใช้แผนที่จ ำเป็นต้องมีควำมรู้ และประสบกำรณ์ในสำขำวิชำที่ต่ำง ๆ 
ที่เกี่ยวข้องกับเรื่องที่ก ำลังศึกษำ จึงจะท ำให้ผลลัพธ์ของกำรวิเครำะห์มีควำมถูกต้อง 

6. สัณฐานโลก (Earth’s shape and size) 
กำรศึกษำสัณฐำน (ขนำดและรูปร่ำง) ของโลกมีควำมส ำคัญต่อกำรท ำแผนที่ เนื่องจำกกำรก ำหนด

ระบบพิกัดที่ใช้ในกำรอ้ำงอิงต ำแหน่งของวัตถุต่ำง ๆ จ ำเป็นต้องมีกำรอ้ำงอิงกับขนำดและรูปร่ำงของโลกที่มี
ควำมถูกต้อง สัณฐำนของโลกสำมำรถแบ่งออกเป็น 3 ประเภท (วิชัย เยี่ยงวีรชน, 2548, น. 5 - 6) (รูปที่ 2.2) 
คือ 

 

 
 

รูปที่ 2.2 สัณฐำนโลก. จำก การส ารวจรังวัด: ทฤษฎีและการประยุกต์ใช้ (น. 6), 
โดย วิชัย เยี่ยงวีรชน, 2548, กรุงเทพฯ: ส ำนักพิมพ์แห่งจุฬำลงกรณ์มหำวิทยำลัย. 

 
1) สัณฐำนโลกทำงกำยภำพ (Terrestrial surface or Earth surface) หมำยถึง เส้นขอบเขตระหว่ำง

พื้นผิวดินหรือพื้นผิวน้ ำกับบรรยำกำศรอบพื้นผิวโลก เป็นลักษณะสัณฐำนจริงของพื้นผิวโลก ไม่สำมำรถนิยำม
ได้ด้วยรูปทรงเรขำคณิต หรือแบบจ ำลองทำงคณิตศำสตร์ 

2) สัณฐำนโลกจีออยด์ (Geoid) หมำยถึง สัณฐำนของโลกที่เกิดจำกกำรสมมุติให้พื้นผิวของน้ ำทะเล 
(Sea surface) ได้ต่อยื่นตัดผ่ำนเข้ำไปในผืนแผ่นดิน พื้นผิวที่ครอบคุลมเชื่อมต่อกันทั้งพื้นผิวน้ ำทะเลและผืน
แผ่นดินนี้ เรียกว่ำ จีออยด์ โดยที่ทุก ๆ จุดบนพื้นผิวมีค่ำศักยภำพแรงโน้มถ่วงเท่ำกัน จีออยด์เป็นพื้นผิวที่ไม่
รำบเรียบ และไม่สะดวกส ำหรับกำรค ำนวณ ส่วนใหญ่ใช้เป็นพื้นผิวอ้ำงอิงส ำหรับงำนรังวัดชั้นสูง และงำนรังวัด
ทำงดำรำศำสตร์ 

3. สัณฐำนโลกรูปทรงรี (Ellipsoid) หมำยถึง รูปทรงรีซึ่งเกิดจำกกำรหมุนของวงรีรอบแกนสั้น เป็น
รูปทรงเรขำคณิตที่สำมำรถนิยำมได้โดยใช้แบบจ ำลองทำงคณิตศำสตร์ และใช้เป็นตัวแทนจีออยด์ในกำร
ค ำนวณค่ำต่ำง ๆ ทำงจีออเดซีหรือภูมิมำตรศำสตร์ (Geodesy) บำงครั้ง เรียกรูปทรงนี้ว่ำ สเฟียรอยด์ 
(Spheroid) 
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7. รูปทรงกลมและรูปทรงรี (Sphere and Ellipsoid) 
 สัณฐำนโลกรูปทรงเรขำคณิตที่ใช้ในงำนแผนที่ทั่ว ๆ ไป แบ่งออกเป็น 2 ประเภท คือ รูปทรงกลมและ
รูปทรงร ี(รูปที่ 2.3) สัณฐำนรูปทรงรีจะมีรูปร่ำงใกล้เคียงกับรูปร่ำงของโลกมำกกว่ำทรงกลม แต่กำรค ำนวณค่ำ
ต่ำง ๆ ในงำนแผนที่จะมีควำมยุ่งยำกมำกกว่ำ รูปทรงกลมมักจะใช้อ้ำงอิงกับงำนแผนที่ที่มีมำตรำส่วนเล็กกว่ำ 
1:5,000,000 เพรำะควำมแตกต่ำงระหว่ำงรูปทรงกลมและรูปทรงรีอ้ำงอิงของมำตรำส่วนระดับนี้ไม่มีผลต่อ
งำนแผนที่ (Kennedy & Kopp, 2000) 
 

 
 

รูปที่ 2.3 สัณฐำนโลกรูปทรงกลมและรูปทรงรี. จำก Understanding map projections (น. 4), 
โดย M. Kennedy, & S. Kopp, 2000, Redlands, CA: ESRI. 

  
รูปทรงกลม 3 มิติ เกิดจำกรูปวงกลม 2 มิติ (Circle)  และรูปทรงรี 3 มิติ เกิดจำกรูปวงรี 2 มิติ 

(Ellipse) รูปร่ำงของวงรีจะขึ้นอยู่กับค่ำรัศมี 2 ค่ำ คือ กึ่งแกนเอก (Major axis) และกึ่งแกนโท (Minor axis)
รูปทรงร ี3 มิติ เกิดจำกกำรหมุนของรูปวงรีรอบแกนโท (รูปที่ 2.4) 
 

 
 

รูปที่ 2.4 กึ่งแกนเอกและกึ่งแกนโทของรูปวงรี 
 

 ตัวแปรที่มีผลต่อขนำดและรูปร่ำงของรูปทรงร ีคือ 1) กึ่งแกนเอก (a)  2) กึ่งแกนโท (b)  3) อัตรำส่วน
ยุบ (อัตรำส่วนยุบ หรือ f ค ำนวณจำก  f = [a – b]/a  ค่ำ f มีค่ำระหว่ำง 0 ถึง 1 รูปทรงกลมมีค่ำ f เท่ำกับ 0 
โดยปกติ นิยมแสดงค่ำอัตรำส่วนยุบในรูป 1/f)   4) ควำมเยื้องศูนย์กลำง (ควำมเยื้องศูนย์กลำง หรือ e 
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ค ำนวณจำก  e2 = [a2 – b2]/a2 ) ทั้งนี้ กำรก ำหนดรูปร่ำงและขนำดของรูปทรงรีต้องใช้ตัวแปร 2 ตัว 
ยกตัวอย่ำงเช่น รูปทรงร ีEverest 1830 มีค่ำ a = 6,377,276.345 เมตร และค่ำ 1/f = 300.801 เป็นต้น 
 ในระบบพิกัดของแผนที่จะมีกำรอ้ำงอิงรูปทรงรี และค่ำพิกัดของสิ่งต่ำง ๆ บนพื้นผิวโลกที่แสดงบน
แผนที่จะมีควำมสัมพันธ์กับรูปทรงรี ดังนั้น วัตถุเดียวกันบนพื้นผิวโลกอำจจะมีค่ำพิกัดแตกต่ำงกัน เมื่อใช้
รูปทรงรีในกำรจัดท ำแผนที่ที่แตกต่ำงกัน 

8. มูลฐาน (Datum) 
 มูลฐำนหรือพื้นหลักฐำน (Datum) เป็นชุดของค่ำตัวแปรที่แสดงควำมสัมพันธ์ระหว่ำงต ำแหน่งและทิศ
ทำงกำรจัดวำงรูปทรงรีอ้ำงอิง (Reference ellipsoid) กับจุดศูนย์กลำงของโลก และใช้เป็นระบบพิกัดอ้ำงอิง
บนแผนที่ 
 มูลฐำนที่ก ำหนดให้พื้นผิวของรูปทรงรีจัดเรียงอยู่ในแนวเดียวกับพื้นผิวโลกบริเวณใดบริเวณหนึ่ง และ
โยงยึดจุดบนพื้นผิวของรูปทรงรีเข้ำกับจุดบนพื้นผิวโลก เรียกว่ำ มูลฐำนท้องถิ่น (Local datum) จุดโยงยืดเป็น
จุดที่ทรำบค่ำพิกัดและถือเป็นจุดก ำเนิดของมูลฐำน โดยที่ค่ำพิกัดของจุดอื่น ๆ จะค ำนวณมำจำกจุดก ำเนิดน้ี 
เนื่องจำกมูลฐำนท้องถิ่นได้รับกำรออกแบบให้มีควำมเหมำะสมกับกำรใช้งำนเฉพำะพื้นที่ จึงไม่เหมำะที่จะ
น ำไปใช้ในพื้นที่อื่น ๆ ตัวอย่ำงของมูลฐำนประเภทนี้ ได้แก่ Indian 1975 ที่อ้ำงอิงรูปทรงรี Everest 1830 
และมีจุดก ำเนิดอยู่ที่เขำสะแกกรัง มูลฐำน Indian 1975 เป็นมูลฐำนที่ส ำคัญเพรำะใช้เป็นมูลฐำนอ้ำงอิงทำง
รำบในกำรจัดท ำแผนที่ภูมิประเทศ L7017 ของประเทศไทย 

มูลฐำนที่มีจุดก ำเนิดอยู่ที่จุดศูนย์กลำงมวลของโลก (Earth’s center of mass) และมีพื้นผิวของ
รูปทรงรีที่ใกล้เคียงกับพ้ืนผิวโลกโดยเฉลี่ย เรียกว่ำ มูลฐำนศูนย์โลก (Best earth-fitting, geocentric datum) 
(รูปที่ 2.5) ตัวอย่ำงของมูลฐำนประเภทนี้ ได้แก่ WGS 1984 (World Geodetic System: WGS) ที่อ้ำงอิง
รูปทรงรี WGS 1984 และมีจุดก ำเนิดอยู่จุดศูนย์กลำงมวลของโลก มูลฐำน WGS 84 เป็นมูลฐำนสำกลที่ได้รับ
ควำมนิยมอย่ำงแพร่หลำยไปทั่วโลก และเป็นมูลฐำนเดียวกับที่ใช้ในระบบก ำหนดต ำแหน่งบนโลกหรือจีพีเอส 
ประเทศไทยได้จัดท ำแผนที่ภูมิประเทศ L7018 โดยใช้ WGS 1984 เป็นมูลฐำนอ้ำงอิงทำงรำบ  
 

 
รูปที่ 2.5 ควำมแตกต่ำงระว่ำงมูลฐำนศูนยโ์ลกและมูลฐำนท้องถิ่น 
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9. ระบบพิกัดภูมิศาสตร์ (Geographic Coordinate System: GCS) 
ระบบพิกัดภูมิศำสตร์เป็นระบบพิกัดแบบ 3 มิติ ที่อ้ำงอิงต ำแหน่งของสิ่งต่ำง ๆ บนพื้นผิวโลกโดย

อำศัยค่ำจ ำนวน 2 ค่ำ คือ ละติจูด (Latitude) และลองจิจูด (Longitude) โดยละติจูดเป็นค่ำมุม นิยมใช้หน่วย
เป็นองศำที่วัดจำกเส้นศูนย์สูตร (Equator) ไปทำงเหนือหรือทำงใต้ ซึ่งมีค่ำอยู่ระหว่ำง 0 ถึง +90 องศำ 
ส ำหรับซีกโลกเหนือ และ 0 ถึง -90 องศำ ส ำหรับซีกโลกใต้ (รูปที่ 2.6)  

 

  
 

รูปที่ 2.6 เส้นละติจูด 
 

ลองจิจูดเป็นค่ำมุม ที่วัดจำกเส้นเมริเดียนแรก (Prime Meridian) ไปทำงตะวันออกหรือทำงตะวันตก 
โดยมีค่ำอยู่ระหว่ำง 0 ถึง +180 องศำ ส ำหรับซีกโลกตะวันออก และ 0 ถึง -180 องศำ ส ำหรับซีกโลก
ตะวันตก (รูปที่ 2.7) 
 

  
 

รูปที่ 2.7 เส้นลองจิจูด 
 

 กำรบอกต ำแหน่งพิกัดของสิ่งใด ๆ ด้วยระบบพิกัดภูมิศำสตร์ จะต้องระบุค่ำละติจูด และลองจิจูด
ควบคูกั่น (รูปที่ 2.8) นิยมแสดงค่ำพิกัดใน 2 รูปแบบ คือ 

 องศำ ลิปดำ และพิลิปดำ (Degree Minute Second: DMS ) ตัวอย่ำงเช่น ต ำบล ก ตั้งอยู่ที่ 
ละติจูด 5 องศำ 15 ลิปดำ 15 พิลิปดำ เหนือ และลองจิจูด 100 องศำ 30 ลิปดำ 30 พิลิปดำ ตะวันออก เมื่อ
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แสดงแบบองศำ ลิปดำ และพิลิปดำ จะแสดงได้เป็น ละติจูด 5° 15' 15" เหนือ และลองจิจูด 100° 30' 30" 
ตะวันออก  

 องศำทศนิยม (Decimal Degree: DD) ณ ต ำแหน่งเดียวกัน สำมำรถแสดงแบบองศำทศนิยม ได้
เป็น ละติจูด 5.25417° เหนือ และลองจิจูด 100.50833° ตะวันออก (ในกำรแปลงค่ำละติจูดและลองจิจูดจำก
รูปแบบ DMS ไปเป็น DD ค ำนวณได้จำกสูตร DD = D + [M/60] + [S/3600]) ทั้งนี้ ซอฟต์แวร์ด้ำน
เทคโนโลยีภูมิสำรสนเทศส่วนใหญ่มักจะนิยมประมวลผลข้อมูลเชิงต ำแหน่งที่อยู่ในระบบพิกัดภูมิศำสตร์ด้วย
องศำทศนิยม 

 
 

รูปที่ 2.8 กำรบอกต ำแหน่งด้วยระบบพิกัดภูมิศำสตร.์ จำก Understanding map projections (น. 2), 
โดย M. Kennedy, & S. Kopp, 2000, Redlands, CA: ESRI. 

 
เส้นละติจูดและลองจิจูดใช้มูลฐำน (ควำมสัมพันธ์ระหว่ำงต ำแหน่งและทิศทำงกำรจัดวำงรูปทรงรี

อ้ำงอิงกับจุดศูนย์กลำงของโลก) เป็นกรอบอ้ำงอิงในกำรระบุต ำแหน่งของสิ่งต่ำง ๆ บนพื้นผิวโลก ดังนั้น เมื่อ
มูลฐำนเปลี่ยนแปลงไป ค่ำละติจูดและลองจิจูดที่เป็นค่ำพิกัดของสิ่งนั้น ๆ จะเปลี่ยนแปลงตำมไปด้วย เช่น 
หมุดหลักฐำนทำงรำบ ณ บริเวณคณะสิ่งแวดล้อม (EN01) เมื่ออ้ำงอ้ำงอิง WGS 84 จะมีค่ำละติจูด 13 องศำ 
47 ลิปดำ 43.13617 พิลิปดำ เหนือ และค่ำลองจิจูด 100 องศำ 19 ลิปดำ 22.20799 พิลิปดำ ตะวันออก แต่
เมื่ออ้ำงอิงกับ Indian 1975 มีค่ำละติจูด 13 องศำ 47 ลิปดำ 37.16392 พิลิปดำ เหนือ และค่ำลองจิจูด 100 
องศำ 19 ลิปดำ 33.94282 พิลิปดำ ตะวันออก เป็นต้น 

10. เส้นโครง (Graticule) 
เส้นโครงประกอบด้วยเส้นสมมุติที่ลำกเชื่อมต ำแหน่งต่ำง ๆ บนพื้นผิวโลกที่มีค่ำละติจูดเดียวกันในแนว

ตะวันออก-ตะวันตก โดยที่เส้นจะบรรจบเป็นวงกลม และขนำนกับเส้นศูนย์สูตร ซึ่งเรียกว่ำ วงกลมละติจูด 
(Circle of latitude) หรือเส้นขนำน (Parallel) ส ำหรับเส้นสมมุติที่ลำกเชื่อมต ำแหน่งต่ำง ๆ บนพื้นผิวโลกที่มี
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ค่ำลองจิจูดเดียวกันในแนวเหนือ-ใต้ จำกขั้วโลกเหนือไปยังขั้วโลกใต้ เรียกว่ำ เส้นเมริเดียน (Meridian หรือ 
Line of longitude) 
 เส้นขนำนและเส้นเมริเดียนที่ลำกตัดกันเป็นโครงข่ำยคล้ำยกับใยแมงมุมนี้ เรียกว่ำ เส้นโครง 
(Graticule) (รูปที่ 2.9) และอำจจะแสดงบนแผนที่ เพื่อใช้ในกำรอ้ำงอิงทำงต ำแหน่ง ทั้งนี้ ลักษณะของเส้น
โครงที่ปรำกฏบนแผนที่จะแตกต่ำงกันไปโดยขึ้นอยู่กับวิธีกำรฉำยแผนที่  
 

 
 

รูปที่ 2.9 เส้นขนำน เส้นเมรเิดียน และเส้นโครง. จำก Understanding map projections (น. 2), 
โดย M. Kennedy, & S. Kopp, 2000, Redlands, CA: ESRI. 

11. การฉายแผนที่ (Map projection) 
กำรฉำยแผนที่ คือ วิธีแสดงหรือฉำยรำยละเอียดบนพื้นผิวของรูปทรงกลมหรือรูปทรงรี 3 มิติ ลงบน

แผนที่ที่แบนรำบ 2 มิติ โดยใช้หลักคณิตศำสตร์ 
เนื่องจำกโลกมีสัณฐำนเป็นรูปทรงกลมหรือทรงรี 3 มิติ แต่กำรท ำแผนที่จะต้องถ่ำยทอดรำยละเอียด

ของสิ่งต่ำง ๆ ที่ปรำกฏบนพื้นผิวโค้งของโลกไปสู่แผนที่ซึ่งมีพื้นผิวแบนรำบ 2 มิติ จึงมีควำมคลำดเคลื่อน 
(Error) หรือกำรบิดเบี้ยว (Distortion) เกิดขึ้น เปรียบเทียบได้กับควำมพยำยำมในกำรคลี่ผิวของเปลือกส้มซึ่ง
เป็นผิวโค้งออกให้แบนรำบ ย่อมต้องมีรอยย่นหรือฉีกขำดของเปลือกส้มเสมอ ดังนั้น จึงกล่ำวได้ว่ำ แผนที่ทุก
ฉบับล้วนมีควำมคลำดเคลื่อน และไม่สำมำรถผลิตแผนที่ให้รำยละเอียดทุก ๆ ส่วนบนแผนที่มีควำมถูกต้อง
เหมือนกับพื้นผิวโลกจริง กำรบิดเบี้ยวอำจท ำให้เกิดควำมคลำดเคลื่อนของระยะ มุม ทิศทำง รูปร่ำง หรือพื้นที่ 
ทั้งนี้ กำรบิดเบี้ยวนี้ไม่สำมำรถขจัดออกได้อย่ำงสมบูรณ์ อย่ำงไรก็ตำม กำรน ำหลักกำรฉำยแผนที่มำใช้ในกำร
ออกแบบและจัดท ำแผนที่ จะท ำให้สำมำรถผลิตแผนที่ที่มีคุณสมบัติของควำมบิดเบี้ยวต่ำง ๆ ลดน้อยลง และมี
ควำมเหมำะสมต่อลักษณะกำรใช้งำนของผู้ใช้ได้ 

เพื่อให้เกิดควำมเข้ำใจเกี่ยวกับกำรฉำยหรือถ่ำยทอดรำยละเอียดจำกพื้นผิว 3 มิติ ไปสู่พื้นรำบ 2 มิติ 
สมมุติให้มีลูกโลกจ ำลองที่ท ำจำกแก้วหรือวัสดุโปร่งแสง และบนพื้นผิวของลูกโลกมีเส้นโครง (Graticule) ซึ่ง
ประกอบด้วยเส้นขนำนและเส้นเมริเดียน เมื่อน ำเอำแผ่นกระดำษพันรอบลูกโลกและให้แสงสว่ำงจำกหลอดไฟ
ฉำยทอดเงำของเส้นโครงจำกพื้นผิวลูกโลกไปยังแผ่นกระดำษ จำกนั้นคลี่แผ่นกระดำษออกให้แบนรำบ จะได้
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เส้นโครงบนแผ่นกระดำษ อย่ำงไรก็ตำม เส้นโครงบนแผ่นกระดำษจะมีลักษณะแตกต่ำงจำกเส้นโครงที่ปรำกฏ
อยู่บนลูกโลก (รูปที่ 2.10) 

 
 

รูปที่ 2.10 กำรฉำยเส้นโครงแผนที่. จำก Understanding map projections (น. 11), 
โดย M. Kennedy, & S. Kopp, 2000, Redlands, CA: ESRI. 

 

ควำมแตกต่ำงของลักษณะของเส้นโครงบนลูกโลกจ ำลองกับเส้นโครงที่ปรำกฏบนแผ่นกระดำษ แสดง
กำรบิดเบี้ยวของกำรฉำย ที่เกิดจำกต ำแหน่งของแหล่งก ำเนิดแสง ลักษณะกำรฉำยแสง และลักษณะของพื้นผิว
ที่ใช้ในกำรฉำย (Projection surface) 

เนื่องจำกมีกำรออกแบบและพัฒนำกำรฉำยแผนที่ชนิดต่ำง ๆ ขึ้นมำกมำย บำงชนิดเหมำะกับกำรใช้
งำนในพื้นที่ขนำดเล็ก แต่บำงชนิดจะเหมำะกับพื้นที่ขนำดใหญ่ เช่น ระดับภูมิภำค หรือระดับโลก เป็นต้น ด้วย
เหตุนี ้กำรจ ำแนกประเภทกำรฉำยแผนที่ออกเป็นหมวดหมู่จะช่วยให้เข้ำใจและจดจ ำลักษณะของกำรฉำยแผน
ที่แต่ละชนิดได้ดียิ่งขึ้น ในที่นี้จะกล่ำวถึงเฉพำะประเภทกำรฉำยแผนที่ ที่จ ำแนกตำมลักษณะพื้นผิวของกำรฉำย
หรือถ่ำยทอดรำยละเอียดเท่ำนั้น โดยสำมำรถแบ่งออกเป็น 3 ประเภท คือ พื้นผิวของทรงกรวย (Cone) พื้นผิว
ของทรงกระบอก (Cylinder) และพื้นผิวรำบ (Plane) แต่ละประเภทมีรำยละเอียด ดังนี ้

 กำรฉำยแผนที่ทรงกรวย (Conic map projection)  เป็นกำรฉำยแผนที่ที่ถ่ำยทอดรำยละเอียดลง
บนพื้นผิวทรงกรวย แนวที่ผิวทรงกรวยสัมผัส (Tangent) กับพื้นผิวของลูกโลก เรียกว่ำ เส้นขนำนมำตรฐำน 
(Standard parallel) ในกำรฉำยลักษณะนี้ เมื่อผ่ำทรงกรวยตำมแนวเส้นเมริเดียนออกและคลี่ให้แบนรำบ จะ
ท ำให้เส้นเมริเดียนมีลักษณะลู่เข้ำไปทำงยอดหรือปลำยของทรงกรวย และมีเส้นขนำนแผ่ออกเป็นวงรัศมีจำก
ยอดหรือปลำยของทรงกรวย เส้นเมริเดียนที่อยู่ตรงกันข้ำมกับแนวกำรผ่ำของทรงกรวย เรียกว่ำ เส้นเมริเดียน
กลำง (Central meridian) (รูปที่ 2.11) 
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รูปที่ 2.11 เสน้ขนำนมำตรฐำน และเส้นเมริเดียนกลำงของกำรฉำยแผนที่ทรงกรวย. จำก Understanding 
map projections (น. 14), โดย M. Kennedy, & S. Kopp, 2000, Redlands, CA: ESRI. 

 
โดยปกติแล้ว กำรบิดเบี้ยวจะแปรผันตำมระยะห่ำงจำกเส้นขนำนมำตรฐำน กล่ำวคือ เมื่อพื้นที่จำก

กำรฉำยมีระยะทำงห่ำงออกจำกเส้นขนำนมำตรฐำนมำกขึ้น จะมีกำรบิดเบี้ยวจำกกำรฉำยเพิ่มมำกขึ้น ดังนั้น 
กำรฉำยแผนที่ด้วยวิธีข้ำงต้น จึงเหมำะกับกำรท ำแผนที่บริเวณละติจูดกลำง (23 – 66 องศำ) ที่มีทิศทำงกำร
วำงตัวอยู่ในแนวตะวันออก-ตะวันตก และไม่เหมำะกับบริเวณขั้วโลก เพรำะมีกำรบิดเบี้ยวที่เกิดจำกกำรฉำย
มำกที่สุด  

ในกรณีที่กำรฉำยแผนที่มีพื้นผิวของทรงกรวยตัดผ่ำน (Secant) กับพื้นผิวของลูกโลก จะเรียกว่ำ 
กำรฉำยแผนที่ทรงกรวยตัด (Secant conic map projection) ซึ่งเป็นกำรฉำยแผนที่ที่มีเส้นขนำนมำตรฐำน 
จ ำนวน 2 เส้น (รูปที่ 2.12) ส ำหรับกำรฉำยแผนที่ที่แกนของทรงกรวยเอียงออกจำกแกนหมุนของโลก จะ
เรียกว่ำ กำรฉำยแผนที่ทรงกรวยเฉียง (Oblique conic map projection) (รูปที่ 2.13) 
 

 
 

รูปที่ 2.12 กำรฉำยแผนที่ทรงกรวยตัด. จำก Understanding map projections (น. 14), โดย              
M. Kennedy, & S. Kopp, 2000, Redlands, CA: ESRI. 
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รูปที่ 2.13 กำรฉำยแผนที่ทรงกรวยกับทรงกรวยตัด. จำก Map projections: From spherical earth to 
flat map, โดย United States Geological Survey, 2013, ค้นเมื่อ 24 กันยำยน 2556, จำก 

http://www.nationalatlas.gov/articles/mapping/a_projections.html. 
  

ตัวอย่ำงของกำรฉำยแผนที่ประเภทนี้ ได้แก่ กำรฉำยแผนที่ทรงกรวยคงรูปแลมเบิร์ต (Lambert 
conformal conic map projection) ที่มีคุณลักษณะสำมำรถรักษำรูปร่ำงของพื้นที่ที่มีขนำดไม่ใหญ่มำกนัก
ได้อย่ำงถูกต้อง หรือกำรฉำยแผนที่ทรงกรวยคงพื้นที่อัลเบอร์ (Albers equal-area conic map projection) 
ซึ่งมีคุณลักษณะสำมำรถรักษำขนำดของพ้ืนที่ได้อย่ำงถูกต้อง 

 กำรฉำยแผนที่แบบทรงกระบอก (Cylindrical map projection) เป็นกำรฉำยแผนที่ที่ถ่ำยทอด
รำยละเอียดลงบนพื้นผิวทรงกระบอก พื้นผิวของทรงกระบอกสำมำรถสัมผัสหรือตัดผ่ำนลูกโลกได้ ตัวอย่ำงใน
กำรฉำยแผนที่ประเภทนี้ที่นิยมใช้กันอย่ำงแพร่หลำย ได้แก่ กำรฉำยแผนที่แบบเมอร์เคเตอร์ (Mercator map 
projection) ซึ่งมีแนวสัมผัสของพื้นผิวทรงกระบอกตำมแนวเส้นศูนย์สูตรเมื่อผ่ำทรงกระบอกตำมแนวเส้นเม
ริเดียนออกและคลี่ให้แบนรำบ เส้นเมริเดียนที่ปรำกฏบนพื้นผิวทรงกระบอกจะมีระยะห่ำงเท่ำ ๆ กัน ส่วน
ระยะห่ำงของเส้นขนำนจะเพิ่มมำกขึ้นเมื่อเข้ำใกล้บริเวณขั้วโลก (รูปที่ 2.14)  
 

 
 

รูปที่ 2.14 กำรฉำยแผนที่แบบทรงกระบอก และแนวสัมผัสหรือแนวตัดผำ่นของเส้นขนำนมำตรฐำน. 
จำก Map projections: From spherical earth to flat map, 

โดย United States Geological Survey, 2013, ค้นเมื่อ 24 กันยำยน 2556, จำก 
http://www.nationalatlas.gov/articles/mapping/a_projections.html. 
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เมื่อแกนของทรงกระบอกเอียงออกจำกแกนหมุนของโลกจะท ำให้แนวเส้นสัมผัสหรือแนวตัดผ่ำน
ระหว่ำงทรงกระบอกกับลูกโลกเปลี่ยนแปลงไป และท ำให้เกิดกำรฉำยแผนที่ที่มีคุณลักษณะแตกต่ำงไปจำกเดิม
เช่น เมื่อแกนของทรงกระบอกตั้งฉำกกับแกนหมุนของโลก จะเรียกกำรฉำยแผนที่ลักษณะนี้ว่ำ กำรฉำยแผนที่
แบบทรงกระบอกตำมขวำง (Transverse cylindrical projection)  ซึ่งมีแนวสัมผัสหรือแนวตัดผ่ำนอยู่ในแนว
เส้นเมริเดียน และมีเส้นขนำนมำตรฐำน (Standard parallel) วำงตัวในแนวเหนือ-ใต้ ในกรณีที่แกนของ
ทรงกระบอกเอียงออกไปในทิศทำงอื่น ๆ นอกเหนือจำกที่กล่ำวไว้แล้ว จะเรียกกำรฉำยแผนที่ประเภทนี้ว่ำ เส้น
โครงแผนที่แบบทรงกระบอกเฉียง (Oblique cylindrical map projection) (รูปที่ 2.15) 
 

 
 

รูปที่ 2.15 เสน้โครงแผนที่ทรงกระบอกตำมขวำง และเสน้โครงแผนที่ทรงกระบอกเฉียง. จำก Map 
projections: From spherical earth to flat map, โดย United States Geological Survey, 2013, ค้น
เมื่อ 24 กันยำยน 2556, จำก http://www.nationalatlas.gov/articles/mapping/a_projections.html. 

 
ในกำรถ่ำยทอดรำยละเอียดของกำรฉำยแผนที่แบบทรงกระบอก แนวเส้นสัมผัสและแนวตัดผ่ำน

จะมีคุณสมบัติคงระยะทำง และไม่มีกำรบิดเบี้ยวเกิดขึ้น แต่จะมีกำรบิดเบี้ยวเกิดขึ้นในบริเวณอื่น ๆ ที่ไม่อยู่ใน
แนวเส้นสัมผัสและแนวตัดผ่ำน 

 กำรฉำยแผนที่แบบระนำบ (Planar projection หรือ Azimuthal map projection หรือ 
Zenithal map projection) เป็นกำรฉำยแผนที่ที่ถ่ำยทอดรำยละเอียดลงบนพื้นระนำบที่สัมผัสหรือตัดผ่ำน
ลูกโลก (รูปที่ 2.16) 
 

MAHID
OL



บทที่ 2 แผนที่และระบบพิกัด  หน้า 69 

 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

 
 

รูปที่ 2.16 กำรฉำยแผนที่แบบระนำบ. จำก Map projections: From spherical earth to flat map, 
โดย United States Geological Survey, 2013, ค้นเมื่อ 24 กันยำยน 2556, จำก 

http://www.nationalatlas.gov/articles/mapping/a_projections.html. 
 

จุดสัมผัสระหว่ำงพื้นผิวระนำบกับลูกโลกสำมำรถก ำหนดได้โดยใช้ค่ำละติจูดและลองจิจูดกลำง 
(Central latitude and central longitude) ที่อำจจะก ำหนดให้อยู่ ณ ขั้วโลกเหนือ ขั้วโลกใต้ เส้นศูนย์สูตร 
หรือจุดใด ๆ (รูปที่ 2.17) 

 

 
 

รูปที่ 2.17 จุดสัมผัสระหว่ำงพื้นผิวระนำบกับลูกโลกของกำรฉำยแผนที่แบบระนำบ. จำก Understanding 
map projections (น. 17), โดย M. Kennedy, & S. Kopp, 2000, Redlands, CA: ESRI. 

 
นอกจำกจุดสัมผัสที่มีผลต่อกำรถ่ำยทอดรำยละเอียดแล้ว ลักษณะของมุมมองในกำรถ่ำยทอด

รำยละเอียด ก็จะมีผลต่อลักษณะของรำยละเอียดที่ปรำกฏบนแผนที่เช่นเดียวกัน เช่น กำรฉำยแผนที่แบบโน
มอน (Gnomonic map projection) ที่มีมุมมองจำกจุดศูนย์กลำงของลูกโลก หรือกำรฉำยแผนที่แบบสเตอริ
โอกรำฟ (Stereographic map projection) ที่มีมุมมองจำกขั้วโลก หรือกำรฉำยแผนที่แบบออร์โทกรำฟิก 
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(Orthographic map projection) ที่มีมุมมองจำกระยะอนันต์ จะถ่ำยทอดรำยละเอียดของเส้นขนำนออกมำ
ได้แตกต่ำงกัน (รูปที่ 2.18) 

 
 

รูปที่ 2.18 ลักษณะของมุมมองในกำรถ่ำยทอดรำยละเอียดของกำรฉำยแผนที่แบบระนำบ. จำก 
Understanding map projections (น. 18), โดย M. Kennedy, & S. Kopp, 2000, Redlands, CA: ESRI. 

 
ระบบพิกัดที่ได้จำกกำรฉำยหรือถ่ำยทอดรำยละเอียดในระบบพิกัดภูมิศำสตร์ 3 มิติ ลงบนระบบพิกัด

พื้นรำบ 2 มิติ เรียกว่ำ ระบบพิกัดจำกกำรฉำยแผนที่ (Projected Coordinate System) กำรบอกต ำแหน่ง
ของวัตถุหรือสถำนที่ต่ำง ๆ บนแผนที่โดยใช้ระบบพิกัดเส้นโครงแผนที่จะแสดงเป็นค่ำพิกัด X,Y ที่อ้ำงอิงกับจุด
ก ำเนิดของระบบพิกัด (รูปที่ 2.19) 

 

 
 

รูปที่ 2.19 กำรบอกต ำแหน่งของระบบพิกัดเส้นโครงแผนทีโ่ดยใช้ค่ำพิกัด X,Y 
 
 

MAHID
OL



บทที่ 2 แผนที่และระบบพิกัด  หน้า 71 

 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

12. ระบบพิกัด UTM (Universal Transverse Mercator: UTM) 
 ระบบพิกัดกริด UTM (Universal Transverse Mercator) เป็นระบบพิกัดแผนที่ที่เป็นระบบสำกล 
นิยมใช้กันอย่ำงแพร่หลำยทั่วโลกครอบคลุมพื้นที่ ละติจูด 84° เหนือ ถึง 80° ใต้ (ส ำหรับพื้นที่บริเวณขั้วโลกใช้
ระบบพิกัดกริด UPS (Universal Polar Stereographic grid) 

ระบบพิกัดกริด UTM ใช้กำรฉำยแผนที่แบบเมอร์เคเตอร์ตำมขวำง (Transverse Mercator map 
projection) (รูปที่ 2.20) เพื่อฉำยรำยละเอียดของสิ่งต่ำง ๆ บนพื้นผิวโลก ระบบพิกัด UTM เป็นระบบพิกัด
คำร์ทีเซียนแบบ 2 มิติ (2D Cartesian coordinate system) ประกอบด้วยเส้นตรง 2 ชุดในแนวเหนือ-ใต้ 
และแนวตะวันออก-ตะวันตก ตัดกันเป็นตำรำงจัตุรัส ค่ำพิกัดที่ใช้ในกำรบอกหรือก ำหนดต ำแหน่งพิกัดทำงรำบ 
มีหน่วยระยะทำงเป็นเมตร 

 

 
 

รูปที่ 2.20 เสน้โครงแผนที่แบบเมอร์เคเตอร์ตำมขวำงที่ใช้พื้นผิวทรงกระบอกตัดผ่ำนพื้นผิวโลก. จำก 
Geometric aspects of mapping, โดย R. Knippers, 2009, ค้นเมื่อ 24 กันยำยน 2556, จำก 

http://kartoweb.itc.nl/geometrics/Map%20projections/mappro.html. 
 

  ระบบพิกัดกริด UTM จะแบ่งพื้นผิวโลกที่อยู่ระหว่ำงละติจูด 84° องศำเหนือ ถึง 80° องศำใต้ 
ออกเป็น 60 เขต (Zone) ตำมแนวลองจิจูด แต่ละเขตมีควำมกว้ำง 6 องศำ โดยเริ่มแบ่งจำกลองจิจูดที่ 180° 
ตะวันตก ไปทำงตะวันออกทีละ 6° และแต่ละเขตจะมีเลขก ำกับเขต ดังนั้น เขตที่ 1 อยู่ระหว่ำงลองจิจูด 180° 
ถึง 174° ตะวันตก เขตที่ 2 อยู่ระหว่ำงลองจิจูด 174° ถึง 168° ตะวันตก และเขตที่ 60 จะอยู่ระหว่ำงลองจิจูด 
174° ถึง 180° ตะวันออก 

หลังจำกนั้นจะแบ่งพื้นผิวโลกตำมแนวละติจูดออกเป็น 60 แถบหรือส่วน (Band) แต่ละแถบมีขนำด 8 
องศำ และมีกำรก ำหนดอักษรประจ ำแถบ โดยเริ่มจำกอักษร C ที่ละติจูด 80° องศำใต้ ไปจนถึงอักษร X ที่
สิ้นสุดที่ละติจูด 84° องศำเหนือ ดังนั้น แถบของอักษร X จะครอบคลุมพื้นที่ตำมแนวละติจูดขนำด 12 องศำ 
(อักษร A, B, I, O, Y, และ Z จะไม่ใช้ในกำรก ำหนดอักษรประจ ำแถบ) ทั้งนี้ ในซีกโลกเหนือ อักษรประจ ำแถบ
จะเริ่มต้นด้วยอักษร N 
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ตัวเลขประจ ำเขตและอักษรประจ ำแถบจะใช้อ้ำงอิงถึงพื้นที่ต่ำง ๆ บนพื้นผิวโลกในรูปของกริด 
เรียกว่ำ เลขอักษรประจ ำเขตกริด (Grid zone designation) กำรอ้ำงอิงจะอ่ำนจำกตัวเลขประจ ำเขตและตำม
ด้วยอักษรประจ ำแถบ เช่น พื้นที่ที่อยู่ระหว่ำงลองจิจูด 162 – 168 องศำตะวันตก และระหว่ำงละติจูด 0 – 8 
องศำเหนือ จะมีเลขอักษรประจ ำเขตกริด คือ 3N เป็นต้น (รูปที่ 2.21) 

 

 
 

รูปที่ 2.21 กำรแบ่งเขตของระบบพิกัด UTM. จำก Geometric aspects of mapping, 
โดย R. Knippers, 2009, ค้นเมื่อ 24 กันยำยน 2556, จำก 

http://kartoweb.itc.nl/geometrics/Map%20projections/mappro.html. 
 
ในซอฟต์แวร์ด้ำนเทคโนโลยีภูมิสำรสนเทศ มักจะให้เลือกก ำหนดระบบพิกัด UTM ของพ้ืนที่ใด ๆ จำก

กำรระบุเลขประจ ำเขตและใช้อักษร N หรือ S (โดยที่อักษร N หมำยถึง ซีกโลกเหนือ และอักษร S หมำยถึง 
ซีกโลกใต้) เพื่อระบุว่ำพื้นที่นั้นอยู่ในซีกโลกเหนือหรือซีกโลกใต้ แทนกำรก ำกับด้วยอักษรประจ ำแถบ เช่น 47N 
หรือ 47S เป็นต้น ซึ่งซอฟต์แวร์จะสำมำรถเข้ำใจว่ำพื้นที่นั้นเป็นพื้นที่ใดในระบบพิกัด UTM อย่ำงไรก็ตำม กำร
อ้ำงอิงต ำแหน่งของกริดด้วยวิธีนี้ อำจท ำให้เกิดควำมสับสนได้ เช่น 47S อำจจะหมำยถึง พื้นที่บริเวณลองจิจูด 
96 – 102 องศำตะวันออก และละติจูด 32 – 40 องศำเหนือ ซึ่งอยู่ในซีกโลกเหนือ หรืออำจจะหมำยถึงพื้นที่
ในซีกโลกใต้บริเวณ ลองจิจูด 96 – 102 องศำตะวันออก  ดังนั้น กำรอ้ำงอิงเลขอักษรประจ ำเขตกริดควรจะ
ระบุให้ชัดเจนว่ำอ้ำงอิงด้วยวิธีใด 

ส ำหรับประเทศไทยซึ่งตั้งอยู่ระหว่ำงละติจูด 5° 37' ถึง 20° 27' เหนือ และลองจิจูด 97° 22' ถึง 105° 
37' ตะวันออก มีเลขอักษรประจ ำเขตกริด ได้แก่ 47N  47P  47Q  48N  48P และ 48Q (รูปที ่2.22) 

MAHID
OL



บทที่ 2 แผนที่และระบบพิกัด  หน้า 73 

 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

 
 

รูปที่ 2.22 เลขอักษรประจ ำเขตกริด ประเทศไทย 
 

กำรอ้ำงอิงต ำแหน่งของวัตถุใด ๆ ในระบบพิกัด UTM ต้องประกอบด้วยข้อมูลอย่ำงน้อย 2 ส่วน ได้แก่ 
1) เลขอักษรประจ ำเขตกริด เช่น 47P หรือตัวเลขประจ ำเขตที่ระบุว่ำพื้นที่อยู่ในซีกโลกเหนือหรือซีกโลกใต้ 
เช่น 47N (เป็นอักษร N ที่ระบุว่ำเป็นพื้นที่ในซีกโลกเหนือ) และ 2) ค่ำพิกัด X และ Y ซึ่งมีจุดก ำเนิดของค่ำ
พิกัดในแต่ละเขตที่เกิดจำกกำรตัดกันระหว่ำงเส้นเมริเดียนกลำง (Central meridian) (เส้นนี้จะอยู่กึ่งกลำงเขต 
และแบ่งเขตออกเป็น 2 ส่วน ส่วนละ 3 องศำ) กับเส้นศูนย์สูตร (รูปที่ 2.23) 

 

 

 
รูปที่ 2.23 จุดก ำเนิดของระบบพิกัด UTM ในแต่ละเขตกริด 
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อย่ำงไรก็ตำม กำรระบุค่ำพิกัดตำมจุดก ำเนิดดังกล่ำวจะท ำให้ค่ำพิกัดของวัตถุที่อยู่ทำงทิศตะวันตก
ของเส้นเมริเดียนกลำง และใต้เส้นศูนย์สูตร (ซีกโลกใต้) มีค่ำเป็นลบ ดังนั้น เพื่อให้กำรอ่ำนและค ำนวณค่ำพิกัด
มีควำมสะดวกมำกขึ้น จึงก ำหนดค่ำพิกัดของจุดตัดระหว่ำงเส้นเมริเดียนกลำงกับเส้นศูนย์สูตรในแต่ละเขตขึ้น
ใหม่ กล่ำวคือ แต่ละเขตในซีกโลกเหนือจะก ำหนดให้ค่ำพิกัด ณ จุดตัดมีค่ำ X หรือค่ำ Easting เท่ำกับ 
500,000 เมตร และมีค่ำ Y หรือค่ำ Northing เท่ำกับ 0 เมตร ส่วนซีกโลกใต้ ค่ำพิกัด ณ จุดตัดมีค่ำ X เท่ำกับ 
500,000 เมตร และมีค่ำ Y เท่ำกับ 10,000,000 เมตร ดังนั้น วัตถุใด ๆ ที่อยู่ทำงทิศตะวันตกของเส้นเมริเดียน
กลำงจะมีค่ำ X น้อยกว่ำ 500,000 เมตร และวัตถุใด ๆ ที่อยู่ทำงทิศตะวันออกของเส้นเมริเดียนกลำงจะมีค่ำ X 
มำกกว่ำ 500,000 เมตร ส ำหรับค่ำ Y ต ำแหน่งของวัตถุใด ๆ ที่อยู่ห่ำงจำกเส้นศูนย์สูตรไปยังขั้วโลกเหนือจะมี
ค่ำ Y มำกกว่ำ 0 แลมีค่ำเพิ่มมำกขึ้นเมื่อเข้ำใกล้ขั้วโลก ต ำแหน่งของวัตถุใด ๆ ที่อยู่ห่ำงจำกเส้นศูนย์สูตรไปยัง
ขั้วโลกใต้จะมีค่ำ Y ลดน้อยลงจำก 10,000,000 เมตร (รูปที่ 2.24)  

เพื่อให้ผู้อ่ำนเข้ำใจกำรบอกต ำแหน่งด้วยระบบพิกัด UTM จึงขอยกตัวอย่ำงกำรบอกต ำแหน่งของคณะ
สิ่งแวดล้อมและทรัพยำกรศำสตร์ มหำวิทยำลัยมหิดล ซึ่งมีค่ำละติจูดเท่ำกับ 13° 47' 43.13617" เหนือ และ
ค่ำลองจิจูดเท่ำกับ 100° 19' 22.20799" ตะวันออก ด้วยค่ำพิกัดระบบ UTM ซึ่งมีต ำแหน่งอยู่ในเขตกริด 47P 
มีค่ำพิกัด X (Easting) = 642990.907 เมตร และมีค่ำค่ำพิกัด Y (Northing) = 1525483.080 เมตร อ้ำงอิง
บนพื้นหลักฐำน WGS84 เป็นต้น 
 ส ำหรับกำรระบุค่ำพิกัดของต ำแหน่งที่หมำยที่อยู่บริเวณขอบของเขตกริด ซึ่งเป็นบริเวณที่มีกำรซ้อน
เหลื่อมกันระหว่ำงเขตกริด จะสำมำรถระบุค่ำพิกัดได้สองค่ำ จะใช้ค่ำพิกัดใดก็ได้ แต่จะต้องบอกเลขอักษร
ประจ ำเขตกริดให้ถูกต้อง ในแผนที่ภูมิประเทศไทย มำตรำส่วน 1:50,000 ชุด L7018 บริเวณลองจิจูด 102° 
ตะวันออก เป็นบริเวณที่มีกำรซ้อนเหลื่อมระหว่ำงเขตกริดที่ 47 กับ 48 ดังนั้น ขอบระวำงแผนที่จะพิมพ์ค่ำ
ก ำกับเส้นกริด 2 ค่ำ ด้วยตัวเลขสีด ำ และตัวเลขสีน้ ำเงิน เพื่อแสดงให้เห็นควำมแตกต่ำงระหว่ำงค่ำพิกัดของทั้ง
สองเขตกริด (รูปที่ 2.25) 
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รูปที่ 2.24 จุดก ำเนิดสมมุติของระบบพิกัด UTM ในแต่ละเขตของซีกโลกเหนือและซีกโลกใต ้
 

 
 

รูปที่ 2.25 ค่ำพิกัดของพ้ืนที่ที่มีกำรซ้อนเหลื่อมระหว่ำงเขตกริด 
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13. การแปลงระบบพิกัดของข้อมูลแผนที่ที่มีมูลฐานแตกต่างกัน (Datum transformation) 
 ในกำรประยุกต์ใช้ระบบสำรสนเทศภูมิศำสตร์กับงำนด้ำนต่ำง ๆ มักจะต้องมีกำรบูรณำกำรข้อมูลจำก
แหล่งข้อมูลต่ำง ๆ เช่น ข้อมูลแผนที่ ข้อมูลจำกภำพดำวเทียม หรือข้อมูลจำกจีพีเอส ซึ่งบ่อยครั้งชุดข้อมูลที่
เก็บรวบรวมมำนั้นมีระบบพิกัดที่อ้ำงอิงมูลฐำนต่ำงกัน เช่น แผนที่ภูมิประเทศ มำตรำส่วน 1:50,000 ที่จัดท ำ
ขึ้นโดยกรมแผนที่ทหำร ล ำดับชุด L7017 ใช้ระบบพิกัด UTM อ้ำงอิงกับมูลฐำน Indian 1975 ที่มี Everest 
1830 เป็นรูปทรงรีอ้ำงอิง ส่วนแผนที่ภูมิประเทศ ล ำดับชุด L7018 ซึ่งใช้ระบบพิกัด UTM เหมือนกัน แต่
อ้ำงอิงกับมูลฐำน WGS 1984 ที่มีรูปทรงรี WGS 1984 เป็นรูปทรงรีอ้ำงอิง และมีจุดก ำเนิดอยู่จุดศูนย์กลำง
มวลของโลก ส่งผลให้วัตถุหรือสิ่งต่ำง ๆ สิ่งเดียวกันมีค่ำพิกัดแตกต่ำงกัน เพรำะใช้มูลฐำนที่มีกำรอ้ำงอิงรูปทรง
รีแตกต่ำงกัน ถึงแม้ว่ำจะใช้ระบบพิกัดเดียวกัน ดังนั้น ในกำรประยุกต์ใช้ระบบสำรสนเทศภูมิศำสตร์ จึงมักจะ
ต้องมีกำรแปลงระบบพิกัดของข้อมูลที่มีมูลฐำนแตกต่ำงกันให้ตรงกัน 

กำรแปลงระบบพิกัดของข้อมูลที่มีมูลฐำนแตกต่ำงกัน สำมำรถท ำได้หลำยวิธี แต่ละวิธีจะมีระดับควำม
ถูกต้องแตกต่ำงกัน ตั้งแต่ระดับเซนติเมตรไปจนถึงระดับเมตร ควำมถูกต้องนี้จะขึ้นอยู่กับ 1) จ ำนวนและ
คุณภำพของจุดควบคุมที่ใช้ในกำรค ำนวณค่ำพำรำมิเตอร์ในกำรแปลง (Transformation parameters) และ 
2) สมกำรที่ใช้ในกำรแปลง กำรแปลงระบบพิกัดของข้อมูลที่มีมูลฐำนแตกต่ำงกัน มีขั้นตอนที่ส ำคัญ ดังน้ี 

1) กำรค ำนวณหำค่ำพำรำมิเตอรใ์นกำรแปลง 
 กำรค ำนวณหำค่ำพำรำมิเตอร์ในกำรแปลง เป็นกำรค ำนวณเพื่อหำค่ำสัมประสิทธิ์ของสมกำร

แปลง โดยอำศัยข้อมูลจุดควบคุม (Control point) หรือจุดร่วม (Common point) ซึ่งเป็นจุดที่ทรำบค่ำพิกัด
ของระบบพิกัดทั้งสองระบบ (Original datum และ Target datum) ที่มีมูลฐำนแตกต่ำงกัน จุดควบคุมควร
เป็นจุดที่มีควำมถูกต้องทำงต ำแหน่งสูงเพียงพอ มีกำรกระจำยตัวของจุดอย่ำงสม่ ำเสมอ และมีจ ำนวนมำกพอ 
เพื่อให้ผลลัพธ์ในกำรค ำนวณมีควำมถูกต้องน่ำเชื่อถือ กำรค ำนวณค่ำพำรำมิเตอร์จะใช้วิธีก ำลังสองน้อยสุด 
(Least square method) 

2) กำรแปลงค่ำพิกัด 
 กำรแปลงค่ำพิกัดจะใช้สมกำรทำงคณิตศำสตร์ที่แสดงควำมสัมพันธ์ระหว่ำงระบบพิกัดทั้งสอง

ระบบที่มีมูลฐำนแตกต่ำงกัน วิธีกำรแปลงค่ำพิกัดที่ส ำคัญมีดังน้ี 

 วิธีกำรแปลงแบบ 3 พำรำมิเตอร์ (Three-parameter methods) เป็นวิธีกำรที่ใช้สมกำร
แสดงควำมสัมพันธ์ของมูลฐำนทั้ง 2 ระบบในรูปของควำมแตกต่ำงของจุดก ำเนิดในแนวแกน X,Y,Z 
(DX,DY,DZ) ที่มีหน่วยเป็นเมตร ค่ำพำรำมิเตอร์น้ีจะใช้ในค ำนวณกำรเลื่อนขนำน (Translation) ของแกนทั้ง 
3 ของระบบพิกัด ซึ่งจะท ำให้จุดก ำเนิดของรูปทรงรีเลื่อนมำตรงกัน (รูปที่ 2.26) 
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รูปที่ 2.26 วิธีกำรแบบ 3 พำรำมิเตอร์. จำก Understanding map projections (น. 25), 

โดย M. Kennedy, & S. Kopp, 2000, Redlands, CA: ESRI. 
 

วิธีกำรแปลงแบบ 3 พำรำมิเตอร์ มีวิธีกำรค ำนวณง่ำยและไม่ซับซ้อน อย่ำงไรก็ตำม ควำม
แตกต่ำงของมูลฐำนอำจจะเกิดจำกขนำดและรูปร่ำงของรูปทรงรีที่แตกต่ำงกัน หรือทิศทำงกำรจัดวำงตัวของ
รูปทรงรีมีควำมแตกต่ำงกัน แต่วิธีกำรนี้ไม่ได้พิจำรณำปัจจัยเหล่ำนี้ จึงท ำให้ผลลัพธ์ของกำรแปลงมีควำม
ถูกต้องปำนกลำง วิธีกำรแปลงนี้เหมำะกับพื้นที่เล็ก ๆ ถ้ำพื้นที่ที่ต้องกำรแปลงมีขนำดใหญ่ ควำมถูกต้องของ
กำรแปลงจะลดลง  

 วิธีกำรแปลงแบบ 7 พำรำมิเตอร ์(Seven-parameter methods) เป็นวิธีกำรที่ใชส้มกำร
ในกำรค ำนวณที่มีค่ำพำรำมิเตอร ์จ ำนวน 7 ตัว ได้แก่ กำรเลื่อนขนำนตำมแนวแกน (DX,DY,DZ) จ ำนวน 3 ตัว 
มีหน่วยเป็นเมตร กำรหมุน (Rotation) ตำมแกน X,Y,Z (rx,ry,rz) จ ำนวน 3 ตัว มีหน่วยเป็นพิลิปดำ และกำร
ปรับขนำดมำตรำส่วน (Scale factor: s) ทีแ่สดงในรูปส่วนในล้ำนส่วน (parts per million: ppm) จ ำนวน 1 
ตัว (รูปที่ 2.27) 

กำรเลื่อนจะท ำให้จุดก ำเนิดของรูปทรงรีเลื่อนมำตรงกัน กำรหมุนท ำให้แกนของระบบ
พิกัดมำขนำนกัน และกำรปรับขนำดมำตรำส่วนจะท ำให้ขนำดของรูปทรงรีทั้งสองใกล้เคียงกัน อย่ำงไรก็ตำม 
เนื่องจำกค่ำพำรำมิเตอร์มีจ ำนวนมำกขึ้น จึงท ำให้สมกำรมีควำมซับซ้อน แต่จะมีควำมถูกต้องของกำรแปลง
มำกกว่ำวิธีกำรแปลงแบบ 3 พำรำมิเตอร ์

วิธีกำรแปลงแบบ 7 พำรำมิเตอร์ อำจจะเรียกว่ำเป็นวิธีกำรแปลงแบบ Bursa-Wolf หรือ
แบบ Helmert ที่ต้องใช้จุดควบคุมอย่ำงน้อย 3 จุดในกำรค ำนวณหำค่ำพำรำมิเตอร์ และจุดควบคุมต้องเป็น
จุดที่มีค่ำ X,Y,Z ถ้ำมีจ ำนวนจุดควบคุมมำกจะให้กำรค ำนวณหำค่ำพำรำมิเตอรก์ำรแปลงมีผลลัพธท์ี่ดขีึ้น  
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รูปที่ 2.27 วิธีกำรแบบ 7 พำรำมิเตอร์. จำก Understanding map projections (น. 25), 

โดย M. Kennedy, & S. Kopp, 2000, Redlands, CA: ESRI. 
 

 วิธีกำรแปลงแบบ Molodensky (Molodensky method) เป็นสมกำรแปลงที่ใช้
ค่ำพำรำมิเตอร ์จ ำนวน 5 ตัว ประกอบด้วยกำรเลื่อนขนำนตำมแนวแกน (DX,DY,DZ) ควำมแตกต่ำงของค่ำกึ่ง
แกนเอก (Da) และควำมแตกต่ำงของค่ำอัตรำส่วนยุบ (Df) ของรูปทรงรีอ้ำงอิงของระบบพิกัดทั้งสองระบบ 
วิธีกำรนี้ไม่ได้พิจำรณำควำมแตกต่ำงระหว่ำงขนำด รูปร่ำง และทิศทำงกำรจัดวำงตัวของรูปทรงรีอ้ำงอิง 

นอกจำกวิธีกำรแปลงแบบ Molodensky แบบปรกติ ยังมีกำรใช้สมกำรแบบย่อ 
(Abridged Molodensky method) ที่ลดควำมซับซ้อนของสมกำรลง และท ำให้กำรค ำนวณมีประสิทธิภำพ
มำกขึ้น 

 วิธีกำรแปลงแบบกริด (Grid-based methods) เป็นกำรแปลงค่ำพิกัดที่อำศัยข้อมูลควำม
แตกต่ำงระหว่ำงค่ำพิกัดของมูลฐำนทั้ง 2 ระบบ (Shift หรือ Offset) จำกจุดควบคุม และใช้สมกำรทำง
คณิตศำสตร์ (Surface-fitting) จ ำลองข้อมูลให้อยู่ในรูปของกริด (Grid of datum shift) เพื่อแปลงค่ำพิกัด
ด้วยวิธีกำรประมำณค่ำในช่วงแบบ Bilinear (Bilinear interpolation) 

กำรแปลงพิกัดด้วยวิธีนี้มีควำมถูกต้องสูง และไม่ต้องใช้ข้อมูลเกี่ยวกับจุดก ำเนิดของมูล
ฐำนหรือพำรำมิเตอร์ของรูปทรงรีในกำรแปลงพิกัด  เป็นวิธีที่นิยมใช้ในประเทศสหรัฐอเมริกำ ประเทศ
ออสเตรเลีย และประเทศแคนำดำ  

เนื่องจำกมีวิธีกำรแปลงค่ำพิกัดหลำยวิธี กำรเลือกใช้วิธีกำรใดจะขึ้นอยู่กับจ ำนวนจุดควบคุมที่ใช้ใน
กำรค ำนวณหำค่ำพำรำมิเตอร์ในกำรแปลง และระดับควำมถูกต้องของผลลัพธ์ที่ได้จำกกำรแปลง โดยทั่ว ๆ ไป 
วิธีกำรแปลงแบบ 3 พำรำมิเตอร์ จะมีควำมคลำดเคลื่อนอยู่ในระดับหลำยสิบเมตร แบบ 7 พำรำมิเตอร์ จะมี
ควำมคลำดเคลื่อนอยู่ในระดับ 5 - 10 เมตร และแบบกริด จะอยู่มีควำมคลำดเคลื่อนอยู่ในระดับต่ ำกว่ำ 50 
เซนติเมตร 
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1. โปรแกรม QGIS คืออะไร 
 โปรแกรม QGIS เป็นโปรแกรมระบบสารสนเทศภูมิศาสตร์รหัสเปิด (Open Source Geographic 
Information System) ที่อยู่ภายใต้ GNU General Public License และเป็นโครงการของ Open Source 
Geospatial Foundation (OSGeo) ที่สามารถท างานบนระบบปฏิบัติการ Linux, Unix, Mac OSX, 
Windows and Android และรองรับการท างานกับแฟ้มข้อมูลหลากหลายรูปแบบ และยังมีค าสั่งต่าง ๆ อีก
จ านวนมาก (Quantum GIS development team, 2011) 

2. การเปิด/ปดิโปรแกรมในระบบปฏิบัติการ Windows 

 การเปิดโปรแกรม QGIS สามารถท าได้ 3 วธิี คือ 
o คลิกเมนู Start > All Programs > Quantum GIS Wroclaw > Quantum GIS (1.7.3) 
o ดับเบิลคลิกไอคอน Quantum GIS (1.7.3) บนหน้า desktop 
o ดับเบิลคลิกแฟ้มโครงการ (QGIS project file) 

 การปิดโปรแกรม QGIS สามารท าได้ 3 วิธี คือ 
o คลิกเมนู File > Exit 
o กดปุ่ม Ctrl + Q บนแผงแป้นอักขระ 
o คลิกปุ่ม Close บริเวณมุมขวาบนของหน้าต่างโปรแกรม 

3. ส่วนต่อประสานกราฟิกกับผู้ใช ้(graphical user interface: GUI) 
 ส่วนต่อประสานกราฟิกกับผู้ใช้  เป็นส่วนที่โปรแกรมคอมพิวเตอร์ใช้ติดต่อโต้ตอบกับผู้ใช้ โดยใช้งาน
คอมพิวเตอร์ผ่านทางสัญลักษณ์หรือภาพ 

ส่วนต่อประสานกราฟิกกับผู้ใช้ เช่น สัญรูปหรือไอคอน (Icon) หน้าต่างการใช้งาน (Window) 
รายการเลือกหรือเมน ู(Menu) ปุ่ม (Button) เป็นต้น จะช่วยให้ผู้ใช้สามารถท างานได้สะดวก และรวดเร็วมาก
ขึ้น 

โปรแกรม QGIS มีสว่นต่อประสานกราฟิกกับผู้ใช้ที่ส าคัญดังนี ้(รูปที่ 3.1) 
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รูปที่ 3.1 ส่วนต่อประสานกราฟิกกับผู้ใช้ของโปรแกรม QGIS 
 

 แถบรายการเลือกหรือแถบเมนู (Menu Bar) 
แถบรายการเลือกหรือแถบเมนูเป็นแถบที่เก็บค าสั่งของโปรแกรม ผู้ใช้สามารถใช้งานค าสั่ง

ต่าง ๆ ของโปรแกรมโดยใช้เมาส์คลิกเลือกเมนูหลัก (Top-level menu) และ/หรือเมนูย่อย (ถ้ามี) และเลือก
รายการค าสั่งที่ต้องการ แถบเมนูหลักของโปรแกรม QGIS มีดังน้ี (รูปที่ 3.2 – 3.11) 

 
 
 
 
 
 
 
 

Map View 

Map Legend 

Map Overview 

Menu Bar Toolbar 

Status Bar 
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รูปที่ 3.2 เมนู File ของโปรแกรม QGIS รูปที่ 3.3 เมนู Edit ของโปรแกรม QGIS 
  

 
 

รูปที่ 3.4 เมนู View ของโปรแกรม QGIS รูปที่ 3.5 เมน ูLayer ของโปรแกรม QGIS 
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รูปที่ 3.6 เมนู Settings ของโปรแกรม QGIS รูปที่ 3.7 เมน ูLayer ของโปรแกรม QGIS 
  

  

รูปที่ 3.8 เมนู Raster ของโปรแกรม QGIS รูปที่ 3.9 เมน ูDatabase ของโปรแกรม QGIS 
  

 

 

รูปที่ 3.10 เมนู Vector ของโปรแกรม QGIS รูปที่ 3.11 เมน ูHelp ของโปรแกรม QGIS 
 

 แถบเครื่องมือ (Toolbar) 
แถบเครื่องมือ เป็นค าสั่งที่อยู่ในรูปของไอคอนหรือสัญรูป (Icon) ที่มีการรวบรวมชุดค าสั่งที่

เกี่ยวข้องกันเข้าเป็นแถบเครื่องมือ เมื่อน าเมาส์วางเหนือไอคอนค าสั่งบนแถบเครื่องมือ ก็จะปรากฏชื่อค าสั่ง
ของไอคอน แถบเครื่องมือหลักที่เป็นค่าเริ่มต้นของโปรแกรม (Default) ส่วนใหญ่เป็นค าสั่งที่ใช้งานบ่อย ๆ 
แถบเครื่องมือหลักของโปรแกรม QGIS มีดังน้ี (รูปที่ 3.12 – 3.20) 
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o แถบเครื่องมือ File 
 

 
 

รูปที่ 3.12 แถบเครื่องมือ File ของโปรแกรม QGIS 
 

สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
New Project สร้างโครงการ 

 
Open Project เปิดโครงการ 

 
Save Project บันทึกโครงการ 

 
Save Project As บันทึกเป็นโครงการใหม ่

 
New Print Composer สร้าง Print Composer 

 
Composer manager จัดการ Print Composer 

 
o แถบเครื่องมือ Manage Layers 

 

 
 

รูปที่ 3.13 แถบเครื่องมือ Manage Layers ของโปรแกรม QGIS 
 

สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Add Vector Layer เพิ่มช้ันข้อมูลเวกเตอร์ 

 
Add Raster Layer เพิ่มช้ันข้อมูลแรสเตอร ์

 
Add PostGIS Layer เพิ่มช้ันข้อมูล PostGIS 

 
Add SpatiaLite Layer เพิ่มช้ันข้อมูล SpatiaLite 

 
Add WMS Layer เพิ่มช้ันข้อมูล WMS 

 
New Shapefile Layer สร้างช้ันข้อมูล Shapefile 

 
Remove Layer(s) ลบชั้นข้อมูล Shapefile 

 
Gps Tools เปิดหน้าต่าง GPS Tools 
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สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Add Oracle GeoRaster Layer เพิ่มช้ันข้อมูล Oracle GeoRaster 

 
Add WFS Layer เพิ่มช้ันข้อมูล WFS 

 
o แถบเครื่องมือ Digitizing 

 

 
 

รูปที่ 3.14 แถบเครื่องมือ Digitizing ของโปรแกรม QGIS 
 

สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Toggle Editing เปิด/ปิดโหมดการแก้ไขข้อมลู 

 
Save edits บันทึกการแก้ไข 

 
Adding Features: Capture Point เพิ่มฟีเจอรจ์ุด 

 
Adding Features: Capture Line เพิ่มฟีเจอรเ์ส้น 

 
Adding Features: Capture Polygon เพิ่มฟีเจอรร์ูปหลายเหลี่ยม 

 
Move Feature(s) ย้ายฟีเจอร ์

 
Node Tool แก้ไขโหนด 

 
Delete Selected ลบฟีเจอร์ที่เลือก 

 
Cut Features ตัดฟีเจอร์ 

 
Copy Features ส าเนาฟีเจอร์ 

 
Paste Features วางฟีเจอร์ 

 
o แถบเครื่องมือ Advanced Digitizing 

 

 
 

รูปที่ 3.15 แถบเครื่องมือ Advanced Digitizing ของโปรแกรม QGIS 
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สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Undo ยกเลิกค าสั่งทีด่ าเนินการแล้ว 

 
Redo ท าซ้ าค าสั่งที่ด าเนินการแล้ว 

 
Simplify Feature ลดรายละเอียดข้อมูล 

 
Add Ring เพิ่ม Ring polygon (โดนัท) 

 
Add Part เพิ่มรูปหลายเหลี่ยมย่อยใน Multipolygon 

 
Delete Ring ลบ Ring polygon (โดนัท) 

 
Delete Part ลบรูปหลายเหลี่ยมย่อยใน Multipolygon 

 
Reshape Features แก้ไขรูปร่างของฟีเจอรช์นิดเส้นหรือรูปหลายเหลี่ยม 

 
Split Features ตัดฟีเจอร์ชนิดเส้นหรือรูปหลายเหลี่ยม 

 
Merge selected features ผสานรวมฟีเจอรท์ี่เลือก 

 
Merge attributes of selected features ผสานรวมข้อมลูลักษณะประจ าของฟีเจอร์ที่เลือก 

 
Rotate Point Symbols ปรับหมุนทิศทางของฟีเจอร์จุด 

 
o แถบเครื่องมือ Map Navigation 

 

 
 

รูปที่ 3.16 แถบเครื่องมือ Map Navigation ของโปรแกรม QGIS 
 

สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Pan Map เลื่อนแผนที ่

 
Zoom In ขยายแผนที ่

 
Zoom Out ย่อแผนที ่

 
Zoom to Native Pixel Resolution ขยายแผนที่โดยพิจารณารายละเอียดข้อมูลแรสเตอร ์

 
Zoom Full ขยายเต็มแผนที่ 

 
Zoom to Selection ขยาย/ย่อแผนที่ไปยังฟีเจอรท์ี่เลือก 

 
Zoom to Layer ขยาย/ย่อแผนที่ไปยังชั้นข้อมูลที่เลือก 
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สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Zoom Last ขยาย/ย่อแผนทีต่ามค าสั่งล่าสุด 

 
Zoom Next ขยาย/ย่อแผนที่ตามค าสั่งถัดไป 

 
Refresh ปรับการแสดงผลแผนทีใ่ห้ทันสมัย 

 
o แถบเครื่องมือ Attribute 

 

 
 

รูปที่ 3.17 แถบเครื่องมือ Attribute ของโปรแกรม QGIS 
 

สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Identify Features แสดงรายละเอียดข้อมูลลักษณะประจ า 

 
Select single feature ชุดเครื่องมือเลือกฟีเจอร์ 

 
Deselect features from all layers ยกเลิกการเลือกฟีเจอร์ 

 
Open Attribute Table เปิดตารางข้อมูลลักษณะประจ า 

 
Measure Line ชุดเครื่องมือวัดระยะทาง พื้นที่ และมุม 

 
Map Tips แสดงรายละเอียดข้อมูลลักษณะประจ าอัตโนมัต ิ

 
New Bookmark สร้าง Bookmark 

 
Show Bookmarks แสดงและจัดการ Bookmarks 

 
Text Annotation ชุดเครื่องมือสร้างและจัดการข้อความบนแผนที ่

 
o แถบเครื่องมือ Raster 

 

 
 

รูปที่ 3.18 แถบเครื่องมือ Raster ของโปรแกรม QGIS 
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สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Stretch histogram to full dataset ปรับความคมชัดข้อมูลภาพของชุดข้อมูลทั้งชุด 

 
Local Histogram Stretch ปรับความคมชัดข้อมูลภาพ 

 
o แถบเครื่องมือ Label 

 

 
 

รูปที่ 3.19 แถบเครื่องมือ Label ของโปรแกรม QGIS 
 

สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Labeling ก าหนดค่าการแสดงป้ายข้อมูล (Label) 

 
Move Label ย้ายป้ายข้อมูล 

 
Rotate Label ปรับหมุนป้ายข้อมูล 

 
Change Label เปลี่ยนป้ายข้อมูล 

 
o แถบเครื่องมือ GRASS 

 

 
 

รูปที่ 3.20 แถบเครื่องมือ GRASS ของโปรแกรม QGIS 
 

สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Open mapset เปิด Mapset 

 
New mapset สร้าง Mapset 

 
Close mapset ปิด Mapset 

 
Add GRASS vector layer เพิ่มช้ันข้อมูล GRASS vector 

 
Add GRASS raster layer เพิ่มช้ันข้อมูล GRASS raster 

 
Create new GRASS vector สร้างช้ันข้อมูล GRASS vector 
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สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Edit GRASS vector layer แก้ไขชั้นข้อมูล GRASS vector 

 
Open GRASS tools เปิดชุดเครื่องมือโปรแกรม GRASS 

 
Display current GRASS region แสดงขอบเขตทางต าแหน่งของชุดข้อมูล 

 
Edit current GRASS region แก้ไขขอบเขตทางต าแหน่งของชุดข้อมูล 

 

 พื้นที่แสดงค าอธิบายสัญลักษณ์ (Map Legend) 
พื้นที่แสดงค าอธิบายสัญลักษณ์ เป็นพื้นที่ที่ใช้แสดงชั้นข้อมูลของโครงงาน (Project) แต่ละ

ชั้นข้อมูลจะมีกล่องเลือก (Checkbox) ที่ใช้เปิด/ปิดการแสดงผลข้อมูล ชั้นข้อมูลแต่ละชั้นสามารถคลิกลาก
แล้วปล่อย (Drag-and-drop) เพื่อสลับล าดับการแสดงผลชั้นข้อมูลก่อนและหลังได้ (Z-Ordering) นอกจากนี้ 
ยังสามารถน าช้ันข้อมูลมาจัดเป็นกลุ่ม (Group) เพื่อให้มีการจัดการชั้นข้อมูลอย่างมีระบบ และช่วยให้การเปิด/
ปิดการแสดงผลชั้นข้อมูลต่าง ๆ ในกลุ่มมีความสะดวกและรวดเร็วมากขึ้น 

เมื่อต้องการเลือกชั้นข้อมูลมากกว่า 1 ชั้นข้อมูล สามารถท าได้โดยกดปุ่ม Ctrl ค้างไว้ ขณะที่
คลิกเลือกชั้นข้อมูลต่าง ๆ ที่ต้องการ ทั้งนี้ พื้นที่แสดงค าอธิบายสัญลักษณ์จะมีลักษณะการท างานคล้ายคลึงกับ
สารบัญข้อมูล (Table of Content: TOC) ของโปรแกรม ArcGIS Desktop 

 พื้นที่แสดงข้อมูลแผนที่ (Map View) 
พื้นที่แสดงข้อมูลแผนที่ เป็นพื้นที่ที่ใช้แสดงข้อมูลเชิงพื้นที่ (Spatial data) ทั้งข้อมูลเวกเตอร์

และแรสเตอร์การแสดงแผนที่ ผู้ใช้สามารถย่อ/ขยายแผนที่ หรือเลื่อนแผนที่ไปยังต าแหน่งที่สนใจ โดยใช้แถบ
เครื่องมือ Map Navigation 

 พื้นที่แสดงภาพรวมของแผนที่ (Map Overview) 
พื้นที่แสดงภาพรวมของแผนที่ เป็นการแสดงขอบเขต (Extent) ของชั้นข้อมูลแผนที่ทั้งหมด

แบบภาพรวม พร้อมกับกรอบสีแดงที่แสดงขอบเขตพื้นที่ที่แสดงผล ณ ปัจจุบัน (Current map extent) 
เพื่อให้ผู้ใช้ทราบพื้นที่แสดงผล ณ ปัจจุบัน และยังสามารถคลิกลากกรอบสีแดงไปยังต าแหน่งต่าง ๆ เพื่อ
เปลี่ยนหรือเลือกพื้นที่แสดงผลที่ต้องการได้อย่างสะดวกรวดเร็ว 

ผู้ใช้ต้องเพิ่มชั้นข้อมูลที่ต้องการไปยังพื้นที่แสดงภาพรวมของแผนที่ (ค าสั่ง Show in 
overview หรือ Add to Overview) เพื่อให้โปรแกรม QGIS สามารถค านวณขอบเขตของชั้นข้อมูลทั้งหมด 
ทั้งนี้ พื้นที่แสดงภาพรวมของแผนที่อาจจะมีมากกว่าหนึ่งช้ันข้อมูล 

 แถบสถานะ (Status Bar) 
แถบสถานะ เป็นแถบแสดงข้อมูลต่าง ๆ ได้แก่ ต าแหน่งพิกัดของเมาส์บนพื้นที่แสดงข้อมูล 

(Coordinate) ขอบเขตพื้นที่ที่แสดงผล ณ ปัจจุบัน (Extents) แถบแสดงความก้าวหน้าการท างาน (Progress 
bar) มาตราส่วนของแผนที่ (Scale) และระบบพิกัดของแผนที่ (Coordinate Reference System: CRS) 
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นอกจากนี้ ผู้ใช้ยังสามารถหยุดหรือยกเลิกการแสดงผลข้อมูลบนแผนที่ (ปุ่มไอคอน Stop map rendering 
และ Toggle map rendering) หรือเปลี่ยนระบบพิกัดของแผนที่ (ปุ่มไอคอน CRS status) ได้จากแถบ
สถานะ 

4. การสร้างหรือแก้ไขแป้นลัด (Keyboard shortcuts) 
 โปรแกรม QGIS ได้ก าหนดแป้นลัดเพื่อให้ผู้ใช้โปรแกรมสามารถเรียกใช้ค าสั่งได้ต่าง ๆ ได้สะดวก
รวดเร็วมากขึ้น เช่น การกดปุ่ม Ctrl + Shift + V บนแผงแป้นอักขระพร้อมกัน จะเป็นการเรียกใช้ค าสั่ง Add 
Vector Layer เป็นต้น ผู้ใช้สามารถสร้างหรือแก้ไขการใช้งานแป้นลัดกับค าสั่งต่าง ๆ ที่จ าเป็นต้องใช้งานบ่อย 
ๆ ได้ดังนี ้
 1) คลิกเมนู Settings 

2) เลือก Configure shortcuts… 
 
 

 
 

 3) ในหน้าต่าง Configure shortcuts เลือกรายการค าสั่งที่ต้องการสร้างหรือแก้ไขแปน้ลัด 
 4) คลิกปุ่ม Change จากนั้นปุ่ม Change จะเปลี่ยนเป็นปุ่ม Input 
 

1. คลิกเมนู Settings 

2. คลิก Configure shortcuts 
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 5) กดปุ่มที่ต้องการใช้เป็นแป้นลัดบนแผงแป้นอักขระ เช่น Ctrl+Alt+O เป็นต้น จากนั้นโปรแกรมจะ
สร้างค่าแป้นลัดให้กับรายการค าสั่ง เมื่อตั้งค่าเสร็จแล้ว คลิกปุ่ม Close 
 

ปุ่ม Change จะเปลี่ยนเปน็ปุ่ม Input 

3. คลิกรายการค าสั่ง 

4. คลิกปุ่ม Change 
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เมื่อต้องการยกเลิกค่าแป้นลัดให้คลิกปุ่ม Set none หรือถ้าต้องการก าหนดค่าแป้นลัดเป็นค่าเริ่มต้น
ของโปรแกรมให้คลิกปุ่ม Set default (None) (ในกรณีที่ต้องการบันทึกการตั้งค่าแป้นลัดทั้งหมดให้คลิกปุ่ม 
Save… และถ้าต้องการใช้งานการตั้งค่าแป้นลัดที่ได้มีการบันทึกไว้ให้คลิกปุ่ม Load…) 

5 การใช้ระบบช่วยเหลือ 
 โปรแกรม QGIS มีระบบช่วยเหลือที่แนะน าการใช้งานโปรแกรม ดังนี ้

 การใช้ระบบช่วยเหลือแบบคู่มือทั่วไป สามารถท าได้โดยการกดปุ่ม F1 บนแผงแป้นอักขระ หรือ
คลิกเมนู Help จากนั้นเลือก Help Contents โปรแกรม QGIS จะเชื่อมโยงไปยังเว็บเพจที่มีคู่มือการใช้งาน
โปรแกรมให้อัตโนมัติ ท าให้ผู้ใช้สามารถค้นหาและศึกษาขั้นตอนการใช้งานของโปรแกรมได้ทันที (ผู้ใช้ต้อง
เชื่อมต่ออินเทอร์เน็ต ขณะที่ใช้ระบบช่วยเหลือประเภทนี)้ 

 

 
 

5. กดปุ่มบนแผงแป้นอักขระ 
เพื่อระบุแป้นลัด 

6. คลิกปุ่ม Close 

คลิกเมนู Help และคลิก 
Help Contents MAHID
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 การใช้ระบบช่วยเหลือแบบค าอธิบายตามบริบท (Context help) สามารถคลิกปุ่ม Help ที่ปรากฏ
อยู่ในหน้าต่างค าสั่ง จากนั้นโปรแกรมจะแสดงหน้าต่างที่มีค าอธิบายเฉพาะเจาะจงตามบริบทของหนา้ต่างค าสั่ง  
 

 
 
 
 
 

 
 

6. การสร้าง บันทึก และเปิดโครงการ (Project file) 
 แฟ้มโครงการ (Project file) เป็นแฟ้มข้อมูลที่เก็บข้อมูลเกี่ยวกับรายละเอียดโครงการ และสถานะ
หรือสภาพการท างานของผู้ใช้ เช่น ชื่อโครงการ หน่วยของระบบพิกัด ชั้นข้อมูลและคุณสมบัติของชั้นข้อมูลที่
ก าลังใช้งานในโครงการ พื้นที่แสดงผลข้อมูลแผนที่ ณ ปัจจุบัน ตลอดจนการตั้งค่าต่าง ๆ ขณะท างาน ทั้งนี้ 
โปรแกรม QGIS จัดเก็บแฟ้มโครงการในรูปแบบ XML ที่มีนามสกุล *.qgs 
 
 

หน้าต่างแสดงค าอธบิายตามบริบท 

คลิกปุ่ม 
Help 
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 การสร้างแฟ้มโครงการ 
โดยปกติแล้ว การเปิดโปรแกรม QGIS เพื่อใช้งานจะเป็นการสร้างแฟ้มโครงการใหม่โดย

อัตโนมัติ อย่างไรก็ตาม ผู้ใช้สามารถสร้างแฟ้มโครงการหลังจากที่เปิดโปรแกรมได้ 3 วิธี คือ 
o การใช้เมนู โดยการคลิกเมนู File > New Project 
o การใช้แถบเครื่องมือ File โดยการคลิกปุ่ม New Project 
o การใช้แป้นลัด โดยการกดปุ่ม Ctrl + N 

 การบันทึกแฟม้โครงการ 
เมื่อผู้ใช้ท างานเสร็จสิ้นแล้ว หรือต้องการบันทึกการท างานในระหว่างที่ก าลังปฏิบัติงาน 

สามารถบันทึกแฟ้มโครงการได้ 3 วิธี คือ 
o การใช้เมนู โดยการคลิกเมนู File > Save Project 
o การใช้แถบเครื่องมือ File โดยการคลิกปุ่ม Save Project 
o การใช้แป้นลัด โดยการกดปุ่ม Ctrl + S 
ถ้าเป็นการบันทึกแฟ้มโครงการครั้งแรก โปรแกรมจะแสดงหน้าต่างเพื่อให้ผู้ใช้ระบุชื่อแฟ้ม

โครงการ และสถานที่จัดเก็บแฟ้มจากช่อง Look in เมื่อผู้ใช้ตั้งค่าเสร็จแล้ว ให้คลิกปุ่ม Save 
 
 
 

 
 
 
 

  ในกรณีที่ผู้ใช้ตอ้งการบันทึกแฟ้มโครงการที่มีอยู่ให้เป็นแฟม้โครงการใหม่ สามารถท าได ้3 วิธี 
คือ 

o การใช้เมนู โดยการคลิกเมนู File > Save Project As 
o การใช้แถบเครือ่งมือ File โดยการคลิกปุ่ม Save Project As 

1. เลือกสถานที่จัดเก็บแฟ้ม 

2. ระบุชื่อแฟ้มโครงการ 

3. คลิกปุ่ม Save เพื่อบันทึกแฟ้มโครงการ MAHID
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o การใช้แป้นลัด โดยการกดปุ่ม Ctrl + Shift + S 
 การเปิดแฟ้มโครงงาน 

ผู้ใช้สามารถเปดิแฟ้มโครงการที่มีอยู่เพ่ือด าเนินงานต่อได้ 3 วิธี คือ 
o การใช้เมนู โดยการคลิกเมนู File > Open Project 
o การใช้แถบเครือ่งมือ File โดยการคลิกปุ่ม Open Project 
o การใช้แป้นลัด โดยการกดปุ่ม Ctrl + O 
เมื่อใช้ค าสั่ง Open Project แล้ว โปรแกรมจะแสดงหน้าต่างเพื่อให้ผู้ใช้เลือกแฟ้มโครงการที่

ต้องการเปิด โดยการระบุสถานที่จัดเก็บแฟ้ม และเลือกชื่อแฟ้มโครงการ เมื่อผู้ใช้ระบุค่าเสร็จแล้ว ให้คลิกปุ่ม 
Open 

 
 

 
 
 
 

7. การเพิ่มชั้นข้อมูลเวกเตอร์ 
 โปรแกรม QGIS อาศัย OGR Lbrary ในการอ่านและเขียนข้อมูลเวกเตอร์ (รูปแบบแฟ้มข้อมูล
เวกเตอร์ที่ OGR Library รองรับสามารถตรวจสอบได้ที่ http://www.gdal.org/ogr/ogr_formats.html) 
 ในตัวอย่างนี้ จะสาธิตการเพิ่มชั้นข้อมูลรูปแบบ ESRI Shapefile ซึ่งมีวิธีการดังนี้ 

 1) คลิกปุ่ม Add Vector Layer (   ) หรือคลิกเมนู Layer > Add Vector Layer หรือใช้แป้น
ลัดโดยกด Ctrl + Shift + V 

1. เลือกสถานที่จัดเก็บแฟ้ม 

2. เลือกชื่อแฟ้มโครงการ 

3. คลิกปุ่ม Open เพื่อเปิดแฟ้มโครงการ 
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 2) ในหน้าต่าง Add Vector Layer คลิกปุ่ม Browse 
 3) ในหน้าต่าง Open an OGR Supported Vector Layer ให้เลือกสถานที่ที่จัดเก็บแฟ้มข้อมูล 
 4) เลือกแฟ้มข้อมูลจากช่อง Look in 
 5) คลิกปุ่ม Open 
 6) คลิกปุ่ม Open ในหน้าต่าง Add Vector Layer จากนั้นโปรแกรมจะแสดงข้อมูลในพื้นที่แสดง
ข้อมูลแผนที่ (Map View) 
 
 

 
 
 
 
 
 
 
 
 
 

1. คลิกปุ่ม Add Vector Layer 

2. คลิกปุ่ม Browse 

MAHID
OL



บทที่ 3 การใช้งานโปรแกรม QGIS เบื้องต้น  หน้า 96 
 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

 
 

 
 
 
 

 
 
 
 

3. เลือกสถานที่จัดเก็บแฟ้ม 

4. เลือกแฟ้มข้อมูล 

5. คลิกปุ่ม Open 

5. คลิกปุ่ม Open MAHID
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8. การเพิ่มชั้นข้อมูลแรสเตอร์ 
โปรแกรม QGIS อาศัย GDAL library ในการอ่านและเขียนข้อมูลเวกเตอร์ (รูปแบบแฟ้มข้อมูล

เวกเตอร์ที่ GDAL library รองรับสามารถตรวจสอบได้ที่ http://www.gdal.org/formats_list.html) 
 ในตัวอย่างนี้ จะสาธิตการเพ่ิมชั้นข้อมูลรูปแบบ Erdas Imagine (*.img) ซึ่งมีวิธีการดังนี้ 
 

1) คลิกปุ่ม Add Raster Layer (   ) หรือคลิกเมนู Layer > Add Raster Layer หรือใช้แป้น
ลัดโดยกด Ctrl + Shift + R 
 2) ในหน้าต่าง Open a GDAL Supported Raster Data Source ให้เลือกสถานที่ที่จัดเก็บ
แฟ้มข้อมูลจากช่อง Look in 
 3) คลิกเลือกแฟ้มข้อมูล 
 4) คลิกปุ่ม Open จากนั้นโปรแกรมจะแสดงข้อมูลในพื้นที่แสดงข้อมูลแผนที่ (Map View) 
 
 

ชั้นข้อมูลที่เพิม่จะแสดงใน
พื้นที่แสดงค าอธิบาย

สัญลักษณ์ (Map Legend) 

ข้อมูลเวกเตอร์ในพื้นที่แสดงข้อมูลแผนที ่(Map View) 
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1. คลิกปุ่ม Add Raster Layer 

2. เลือกสถานที่จัดเก็บแฟ้ม 

3. เลือกแฟ้มข้อมูล 

4. คลิกปุ่ม Open 

ชั้นข้อมลูที่เพิ่มจะแสดงในพื้นที่แสดงค าอธิบายสัญลักษณ์ 
(Map Legend) 

ข้อมูลแรสเตอร์ในพื้นที่แสดงข้อมูลแผนที ่(Map View) 
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9. การจัดล าดบัการแสดงชัน้ข้อมูล 
 การแสดงชั้นข้อมูลในแผนที่ของโปรแกรม QGIS จะแสดงเป็นล าดับชั้น ชั้นข้อมูลที่วางอยู่บนสุดใน
พื้นที่แสดงค าอธิบายสัญลักษณ์ (Map Legend) จะวางซ้อนทับชั้นข้อมูลที่อยู่ถัดลงไปด้านล่าง ด้วยเหตุนี้ เมื่อ
ผู้ใช้เพิ่มชั้นข้อมูลเพื่อแสดงในแผนที่มากกว่า 1 ชั้นข้อมูล อาจจะท าให้ชั้นข้อมูลที่วางอยู่ด้านบนบดบังการ
แสดงผลของชั้นข้อมูลด้านล่าง ยกตัวอย่างเช่น ชั้นข้อมูลขอบเขตอ าเภอที่เป็นข้อมูลประเภทรูปหลายเหลี่ยม
บดบังช้ันข้อมูลหมู่บ้านที่เป็นข้อมูลประเภทจุดที่วางอยู่ด้านล่าง 
 ผู้ใช้สามารถเปลี่ยนล าดับการแสดงช้ันข้อมูลได้ดังนี้ 
 1) คลิกชั้นข้อมูลที่ต้องการเปลี่ยนล าดับการแสดงผลค้างไว้ 
 2) เลื่อนเมาส์ (ขณะที่ยังคงคลิกเมาส์ค้างอยู่และเลื่อนเมาส์ ตัวชี้ต าแหน่งของเมาส์จะเปลี่ยนลูกศรขึ้น
ลง) ไปวาง ณ ต าแหน่งที่ต้องการแล้วปล่อย โปรแกรมจะปรับเปลี่ยนล าดับและจะแสดงผลชั้นข้อมูลในแผนที่
ตามส าดับที่ก าหนดไว ้ 

 
 

 
 

ชั้นข้อมูลขอบเขตอ าเภอวางอยู่
เหนือชั้นข้อมูลหมู่บ้าน 

 

ชั้นข้อมูลขอบเขตอ าเภอบดบังชั้นข้อมูลหมู่บ้าน 
 

1. คลิกชั้นข้อมูลค้างไว ้

2. ลากชั้นข้อมูลไปยัง
ต าแหน่งที่ต้องการแล้วปล่อย 

MAHID
OL



บทที่ 3 การใช้งานโปรแกรม QGIS เบื้องต้น  หน้า 100 
 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

 
 

10. การเปิด/ปิดการแสดงผลชั้นข้อมูล 
 เมื่อผู้ใช้แสดงผลชั้นข้อมูลทุก ๆ ชั้นในแผนที่ อาจจะท าให้การแสดงผลข้อมูลช้าลง ดังนั้น ถ้าผู้ใช้
ต้องการท างานบางอย่างที่เกี่ยวข้องกับชั้นข้อมูลเฉพาะบางชั้นข้อมูล ผู้ใช้สามารถปิดการแสดงชั้นข้อมูลอื่น ๆ 
ที่ไม่เกี่ยวข้องชั่วคราว และเปิดการแสดงผลข้อมูลอีกครั้ง เมื่อต้องการท างานกับชั้นข้อมูลนั้น การเปิด/ปิดการ
แสดงผลชั้นข้อมูล จะช่วยให้สามารถท างานกับชั้นข้อมูลบนแผนที่ได้ง่าย และการแสดงผลข้อมูลจะมีความ
รวดเร็วมากขึ้น 

เครื่องหมายกากบาทหน้ากล่องเลือก (Checkbox) บ่งบอกสถานะการเปิด/ปิดการแสดงผลชั้นข้อมูล 
ถ้ากล่องเลือกมีเครื่องหมายกากบาทหมายถึงมีการเปิดแสดงผลชั้นข้อมูล แต่ถ้ากล่องเลือกไม่มีเครื่องหมาย
กากบาทหมายถึงมีการปิดแสดงผลชั้นข้อมูล การคลิกที่กล่องเลือกจะเป็นการสลับการเปิด/ปิดการแสดงผลชั้น
ข้อมูล 

วิธีการเปิด/ปิดการแสดงผลชั้นข้อมูล สามารถท าได้โดยคลิกที่กล่องเลือก (Checkbox) บริเวณชั้น
ข้อมูล 

 

ชั้นข้อมูลหมู่บา้นวางอยู่เหนอืชั้น
ข้อมูลขอบเขตอ าเภอ 

 

ชั้นข้อมูลหมู่บา้นไม่ถูกบดบังจากชั้นข้อมลู 
ขอบเขตอ าเภอ  
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คลิกทีก่ล่องเลอืก (Checkbox) ขณะที่กล่องเลือกมี
เครื่องหมายกากบาทจะท าให้เครื่องหมายกากบาทหายไป 

และเปน็การปดิการแสดงผลชั้นข้อมลู) 

กล่องเลือกมีเครื่องหมายกากบาทหมายถงึ
มีการเปิดแสดงผลชั้นข้อมูล  

หลังจากคลิกที่กล่องเลือก 
เครื่องหมายกากบาทหายไป 

ชั้นข้อมูลไม่ปรากฏบนแผนที ่ 
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11. การลบชัน้ข้อมูล 
เนื่องจากการปฏิบัติงานในระบบสารสนเทศภูมิศาสตร์มักจะมีชั้นข้อมูลจ านวนมากในแผนที่ ซึ่งอาจจะ

เกิดจากการที่ผู้ใช้ต้องการส ารวจหรือศึกษาข้อมูลเบื้องต้น หรืออาจจะเกิดจากการประมวลผลหรือวิเคราะห์
ข้อมูลที่ได้ผลลัพธ์เป็นชั้นข้อมูลใหม่ ดังนั้น เมื่อไม่มีความจ าเป็นต้องใช้งานชั้นข้อมูล ผู้ใช้สามารถลบชั้นข้อมูล
ออกจากแผนที่ได้ 4 วิธี คือ 

 การใช้เมนู โดยการคลิกเลือกชั้นข้อมูลที่ต้องการลบ (การเลือกชั้นข้อมูลมากกว่า 1 ชั้นให้กดปุ่ม 
Ctrl หรือปุ่ม Shift) จากนั้นคลิกเมนู Layer > Remove Layer(s)  

 การใช้แถบเครื่องมือ Manage Layers โดยการคลิกเลือกชั้นข้อมูลที่ต้องการลบจากนั้นคลิกปุ่ม 

Remove Layer(s)  (   ) 
 

 
 

การใช้แป้นลัด โดยการคลิกเลือกช้ันข้อมูลที่ต้องการลบ จากนั้นกดปุ่ม Ctrl + D 

การใช้เมนูตามบริบท (Context menu) โดยการคลิกขวาที่ชั้นข้อมูลที่ต้องการลบ จากนั้นคลิก 
Remove 
 

 
 

1. คลิกเลือกชัน้ข้อมูลที่ต้องการลบ 

2. คลิกปุ่ม Remove Layer(s) 

คลิกขวาที่ชั้นข้อมูล จากนัน้คลิก Remove MAHID
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12. การแสดงรายละเอียดขอ้มูลลักษณะประจ า 
 การแสดงข้อมูลลักษณะประจ าของฟีเจอร์มีขั้นตอนดังนี้ 
 1) คลิกชั้นข้อมูลที่ต้องการดูข้อมูลลักษณะประจ า 

 2) คลิกปุ่ม Identify Features (  ) บนแถบเครื่องมือ Attribute 
 3) คลิกฟีเจอร์ที่ต้องการดูรายละเอียดข้อมูลลักษณะประจ า เมื่อคลิกแล้วโปรแกรมจะเน้นฟีเจอร์ที่ถูก
เลือกให้เด่น (Highlight) และจะแสดงข้อมูลลักษณะประจ าของฟีเจอร์ในหน้าต่าง Identify Results 
  

 
 

13. การแสดงตารางข้อมูลลักษณะประจ าของชั้นข้อมูล 
 การเปิดตารางข้อมูลลักษณะประจ าของช้ันข้อมูลมีวิธีการดังนี้ 
 1) คลิกชั้นข้อมูลที่ต้องการเปิดตารางข้อมูลลักษณะประจ า  

 2) คลิกปุ่ม Open Attribute Table (  ) บนแถบเครื่องมือ Attribute จากนั้นโปรแกรมจะเปิด
ตารางข้อมูลลักษณะประจ าของชั้นข้อมูลในหน้าต่าง Attribute table 
 

2. คลิกปุ่ม Identify Features 

3. คลิกฟเีจอร ์

1. คลิกชัน้ข้อมูล 

หน้าต่าง Identify Results แสดงข้อมูล
ลักษณะประจ าของฟีเจอร ์
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14. การเลือกและการยกเลกิการเลือกข้อมูล (Select and deselect features) 
 การเลือกข้อมูล คือ การเลือกข้อมูลบางส่วนจากข้อมูลทั้งหมด ยกตัวอย่างเช่น ประเทศไทยมี 77 
จังหวัด เมื่อจัดเก็บข้อมูลขอบเขตจังหวัดของประเทศไทยเป็นช้ันข้อมูลในระบบสารสนเทศภูมิศาสตร์ ชั้นข้อมูล
น้ีจะมีฟีเจอร์ทั้งหมด 77 ฟีเจอร์หรือ 77 จังหวัด สมมุติว่าผู้ใช้ต้องการทราบขนาดพื้นที่รวมของจังหวัดใน
ภาคใต้ ดังนั้น ผู้ใช้จ าเป็นต้องเลือก (Select) ฟีเจอร์จังหวัดในภาคใต้ จ านวน 14 จังหวัดจากจังหวัดทั้งหมด 
77 จังหวัด และน าข้อมูลฟีเจอร์ที่เลือกไดม้าค านวณหาขนาดพื้นที่ เป็นต้น 

ในระบบสารสนเทศภูมิศาสตร์สามารถแบ่งวิธีการเลือกข้อมูลได้ 2 ประเภท คือ 1) การเลือกโดยอาศัย
ข้อมูลเชิงพื้นที่ และ 2) การเลือกโดยอาศัยข้อมูลลักษณะประจ า นอกจากนี้ อาจจะมีการใช้รูปกราฟิกในการ
เลือกฟีเจอร์ด้วยมือ ซึ่งโปรแกรม QGIS มีชุดเครื่องมือเลือกฟีเจอร์ในแผนที่โดยใช้รูปกราฟิกบนแถบเครื่องมือ 
Attribute ประกอบด้วยเครื่องมือเลือกข้อมูลแบบต่าง ๆ ดังนี ้

 
 
 
 
 
 

1. คลิกชัน้ข้อมูล 2. คลิกปุ่ม Open Attribute Table 

หน้าต่างข้อมลูลักษณะประจ า 
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สัญรูป ชื่อค าสั่ง ค าอธิบาย 

 
Select single feature 

เลือกข้อมูลทลีะฟีเจอร ์(ผู้ใชต้้องคลิกเลือกฟีเจอร์ที่ต้องการ
เพียงครั้งเดียว) 

 
Select features by rectangle 

เลือกฟีเจอร์โดยใช้รูปสี่เหลี่ยมมุมฉาก (ผู้ใชต้้องคลิกและลาก
เพื่อวาดรูปสี่เหลี่ยมมมุฉากให้ครอบคลุมฟีเจอร์ที่ต้องการ
เลือก) 

 
Select features by polygon 

เลือกฟีเจอร์โดยใช้รูปหลายเหลี่ยม (ผู้ใช้ต้องคลิกเพื่อวาดรูป
หลายเหลี่ยมให้ครอบคลุมฟีเจอร์ที่ต้องการเลือก) 

 
Select features by freehand 

เลือกฟีเจอร์โดยใช้รูปวาดอิสระ (ผู้ใช้ต้องคลิกและลากเพื่อวาด
รูปกราฟิกให้ครอบคลุมฟีเจอร์ที่ต้องการเลือก)  

 
Select features by radius 

เลือกฟีเจอร์โดยใช้รูปวงกลม (ผู้ใช้ต้องคลิกและลากเพ่ือวาด
รูปวงกลมให้ครอบคลุมฟีเจอร์ที่ต้องการเลือก) 

 
เนื่องจากวิธีการเลือกข้อมูลด้วยเครื่องมือในกลุ่มนี้มีความคล้ายคลึงกัน แตกต่างกันเพียงวิธีการวาดรูป

กราฟิก และจ านวนฟีเจอร์ที่สามารถเลือกได้ ดังนั้น ในตัวอย่างนี้ จะสาธิตวิธีการเลือกข้อมูลโดยใช้เครื่องมือ 
Select single feature เพียงเท่านั้น ส าหรับเครื่องมืออื่น ๆ ผู้ใช้สามารถทดลองการใช้งานได้ด้วยตนเอง 

วิธีการเลือกข้อมูลด้วยเครื่องมือ Select single feature มีขั้นตอนดังนี ้
1) คลิกชั้นข้อมูลที่ต้องการเลือกฟีเจอร์  

2) คลิกปุ่ม Select single feature (   ) บนแถบเครื่องมือ Attribute 
3) คลิกเลือกฟีเจอร์ที่ต้องการ เมื่อคลิกแล้วโปรแกรมจะเน้นฟีเจอร์ที่ถูกเลือกให้เด่น (Highlight)  
 

 

1. คลิกชัน้ข้อมูล 

2. คลิกปุ่ม Select single feature 

3. คลิกเลือกฟีเจอร์ MAHID
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ภายหลังจากการเลือกฟีเจอร์แล้ว เมื่อผู้ใช้เปิดตารางข้อมูลลักษณะประจ าของชั้นข้อมูลนั้นจะพบว่า 
แถวของข้อมูลในตารางที่เป็นข้อมูลลักษณะประจ าของฟีเจอร์นั้นก็จะถูกเลือกไว้ เช่นเดียวกัน โดยแถวที่ถูก
เลือกจะเน้นให้เด่นด้วยแถบสีน้ าเงิน และที่บริเวณแถบชื่อของหน้าต่างตารางข้อมูลลักษณะประจ าจะแสดง
จ านวนฟีเจอร์ที่ถูกเลือกจากจ านวนฟีเจอร์ทั้งหมด 

 

 
 
ผู้ใช้สามารถน าข้อมูลฟีเจอร์ที่เลือกไว้ไปประมวลผลหรือวิเคราะห์ข้อมูลได้ทันที หรืออาจจะคัดลอก 

หรือบันทึกเป็นแฟ้มข้อมูลใหม่ เพื่อน าไปใช้ในการปฏิบัติงานขั้นตอนอื่น ๆ ต่อไป 
เมื่อต้องการยกเลิกการเลือกสามารถท าได้โดยการคลิกปุ่ม Deselect features from all layers       

(  ) จากแถบเครื่องมือ Attribute ผลลัพธ์คือ โปรแกรมจะยกเลิกการเลือกและการเน้นฟีเจอร์ที่ถูกเลือก  
 

แถวที่ถูกเลือกใน
ตารางข้อมูลลักษณะประจ า 

จ านวนฟีเจอรท์ี่ถูกเลือก 
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15. การสร้างและจัดการ Spatial bookmarks 
 Spatial bookmark คือ พื้นที่บริเวณใดบริเวณหนึ่งในแผนที่ที่ผู้ใช้บันทึกค่าพิกัดต าแหน่งไว้ ท าให้ผู้ใช้
สามารถแสดงพื้นที่บริเวณนั้นในแผนที่ได้ในภายหลัง คล้ายคลึงกับการใช้ที่คั่นหนังสือคั่นหน้าที่สนใจ เพื่อให้
กลับมาเปิดอ่านต่อได้ในภายหลัง  
 โดยทั่ว ๆ ไป ผู้ใช้มักจะสร้างและใช้งาน Spatial bookmark กับพื้นที่ที่ต้องท างานบ่อย ๆ ขั้นตอน
การสร้างและจัดการ Spatial bookmarks มีดังน้ี 

 การสร้าง Spatial bookmarks 
1) ขยาย ย่อ หรือเลื่อนแผนที่ไปยังบริเวณที่ต้องการสร้าง Spatial bookmarks 

2) คลิกปุ่ม New Bookmark (  ) หรือคลิกเมนู View > New Bookmark หรือกด
แป้นลัด Ctrl + B 

3) พิมพ์ช่ือ Bookmark 
4) คลิกปุ่ม OK 

 

ยกเลิกการเลือกและการเน้นฟีเจอร์ 

คลิกปุ่ม Deselect features 
from all layers 
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 การใช้ Spatial bookmark 

1) คลิกปุ่ม Show Bookmarks (   ) หรือคลิกเมนู View > Show Bookmarks หรือ
กดแป้นลัด Ctrl + Shift + B 

2) ในหน้าต่าง Geospatial Bookmarks ให้คลิกเลือก Spatial bookmark เช่น อ าเภอทอง
ผาภูมิ 

3) คลิกปุ่ม Zoom to เพื่อแสดงพื้นที่บริเวณที่มีการจัดท า Spatial bookmark ในแผนที่ 

1. เลือกพื้นทีท่ี่ต้องการสร้าง Spatial bookmark 

 

2. คลิกปุ่ม New Bookmark 

3. พิมพ์ชื่อ Spatial bookmark 

4. คลิกปุ่ม OK MAHID
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4) คลิกปุ่ม close เพื่อปิดหน้าต่าง Geospatial Bookmarks 
 
 

 
 
 
 
 

 
 
 
 

พื้นที่แสดงข้อมูลแผนที่ ณ ปัจจุบัน
ก่อนการใช้ Spatial bookmark 

 

1. คลิกปุ่ม Show Bookmarks 

2. คลิกชื่อ Spatial bookmark 

3. คลิกปุ่ม Zoom to 4. คลิกปุ่ม Close 
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 การลบ Spatial bookmark 

1) คลิกปุ่ม Show Bookmarks (   ) หรือคลิกเมนู View > Show Bookmarks หรือ
กดแป้นลัด Ctrl + Shift + B 

2) ในหน้าต่าง Geospatial Bookmarks ให้คลิกเลือก Spatial bookmark ที่ต้องการลบ 
3) คลิกปุ่ม Delete 
4) คลิกปุ่ม close เพื่อปิดหน้าต่าง Geospatial Bookmarks 

 

พื้นที่แสดงข้อมูลแผนที่หลังจาก
การใช้ Spatial bookmark 
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1. การเปิดหนา้ต่าง Vector Properties 
 การเปิดหน้าต่าง Vector Properties เพื่อก าหนดคุณสมบัติของชั้นข้อมูลเวกเตอร์สามารถท าได้ 3 วิธี
ดังนี้ 

 การใช้เมนู โดยการคลิกชั้นข้อมูล จากนั้นคลิกเมนู Layer > Properties 
 

 
 

 การใช้เมนูตามบริบท (Context menu) โดยการคลิกขวาที่ชั้นข้อมูล จากนั้นคลิก Properties 
 

 
 
 

1. คลิกชัน้ข้อมูล 

2. คลิกเมนู Layer > Properties 

1. คลิกขวาที่ชั้นข้อมลู 

2. คลิก Properties 
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 ดับเบิลคลิกที่ชั้นข้อมูล 
 หลังจากนั้น โปรแกรมจะแสดงหน้าต่าง Layer Properties ที่ใช้ในการก าหนดคุณลักษณะของชั้น
ข้อมูล โปรแกรม QGIS ได้จัดแบ่งกลุ่มการตั้งค่าการท างานของชั้นข้อมูลออกเป็นส่วน ๆ เรียกว่า แท็บ (Tab) 
ซึ่งประกอบด้วยแท็บต่าง ๆ ดังนี้ 

o Style tab: ใช้ก าหนดสัญลักษณ์ของช้ันข้อมูล 
o Labels tab: ใช้ก าหนดข้อความที่ต้องการแสดงในแผนที่ โดยอาศัยข้อมูลจาก

ตารางข้อมูลลักษณะประจ า 
o Field tab: ใช้ก าหนดคุณสมบัติของเขตข้อมูลหรือฟิลด์  (Field) ในตารางข้อมูล

ลักษณะประจ า 
o General tab:  ใช้ก าหนดคุณสมบัติทั่ว ๆ ไปของชั้นข้อมูล เช่น ชื่อชั้นข้อมูล 

ระบบพิกัด ช่วงของมาตราส่วนที่ต้องการแสดงชั้นข้อมูล (Scale range) และเงื่อนไขที่ใช้ในการเลือกฟีเจอร์ที่
จะแสดงในช้ันข้อมูล เป็นต้น 

o Metadata tab: ใช้แสดงรายละเอียดชั้นข้อมูล เช่น รูปแบบแฟ้มข้อมูล สถานที่
จัดเก็บข้อมูล ประเภทของฟีเจอร์ (จุด เส้น หรือรูปหลายเหลี่ยม) จ านวนของฟีเจอร์ ระดับหรือขอบเขตที่จะ
สามารถแก้ไขชั้นข้อมูล ขอบเขตพื้นที่ของช้ันข้อมูล และระบบพิกัด 

o Actions tab: ใช้ส าหรับก าหนดเงื่อนไขการท างานของโปรแกรมโดยพิจารณาจากค่าของ
ข้อมูลลักษณะประจ า 

o Joins tab: ใช้เชื่อมโยงตารางข้อมูลลักษณะประจ ากับตารางอื่น ๆ ที่เกี่ยวข้องกัน 
ผลลัพธ์ที่ได้จะเป็นการนาข้อมูลจากสองตารางมารวมไว้ในตารางเดียว โดยใช้ฟิลด์ที่เหมือนกัน ( Common 
fields) เป็นตัวเช่ือม 

o Diagram tab: ใช้แสดงแผนภาพ เช่น แผนภูมิรูปวงกลม (Pie chart) หรือ
แผนภูมิข้อวาม (Text diagram) 

o Overlay tab: ใช้แสดงแผนภาพ เช่น แผนภูมิรูปวงกลม (Pie chart) แผนภูมิแท่ง (Bar 
chart) และภาพกราฟิก (Proportional SVG symbols) 
 
 

 
 
 
 
 

แท็บการตั้งคา่ 
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2. การก าหนดชื่อชั้นข้อมูล 
 เมื่อผู้ใช้เพิ่มชั้นข้อมูลที่เป็นแฟ้มข้อมูลจากแหล่งข้อมูลทุติยภูมิ หรือแหล่งข้อมูลจากภายนอก (ผู้ใช้
ไม่ได้จัดท าข้อมูลด้วยตนเอง) อาจจะพบว่าชื่อชั้นข้อมูลจดจ าได้ยากหรือไม่สื่อความหมาย ดังนั้น ผู้ใช้สามารถ
เปลี่ยนช่ือชั้นข้อมูลให้สื่อความหมายมากขึ้น การก าหนดช่ือชั้นข้อมูลสามารถท าได้ 3 วิธี คือ 

 การก าหนดช่ือชั้นข้อมูลในหน้าต่าง Layer Properties มีขั้นตอนดังนี้ 
1) เปิดหน้าต่าง Layer Properties จากนั้นคลิกแท็บ General 
2) ในช่อง Display name ให้พิมพ์ชื่อชั้นข้อมูลที่ต้องการ 
3) คลิกปุ่ม OK 

 
 
 

 
 
 
 

 
 

 
 

1. คลิกแท็บ General 

2. พิมพ์ชื่อชั้นข้อมูล 

3. คลิกปุ่ม OK 

MAHID
OL



บทที่ 4 การก าหนดคุณสมบัติของชั้นข้อมูลเวกเตอร์  หน้า 114 
 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

 การก าหนดช่ือชั้นข้อมูลโดยการใช้เมนูตามบริบท มีขั้นตอนดังนี้ 
 1) คลิกขวาที่ช้ันข้อมูล จากนัน้คลิก Rename  
 2) พิมพ์ช่ือชั้นข้อมูล และกดปุ่ม Enter 

 

 
 
 
  
 
 
 
 

  

 การใช้แป้นลัด มีขั้นตอนดังนี ้
1) คลิกที่ชั้นข้อมูล 
2) กดปุ่ม F2 
3) พิมพ์ช่ือชั้นข้อมูล และกดปุ่ม Enter 

 
 

1. คลิก Rename 

2. พิมพ์ชื่อชั้นข้อมูล 
และกดปุ่ม Enter

คลิกปุ่ม OK 
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3. การก าหนดช่วงของมาตราส่วนที่ต้องการแสดงชั้นข้อมูล (Scale range) 
ในการปฏิบัติงานที่ต้องบูรณาการชั้นข้อมูลต่าง ๆ ที่มีมาตราส่วนแผนที่แตกต่างกันมาก และ/หรือเป็น

ชั้นข้อมูลที่มีฟีเจอร์จ านวนมาก เช่น ข้อมูลถนน การแสดงผลฟีเจอร์ทั้งหมดอาจจะท าให้การมองดูข้อมูลมี
ความยากล าบาก หรืออาจจะท าให้การขยาย ย่อ หรือเลื่อนแผนที่ไปยังพื้นที่ต่าง ๆ ที่สนใจเพื่อแสดงผลข้อมูล
จะใช้เวลานาน ด้วยเหตุน้ี การก าหนดให้ชั้นข้อมูลแสดงผลเมื่ออยู่ในช่วงของมาตราส่วนที่ต้องการ จะท าให้การ
ท างานมีประสิทธิภาพมากขึ้น 

ในตัวอย่างนี้ สมมุติให้มีชั้นข้อมูลจ านวน 2 ชั้นข้อมูล ได้แก่ ชั้นข้อมูลขอบเขตจังหวัด และชั้นข้อมูล
ถนน และผู้ใช้ต้องการก าหนดให้แสดงผลชั้นข้อมูลถนนเมื่อแผนที่มีมาตราส่วนระหว่าง 1:50,000 ถึง 
1:250,000 ซึ่งวิธีการการก าหนดช่วงของมาตราส่วนที่ต้องการแสดงชั้นข้อมูลมีขั้นตอนดังนี ้

1) เปิดหน้าต่าง Layer Properties จากนัน้คลิกแท็บ General 
2) คลิกกล่องเลือก Use scale dependent rendering 
3) พิมพ์ช่วงมาตราส่วนแผนที่ที่ต้องการแสดงผลชั้นข้อมูลในช่อง Minimum และ Maximum เช่น 

Minimum ก าหนดค่าเป็น 50,000 และ Maximum ก าหนดค่าเป็น 250,000 ในกรณีนี้ ชั้นข้อมูลจะแสดงผล
เมื่อมาตราส่วนของแผนที่อยู่ระหว่าง 1:50,000 ถึง 1:250,000 ถ้าแผนที่มีมาตราส่วนใหญ่กว่า 1:50,000 หรือ
เล็กกว่า 1:250,000 จะไม่ปรากฏชั้นข้อมูลบนแผนที่ (มาตราส่วนของแผนที่จะแสดงอยู่ในช่อง Scale ของ
แถบสถานะ) 

4) คลิกปุ่ม OK 
 

 
 

แถบสถานะแสดงมาตราส่วนของแผนที ่
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หลังจากการก าหนดช่วงมาตราส่วนให้กับชั้นข้อมูลแล้ว เมื่อผู้ใช้พิมพ์มาตราส่วนแผนที่ที่ต้องการ

แสดงผลในช่อง Scale ของแถบสถานะ หรือใช้เครื่องมือขยายหรือย่อแผนที่จากแถบเครื่องมือ Navigation 
toolbar จะพบว่าชั้นข้อมูลจะแสดงผลเมื่อแผนที่มีมาตราส่วนอยู่ในช่วงที่ก าหนดเท่านั้น 

 

   

แผนที่แสดงผลที่มาตราส่วน 
1:12,069,569 

(ไม่แสดงผลช้ันข้อมูล) 

แผนที่แสดงผลที่มาตราส่วน 
1:1100,000 

(แสดงผลชั้นขอ้มูล) 

แผนที่แสดงผลที่มาตราส่วน 
1:25,000 

(ไม่แสดงผลช้ันข้อมูล) 

1. คลิกแท็บ General 

2. คลิกกล่องเลือก Use scale dependent rendering 

3. พิมพ์ช่วงของมาตราส่วนแผนที่ในช่อง 
Minimum และ Maximum 

 

4. คลิกปุ่ม OK 
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4. การก าหนดสญัลักษณ์ของชั้นข้อมลูเวกเตอร ์
 ผู้ใช้สามารถก าหนดสัญลักษณ์ของชั้นข้อมูลในโปรแกรม QGIS ได้จากแท็บ Style ในหน้าต่าง Layer 
Properties ทั้งนี้ โปรแกรม QGIS ตั้งแต่รุ่น 1.4.0 ขึ้นไป มีชุดค าสั่งที่ท างานกับสัญลักษณ์ของชั้นข้อมูลแบบ
ใหม่ (New symbology) แต่ยังคงมีชุดค าสั่งเดิม (Old symbology) จัดเตรียมไว้รองรับการใช้งานของผู้ใช้
เช่นเดียวกัน (โปรแกรม QGIS ใช้ชุดค าสั่งใหม่เป็นค่าเริ่มต้นของระบบ) 
 
 
 

 
 
สัญลักษณ์ที่ใช้แสดงข้อมูลฟีเจอร์บนแผนที่ แบ่งออกเป็น 3 ประเภท ได้แก่ 1) สัญลักษณ์ที่แทนข้อมูล

จุด (Marker symbols) 2) สัญลักษณ์ที่แทนข้อมูลเส้น (Line symbols) และ 3) สัญลักษณ์ที่แทนข้อมูลพื้นที่ 
(Fill and outline symbols) โปรแกรม QGIS จัดเก็บข้อมูลสัญลักษณ์เป็นชั้นข้อมูล เรียกว่า ชั้นข้อมูล
สัญลักษณ์ (Symbol layer) สัญลักษณ์ที่แทนข้อมูลฟีเจอร์อาจจะประกอบด้วยชั้นข้อมูลสัญลักษณ์มากกว่า 1 
ชั้นข้อมูล (Multilayer symbol) โดยปกติแล้ว สัญลักษณ์ที่ประกอบด้วยชั้นข้อมูลสัญลักษณ์หลาย ๆ ชั้น 
มักจะเป็นสัญลักษณ์พิเศษที่ผสมผสานสัญลักษณ์พื้นฐานประเภทต่าง ๆ เข้าด้วยกัน  

ชั้นข้อมูลสัญลักษณ์ที่รองรับการใช้งานกับชั้นข้อมูลเวกเตอร ์มีดังน้ี 

แท็บ Style ปุ่มสลับการใช้ชุดค าสั่งเก่าและใหม ่
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ประเภทชั้นข้อมูล 
(Vector layer) 

ชื่อช้ันข้อมูลสัญลักษณ ์
(Symbol layer) 

ค าอธิบาย 

ชั้นข้อมูลจุด 
(Point layers) 

Font marker แสดงข้อมูลจุดโดยใช้ชุดแบบอักษร 
Simple marker แสดงข้อมูลจุดโดยใช้เครื่องหมายแบบง่าย 
SVG marker แสดงข้อมูลจุดโดยใช้ภาพกราฟิกรูปแบบ SVG 

ชั้นข้อมูลเส้น 
(Line layers) 

Line decoration แสดงข้อมูลเส้นโดยใช้เครื่องหมายรูปลูกศร 
Marker line แสดงข้อมูลเส้นโดยใช้เครื่องหมายแบบง่าย 
Simple line แสดงข้อมูลเส้นโดยใช้เส้นแบบง่าย 

ชั้นข้อมูลรูปหลายเหลี่ยม 
(Polygon layers) 

Centroid fill 
แสดงเซนทรอยด์หรือจุดกึ่งกลางของของรูป
หลายเหลี่ยมโดยใชเ้ครื่องหมาย 

SVG fill 
แสดงพื้นที่ ภายในรูปหลายเหลี่ ยมโดยใช้
ภาพกราฟิกรูปแบบ SVG 

Simple fill 
แสดงพื้นที่ภายในรูปหลายเหลี่ยมโดยใช้แบบรูป
และสีแบบง่าย 

Outline: Line decoration 
แสดงเส้นขอบของรูปหลายเหลี่ ยมโดยใช้
เครื่องหมายรูปลูกศร 

Outline: Marker line 
แสดงเส้นขอบของรูปหลายเหลี่ ยมโดยใช้
เครื่องหมาย 

Outline: Simple line 
แสดงเส้นขอบของรูปหลายเหลี่ยมโดยใช้เส้น
แบบง่าย 

 
การก าหนดสัญลักษณ์ของช้ันข้อมูลเวกเตอร์ประเภทจุด เส้น และรูปหลายเหลี่ยมมีขัน้ตอนดังนี้ 

 การก าหนดสัญลักษณ์ของช้ันข้อมูลจุด 
1) เปิดหน้าต่าง Layer Properties ของช้ันข้อมูลจุด จากนั้นคลิกแท็บ Style 
2) คลิกปุ่ม Change จะปรากฏหน้าต่าง Symbol Properties 
3) ในหน้าต่าง Symbol Properties ให้ก าหนดประเภทของชั้นข้อมูลสัญลักษณ์ (Symbol 

layer type) ส าหรับข้อมูลจุด (Font marker, Simple marker หรือ SVG marker ในกรณีที่มีชั้นข้อมูล
สัญลักษณ์มากกว่า 1 ชั้น ผู้ใช้ต้องคลิกเลือกชั้นข้อมูลสัญลักษณ์ในกรอบ Symbol layers จากนั้น โปรแกรม
จะแสดงคุณสมบัติต่าง ๆ ของสัญลักษณ์ที่สามารถก าหนดได้ในกรอบ Symbol layer properties) 

4) เมื่อคลิกเลือกชั้นข้อมูลสัญลักษณ์แล้ว (ในตัวอย่างน้ีเลือกชั้นข้อมูลสัญลักษณ์แบบ 
Simple marker) ให้ก าหนดคุณสมบัติของสัญลักษณ์ประเภทจุด ได้แก่ ชนิดของเครื่องหมาย เช่น วงกลม 
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สี่เหลี่ยม สามเหลี่ยม ฯลฯ  รวมทั้ง ลักษณะของสัญลักษณ์อื่น ๆ เช่น สีของขอบเครื่องหมาย (Border color) 
สีของเครื่องหมาย (Fill color) ขนาด (Size) มุมการหมุน (Angle) ค่าความเยื้องในแนวแกน X,Y (Offset) 
ทั้งนี้ ผู้ใช้สามารถดูผลลัพธ์ของการก าหนดค่าคุณสมบัติต่าง ๆ ได้ในกรอบแสดงตัวอย่างสัญลักษณ์ (Symbol 
preview) (ทั้งนี้ ตัวเลือกในการก าหนดคุณสมบัติของสัญลักษณ์ในกรอบ Symbol layer properties จะ
แตกต่างกันไปตามประเภทของช้ันข้อมูลสัญลักษณ์) 

5) เมื่อตั้งค่าแล้ว คลิกปุ่ม OK ในหน้าต่าง Symbol Properties 
6) (ในกรณีที่ต้องการก าหนดคุณสมบัติของสัญลักษณ์รวม ซึ่งจะมีผลต่อชั้นข้อมูลสัญลักษณ์

ทุกชั้น สามารถก าหนดได้จากหน้าต่าง Layer Properties ได้แก่ หน่วยที่ใช้ก าหนดขนาดสัญลักษณ์ (Unit) 
ขนาดสัญลักษณ์ (Size) ความโปร่งใส (Transparency) การหมุนสัญลักษณ์ (Rotation) และสีของสัญลักษณ์ 
(Color)) จากนั้นคลิกปุ่ม OK ในหน้าต่าง Layer Properties  
 
 

 

 
 
 
 

1. คลิกแท็บ Style 

2. คลิกปุ่ม Change 

6. คลิกปุ่ม OK 
 

ก าหนดคุณสมบัติของสัญลักษณ์รวม 

 

ตัวอย่างสญัลักษณ์รวม 
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 การก าหนดสัญลักษณ์ของชั้นข้อมูลเส้น 
1) เปิดหน้าต่าง Layer Properties ของช้ันข้อมูลเส้น จากนั้นคลิกแท็บ Style 
2) คลิกปุ่ม Change จะปรากฏหน้าต่าง Symbol Properties 
3) ในหน้าต่าง Symbol Properties ให้ก าหนดประเภทของชั้นข้อมูลสัญลักษณ์ส าหรับ

ข้อมูลเส้น (Line decoration, Marker line หรือ Simple line ในกรณีที่มีชั้นข้อมูลสัญลักษณ์มากกว่า 1 ชั้น 
ผู้ใช้ต้องคลิกเลือกชั้นข้อมูลสัญลักษณ์ในกรอบ Symbol layers จากนั้น โปรแกรมจะแสดงคุณสมบัติต่าง ๆ 
ของสัญลักษณ์ที่สามารถก าหนดได้ในกรอบ Symbol layer properties) 

4) เมื่อคลิกเลือกชั้นข้อมูลสัญลักษณ์แล้ว (ในตัวอย่างน้ีเลือกชั้นข้อมูลสัญลักษณ์แบบ 
Simple line) ให้ก าหนดคุณสมบัติของสัญลักษณ์ประเภทเส้น ได้แก่ สีของเส้น (Color) ขนาดของเส้น (Pen 
width) ค่าความเยื้องของเส้น (Offset) รูปแบบของเส้น (Pen style) รูปแบบของเส้นประ (Use custom 
dash pattern) รูปแบบรอยต่อของเส้น (Join style) และรูปแบบปลายเส้น (Cap style) ทั้งนี้ ผู้ใช้สามารถดู
ผลลัพธ์ของการก าหนดค่าคุณสมบัติต่าง ๆ ได้ในกรอบแสดงตัวอย่างสัญลักษณ์ (ทั้งนี้ ตัวเลือกในการก าหนด
คุณสมบัติของสัญลักษณ์ในกรอบ Symbol layer properties จะแตกต่างกันไปตามประเภทของชั้นข้อมูล
สัญลักษณ์) 

5) เมื่อตั้งค่าแล้ว คลิกปุ่ม OK ในหน้าต่าง Symbol Properties 

ชั้นข้อมูลสญัลักษณ์และค าสั่งที่
ใช้เพิ่ม ลบ หรือเปลี่ยนล าดบั 

4. ก าหนดคุณสมบัติของสัญลักษณ ์

 

ตัวอย่างสัญลกัษณ ์
 

 

3. ก าหนดประเภทชั้น
ข้อมูลสัญลักษณ ์

 

5. คลิกปุ่ม OK 
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6) ในกรณีที่ต้องการก าหนดคุณสมบัติของสัญลักษณ์รวม ซึ่งจะมีผลต่อชั้นข้อมูลสัญลักษณ์
ทุกชั้น สามารถก าหนดได้จากหน้าต่าง Layer Properties ได้แก่ หน่วยที่ใช้ก าหนดขนาดสัญลักษณ์ (Unit) 
ขนาดความกว้างของเส้น (Width) ความโปร่งใส (Transparency) และสีของสัญลักษณ์ (Color) หรือสามารถ
คลิกเลือกสัญลักษณ์ประเภทเส้นที่โปรแกรมจัดเตรียมไว้ให้ในกรอบ Saved styles) จากนั้นคลิกปุ่ม OK ใน
หน้าต่าง Layer Properties  

 
 
 

 
 
 
 
 
 
 
 
 

สัญลักษณ์ประเภทเส้นที่
โปรแกรมจัดเตรียมไว้ให้ 

 

ก าหนดคุณสมบัติของสัญลักษณ์รวม 

 

1. คลิกแท็บ Style 

2. คลิกปุ่ม Change 

6. คลิกปุ่ม OK 
 

ตัวอย่างสัญลักษณ์รวม 
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 การก าหนดสัญลักษณ์ของชั้นข้อมูลรูปหลายเหลี่ยม 
1) เปิดหน้าต่าง Layer Properties ของช้ันข้อมูลรูปหลายเหลี่ยม จากนั้นคลิกแท็บ Style 
2) คลิกปุ่ม Change จะปรากฏหน้าต่าง Symbol Properties 
3) ในหน้าต่าง Symbol Properties ให้ก าหนดประเภทของชั้นข้อมูลสัญลักษณ์ส าหรับ

ข้อมูลรูปหลายเหลี่ยม (Centroid fill, SVG fill, Simple fill, Outline: Line decoration, Outline: Marker 
line หรือ Outline: Simple line ในกรณีที่มีชั้นข้อมูลสัญลักษณ์มากกว่า 1 ชั้น ผู้ใช้ต้องคลิกเลือกชั้นข้อมูล
สัญลักษณ์ในกรอบ Symbol layers จากนั้น โปรแกรมจะแสดงคุณสมบัติต่าง ๆ ของสัญลักษณ์ที่สามารถ
ก าหนดได้ในกรอบ Symbol layer properties) 

4) เมื่อคลิกเลือกชั้นข้อมูลสัญลักษณ์แล้ว (ในตัวอย่างน้ีเลือกชั้นข้อมูลสัญลักษณ์แบบ 
Simple fill) ให้ก าหนดคุณสมบัติของสัญลักษณ์ประเภทรูปหลายเหลี่ยม ได้แก่ สีของรูปหลายเหลี่ยม (Color) 
รูปแบบพื้นของรูปหลายเหลี่ยม (Fill style) สีขอบของรูปหลายเหลี่ยม (Border color) รูปแบบเส้นขอบของ
รูปหลายเหลี่ยม (Border style) ขนาดเส้นขอบของรูปหลายเหลี่ยม (Border width) ค่าความเยื้องใน
แนวแกน X,Y (Offset) (ทั้งนี้ ตัวเลือกในการก าหนดคุณสมบัติของสัญลักษณ์ในกรอบ Symbol layer 
properties จะแตกต่างกันไปตามประเภทของช้ันข้อมูลสัญลักษณ์) 

5) เมื่อตั้งค่าแล้ว คลิกปุ่ม OK ในหน้าต่าง Symbol Properties 

ชั้นข้อมูลสญัลักษณ์และค าสั่งที่
ใช้เพิ่ม ลบ หรือเปลี่ยนล าดบั 

4. ก าหนดคุณสมบัติของสัญลักษณ ์

 

ตัวอย่างสัญลกัษณ ์
 

 

3. ก าหนดประเภทชั้น
ข้อมูลสัญลักษณ ์

 

5. คลิกปุ่ม OK 
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6) ในกรณีที่ต้องการก าหนดคุณสมบัติของสัญลักษณ์รวม ซึ่งจะมีผลต่อชั้นข้อมูลสัญลักษณ์
ทุกชั้น สามารถก าหนดได้จากหน้าต่าง Layer Properties ได้แก่ หน่วยที่ใช้ก าหนดขนาดสัญลักษณ์ (Unit) 
ความโปร่งใส (Transparency) และสีของสัญลักษณ์ (Color)) จากนั้นคลิกปุ่ม OK ในหน้าต่าง Layer 
Properties 

 
 
 

 
 
 
 
 
 
 
 
 
 

ก าหนดคุณสมบัติของสัญลักษณ์รวม 

 

1. คลิกแท็บ Style 

2. คลิกปุ่ม Change 

6. คลิกปุ่ม OK 
 

ตัวอย่างสัญลกัษณ์รวม 
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5. การก าหนดสัญลักษณ์แผนที่เฉพาะเรื่องของชั้นข้อมลูเวกเตอร ์
 ในซอฟต์แวร์ระบบสารสนเทศเทศภูมิศาสตร์ส่วนใหญ่ จะมคี าสั่งส าหรับจัดท าสัญลักษณ์ชั้นข้อมูลแผน
ที่ประเภทต่าง ๆ โดยมีจุดมุ่งหมายที่จะน าเสนอข้อมูลเชิงคุณภาพหรือข้อมูลเชิงปริมาณของชั้นข้อมูลให้สื่อ
ความหมายต่อผู้ใช้แผนที่ ส าหรับโปรแกรม QGIS จะสามารถก าหนดสัญลักษณ์เพื่อจัดท าแผนที่ได้ 4 ประเภท 
ได้แก่ 1) แบบ Single Symbol  2) แบบ Categorized หรือ Unique color  3) แบบ Graduated หรือ 
Graduated color  และ 4) แบบ Rule-based  การก าหนดสัญลักษณ์แผนที่ประเภทต่าง ๆ มีขั้นตอน ดังนี้ 

 แบบ Single Symbol เป็นการก าหนดให้ทุก ๆ ฟีเจอร์ของชั้นข้อมูลมีสัญลักษณ์เหมือนกัน จัดว่า
เป็นการก าหนดสัญลักษณ์เพื่อจัดท าแผนที่แบบง่าย ส่วนใหญ่จะใช้ก าหนดสัญลักษณ์ให้กับชั้นข้อมูลที่เป็น
ข้อมูลพื้นฐานหรือข้อมูลเสริมประกอบ เช่น ข้อมูลจุดความสูง เส้นทางรถไฟ แนวเขตการปกครอง หรือแหล่ง
น้ า ฯลฯ เพื่อให้ผู้ใช้แผนที่สามารถท าความเข้าใจแผนที่ได้ง่ายมากขึ้น ในตัวอย่างนี้ จะสาธิตการก าหนด
สัญลักษณ์แผนที่แบบ Single Symbol ของช้ันข้อมูลจุด ซึ่งมีขั้นตอนดังนี ้ 

1) เปิดหน้าต่าง Layer Properties ของช้ันข้อมูลจุด จากนั้นคลิกแท็บ Style 
2) คลิกเลือก Single Symbol 
3) ก าหนดคุณสมบัติของสัญลักษณ์ 
4) คลิกปุ่ม OK 

ชั้นข้อมูลสญัลักษณ์และค าสั่งที่
ใช้เพิ่ม ลบ หรือเปลี่ยนล าดบั 

4. ก าหนดคุณสมบัติของสัญลักษณ ์

 

ตัวอย่างสัญลกัษณ ์
 

 

3. ก าหนดประเภทชั้น
ข้อมูลสัญลักษณ ์

 

5. คลิกปุ่ม OK 
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3. ก าหนดคุณสมบัติของสัญลักษณ์
รวม 

 

1. คลิกแท็บ Style 2. คลิกเลือก Single Symbol 

4. คลิกปุ่ม OK 
 

ผลลัพธ์ของการก าหนด
สัญลักษณแ์ผนที่แบบ 

Single Symbol 
 

 

สัญลักษณแ์ผนที่แบบ 
Single Symbol MAHID
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 แบบ Categorized เป็นการก าหนดให้สัญลักษณ์ของฟีเจอร์ในชั้นข้อมูลมีส ี(Color) แตกต่างกันไป
ตามค่าของข้อมูลลักษณะประจ าของฟีเจอร์ ค่านี้จะเป็นค่าที่จัดเก็บอยู่ในเขตข้อมูล (Field) ของตารางข้อมูล
ลักษณะประจ า (Feature attribute table) ส าหรับการจัดท าสัญลักษณ์แผนที่แบบ Categorized มักจะใช้
ค่าของเขตข้อมูลที่เป็นข้อมูลเชิงคุณภาพที่บ่งบอกชื่อ ชนิด หรือประเภท เช่น ชื่อหมู่บ้าน ประเภทของถนน 
ประเภทประเภทการใช้ที่ดิน ฯลฯ ในตัวอย่างนี้ จะสาธิตการก าหนดสัญลักษณ์แผนที่แบบ Categorized ของ
ชั้นข้อมูลเส้น ซึ่งมีขั้นตอนดังนี้  

1) เปิดหน้าต่าง Layer Properties ของช้ันข้อมูลเส้น จากนั้นคลิกแท็บ Style 
2) คลิกเลือก Categorized 
3) คลิกเลือกเขตข้อมูลในช่องแสดงรายการ Column 
4) ก าหนดคุณสมบัติของสัญลักษณ์โดยการคลิกปุ่ม Change ในช่อง Symbol และ/หรือ

คลิกเลือกสีจากช่องแสดงรายการ Color ramp 
5) คลิกปุ่ม Classify เพื่อให้โปรแกรมก าหนดสัญลักษณ์ของฟีเจอร์ตามค่าของข้อมูลโดย

อัตโนมัติ ภายหลังจากการคลิกปุ่ม Classify ผู้ใช้สามารถเพิ่มรายการสัญลักษณ์ได้โดยการคลิกปุ่ม Add หรือ
ลบรายการสัญลักษณ์ออกโดยการคลิกปุ่ม Delete ในกรณีที่ต้องการแก้ไขคุณสมบัติของสัญลักษณ์เพิ่มเติมให้
ดับเบิลคลิกที่สัญลักษณ์ที่ต้องการแก้ไขในสดมภ์ที่ชื่อ Symbol หรือถ้าต้องการแก้ไขข้อความที่ใช้อธิบาย
สัญลักษณ์ (Label) ก็สามารถท าได้โดยคลิกเลือกรายการข้อความในสดมภ์ที่ชื่อ Label จากนั้นกดปุ่ม F2 เมื่อ
แก้ไขข้อความเสรจ็แล้วให้กดปุ่ม Enter บนแผงแป้นอักษร 

6) คลิกปุ่ม OK 
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4. ก าหนดคุณสมบัติของสัญลักษณ์
รวม 

 

1. คลิกแท็บ Style 2. คลิกเลือก Categorized 

6. คลิกปุ่ม OK 
 

3. คลิกเลือกเขตข้อมูล 

5. คลิกปุ่ม Classify 

 

สัญลักษณ์ที่โปรแกรมสร้างขึ้น
อัตโนมัติ หลังจากกดปุ่ม Classify 

ผลลัพธ์ของการก าหนด
สัญลักษณแ์ผนที่แบบ 

Categorized 
 

 

สัญลักษณ์แผนที่แบบ 
Categorized MAHID
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 แบบ Graduated เป็นการน าค่าของข้อมูลจากเขตข้อมูล (Field) ในตารางข้อมูลคุณลักษณะ
ประจ ามาจัดแบ่งออกเป็นกลุ่ม (Class) และก าหนดสัญลักษณ์ของแต่ละกลุ่มให้มีสีแตกต่างกัน แต่ละฟีเจอร์ใน
ชั้นข้อมูลที่มีค่าของข้อมูลอยู่ในช่วงกลุ่มข้อมูลใด ก็จะใช้สัญลักษณ์ของกลุ่มข้อมูลนั้นในการแสดงผลข้อมูล  

การจัดท าสัญลักษณ์แผนที่แบบ Graduated จะใช้เขตข้อมูลที่จัดเก็บค่าข้อมูลเชิงปริมาณ ซึ่ง
อาจจะเป็นข้อมูลประเภทไม่ต่อเนื่อง (Discrete) เช่น จ านวนประชากร หรือข้อมูลประเภทต่อเนื่อง 
(Continuous) เช่น ปริมาณผลผลิตทางการเกษตร ส่วนใหญ่นิยมใชส้ัญลักษณ์ประเภทน้ีจัดท าแผนที่แสดงการ
กระจายตัวเชิงพื้นที่ เช่น จ านวนประชากรในแต่ละจังหวัด ระดับปริมาณน้ าฝน ฯลฯ ในตัวอย่างนี้ จะสาธิต
การก าหนดสัญลักษณ์แผนที่แบบ Graduated ของช้ันข้อมูลรูปหลายเหลี่ยม ซึ่งมีขั้นตอนดังนี้  

1) เปิดหน้าต่าง Layer Properties ของช้ันข้อมูลรูปหลายเหลี่ยม จากนั้นคลิกแท็บ Style 
2) คลิกเลือก Graduated  
3) คลิกเลือกเขตข้อมูลในช่องแสดงรายการ Column 
4) ก าหนดคุณสมบัติของสัญลักษณ์โดยการคลิกปุ่ม Change ในช่อง Symbol และ/หรือ

คลิกเลือกสีจากช่องแสดงรายการ Color ramp 
5) คลิกเลือกวิธีการจ าแนกหรือจัดแบ่งกลุ่มข้อมูล มีทั้งหมด 5 วิธี ได้แก่ 

 Equal Interval: เป็นการจัดแบ่งกลุ่มข้อมูลที่มีขนาดของกลุ่มหรือช่วงของค่า
ข้อมูลเท่ากัน เช่น ถ้าข้อมูลมีค่าระหว่าง 0 – 100 และต้องการแบ่งข้อมูลออกเป็น 5 กลุ่ม จะได้กลุ่มข้อมูลที่มี
ค่า 0 – 20, 20 – 40, 40 – 60, 60 – 80 และ 80 – 100 เป็นต้น 

 Quantile: เป็นการจัดแบ่งกลุ่มข้อมูลที่แต่ละกลุ่มจะมีจ านวนของค่าเท่ากัน เช่น 
มีค่าของข้อมูล จ านวน 100 ค่า และต้องการแบ่งข้อมูลออกเป็น 4 กลุ่ม จะได้กลุ่มข้อมูลที่แต่ละกลุ่มจะมีค่า
ของข้อมูล 25 ค่า  

 Natural Breaks (Jenks): เป็นการแบ่งกลุ่มข้อมูลโดยพิจารณาจากค่าความ
แปรปรวน เมื่อก าหนดจ านวนกลุ่มข้อมูลที่ต้องการแล้ว โปรแกรมจะค านวณข้อมูลและจัดแบ่งกลุ่มโดยที่ค่า
ความแปรปรวนภายในแต่ละกลุ่มข้อมูลจะมีค่าน้อยที่สุด และค่าความแปรปรวนระหว่างกลุ่มข้อมูลจะมีค่ามาก
ที่สุด 

 Standard Deviation: เป็นการจัดแบ่งกลุ่มข้อมูลโดยเริ่มจากการค านวณค่าเฉลี่ย
ของชุดข้อมูล และแบ่งกลุ่มข้อมูลจากค่าเบี่ยงเบนมาตรฐาน 

 Pretty Breaks: เป็นการจัดแบ่งกลุ่มข้อมูลโดยอาศัยขั้นตอนวิธีค านวณแบบ 
Pretty breakpoints ของภาษาอาร์ (ภาษาโปรแกรมบนคอมพิวเตอร์ส าหรับวิเคราะห์ทางด้านสถิติ) ซึ่งจะปัด
เศษค่าที่ใช้แบ่งกลุ่มข้อมูลให้ และท าให้ช่วงช้ันของกลุ่มข้อมูลมีความสละสลวย (Pretty) มากขึ้น แต่อาจจะท า
ให้จ านวนกลุ่มข้อมูลแตกต่างไปจากที่ผู้ใช้ก าหนด 

6) ก าหนดคุณสมบัติของสัญลักษณ์โดยการคลิกปุ่ม Change ในช่อง Symbol และ/หรือ
คลิกเลือกสีจากช่องแสดงรายการ Color ramp 
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7) คลิกปุ่ม Classify เพื่อให้โปรแกรมก าหนดสัญลักษณ์ของฟีเจอร์ตามกลุ่มข้อมูลโดย
อัตโนมัติ ภายหลังจากการคลิกปุ่ม Classify ผู้ใช้สามารถเพิ่มรายการสัญลักษณ์ของกลุ่มข้อมูลโดยการคลิกปุ่ม 
Add class หรือลบรายการสัญลักษณ์ที่ไม่ต้องการออก โดยการคลิกปุ่ม Delete class ในกรณีที่ต้องการแก้ไข
คุณสมบัติของสัญลักษณ์เพิ่มเติมให้ดับเบิลคลิกที่สัญลักษณ์ที่ต้องการแก้ไขในสดมภ์ที่ชื่อ Symbol ถ้าต้องการ
แก้ไขช่วงของกลุ่มข้อมูล (Range) ให้ดับเบิลคลิกที่ช่วงของข้อมูล และ/หรือถ้าต้องการแก้ไขข้อความที่ใช้
อธิบายสัญลักษณ์ (Label) ก็สามารถท าได้โดยคลิกเลือกรายการที่ต้องการแก้ไข จากนั้นกดปุ่ม F2 เมื่อแก้ไข
ข้อความเสร็จแล้วให้กดปุ่ม Enter บนแผงแป้นอักษร 

8) คลิกปุ่ม OK 
 
 
 

 
 

 
 
 
 

6. ก าหนดคุณสมบัติของสัญลักษณ์
รวม 

 

2. คลิกเลือก Graduated 

8. คลิกปุ่ม OK 
 

3. คลิกเลือกเขตข้อมูล 

7. คลิกปุ่ม Classify 

 

สัญลักษณ์ที่โปรแกรมสร้างขึ้น
อัตโนมัติ หลังจากกดปุ่ม Classify 

1. คลิกแท็บ Style 

5. คลิกเลือกวธิี
จ าแนกกลุ่มขอ้มูล 

OK 
 

4. คลิกเพิ่ม/ลด
จ านวนกลุ่มขอ้มูล

ปุ่ม OK 
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 แบบ Rule-based เป็นการก าหนดเงื่อนไขหรือหลักเกณฑ์ (Rule) เพื่อสร้างหรือแบ่งกลุ่มข้อมูล
ฟีเจอร์บนแผนที่โดยใช้ข้อความสั่งของภาษาเอสคิวแอล (SQL statement) และผู้ใช้สามารถก าหนด
สัญลักษณ์ให้กับฟีเจอร์ให้แตกต่างกันไปตามเง่ือนไขนั้น ๆ 

ในตัวอย่างนี้ จะสาธิตการก าหนดสัญลักษณ์แผนที่แบบ Rule-based โดยการจ าแนกขนาด
แผ่นดินไหว (Earthquake magnitude class) ออกเป็นระดับต่าง ๆ ซึ่งมีขั้นตอนดังนี้  

1) เปิดหน้าต่าง Layer Properties ของช้ันข้อมูลรูปหลายเหลี่ยม จากนั้นคลิกแท็บ Style 
2) คลิกเลือก Rule-based  
3) คลิกปุ่ม Add หรือดับเบิลคลิกที่รายการ (no filter) ในคอลัมน์ Rule 
 

 
 

 
 
 

ผลลัพธ์ของการก าหนด
สัญลักษณแ์ผนที่แบบ 

Graduated 
 

 

สัญลักษณ์แผนที่
แบบ Graduated 

2. คลิกเลือก Rule-based 1. คลิกแท็บ Style 

3. คลิกปุ่ม Add 
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4) ในหน้าต่าง Rule properties ให้ก าหนดชื่อกลุ่มหรือประเภทข้อมูลในช่อง Label 
สามารถก าหนดเงื่อนไข 

5) คลิกปุ่ม        เพื่อก าหนดเงื่อนไขหรือหลักเกณฑ์ส าหรับการจัดกลุ่มหรือ
ประเภทข้อมูล ดังนี้ 

5.1) ในหน้าต่าง Search query builder ให้ผู้ใช้ดับเบิลคลิกเขตข้อมูลในกรอบ 
Fields และตัวด าเนินการในกรอบ Operators และ/หรือคลิกปุ่ม Sample หรือ All ในกรอบ Values ซึ่งจะ
แสดงรายการข้อมูลเพียงบางส่วนหรือทั้งหมดในเขตข้อมูล เพื่อสร้างข้อความเงื่อนไข (Expression) ที่ต้องการ 
ซึ่งจะปรากฏอยู่ในกรอบ SQL where clause 

5.2) คลิกปุ่ม Test เพื่อตรวจสอบว่าเงื่อนไขที่ก าหนดมีความถูกต้องหรือไม่ ถ้า
ถูกต้องโปรแกรมจะแสดงจ านวนฟีเจอร์ที่ตรงกับเงื่อนไข แต่ถ้าไม่ถูกต้อง โปรแกรมจะแสดง
ข้อความผิดพลาด ซึ่งผู้ใช้ต้องก าหนดเง่ือนไขใหม่ให้ถูกต้อง 

5.3) คลิกปุ่ม OK 
 
 

 
 

 

4. ก าหนดชื่อกลุ่มหรือชั้นขอ้มูล 5. คลิกปุ่ม ... 
 

5.1 ก าหนดเงื่อนไขหรือหลักเกณฑ์ 

 

5.2 คลิกปุ่ม Test 5.3 คลิกปุ่ม OK 
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6) ก าหนดสัญลักษณ์ในหน้าต่าง Rule properties 
7) คลิกปุ่ม OK ในหน้าต่าง Rule properties 

 

 
 
 
 

8) ในหน้าต่าง Layer Properties ให้ก าหนดเงื่อนไขที่ต้องการจบครบ โดยท าซ้ าขั้นตอนที่ 3 
ถึง 7 ในกรณีที่ต้องการแก้ไขเงื่อนไขให้ดับเบิลคลิกที่รายการเงื่อนไข หรือให้คลิกเลือกรายการเงื่อนไข จากนั้น
คลิกปุ่ม Edit และถ้าต้องการลบเง่ือนไขให้คลิกที่รายการเง่ือนไข จากนัน้คลิกปุ่ม Remove 

9) คลิกปุ่ม OK 
 
 

6. ก าหนดสัญลักษณ ์

 

7. คลิกปุ่ม OK MAHID
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ปุ่มแก้ไขเงื่อนไข 

ปุ่มลบเงื่อนไข 

8. ก าหนดรายการเงื่อนไขจนครบ 9. คลิกปุ่ม OK 

 

ผลลัพธ์ของการก าหนด
สัญลักษณแ์ผนที่แบบ 

Rule-based 
 

 

สัญลักษณ์แผนที่
แบบ Rule-based MAHID
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6. การแสดงข้อมูลลักษณะประจ าของฟีเจอร์บนแผนที่ (Labeling) 
 โปรแกรม QGIS สามารถน าข้อมูลจากเขตข้อมูล (Field) ในตารางข้อมูลลักษณะประจ าของฟีเจอร์ 
(ชั้นข้อมูลเวกเตอร์) มาแสดงบนแผนที่ โดยมีวัตถุประสงค์เพื่อแสดงรายละเอียดเกี่ยวกับฟีเจอร์บนแผนที่แบบ
อัตโนมัติ จัดเป็นเครื่องมือที่จ าเป็นและมีประโยชน์มากในการจัดท าแผนที่ที่มีฟีเจอร์ของช้ันข้อมูลจ านวนมาก 
 ทั้งนี้ โปรแกรม QGIS รุ่น 1.7.0 จะมีชุดค าสั่งที่ท างานกับ Label ของชั้นข้อมูลทั้งแบบเดิม (Old 
labeling engine) ที่สามารถเข้าถึงได้โดยเปิดหน้าต่าง Vector Properties และคลิกเลือกแท็บ Labels และ
แบบใหม่ (New labeling engine) ที่ถูกพัฒนาทดแทนแบบเดิม ท าให้ใช้งานง่ายและมีประสิทธิภาพมากขึ้น 
และจัดเป็นเครื่องมือหลักในการ Labeling ในปัจจุบัน (แบบเดิมจะถูกเลิกใช้ในอนาคต) 

การแสดงข้อมูลลักษณะประจ าของฟีเจอร์บนแผนที่ มีขั้นตอนดังนี ้
1) คลิกเลือกชั้นข้อมูลเวกเตอร์ที่ต้องการแสดงข้อมูลลักษณะประจ าของฟีเจอร์บนแผนที่ 

2) คลิกปุ่ม Labeling (  ) บนแถบเครื่องมือ Label 
3) ในหน้าต่าง Layer labeling settings คลิกกล่องเลือก Label this layer 
4) คลิกเลือกเขตข้อมูลที่ต้องการแสดงข้อมูลลักษณะประจ าบนแผนที่ 
5) ในกรอบ Text style ให้ก าหนดแบบอักษร (Font) สี (Color) ขนาดของอักษร (Size) และหน่วย

ของขนาดอักษร (Unit) (ตัวอย่างข้อความที่ได้จากการก าหนดค่าต่าง ๆ จะแสดงในช่อง Sample) 
6) ถ้าต้องการก าหนดรายละเอียดระยะแนวกันชน (Buffer) ของข้อความ สามารถท าได้โดย

ก าหนดค่าในกรอบ Buffer ขนาดของระยะแนวกันชนก าหนดได้จากจากช่อง Size และสีของระยะแนวกันชน
ก าหนดได้โดยการดับเบิลคลิกปุ่ม Color 

7) ถ้าต้องการจากก าหนดช่วงมาตราส่วนส าหรับแสดงข้อมูลลักษณะประจ าบนแผนที่ ให้คลิกกล่อง
เลือก Scale-based visibility จากนั้นก าหนดมาตราส่วนที่ต้องการในช่อง Minimum และ/หรือ Maximum 

8) คลิกปุ่ม OK โปรแกรมจะแสดงข้อมูลลักษณะประจ าของฟีเจอร์บนแผนที่ 
 
 
 
 

 
 
 
 

1. คลิกเลือกชัน้ข้อมูล 2. คลิกปุ่ม Labeling MAHID
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3. คลิก Label this layer 4. คลิกเลือกเขตข้อมูล 

ตัวอย่างข้อความ 

7. ก าหนดคุณสมบัติของ
มาตราส่วน 

 

5. ก าหนดคุณสมบัติของข้อความ 

6. ก าหนดคุณสมบัติของระยะแนวกัน
ชน 
 

 

 

8. คลิกปุ่ม OK 

ข้อมูลลักษณะประจ าของ
ฟีเจอร์ที่แสดงบนแผนที ่

ฟีเจอร์บนแผนที ่MAHID
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 ในตัวอย่างขั้นตอนการก าหนดค่าการแสดงข้อมูลลักษณะประจ าของฟีเจอร์บนแผนที่ข้างต้น เป็นการ
ก าหนดค่าพื้นฐานอย่างง่ายจากแท็บ Label settings ในกรณีที่ต้องการก าหนดค่าที่เฉพาะเจาะจง สามารถ
ก าหนดได้จากแท็บ Advanced หรือถ้าต้องการก าหนดค่าโดยใช้ข้อมูลจากตารางข้อมูลลักษณะประจ า
สามารถท าได้โดยใช้แท็บ Data defined settings 

การก าหนดค่าการแสดงข้อมูลลักษณะประจ าของฟีเจอร์แบบจุด เส้น และรูปหลายเหลี่ยม แบบขั้นสูง
จากแท็บ Advanced มีรายละเอียดของตัวเลือกต่าง ๆ ดังนี้  

 การก าหนดค่าขั้นสูงของฟีเจอร์ประเภทจุดจากแท็บ Advanced มีตัวเลือกดังนี้ 
o ต าแหน่งของข้อความ (Placement) ได้แก่ การวางข้อความบน (over point) หรือ

ด้านข้าง (around point) ของฟีเจอร์ เมื่อเลือกตัวเลือกวางข้อความด้านข้างจะสามารถก าหนดระยะห่างของ
ข้อความกับฟีเจอร์ได้ (Label distance) 

 
 
 

 
 
 
 

o ล าดับความส าคัญของการแสดงข้อความ (Priority) เมื่อมีข้อความจากหลายชั้นข้อมูล
ซ้อนทับกัน ชั้นข้อมูลที่มีระดับความส าคัญสูงกว่า โปรแกรมจะแสดงผลข้อความจากชั้นข้อมูลนั้นก่อน 
 

 
 

o ตัวเลือกอื่น ๆ (Options) ได้แก่ การก าหนดให้แสดงข้อความทุก ๆ ฟีเจอร์ย่อยในฟีเจอร์
แบบ Multi-part feature (Label every part of multi-part features) การก าหนดให้เป็นข้อความหลาย
บรรทัด (Multiline labels) หรือการก าหนดให้ฟีเจอร์มีผลต่อการแสดงข้อความ (Features don’t act as 
obstacles for labels) นอกจากนี้ ยังสามารถก าหนดวิธีค้นหาต าแหน่งการวางข้อความได้จากปุ่ม Engine 
settings 

การก าหนดต าแหน่งข้อความ ระยะห่างของข้อความกับฟีเจอร ์

การวางข้อความด้านข้างฟีเจอร ์การวางข้อความบนฟีเจอร ์
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 การก าหนดค่าขั้นสูงของฟีเจอร์ประเภทเส้นจากแท็บ Advanced มีตัวเลือกดังนี้ 
o ต าแหน่งของข้อความ (Placement) ได้แก่ ทิศทางการวางข้อความขนานไปกับฟีเจอร์ 

(Parallel) หรือการวางข้อความตามความโค้งของฟีเจอร์ (Curved) หรือการวางข้อความแบบปกติ 
(Horizontal) เมื่อเลือกต าแหน่งทิศทางการวางข้อความแบบขนานหรือแบบโค้งจะสามารถก าหนดต าแหน่ง

การแสดงข้อความทุก ๆ ฟีเจอร์ย่อย
ในฟเีจอร์แบบ Multi-part feature 

การแสดงข้อความหลายบรรทัด 

การก าหนดใหฟ้ีเจอร์มีผล
ต่อการแสดงขอ้ความ 

ก าหนดวิธีค้นหาต าแหนง่
การวางข้อความ 

วิธีค้นหาต าแหน่ง
การวางข้อความ 

จ านวนต าแหน่งที่เป็น
ตัวเลือกในการวาง
ข้อความข้อความ 

 

ก าหนดให้แสดงข้อความ
ทุก ๆ ข้อความ ถึงแม้ว่า
จะมีข้อความซ้อนทับกัน 
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การวางข้อความเหนือ (above line) หรือบน (on line) หรือล่าง (below) ของฟีเจอร์ รวมทั้งการก าหนด
ระยะห่างของข้อความกับฟีเจอร์ได้ (Label distance) 

 

 
 
 
 

o ล าดับความส าคัญของการแสดงข้อความ (Priority) เมื่อมีข้อความจากหลายชั้นข้อมูล
ซ้อนทับกัน ชั้นข้อมูลที่มีระดับความส าคัญสูงกว่า โปรแกรมจะแสดงผลข้อความจากชั้นข้อมูลนั้นก่อน 
 

 
 

o ตัวเลือกอื่น ๆ (Options) ได้แก่ การก าหนดให้แสดงข้อความทุก ๆ ฟีเจอร์ย่อยในฟีเจอร์
แบบ Multi-part feature (Label every part of multi-part features) การก าหนดให้เส้นที่เชื่อมต่อกัน
และมีข้อมูลลักษณะประจ าเหมือนกันถือว่าเป็นเส้นเดียวกัน (Merge connected line to avoid duplicate 
labels) ซึ่งจะลดความซ้ าซ้อนของ Label  การก าหนดให้เป็นข้อความหลายบรรทัด (Multiline labels) การ
ก าหนดให้ Label แสดงสัญลักษณ์บอกทิศทาง (Add direction symbol) การงดแสดง Label เมื่อฟีเจอร์เส้น
มีขนาดความยาวต่ ากว่าค่าที่ก าหนด (Suppress labeling of features smaller than) หรือการก าหนดให้
ฟีเจอร์มีผลต่อการแสดงข้อความ (Features don’t act as obstacles for labels) นอกจากนี้ ยังสามารถ
ก าหนดวิธีค้นหาต าแหน่งการวางข้อความได้จากปุ่ม Engine settings เช่นเดียวกับฟีเจอร์จุด 

 

 

ทิศทางการวางข้อความ 

 

ต าแหน่งที่เปน็ตัวเลือกในการวางข้อความ
ข้อความ 
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 การก าหนดค่าขั้นสูงของฟีเจอร์ประเภทรูปหลายเหลี่ยมจากแท็บ Advanced มีตัวเลือกดังนี้ 
o ต าแหน่งของข้อความ (Placement) ได้แก่ การวางข้อความแบบปกติ (Horizontal) เมื่อ

เลือกต าแหน่งทิศทางการวางข้อความแบบขนานหรือแบบโค้งจะสามารถก าหนดต าแหน่งการวางข้อความ
เหนือ (above line) หรือบน (on line) หรือล่าง (below) ของฟีเจอร์ รวมทั้งการก าหนดระยะห่างของ
ข้อความกับฟีเจอร์ได้ (Label distance) 

 

 
 
 
 

o ล าดับความส าคัญของการแสดงข้อความ (Priority) เมื่อมีข้อความจากหลายชั้นข้อมูล
ซ้อนทับกัน ชั้นข้อมูลที่มีระดับความส าคัญสูงกว่า โปรแกรมจะแสดงผลข้อความจากชั้นข้อมูลนั้นก่อน 
 

 
 

o ตัวเลือกอื่น ๆ (Options) ได้แก่ การก าหนดให้แสดงข้อความทุก ๆ ฟีเจอร์ย่อยในฟีเจอร์
แบบ Multi-part feature (Label every part of multi-part features) การก าหนดให้เป็นข้อความหลาย
บรรทัด (Multiline labels) การก าหนดให้ไม่แสดงข้อความเมื่อฟีเจอร์พื้นที่มีขนาดเล็กกว่าค่าที่ก าหนด 
(Suppress labeling of features smaller than) หรือการก าหนดให้ฟีเจอร์มีผลต่อการแสดงข้อความ 
(Features don’t act as obstacles for labels) นอกจากนี้ ยังสามารถก าหนดวิธีค้นหาต าแหน่งการวาง
ข้อความได้จากปุ่ม Engine settings เช่นเดียวกับฟีเจอร์จุดและเส้น 

 

 

ต าแหน่งการวางข้อความ 

 

ระยะห่างและการหมุนของ
ข้อความกับฟีเจอร ์

ข้อความ 
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1. การเพิ่มตารางข้อมลู 
 ในการปฏิบัติงานด้านระบบสารสนเทศภูมิศาสตร์ ข้อมูลจากแหล่งข้อมูลหลาย ๆ ประเภท เช่น ข้อมูล
จากการส ารวจด้วยเครื่องจีพีเอส มักจัดเก็บอยู่ในรูปตารางข้อมูล ดังนั้น การเพิ่มตารางข้อมูลเพื่อน าข้อมูลมา
ใช้ในโครงการ (Project) จึงเป็นขั้นตอนการท างานพื้นฐานที่มีความส าคัญ 

โปรแกรม QGIS จัดการกับข้อมูลตารางโดยมองว่าข้อมูลตารางเป็นข้อมูลเวกเตอร์ประเภทหนึ่ง และ
อาศัย OGR Library ในการอ่านและเขียนข้อมูลตาราง (รูปแบบแฟ้มข้อมูลตารางที่ OGR Library รองรับ
สามารถตรวจสอบได้ที่ http://www.gdal.org/ogr/ogr_formats.html) รูปแบบข้อมูลตารางที่นิยมใช้งาน 
ได้แก่ *.csv, *.xls หรือ *.dbf ในกรณีที่ข้อมูลจัดเก็บในรูปแบบที่โปรแกรม QGIS ไม่รองรับการท างาน ผู้ใช้
อาจจะต้องแปลงข้อมูลให้อยู่ในรูปแบบที่เหมาะสมก่อนที่จะน ามาเปิดใช้งานกับโปรแกรม QGIS 

ในตัวอย่างนี้ จะสาธิตการเพิ่มตารางข้อมูลรูปแบบ dbf ในโครงการ ซึ่งมีขั้นตอนดังนี ้

 1) คลิกปุ่ม Add Vector Layer (   ) หรือคลิกเมนู Layer > Add Vector Layer หรือใช้แป้น
ลัดโดยกด Ctrl + Shift + V 

 2) ในหน้าต่าง Add Vector Layer คลิกปุ่ม Browse 
 3) ในหน้าต่าง Open an OGR Supported Vector Layer ให้เลือกสถานที่ที่จัดเก็บแฟ้มข้อมูล 
 4) ในช่อง Files of type: ให้คลิกเลือก All files (*) 
5) คลิกเลือกข้อมูลตารางที่ต้องการเพิ่มในโครงการ แฟ้มข้อมูลจากช่อง Look in 
 6) คลิกปุ่ม Open 
 7) คลิกปุ่ม Open ในหน้าต่าง Add Vector Layer จากนั้นโปรแกรมจะแสดงข้อมูลตารางในพื้นที่

แสดงค าอธิบายสัญลักษณ์ (Map Legend) 
 
 

 
 
 
 
 
 
 
 

1. คลิกปุ่ม Add Vector Layer 

2. คลิกปุ่ม Browse 
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ตารางข้อมูลทีเ่พิ่มจะแสดงในพื้นที่แสดง
ค าอธบิายสัญลักษณ์ (Map Legend) 

3. เลือกสถานที่จัดเก็บแฟ้ม 

5. เลือกแฟ้มข้อมูล 

6. คลิกปุ่ม Open 

7. คลิกปุ่ม Open 

4. คลิกเลือก All files (*) 
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2. การเปิดดูโครงสร้างตารางข้อมูล 
 ตารางข้อมูลประกอบขึ้นด้วยเขตข้อมูล (Field) หรือคอลัมน์ (Column) ที่จัดเก็บข้อมูลลักษณะ
ประจ าของฟีเจอร์ ข้อมูลแต่ละฟีเจอร์จะจัดเก็บเป็นระเบียน (Record) หรือแถว (Row) ในตารางข้อมูล 
โครงสร้างตารางข้อมูลจะอธิบายว่าตารางข้อมูลมีเขตข้อมูลชื่ออะไร จัดเก็บข้อมูลประเภทใด และเขตข้อมูล
สามารถจัดเก็บข้อมูลได้มากน้อยเพียงใด รวมทั้งยังสามารถก าหนดชื่อเขตข้อมูลสมมุติ (Alias) เพื่อใช้แทนชื่อ
เขตข้อมูลจริง เมื่อชื่อของเขตข้อมูลไม่สื่อความหมายหรือไม่กระชับ 
 การเปิดดูโครงสร้างตารางข้อมูลมีขั้นตอนดังนี ้

1) คลิกขวาทีต่ารางข้อมูลในพื้นที่แสดงค าอธิบายสัญลักษณ์ 
2) คลิกเลือก Properties 
3) คลิกแท็บ Fields 
4) คลิกปุ่ม OK เมื่อดูโครงสร้างตารางข้อมูลเสร็จแล้ว และต้องการปิดหน้าต่าง Layer Properties 

 

 
 
 
 
 
 

1. คลิกขวาที่ตารางข้อมูล 

2. คลิก Properties 
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 คอลัมน์ต่าง ๆ ที่แสดงโครงสร้างตารางข้อมูลในแท็บ Fields มีความหมายดังนี ้

ชื่อคอลัมน ์ ความหมาย 
Id หมายเลขระบุล าดับเขตข้อมูล 
Name ชื่อเขตข้อมูล 
Type ประเภทเขตข้อมูลที่จัดเก็บในเขตข้อมูล 
Length ขนาด จ านวน หรือช่วงของข้อมูลที่สามารถจัดเก็บได้ 
Precision จ านวนจุดทศนิยม (เมื่อจัดเก็บข้อมูลแบบเลขจ านวนจริง) 
Comment ค าอธิบายเขตข้อมูล 
Edit widget เงื่อนไขหรือเกณฑ์ที่ใช้ก าหนดค่าหรือช่วงของข้อมูลที่ผู้ใช้สามารถน าเข้าข้อมูลได ้
Alias ชื่อเขตข้อมูลสมมุติที่ก าหนดขึ้นเพื่อใช้แทนชื่อเขตข้อมูลจริง 

 

3. คลิกแท็บ Fields 

4. คลิกปุ่ม OK 
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3. ส่วนต่อประสานกราฟิกกับผู้ใช้ของตารางข้อมูลลักษณะประจ า 
 หน้าต่าง Attribute table เป็นหน้าต่างที่แสดงข้อมูลตาราง ซึ่งมีส่วนต่อประสานกราฟิกกับผู้ใช้ 
(GUI) ที่ใช้ส าหรับการจัดการกับข้อมูลในตารางที่ส าคัญดังนี้ 
 
 
 
 
 

 
 
 
 
 

4. การเชื่อมตารางข้อมูลลักษณะประจ า 
 ในระบบสารสนเทศภูมิศาสตร์ส่วนใหญ่จะจัดเก็บข้อมูลแบบฐานข้อมูลเชิงสัมพันธ์ (Relational 

database) ที่จัดเก็บข้อมูลในรูปของตารางข้อมูล และไม่นิยมจัดเก็บข้อมูลทั้งหมดในตารางเดียว แต่จะใช้
หลักการออกฐานข้อมูล (Database design) และกระบวนการที่เรียกว่า Normalization วิเคราะห์และ
แยกแยะข้อมูล เพื่อให้การจัดเก็บข้อมูลมีความซ้ าซ้อน (Redundancy) น้อยที่สุด ท าให้การแก้ไขและ
ประมวลผลข้อมูลมีประสิทธิภาพมากขึ้น 

 

จ านวนแถวทัง้หมด 

ชื่อตารางข้อมลู เขตข้อมลูหรือคอลัมน ์

จ านวนแถวทีถู่กเลือก 
 

 

 

 

ข้อมูลลักษณะประจ าของฟีเจอร ์

ชุดเครื่องมือทีใ่ช้สบืค้นและแก้ไขข้อมูล
ลักษณะประจ าของฟีเจอร ์

ระเบยีนหรือแถวข้อมูล 
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ผลลัพธ์จากกระบวนการ Normalization จะท าให้มีตารางข้อมูลที่เกี่ยวข้องกันหลาย ๆ ตาราง และ
เมื่อต้องการใช้ข้อมูลที่จัดเก็บในตารางข้อมูลที่เกี่ยวข้องกันหลายตารางพร้อมกัน ก็จะใช้การเชื่อมโยงตาราง 
(Join)  

ตารางที่จะเชื่อมโยงกันต้องมีเขตข้อมูลร่วมกัน (Common field) เขตข้อมูลในตารางหลักที่จะใช้ใน
การเชื่อมโยงจะเรียกว่า คีย์นอก (Foreign key) และเขตข้อมูลของตารางที่จะน ามาเชื่อมโยงจะเรียกว่า คีย์
หลัก (Primary key) เขตข้อมูลร่วมเป็นเขตข้อมูลที่แสดงความสัมพันธ์ของข้อมูลทั้งสองตาราง และไม่
จ าเป็นต้องมีชื่อเขตข้อมูลเหมือนกัน แต่ส่วนใหญ่มักจะก าหนดให้มีชื่อเขตข้อมูลเหมือนกัน 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
ผลลัพธ์ของการเชื่อมโยงตารางจะท าให้ชั้นข้อมูลมีข้อมูลลักษณะประจ าเพิ่มขึ้น และสามารถน าไปใช้

ในการสอบถามข้อมูล (Query) เพื่อการวิเคราะห์หรือจัดท าแผนที่ การเช่ือมโยงตารางข้อมูลมีขั้นตอนดังนี้ 
1) คลิกขวาที่ชั้นข้อมูลที่ต้องการเช่ือมโยงตารางในพื้นที่แสดงค าอธิบายสัญลักษณ์ 
2) คลิกเลือก Properties 
3) ในหน้าต่าง Layer Properties คลิกแท็บ Joins 

4) คลิกปุ่ม  เพื่อก าหนดค่าการเชื่อมโยงตาราง 
5) ในหน้าต่าง Add vector join ให้ก าหนดค่าต่าง ๆ ดังนี้ 

 ในช่อง Join layer ให้เลือกตารางที่จะน ามาเชื่อมโยง 

 ในช่อง Join field ให้เลือกคีย์หลักของตารางที่จะน ามาเช่ือมโยง  

 

 
คีย์หลัก (Primary key) 

คีย์นอก (Foreign key) 
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 ในช่อง Target field ให้เลือกคีย์นอกของตารางที่จะถูกเชื่อมโยง จากนั้นคลิกปุ่ม OK 
โปรแกรมจะแสดงการก าหนดค่าการเชื่อมโยงตารางในแท็บ Joins ของหน้าต่าง Layer Properties 

6. คลิกปุ่ม OK และเมื่อเปิดตารางข้อมูลลักษณะประจ าของชั้นข้อมูลจะพบว่าตารางมีเขตข้อมูล
เพิ่มขึ้น 

 
 

 

 
 
 
 
 
 
 
 
 
 
 

1. คลิกขวาทีช่ั้นข้อมลู 

2. คลิก Properties 
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3. คลิกแท็บ Joins 
 

4. คลิกปุ่มเครือ่งหมายบวก 

5. ก าหนดค่าการเชื่อมโยง
ตาราง 

 

ผลลัพธ์ของการก าหนดคา่การเชื่อมโยง
ตาราง 

 

6. คลิกปุ่ม OK 

 

ข้อมูลลักษณะประจ าที่มีอยู่เดิม 

เขตข้อมลูที่น ามาเชื่อมโยงเพิ่มเติม 

เขตข้อมลูร่วม 
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5. การจัดเรียงข้อมูลในเขตข้อมูล 
 ในบางครั้งกรณีที่ผู้ใช้ต้องการทราบข้อมูลอันดับสูงสุดหรือต่ าสุดในเขตข้อมูล เช่น หมู่บ้านใดมีจ านวน
ประชากรสูงที่สุด หรือบริเวณใดที่มีการปนเปื้อนสารพิษมากที่สุด เป็นต้น ผู้ใช้สามารถเรียงล าดับข้อมูลได้โดย
การคลิกที่ชื่อเขตข้อมูล (Field header) ซึ่งจะปรากฏสัญลักษณ์การเรียงล าดับข้อมูลขึ้น เครื่องหมาย
สามเหลี่ยมที่มีจุดยอดมุมชี้ขึ้น หมายถึง การเรียงล าดับจากน้อยไปหามาก เครื่องหมายสามเหลี่ยมที่มีจุดยอด
มุมชี้ลง หมายถึง การเรียงล าดับจากมากไปหาน้อย ทั้งนี้ เมื่อต้องการสลับการเรียงล าดับข้อมูลให้คลิกที่ชื่อเขต
ข้อมูลอีกคร้ัง 
  
 

 
 
 

 
 

 

คลิกชื่อเขตข้อมูลเพื่อเรียงล าดับข้อมูลจากน้อยไปหามาก 
 

 

คลิกชื่อเขตข้อมูลอีกครั้งเพื่อเรียงล าดับขอ้มูลจากมากไปหาน้อย 
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6. การค้นหาข้อมูลแบบงา่ย (Look for) 
 การค้นหาข้อมูลแบบง่ายในช่อง Look for เป็นการเลือกข้อมูลจากตารางประเภทหนึ่ง ทั้งนี้ ผู้ใช้
ทราบว่า 1) ต้องการค้นหาข้อมูลจากเขตข้อมูลใด และ 2) ต้องทราบค าส าคัญหรือค าหลัก (Keyword)  ใน
ตัวอย่างนี้ สมมุติให้ผู้ใช้ต้องการค้นหาชื่อหมู่บ้านที่ขึ้นต้นด้วยโคก (อาจจะเป็นบ้านโคกโพธิ์ บ้านโคกลอย ฯลฯ) 
ดังนั้น เขตข้อมูลที่ใช้ในค้นหา คือ เขตข้อมูลชื่อหมู่บ้าน และมีค าส าคัญ คือ “บ้านโคก” ขั้นตอนการค้นหา
ข้อมูลแบบง่ายมีดังน้ี 

 1) เปิดตารางข้อมูลลักษณะประจ า และพิมพ์ค าส าคัญหรือค าหลักในช่อง Look for (ในกรณีที่ค าค้น
เป็นภาษาอังกฤษ สามารถคลิกกล่องเลือก Case sensitive เพื่อก าหนดให้การค้นหาข้อมูลมีความไวต่ออักษร
ใหญ่เล็ก) 

 2) เลือกเขตข้อมูลที่ใช้ในการค้นหา 
 3) คลิกปุ่ม Search โปรแกรมจะค้นหาข้อมูลและเลือกแถวข้อมูลที่มีข้อมูลตรงกับค าค้น (Matching) 

โดยจะแสดงจ านวนแถวข้อมูลที่ถูกเลือกทั้งหมดในแถบชื่อตาราง (Title bar) 
 
 
 

 
 
 

7. การสอบถามข้อมูลโดยใชเ้ครื่องมือ Query Builder 
 เครื่องมือ Query Builder เป็นเครื่องมือที่ใช้ในการเลือกแถวข้อมูลตามเงื่อนไขที่ผู้ใช้ก าหนด ส่วน
ใหญ่จะใช้สอบถามข้อมูลที่มีความซับซ้อน ผู้ใช้สามารถดับเบิลคลิกเขตข้อมูลในกรอบ Fields และตัว
ด าเนินการในกรอบ Operators และ/หรือคลิกปุ่ม Sample หรือ All ในกรอบ Values เพื่อแสดงค่าของเขต

1. พิมพ์ค าส าคัญหรือค าหลกั 

แถวทีม่ีเงื่อนไขตรง
กับค าค้นจะถกูเลือก 

จ านวนแถวขอ้มูลที่ถูกเลือกทั้งหมด 

2. เลือกเขตขอ้มูล 

3. คลิกปุ่ม Search MAHID
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ข้อมูลเพียงบางส่วนหรือทั้งหมด และน าค่าดังกล่าว หรือผู้ใช้อาจจะพิมพ์ค่าที่ต้องการจากแผงแป้นอักขระ เพื่อ
สร้างข้อความเง่ือนไข (Expression) ที่ต้องการ ซึ่งจะปรากฏอยู่ในกรอบ SQL where clause 
 ในตัวอย่างนี้ จะสาธิตการสอบถามข้อมูลตามเงื่อนไข 2 ตัวอย่าง ได้แก่ 1) หมู่บ้านที่มีประชากร
มากกว่า 500 คน และ 2) เนื้อดินเป็นดินเหนียวและมีการระบายน้ าเลว ซึ่งมีขั้นตอนดังนี ้

 การค้นหาหมู่บ้านที่มีประชากรมากกว่า 500 คน มีขั้นตอนดังนี ้
1) เพิ่มช้ันข้อมูล และเปิดหน้าต่างข้อมูลลักษณะประจ า ในตัวอย่างนี้ใช้ชั้นข้อมูลหมู่บ้าน (ใน

กรณีที่เขตข้อมูลที่ใช้ในการก าหนดเงื่อนไขเป็นเขตข้อมูลที่จัดเก็บอยู่ในตารางอื่น จะต้องใช้การเชื่อมโยง
ตารางข้อมูลเข้าด้วยกัน) จากนั้นคลิกปุ่ม Advanced search 

2) ในกรอบ Fields ให้ดับเบิลคลิกที่ชื่อเขตข้อมูลที่ใช้สร้างเงื่อนไข ในตัวอย่างนี้เขตข้อมูล
จ านวนประชากร (NOPEOPLE) 

3) ในกรอบ Operators ให้ดับเบิลคลิกที่ตัวด าเนินการที่ใช้สร้างเงื่อนไข ในตัวอย่างนี้คือ
เครื่องหมายมากว่า (>) 

4) ในกรอบ SQL where clause ให้พิมพ์ค่าข้อมูลที่ใช้สร้างเงื่อนไข ในตัวอย่างนี้ให้พิมพ์ค่า 
500 

5) คลิกปุ่ม Test เพื่อทดสอบความถูกต้องของข้อความเงื่อนไขที่ก าหนดไว้ในกรอบ SQL 
where clause ถ้าถูกต้องโปรแกรมจะแสดงหน้าต่าง Search results เพื่อบ่งบอกจ านวนแถวข้อมูลที่ตรงกับ
เงื่อนไข แต่ถ้าไม่ถูกต้อง โปรแกรมจะแสดงข้อความผิดพลาด ซึ่งผู้ใช้ต้องก าหนดเงื่อนไขใหม่ให้ถูกต้อง 

6) คลิกปุ่ม OK โปรแกรมจะเลือกแถวข้อมูลที่ตรงตามเงื่อนไขที่ผู้ใช้ก าหนด และจะแสดง
จ านวนแถวที่ถูกเลือกในแถบชื่อตาราง (Title bar) 

 
 

 
 

แถวข้อมูลของตารางยังไม่ถูกเลือก 

1. คลิกปุ่ม Advanced Search 
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2. ดับเบิลคลกิชื่อเขตข้อมลู 

3. ดับเบิลคลกิตัวด าเนินการ 

4. พิมพ์ค่าข้อมูล 

5. คลิกปุ่ม Test 6. คลิกปุ่ม OK 

แถวข้อมูลที่ตรงกับเงื่อนไขจะถูกเลือก 

จ านวนแถวขอ้มูลที่ถูกเลือกทั้งหมด 
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 การค้นหาข้อมูลดินที่เนื้อดินเป็นดินเหนียวและมีการระบายน้ าเลว มีขั้นตอนดังนี ้
1) เพิ่มชั้นข้อมูล และเปิดหน้าต่างข้อมูลลักษณะประจ า ในตัวอย่างนี้ใช้ชั้นข้อมูลชุดดิน (ใน

กรณีที่เขตข้อมูลที่ใช้ในการก าหนดเงื่อนไขเป็นเขตข้อมูลที่จัดเก็บอยู่ในตารางอื่น จะต้องใช้การเชื่อมโยง
ตารางข้อมูลเข้าด้วยกัน) จากนั้นคลิกปุ่ม Advanced search 

2) ในกรอบ Fields ให้ดับเบิลคลิกที่ชื่อเขตข้อมูลที่ใช้สร้างเงื่อนไข ในตัวอย่างนี้ใช้เขตข้อมูล
เนื้อดิน (TEX_DESC_T) (ในกรณีที่เขตข้อมูลมีจ านวนมากอาจจะต้องใช้แถบเลื่อนหน้าจอ (Scroll bar) เลื่อน
ไปยังเขตข้อมูลที่ต้องการเลือก) 

3) ในกรอบ Operators ให้ดับเบิลคลิกที่ตัวด าเนินการที่ใช้สร้างเงื่อนไข ในตัวอย่างนี้คือ
เครื่องหมายเท่ากับ (=) 

4) ในขณะที่เขตข้อมูลในกรอบ Fields ยังคงถูกเลือกอยู่ (ในที่นี้คือเนื้อดิน) ให้คลิกปุ่ม All ใน
กรอบ Values โปรแกรมจะแสดงรายการค่าข้อมูลทั้งหมดของเขตข้อมูล ซึ่งผู้ใช้สามารถน าไปใช้สร้างเงื่อนไข
ในการค้นหาข้อมูลได้ 

5) ในกรอบ Values ให้ดับเบิลคลิกค่าข้อมูล ในตัวอย่างนี้คือ ‘ดินเหนียว’ 
6) เนื่องจากตัวอย่างนี้ ผู้ใช้ต้องการค้นหาข้อมูลเนื้อดินที่เป็นดินเหนียวและมีการระบายน้ า

เลว ดังนั้น จึงต้องใช้ตัวด าเนินการตรรกะ (Logical operator) AND ในเงื่อนไขการค้นหา  โดยให้ดับเบิลคลิก
ปุ่ม AND ในกรอบ Operators 

ฟีเจอร์ที่ตรงกบัเงื่อนไข
จะถูกเลือกบนแผนที ่
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7) ในกรอบ Fields ให้ดับเบิลคลิกที่ชื่อเขตข้อมูลที่ใช้สร้างเงื่อนไข ในตัวอย่างนี้ใช้เขตข้อมูล
การระบายน้ าของดิน (DRAINGE_T) 

8) ในกรอบ Operators ให้ดับเบิลคลิกที่ตัวด าเนินการที่ใช้สร้างเงื่อนไข ในตัวอย่างนี้คือ
เครื่องหมายเท่ากับ (=) 

9) ในขณะที่เขตข้อมูลในกรอบ Fields ยังคงถูกเลือกอยู่ (ในที่นี้คือการระบายน้ าของดิน) ให้
คลิกปุ่ม All ในกรอบ Values 

10) ในกรอบ Values ให้ดับเบิลคลิกค่าข้อมูล ในตัวอย่างนี้คือ ‘ดินที่มีการระบายน้ าเลว’ 
11) คลิกปุ่ม Test เพื่อทดสอบความถูกต้องของข้อความเงื่อนไข 
12) คลิกปุ่ม OK โปรแกรมจะเลือกแถวข้อมูลที่ตรงตามเงื่อนไขที่ผู้ใช้ก าหนด โดยจะแสดง

จ านวนแถวที่ถูกเลือกในแถบชื่อตาราง (Title bar)  
หมายเหตุ: ในหน้าต่าง Search query builder เมื่อผู้ใช้ต้องการลบข้อความเงื่อนไขทั้งหมด

ให้คลิกปุ่ม Clear และถ้าต้องการยกเลิกการสืบค้นให้คลิกปุ่ม Cancel นอกจากนี้ ถ้าเงื่อนไขที่ใช้ในการค้นหา
ข้อมูลเป็นเง่ือนไขที่มีการใช้งานบ่อยครั้ง ผู้ใช้สามารถคลิกปุ่ม Save เพื่อบันทึกข้อความเงื่อนไขเป็นแฟ้มข้อมูล
ที่มีนามสกุล *.qqf และสามารถจะน ามาใช้งานได้โดยการคลิกปุ่ม Load 

 
 
 

 
 

แถวข้อมูลของตารางยังไม่ถูกเลือก 

1. คลิกปุ่ม Advanced Search MAHID
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2. ดับเบิลคลกิชื่อเขตข้อมลู 

3. ดับเบิลคลกิตัวด าเนินการ 

4. คลิกปุ่ม All 

5. ดับเบิลคลกิค่าข้อมูล 

6. ดับเบิลคลกิตัวด าเนินการ 

7. ดับเบิลคลกิชื่อเขตข้อมลู 

8. ดับเบิลคลกิตัวด าเนินการ 

9. คลิกปุ่ม All 

10. ดับเบิลคลิกค่าข้อมูล 

11. คลิกปุ่ม Test 

เงื่อนไขที่ผู้ใชก้ าหนด 

 

12. คลิกปุ่ม OK 
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แถวข้อมูลที่ตรงกับเงื่อนไขจะถูกเลือก 

จ านวนแถวขอ้มูลที่ถูกเลือกทั้งหมด 

ฟีเจอร์ที่ตรงกบัเงื่อนไข
จะถูกเลือกบนแผนที ่
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8. การค้นหาข้อมูลแบบซ้อน 
 ในการสร้างข้อความเง่ือนไขโดยใช้เครื่องมือ Query Builder เพื่อการสอบถามข้อมูลที่มีความซับซ้อน 
อาจจะท าให้ผู้ใช้ที่ไม่มีความช านาญเกิดความสับสนได้ ดังนั้น การแบ่งเงื่อนไขที่มีความซับซ้อนมาก ๆ ออกเป็น
เงื่อนไขย่อย ๆ ที่มีความซับซ้อนน้อยกว่า จะท าให้การสร้างเงื่อนไขที่ใช้ค้นหาหรือเลือกแถวข้อมูลง่ายขึ้น และ
ลดความผิดพลาดที่เกิดจากไวยากรณ์หรือตรรกะของเงื่อนไขในการสอบถามข้อมูลลง 

ตัวเลือก Search selected only ในหน้าต่าง Attribute table ใช้ส าหรับการเลือกแถวข้อมูลจาก
แถวข้อมูลที่ถูกเลือกอยู่ในปัจจุบัน (Selection from the currently selected records) จึงมีแนวคิดในการ
ประยุกต์ใช้งานเหมือนกับการแบ่งเงื่อนไขค้นหาข้อมูลที่มีความซับซ้อนออกเป็นเงื่อนไขย่อยที่ง่ายกว่า 

ในตัวอย่างนี้ จะสาธิตการค้นหาข้อมูลดินที่เนื้อดินเป็นดินเหนียวและมีการระบายน้ าเลว โดยใช้
ตัวเลือก Search selected only ที่เป็นการค้นหาข้อมูลแบบซ้อนแทนการใช้เครื่องมือ Query Builder ซึ่งมี
ขั้นตอนดังนี้ 

1) เพิ่มช้ันข้อมูล และเปิดหน้าต่างข้อมูลลักษณะประจ า ในตัวอย่างนี้ใช้ชั้นข้อมูลชุดดิน (ในกรณีที่เขต
ข้อมูลที่ใช้ในการก าหนดเงื่อนไขเป็นเขตข้อมูลที่จัดเก็บอยู่ในตารางอื่น จะต้องใช้การเชื่อมโยงตารางข้อมูลเข้า
ด้วยกัน) จากนั้นคลิกปุ่ม Advanced search 

2) ในกรอบ Fields ให้ดับเบิลคลิกที่ชื่อเขตข้อมูลที่ใช้สร้างเงื่อนไข ในตัวอย่างนี้ใช้เขตข้อมูลเนื้อดิน 
(TEX_DESC_T) (ในกรณีที่เขตข้อมูลมีจ านวนมากอาจจะต้องใช้แถบเลื่อนหน้าจอ (Scroll bar) เลื่อนไปยังเขต
ข้อมูลที่ต้องการเลือก) 

3) ในกรอบ Operators ให้ดับเบิลคลิกที่ตัวด าเนินการที่ใช้สร้างเงื่อนไข ในตัวอย่างนี้คือเครื่องหมาย
เท่ากับ (=) 

4) ในขณะที่เขตข้อมูลในกรอบ Fields ยังคงถูกเลือกอยู่ (ในที่นี้คือเนื้อดิน) ให้คลิกปุ่ม All ในกรอบ 
Values โปรแกรมจะแสดงรายการค่าข้อมูลทั้งหมดของเขตข้อมูล ซึ่งผู้ใช้สามารถน าไปใช้สร้างเงื่อนไขในการ
ค้นหาข้อมูลได ้

5) ในกรอบ Values ให้ดับเบิลคลิกค่าข้อมูล ในตัวอย่างนี้คือ ‘ดินเหนียว’ 
6) คลิกปุ่ม Test 
7) คลิกปุ่ม OK โปรแกรมจะเลือกแถวข้อมูลที่ตรงกับเงื่อนไขที่ผู้ใช้ก าหนดขึ้น จัดเป็นขั้นตอนย่อยที่ 1 

ในการค้นหาข้อมูล 
8) คลิกกล่องตัวเลือก Search selected only เพื่อก าหนดให้โปรแกรมเลือกแถวข้อมูลจากแถว

ข้อมูลที่ถูกเลือกอยู่ในปัจจุบัน 
9) คลิกปุ่ม Advanced search 
10) ในกรอบ Fields ให้ดับเบิลคลิกที่ชื่อเขตข้อมูลที่ใช้สร้างเงื่อนไข ในตัวอย่างนี้ใช้เขตข้อมูลการ

ระบายน้ าของดิน (DRAINGE_T)  
11) ในกรอบ Operators ให้ดับเบิลคลิกที่ตัวด าเนินการที่ใช้สร้างเงื่อนไข ในตัวอย่างนี้คือเครื่องหมาย

เท่ากับ (=)  
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12) ในขณะที่เขตข้อมูลในกรอบ Fields ยังคงถูกเลือกอยู่ (ในที่นี้คือการระบายน้ าของดิน) ให้คลิกปุ่ม 
All ในกรอบ Values 

13) ในกรอบ Values ให้ดับเบิลคลิกค่าข้อมูล ในตัวอย่างนี้คือ ‘ดินที่มีการระบายน้ าเลว’ 
14) คลิกปุ่ม Test 
15) คลิกปุ่ม OK โปรแกรมจะเลือกแถวข้อมูลที่ตรงตามเงื่อนไขที่ผู้ใช้ก าหนด จัดเป็นขั้นตอนย่อยที่ 2 

ในการค้นหาข้อมูล ซึ่งจะให้ผลลัพธ์ในการค้นหาข้อมูลเช่นเดียวกับการใช้เครื่องมือ Query Builder 
 
 
 
 

 
 
 

แถวข้อมูลของตารางยังไม่ถูกเลือก 

1. คลิกปุ่ม Advanced Search 
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2. ดับเบิลคลกิชื่อเขตข้อมลู 

3. ดับเบิลคลกิตัวด าเนินการ 

4. คลิกปุ่ม All 

5. ดับเบิลคลกิค่าข้อมูล 

6. คลิกปุ่ม Test 7. คลิกปุ่ม OK 

จ านวนแถวขอ้มูลที่ถูกเลือกจากขั้นตอนย่อยที่ 1 

8. คลิกกล่องตัวเลือก 
Search selected only 

9. คลิกปุ่ม 
Advanced search 
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จ านวนแถวขอ้มูลที่ถูกเลือกจากขั้นตอนย่อยที่ 2 

10. ดับเบิลคลิกชื่อเขตข้อมูล 

11. ดับเบิลคลิกตัวด าเนินการ 

12. คลิกปุ่ม All 

13. ดับเบิลคลิกค่าข้อมูล 

14. คลิกปุ่ม Test 15. คลิกปุ่ม OK 
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9. การจัดการกับแถวข้อมูลที่ถูกเลือก (Selected record) 
 การใช้เครื่องมือในการค้นหาหรือสอบถามขอ้มูลประเภทต่าง ๆ ที่ได้กล่าวไว้ข้างต้น จะได้ผลลัพธ์เป็น
แถวข้อมูลที่ถูกเลือกในตารางข้อมูล ผู้ใช้สามารถจัดการกับแถวข้อมูลนีไ้ด้ดังนี้ 

 การแสดงแถวข้อมูลที่ถูกเลือกก่อนแถวข้อมูลที่ไม่ถูกเลือก 
ในตารางข้อมูลที่มีแถวข้อมูลจ านวนมาก และแถวข้อมูลที่ถูกเลือกกระจัดกระจายปะปนอยู่

กับแถวข้อมูลที่ไม่ถูกเลือก จึงท าให้ยากต่อการดูหรือตรวจสอบข้อมูล ทั้งนี้ ผู้ใช้สามารถก าหนดให้แสดงแถว
ข้อมูลที่ถูกเลือกก่อนจากนั้นจึงค่อยแสดงแถวข้อมูลที่ไม่ถูกเลือก โดยใช้ค าสั่ง Move selection to top หรือ
ใช้แป้นลัดโดยกด Ctrl + T 

 

 
 
 
 

 

จ านวนแถวขอ้มูลที่ถูกเลือกจากแถวข้อมูลทั้งหมด 

แถวข้อมูลที่ถูกเลือกปะปนกบัแถวข้อมูลทีไ่ม่ถูกเลือก 

 

คลิกปุ่ม Move selection to top หรือกด Ctrl + T 

แถวข้อมูลที่ถูกเลือกแสดงผลก่อนแถวข้อมูลที่ไม่ถูกเลือก 
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 การสลับการเลือกแถวข้อมูล 
ในการเลือกข้อมูลที่มีความซับซ้อนมาก ผู้ใช้สามารถก าหนดเงื่อนไขในการเลือกข้อมูลแบบ

ตรงกันข้ามและใช้การสลับผลลัพธ์ของการเลือก เพื่อให้ได้แถวข้อมูลที่ต้องการ โดยใช้ค าสั่ง Invert selection 
หรือใช้แป้นลัดโดยกด Ctrl + S 

 
 
 

 
 

 
 

จ านวนแถวขอ้มูลที่ถูกเลือกมีจ านวน 85 แถว
จากแถวข้อมูลทั้งหมดจ านวน 662 แถว 

คลิกปุ่ม Invert selection หรือกด Ctrl + S 

ผลลัพธ์ของการสลับการเลือกแถวข้อมูลท าให้
จ านวนแถวขอ้มูลที่ถูกเลือกมีจ านวน 577 แถว

จากแถวข้อมูลทั้งหมดจ านวน 662 แถว MAHID
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 การคัดลอกแถวข้อมูลที่ถูกเลือกไปยังคลิปบอร์ด (Clipboard) 
ในกรณีที่ต้องการน าข้อมูลของแถวที่ถูกเลือกไปใช้งานในโปรแกรมอื่น ผู้ใช้สามารถใช้ค าสั่ง 

Copy selected rows to clipboard หรือใช้แป้นลัดโดยกด Ctrl + C เพื่อคัดลอกแถวข้อมูลที่ถูกเลือกไปยัง
คลิปบอร์ด ซึ่งสามารถน าไปใช้กับโปรแกรมอื่น ๆ ได้ต่อไป 

 
 
 
 
 
 

 
 
 
 

 การขยาย/ย่อแผนที่ไปยังฟีเจอร์ที่ถูกเลือก 
เนื่องจากข้อมูลบนแผนที่และข้อมูลจากตารางข้อมูลลักษณะประจ ามีความเชื่อมโยง ผู้ใช้

สามารถใช้ค าสั่ง Zoom map to the selected rows หรือใช้แป้นลัดโดยกด Ctrl + J เพื่อขยาย/ย่อแผนที่
ไปยังฟีเจอร์บนแผนที่ที่ถูกเลือก 
 

คลิกปุ่ม Copy selected rows to clipboard หรือกด Ctrl + C 

ข้อมูลที่คัดลอกถูกน ามาใช้ในโปรแกรม
แผ่นตารางท าการ Microsoft Excel 
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 การแสดงแถวข้อมูลในตารางข้อมูลเฉพาะแถวข้อมูลที่ถูกเลือก 
เมื่อผู้ใช้เลือกแถวข้อมูลได้ตามต้องการแล้ว และต้องการแสดงเฉพาะแถวข้อมูลที่ถูกเลือกใน

ตารางข้อมูลเท่านั้น ผู้ใช้สามารถใช้กล่องตัวเลือก Show selected only เพื่อแสดงแถวข้อมูลในตารางข้อมูล
เฉพาะแถวข้อมูลที่ถูกเลือก 
 

คลิกปุ่ม Zoom map to the selected rows หรือกด Ctrl + J 

แผนที่ก่อนการใช้ค าสั่ง 
Zoom map to the selected rows 

แผนที่หลังจากการใช้ค าสั่ง 
Zoom map to the selected rows 
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กล่องตัวเลือก Show selected only ยังไม่ใช้งาน 

แถวข้อมูลที่ถูกเลือกและไมถู่กเลือกแสดงในตารางข้อมลู 

 

กล่องตัวเลือก Show selected only ถูกใช้งาน 

 

ตารางแสดงขอ้มูลเฉพาะแถวข้อมูลที่ถูกเลอืกเท่านั้น 
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 การยกเลิกการเลือก 
เมื่อผู้ใช้ต้องการยกเลิกการเลือกแถวข้อมูลสามารถท าได้โดยการใช้ค าสั่ง Unselect all หรือ

ใช้แป้นลัดโดยกด Ctrl + U 
 

 
 
 
 
 

 
 

จ านวนแถวขอ้มูลที่ถูกเลือก 

คลิกปุ่ม Unselect all หรือกด Ctrl + U 
 

ไม่มีจ านวนแถวข้อมูลที่ถูกเลือกหลังใช้ค าสั่ง Unselect all 
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10. การเพิ่ม/ลบเขตข้อมลู 
 การเพิ่มและลบเขตข้อมูลเป็นการแก้ไขโครงสร้างตารางข้อมูลที่สามารถด าเนินการได้เมื่ออยู่ในโหมด
การแก้ไข (Editing mode) ในโปรแกรม QGIS รุ่น 1.7.3 ผู้ใช้สามารถเพิ่มเขตข้อมูลในชั้นข้อมูลเวกเตอร์ได้กับ
แฟ้มข้อมูลหลายรูปแบบ (Format) แต่การลบเขตข้อมูลจะด าเนินการได้กับข้อมูล PostGIS เท่านั้น 

ในตัวอย่างนี้ จะสาธิตวิธีการเพิ่มเขตข้อมูลให้กับชั้นข้อมูล Shapefile ดังนี้ 
1) เปิดตารางข้อมูลลักษณะประจ า และคลิกปุ่ม Toggle editing mode หรือกดปุ่ม Ctrl + E) เพื่อ

เข้าสู่โหมดการแก้ไข 
 2) คลิกปุ่ม New column 
 3) ในหน้าต่าง Add column ให้ก าหนดชื่อของเขตข้อมูลในช่อง Name เช่น POP2013 ในกรณีที่
ผู้ใช้ต้องการอธิบายข้อมูลเกี่ยวกับเขตข้อมูลเพิ่มเติมสามารถเพิ่มข้อมูลได้ในช่อง Comment เช่น Population 
2013 ซึ่งเป็นการอธิบายให้ผู้ใช้ข้อมูลทราบว่าเขตข้อมูลนี้เป็นข้อมูลประชากรปี 2013 
 4) ในช่อง Type ให้เลือกชนิดข้อมูลที่ต้องการจัดเก็บในเขตข้อมูลที่สร้างขึ้น ชนิดข้อมูลที่โปรแกรม 
QGIS รองรับประกอบด้วย 1) ข้อมูลเลขจ านวนเต็ม (Whole number หรือ Integer) 2) ข้อมูลเลขจ านวน
จริงหรือเลขที่มีทศนิยม (Decimal number หรือ Real number) และ 3) ข้อมูลที่เป็นข้อความ (Text) 
เนื่องจากตัวอย่างนี้ต้องการสร้างเขตข้อมูลเพื่อจัดเก็บข้อมูลจ านวนประชากร จึงก าหนดให้เขตข้อมูลจัดเก็บ
ข้อมูลแบบเลขจ านวนเต็ม 
 5) ในช่อง Width ให้ก าหนดขนาดข้อมูลที่สามารถจัดเก็บได้ในเขตข้อมูล ตัวอย่างนี้ ก าหนดค่าเป็น 7 
 6) คลิกปุ่ม OK โปรแกรมจะสร้าง/เพิ่มเขตข้อมูลในตารางข้อมูล ซึ่งเป็นเขตข้อมูลล าดับสุดท้ายใน
ตาราง และมีค่าของข้อมูลเป็นค่าว่าง (Null) 
 

 
 

1. คลิกปุ่ม Toggle editing mode 
 

2. คลิกปุ่ม New column 
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11. การค านวณข้อมูลโดยใช้เครื่องมือ Field calculator 
 เครื่องมือ Field calculator เป็นเครื่องมือที่ใช้ในการน าเข้าหรือแก้ไขข้อมูลในตารางข้อมูล และจะ
สามารถใช้งานได้เมื่ออยู่ในโหมดการแก้ไข (Editing mode) เท่านั้น จัดเป็นเครื่องมือที่มีความส าคัญ และ
สามารถประยุกต์ใช้งานได้อย่างกว้างขวาง ในตัวอย่างนี้ จะสาธิตการใช้เครื่องมือ Field calculator ค านวณ
ความหนาแน่นของประชากร ซึ่งมีขั้นตอนดังนี ้

3. ก าหนดชื่อเขตข้อมูล 

4. ก าหนดชนดิข้อมูล 
 

6. คลิกปุ่ม OK 
 

5. ก าหนดขนาดข้อมูล 

ก าหนดค าอธบิาย
เขตข้อมลู 

 
เขตข้อมลูที่สรา้ง/เพิ่มในตาราง 
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 1) เปิดตารางข้อมูลลักษณะประจ า และคลิกปุ่ม Toggle editing mode หรือกดปุ่ม Ctrl + E) เพื่อ
เข้าสู่โหมดการแก้ไข 

 2) คลิกปุ่ม Open field calculator หรือใช้แป้นลัดโดยกด Ctrl + I 
 3) ในหน้าต่าง Field calculator ให้ตั้งค่าต่าง ๆ ดังนี้ 

 3.1) เนื่องจากในตัวอย่างนี้ต้องการแก้ไขข้อมูลในเขตข้อมูลที่มีอยู่แล้ว ดังนั้นจึงคลิกกล่อง
ตัวเลือก Update existing field 

3.2) เลือกเขตข้อมูลที่ต้องการแก้ไข ในตัวอย่างนี้ ต้องการค านวณความหนาแน่นของ
ประชากร และจัดเก็บค่าที่ได้จากการค านวณไว้ในเขตข้อมูลที่ชื่อ POP_DEN_2013 จึงเลือก 
POP_DEN_2013 ในช่องแสดงรายการเขตข้อมูล 

3.3) ใช้ค่าจากช่อง Field  และช่อง Values และใช้ปุ่ม Operators ต่าง ๆ รวมทั้ง
เครื่องหมายวงเล็บ เพื่อก าหนดเงื่อนไขการค านวณ ในตัวอย่างนี้ ต้องการค านวณหาความหนาแน่นของ
ประชากร ซึ่งมีสูตรในการค านวณคือ จ านวนประชากรหารด้วยขนาดพื้นที่ เขตข้อมูลที่จ าเป็นต้องใช้จึงได้แก่  
POP2013 ซึ่งจัดเก็บข้อมูลจ านวนประชากร และเขตข้อมูล AREA ซึ่งจัดเก็บข้อมูลขนาดพื้นที่มีหน่วยเป็น
ตารางเมตร แต่เนื่องจากว่าต้องการให้ผลลัพธ์ของการค านวณมีหน่วยเป็นตารางกิโลเมตร จึงต้องคูณด้วย 
1,000,000 ดังนั้น เงื่อนไขที่ปรากฏในช่อง Field calculator expression จะมีค่าดังนี้ (POP2013 / AREA) 
* 1000000 

3.4) คลิกปุ่ม OK เพื่อให้โปรแกรมค านวณค่าของเขตข้อมูล 
 4) คลิกปุ่ม Toggle editing mode เพื่อยุติการแก้ไขข้อมูล จากนั้นคลิกปุ่ม Save 
 

 
 
 

1. คลิกปุ่ม Toggle editing mode 
 

2. คลิกปุ่ม Open field calculator 
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3.1 คลิกกล่องตัวเลือก Update existing field 
 
 

3.2 คลิกเลือกเขตข้อมลู
ที่จัดเก็บค่าการค านวณ 

เงื่อนไขการค านวณ 
 
 

3.4 คลิกปุ่ม OK 

3.3 คลิกรายการข้อมูลและปุ่มเพื่อ
ก าหนดเงื่อนไขการค านวณ 

 

 

 

 

ผลลัพธ์จากการค านวณ 

4. คลิกปุ่ม Toggle editing mode 
เพื่อยุติการแกไ้ขข้อมูล 
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บทที่ 6 การน าเข้าและแก้ไขข้อมูลเวกเตอร ์

 ในการประยุกต์ใช้ระบบสารสนเทศภูมิศาสตร์ในด้านต่าง ๆ ให้บรรลุผลส าเร็จตามเป้าหมายที่ได้วางไว้ 
ข้อมูลจัดเป็นองค์ประกอบหนึ่งที่ส าคัญของระบบที่จ าเป็นต้องมีความถูกต้อง ครบถ้วน และทันสมัยอย่าง
เพียงพอ อย่างไรก็ตาม ผู้ใช้ส่วนใหญ่มักจะพบว่า ข้อมูลที่มีอยู่มีไม่ครบถ้วน ล้าสมัย ไม่ถูกต้อง หรืออาจจะอยู่
ในรูปที่ไม่เหมาะสมต่อการน าไปใช้งาน ดังนั้น ผู้ใช้จ าเป็นต้องน าเข้าข้อมูลเพิ่มเติมหรือแก้ไขข้อมูลที่มีอยู่ 
เพื่อให้การวิเคราะห์ข้อมูลหรือการน าข้อมูลไปใช้ประโยชน์ได้ผลลัพธ์ที่มีความถูกต้องและน่าเช่ือถือ 

ในบทนี้ จะกล่าวถึงการน าเข้าและแก้ไขข้อมูลเวกเตอร์ของชั้นข้อมูลชนิด OGR, PostGIS หรือ 
Spatialite (ส าหรับช้ันข้อมูลชนิด GRASS จะมีวิธีการที่แตกต่างกันออกไป) ซึ่งมีรายละเอียดดังนี ้

1. การสร้างชั้นข้อมูล Shapefile 
 1) เปิดหน้าต่าง New Vector Layer เพื่อสร้างช้ันข้อมูล Shapefile สามารถได ้3 วิธดีังนี ้

 การใช้เมนู โดยการคลิกเมนู Layer > New > New Shapefile Layer 

 การใช้แถบเครื่องมือ File โดยการคลิกปุ่ม New Shapefile Layer (   ) บนแถบ
เครื่องมือ Manage Layers  

 การใช้แป้นลัด โดยการกดปุ่ม Ctrl + Shift + N 
2) ในหน้าต่าง Coordinate Reference System Selector ให้ก าหนดระบบพิกัดของชั้นข้อมูล เช่น  

WGS 84/UTM zone 47N 
 3) คลิกปุ่ม OK ในหน้าต่าง Coordinate Reference System Selector 
 4) ในกรอบ Type ให้เลือกประเภทของชั้นข้อมูล ได้แก่ จุด เส้น หรือรูปหลายเหลี่ยม ในตัวอย่างนี้ 

ต้องการสร้างชั้นข้อมูลแหล่งน้ า จึงคลิกเลือก Polygon 
 5) ถ้าต้องการเปลี่ยนแปลงระบบพิกัดที่ก าหนดไว้ในขั้นตอนที่ 2 ให้คลิกปุ่ม Specify CRS เพื่อระบุ

ระบบพิกัดของช้ันข้อมูลอีกครั้ง 
6) ถ้าผู้ใช้ต้องการสร้างเขตข้อมูลในตารางข้อมูลลักษณะประจ า สามารถก าหนดค่าต่าง ๆ ในกรอบ 

New Attribute ในตัวอย่างนี้ ต้องการสร้างเขตข้อมูลเพ่ือจัดเก็บชื่อแหล่งน้ า จึงก าหนดค่าได้ดังนี ้

 ในช่อง NAME ให้ระบุชื่อของเขตข้อมูล ในตัวอย่างนี้ให้พิมพ์ Name 

 ในช่อง Type ให้ก าหนดชนิดข้อมูลที่จัดเก็บในเขตข้อมูล ในตัวอย่างนี้ให้เลือก Text data 
เนื่องจากต้องการเก็บข้อมูลชื่อแหล่งน้ า ซึ่งเป็นข้อมูลประเภทข้อความ 

 ในช่อง Width ให้ก าหนดขนาดข้อมูลที่สามารถจัดเก็บได้ในเขตข้อมูล ตัวอย่างนี้ 
ก าหนดค่าเป็น 100 

 เมื่อก าหนดค่าต่าง ๆ แล้วคลิกปุ่ม Add to attributes list เขตข้อมูลจะไปปรากฏอยู่ใน
รายการเขตข้อมูล (Attribute list) 
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หมายเหตุ: เขตข้อมูลชื่อ id ที่ปรากฏในรายการเขตข้อมูล เป็นเขตข้อมูลที่โปรแกรมสร้างขึ้น
อัตโนมัติ ถ้าต้องการลบเขตข้อมูล ให้คลิกที่แถวรายการเขตข้อมูลที่ต้องการลบ จากนั้น คลิกปุ่ม Remove 
attribute เมื่อต้องการสร้างเขตข้อมูลอื่น ๆ เพิ่มเติม ให้ท าซ้ าในขั้นตอนที่ 6  

 7) คลิกปุ่ม OK 
 8) ในหน้าต่าง Save As ช่อง Look in: ให้ก าหนดสถานที่จัดเก็บแฟ้มข้อมูล 
9) ในช่อง File name: ให้ก าหนดชื่อแฟ้มข้อมูล 
10) คลิกปุ่ม Save 

 
    
 

 
 

 
 
 
 
 
 

1. คลิกปุ่ม New Shapefile Layer 

2. คลิกเลือกระบบพิกัดของชั้นข้อมูล 

3. คลิกปุ่ม OK MAHID
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4. คลิกเลือกประเภทของชั้นข้อมูล 

 

6. สร้างเขตขอ้มูล 

 

5. ก าหนดระบบพิกัดชัน้ข้อมูล 

เขตข้อมลูที่สรา้ง 

ปุ่มลบเขตข้อมูล 

7. คลิกปุ่ม OK 
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8. ก าหนดสถานที่จัดเก็บแฟ้มข้อมูล 

9. ก าหนดชื่อแฟ้มข้อมูล 

10. คลิกปุ่ม Save 

ชั้นข้อมลูที่สรา้งขึ้นจะปรากฏในพื้นที่
แสดงค าอธิบายสัญลักษณ ์
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2. การก าหนดค่า Snapping tolerance และ Search radius 
 ในการจัดเก็บข้อมูลถนน แม่น้ า ขอบเขตที่ดิน ขอบเขตแหล่งน้ า ฯลฯ เส้น (Line) ที่เป็นฟีเจอร์หรือ
ประกอบกันเป็นฟีเจอร์ต้องมีการเชื่อมต่อกัน เช่น เส้นถนนหรือแม่น้ ามาบรรจบกัน หรือเส้นที่ประกอบกันเป็น
ขอบเขตที่ดินหรือแหล่งน้ าต้องบรรจบกันเป็นรูปปิด ทั้งนี้ เส้นจะบรรจบกันหรือเชื่อมต่อกันได้ต้องมีค่าพิกัด 
X,Y ของจุดปลายของเส้นที่บรรจบกันเป็นค่าเดียวกัน อย่างไรก็ตาม โดยปกติแล้ว การน าเข้าข้อมูลเชิงพื้นที่
ด้วยวิธีการดิจิไทซ์ (Digitizing) ธรรมดามักจะไม่สามารถน าเข้าข้อมูลเส้นให้เชื่อมต่อกันได้ เพราะผู้น าเข้า
ข้อมูลไม่สามารถน าเข้าหรือดิจิไทซ์จุดปลายของเส้นให้ไปบรรจบกบัจุดของเส้น (Vertex) หรือส่วนของเส้นตรง 
(Segment) โดยมีค่าพิกัด X,Y เป็นค่าเดียวกันได้ ดังนั้น โปรแกรมระบบสารสนเทศภูมิศาสตร์ส่วนใหญ่จึงมี
ค าสั่งที่จะก าหนดให้เคลื่อนย้ายจุดไปบรรจบกับจุดหรือส่วนของเส้นตรงอื่นที่อยู่ใกล้กันภายในระยะที่ก าหนด 
ระยะนี้เรียกว่า Snapping tolerance ซึ่งอาจจะมีหน่วยของระยะเป็นหน่วยของแผนที่ (map unit) หรือ
หน่วยของจุดภาพ (pixel) บนจอแสดงผล ยกตัวอย่างเช่น ถ้าก าหนดให้ค่า Snapping tolerance เท่ากับ 5 
เมตร เมื่อผู้ใช้น าเข้าหรือเคลื่อนย้ายจุดของเส้นจนไปอยู่ใกล้กับจุดหรือส่วนของเส้นตรงอื่นภายในระยะ 5 
เมตร จุดนั้นจะเคลื่อนเข้าไปหาและบรรจบกับจุดหรือส่วนของเส้นตรงที่อยู่ใกล้โดยอัตโนมัต ิ
 

 
 

 ด้วยเหตุผลข้างต้น เพื่อให้การน าเข้าหรือแก้ไขข้อมูลมีความถูกต้อง จึงควรก าหนดค่า Snapping 
tolerance ก่อนการน าเข้าหรือแก้ไขข้อมูลเชิงพื้นที่ทุกครั้ง โปรแกรม QGIS สามารถก าหนดค่า Snapping 
tolerance ได้ 2 ระดับ คือ 1) ระดับโครงการ และ 2) ระดับชั้นข้อมูล โดยมีขั้นตอนการก าหนดค่าดังนี ้

 การก าหนดค่า Snapping tolerance ระดับโครงการ (Project based snapping tolerance) มี
ขั้นตอนดังนี้ 

1) คลิกเมนู Settings > Options 
2) คลิกแท็บ Digitizing 
3) ในกรอบ Snapping สามารถก าหนดค่าได้ดังนี้ 

MAHID
OL



บทที่ 6 การน าเข้าและแก้ไขข้อมูลเวกเตอร์  หน้า 175 
 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

 Default snap mode เป็นการก าหนดให้จุดของเส้นไปบรรจบกับจุด (To 
vertex) หรือส่วนของเส้นตรง (To segment) หรือจุดและส่วนของเส้นตรง (To vertex and segment) 
อย่างใดอย่างหนึ่ง  

 Default snapping tolerance เป็นการก าหนดค่า Snapping tolerance 

 Search radius for vertex edits เป็นการก าหนดระยะที่โปรแกรม QGIS ใช้
ค้นหาจุด (Vertex) เมื่อผู้ใช้คลิกเลือกจุดที่จะลบหรือเคลื่อนย้ายบนแผนที่ ถ้าต าแหน่งที่ผู้ใช้คลิกเลือกจุดบน
แผนที่ไม่อยู่ภายในค่า Search radius โปรแกรม QGIS จะแสดงหน้าต่างแจ้งเตือนความผิดพลาด แต่ถ้าผู้ใช้
คลิกจุดของเส้นภายในระยะ Search radius จุดของเส้นจะถูกเลือกและสามารถแก้ไขได้ 

4) คลิกปุ่ม OK 
 

 

 
 
 
 
 
 
 
 

1. คลิกเมนู Settings > Options 

2. คลิกแท็บ Digitizing 

3. ก าหนดค่า Snapping tolerance ระดับโครงการ 

 

4. คลิกปุ่ม OK 
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 การก าหนดค่า Snapping tolerance ระดับชั้นข้อมูล (Layer based snapping tolerance) ให้
เลือก 

1) คลิกเมนู Settings > Snapping Options 
2) ในหน้าต่าง Snapping options ให้ก าหนดค่า Snapping tolerance ของช้ันข้อมูลดังนี้ 

 คลิกกล่องเลือกหน้ารายการชั้นข้อมูล เพื่อเปิดการใช้งาน Snapping tolerance 
ของช้ันข้อมูล 

 ในคอลัมน์ Mode ให้เลือกแบบการบรรจบ (Snapping) 

 ในคอลัมน์ Tolerance ให้ระบุค่า Snapping tolerance 

 ในคอลัมน์ Units ให้ก าหนดหน่วยของค่า Snapping tolerance ซึ่งอาจ
ก าหนดค่าเป็นหน่วยของแผนที่ (map unit) หรือหน่วยของจุดภาพ (pixel) 

 ในคอลัมน์ Avoid Int. เป็นตัวเลือกที่มีเฉพาะชั้นข้อมูลประเภทรูปหลายเหลี่ยม 
ย่อมากจากค าว่า “Avoid intersection of new polygons” หมายถึง การหลีกเลี่ยงการตัดกันของรูปหลาย
เหลี่ยม เมื่อคลิกเลือกกล่องให้มีเครื่องหมายกากบาท การน าเข้าหรือแก้ไขรูปหลายเหลี่ยมจะไม่มีส่วนใดของรูป
หลายเหลี่ยมซ้อนทับกัน 
 
 

 
 

 

1. คลิกเมนู Settings > Snapping Options 

2. ก าหนดค่าการบรรจบ (Snapping) ของชั้นข้อมลู 

 

คลิกเพื่อให้การย้ายจุดร่วมเป็นไปอย่างอัตโนมัติ 

เปิดใชง้าน Snapping tolerance ของชั้นข้อมูล 
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หมายเหตุ: การคลิกกล่องเลือกหน้ารายการชั้นข้อมูลเป็นการก าหนดให้ใช้งาน Snapping tolerance 
ของชั้นข้อมูล เพราะฉะนั้น ก่อนการน าเข้าหรือแก้ไขข้อมูล ผู้ใช้ต้องเปิดการใช้งาน Snapping tolerance 
ของชั้นข้อมูลก่อนเสมอ มิฉะนั้น ถึงแม้ว่าผู้ใช้จะก าหนดค่า Snapping tolerance ในระดับโครงการ แต่ถ้าไม่
เปิดการใช้งาน Snapping tolerance ก็จะไม่มีผลต่อการบรรจบของจุดหรือเส้นหรือรูปหลายเหลี่ยมของชั้น
ข้อมูล นอกจากนี้ การก าหนดค่า Snapping tolerance ในระดับชั้นข้อมูลจะมีล าดับความส าคัญหรือมีล าดับ
เหนือกว่าระดับโครงการ ยกตัวอย่างเช่น ถ้า Snapping tolerance ในระดับโครงการมีค่า 5 pixel แต่ 
Snapping tolerance ของชั้นข้อมูลมีค่า 10 pixel โปรแกรม QGIS จะใช้ค่า Snapping tolerance 10 
pixel แทน 5 pixel 

ในกรณีที่ต้องการเคลื่อนย้ายจุดของรูปหลายเหลี่ยมที่อยู่ติดกัน (Shared/Common boundary) ผู้ใช้
สามารถคลิกกล่อง Enable topological editing เพื่อให้การย้ายจุดร่วมเป็นไปอย่างอัตโนมัติ  

3. การน าเข้าข้อมูลฟีเจอร์โดยการดิจิไทซ์ 
 1) สร้างหรือเพิ่มช้ันข้อมูลเวกเตอรท์ี่ต้องการน าเข้าข้อมูล จากนั้นคลิกเลือกชั้นข้อมูล 

2) คลิกปุ่ม Toggle editing (   ) จากแถบเครื่องมือ Digitizing หรือกดปุ่ม Ctrl + E หรือคลิก
ขวาที่ช้ันข้อมูล จากนั้นคลิกเลือก Toggle editing เพื่อเข้าสู่โหมดการแก้ไข ในกรณีที่เป็นชั้นข้อมูลเส้นหรือรูป
หลายเหลี่ยม จุด (Vertex) จะปรากฏเป็นเครื่องหมายกากบาท (Marker) และเครื่องมือต่าง ๆ ในแถบ
เครื่องมือ Digitizing จะสามารถใช้งานได้ 

3) คลิกปุ่ม Capture point (  ) หรือ Capture line (  ) หรือ Capture polygon        

(  ) (การเลือกคลิกปุ่มใดจะขึ้นอยู่กับประเภทของฟีเจอร์) เพื่อเข้าสู่โหมดดิจิไทซ์ (Digitizing mode) 
และตัวช้ีต าแหน่งของเมาส์ (Mouse cursor) จะเปลี่ยนแปลงเป็นรูป   

4) คลิกไปยังต าแหน่งที่ต้องการน าเข้าข้อมูล ถ้าเป็นฟีเจอร์ประเภทจุดให้คลิกเมาส์ปุ่มซ้ายเพียงครั้ง
เดียว ถ้าเป็นฟีเจอร์ประเภทเส้นหรือรูปหลายเหลี่ยมให้คลิกเมาส์ซ้ายไปตามฟีเจอร์ที่ต้องการดิจิไทซ์และให้
คลิกขวาเมื่อต้องการจบการดิจิไทซ์ข้อมูลเชิงพื้นที่ของฟีเจอร์ ในกรณีที่เป็นการดิจิไทซ์รูปหลายเหลี่ยม 
โปรแกรมจะสร้างรูปปิดให้กับฟีเจอร์โดยอัตโนมัติเมื่อผู้ใช้คลิกขวา 

5) หลังจากผู้ใช้น าเข้าข้อมูลเชิงพื้นที่ของฟีเจอร์เสร็จแล้ว จะปรากฏหน้าต่าง Attributes ให้ผู้ใช้ป้อน
ข้อมูลลักษณะประจ าของฟีเจอร ์

6) เมื่อป้อนค่าในหน้าต่าง Attributes เสร็จแล้วให้คลิกปุ่ม OK 
7) คลิกปุ่ม Save Edits เพื่อบันทึกการน าเข้าข้อมูล ในกรณีที่ต้องการน าเข้าข้อมูลฟีเจอร์อื่น ๆ 

เพิ่มเติม ให้ท าซ้ าในขั้นตอนที่ 4 - 6 

8) เมื่อต้องการสิ้นสุดการน าเข้าข้อมูลให้คลิกปุ่ม Toggle editing (   ) จากแถบเครื่องมือ 
Digitizing 
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1. สร้างหรือเพิ่มชั้นข้อมลูเวกเตอร์ 
และคลิกเลือกชั้นข้อมลู 

2. คลิกขวาทีช่ั้นข้อมูล เลือก Toggle editing 
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4. คลิกเมาส์ซา้ย ณ ต าแหนง่ที่
ต้องการน าเขา้ข้อมูล 

3. คลิกปุ่ม Capture polygon 

ตัวชี้ต าแหน่งของเมาส ์

 

5. ป้อนข้อมลูลักษณะประจ าของฟเีจอร ์

6. คลิกปุ่ม OK 
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7. คลิกปุ่ม Save Edits 

8. คลิกขวาทีช่ั้นข้อมูล เลือก Toggle editing 

ฟีเจอร์ที่ได้จากการน าเข้าขอ้มูล
โดยการดิจิไทซ ์

ฟีเจอร์ขณะทีอ่ยู่ในโหมดการแก้ไข 

ฟีเจอร์ขณะทีอ่ยู่ในโหมดปกต ิ
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หมายเหตุ: การน าเข้าหรือแก้ไขข้อมูลเชิงพื้นที่โดยการดิจิไทซ์ ส่วนใหญ่จะใช้ข้อมูลรูปถ่ายทางอากาศ
หรือภาพดาวเทียมเป็นภาพพื้นหลัง (Backdrop) เรียกกระบวนการน าเข้าหรือแก้ไขข้อมูลลักษณะนี้ว่า On-
screen digitizing หรือ Head-up digitizing 

ในกระบวนการดิจิไทซ์ข้อมูลมักจะต้องมีการขยาย/ย่อ และเลื่อนแผนที่ไปยังต าแหน่งต่าง ๆ 
ตลอดเวลา ดังนั้น เพื่อให้การดิจิไทซ์ข้อมูลมีความสะดวกรวดเร็วมากขึ้น โปรแกรม QGIS จึงมีแป้นลัด (Hot 
key) (นอกเหนือจากปุ่มเครื่องมือ Pan Map, Zoom In, และ Zoom Out บนแถบเครื่องมือ Map 
Navigation) ที่ใช้ในการควบคุมการขยาย/ย่อ และเลื่อนแผนที่ไปยังต าแหน่งต่าง ๆ ดังนี้ 

 การขยาย: หมุนล้อเลื่อนของเมาส์ไปข้างหน้า (ออกจากตัวผู้ใช้) หรือกดปุ่ม Page Up บนแผงแป้น
อักขระ 

 การย่อ: หมุนล้อเลื่อนของเมาส์ไปข้างหลัง (เข้าหาตัวผู้ใช้) หรือกดปุ่ม Page Down บนแผงแป้น
อักขระ 

 การเลื่อน: ใช้การคลิกล้อเลื่อนของเมาส์ (Mouse wheel) ค้างไว้ หรือใช้ปุ่มลูกศรบนแผงแป้น
อักขระ หรือกดปุ่ม Spacebar บนแผงแป้นอักขระค้างไว้และใช้เมาส์เลื่อนไปบนแผนที่ 

ทั้งนี้ ผู้ใช้สามารถก าหนดค่าการท างานของแป้นลัดได้จากกรอบ Panning and zooming จากแท็บ 
Map tools ในหน้าต่าง Options (คลิกเมนู Settings > Options เพื่อเปิดหน้าต่าง Options) 

 

 
 

ก าหนดค่าการท างานของแปน้ลัด 
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โดยค่าเริ่มต้น (Default) ของโปรแกรม QGIS เมื่อผู้ใช้น าเข้าข้อมูลเชิงพื้นที่เสร็จแล้ว โปรแกรมจะ
แสดงหน้าต่าง Attributes โดยอัตโนมัติ เพื่อให้ผู้ใช้ป้อนค่าข้อมูลลักษณะประจ าของฟีเจอร์ได้ทันที อย่างไรก็
ตาม ถ้าผู้ใช้ต้องการปิดไม่ให้โปรแกรมแสดงหน้าต่าง Attributes อัตโนมัติ สามารถท าได้โดยการปิดตัวเลือก 
Suppress attributes pop-up windows after each created feature ในกรอบ Enter attribute 
values จากแท็บ Digitizing ในหน้าต่าง Options (คลิกเมนู Settings > Options เพื่อเปิดหน้าต่าง 
Options) 

 

 
 

4. การเพิ่ม การลบ และการย้ายต าแหน่ง Vertex 

 เครื่องมือ Node tool (     ) จากแถบเครื่องมือ Digitizing เป็นเครื่องมือที่ใช้ในการจัดการจุด 
(Vertex) ของฟีเจอร ์ได้แก่ การเพ่ิม ลบ หรือย้ายต าแหน่ง 

การลบหรือย้ายจุดจ าเป็นต้องมีการเลือกจุดที่จะแก้ไข ดังนั้น เพื่อให้โปรแกรม QGIS สามารถค้นหา
และเลือกจุดเพื่อแก้ไขได้อย่างถูกต้อง ผู้ใช้จ าเป็นต้องก าหนดค่า Search radius ก่อนการแก้ไขข้อมูลเชิงพื้นที่
ทุกครั้ง มิฉะนั้น โปรแกรมจะแสดงข้อความผิดพลาด (ดูวิธีการก าหนดค่าได้จากหัวข้อ การก าหนดค่า 
Snapping tolerance และ Search radius) 

การแก้ไข Vertex มีรายละเอียดดังนี ้

 การเพ่ิม Vertex มีขั้นตอนดังนี ้
1) ขยายและ/หรือเลื่อนแผนที่ไปยังพ้ืนที่ที่ต้องการเพ่ิม Vertex 

 

ปิดการแสดงหน้าต่าง 
Attributes อัตโนมัต ิ
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2) คลิกขวาที่ชั้นข้อมูลที่ต้องการเพ่ิม Vertex เลือก Toggle editing 
3) คลิกเครื่องมือ Node tool จากแถบเครื่องมือ Digitizing 
4) วางตัวช้ีต าแหน่งของเมาส์ในต าแหน่งที่ต้องการเพ่ิม Vertex 
5) ดับเบิลคลิก โปรแกรมจะสร้าง/แทรก Vertex ณ ส่วนของเส้นตรงที่ผู้ใช้ดับเบิลคลิกเมาส์ 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

1. ขยาย/เลื่อนแผนที่ไปยังต าแหน่ง
ที่ต้องการแก้ไขข้อมูล 

2. คลิกขวาที่ชั้นข้อมลู 
คลิกเลือก Toggle editing 

3. คลิกเครื่องมือ Node tool 
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 การเลือก Vertex เป็นขั้นตอนที่ใช้ในการเลือก Vertex เพื่อลบหรือย้ายต าแหน่ง สามารถท าได้
ขณะที่ชั้นข้อมูลอยู่ในโหมดการแก้ไขและก าลังใช้งานเครื่องมือ Node tool การเลือก Vertex มี 3 วิธี ดังน้ี 

o การเลือก Vertex โดยการคลิกเลือกเพียงจุดเดียว สามารถท าได้โดยการคลิกบน Vertex 
ที่ต้องการเลือก ซึ่งจะท าให้มี Vertex ถูกเลือกเพียงจุดเดียว 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. วางตัวชี้ต าแหน่งของเมาส์ใน
ต าแหน่งที่ต้องการเพิ่ม Vertex 

5. ดับเบิลคลกิ 

คลิกบน Vertex 

Vertex เพียงจุดเดียวถูกเลอืก MAHID
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o การเลือก Vertex โดยการคลิกที่ส่วนของเส้นตรง สามารถท าได้โดยการคลิกบน ส่วนของ
เส้นตรง ซึ่ง Vertex ที่ถูกเลือกจะเป็นจุดปลายของส่วนของเส้นตรง 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

o การเลือก Vertex โดยการคลิกแล้วลากรูปสี่เหลี่ยมมุมฉาก สามารถท าได้โดยการคลิกและ
ลากไปบนแผนที่จนเกิดรูปสี่เหลี่ยมมุมฉาก ซึ่ง Vertex ที่ถูกเลือกจะเป็น Vertex ที่อยู่ภายในรูปสี่เหลี่ยมมุม
ฉาก 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

คลิกบนส่วนของเส้นตรง 

Vertex ที่เป็นจุดปลายถูกเลอืก 

คลิกและลากให้ครอบคลุม 
Vertex ที่ต้องการเลือก 

Vertex ที่เป็นจุดปลายถูกเลอืก 
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 การลบ Vertex มีขั้นตอนดังนี ้
1) คลิกเลือก Vertex 
2) คลิกปุ่ม Delete บนแผงแป้นอักขระ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 การย้ายต าแหน่ง Vertex แบ่งออกได้เป็น 3 ลักษณะ คือ 1) การย้าย Vertex เพียงจุดเดียว 
สามารถท าได้โดยการคลิกและลาก Vertex ไปยังต าแหน่งใหม่ที่ต้องการได้โดยตรง 2) การย้าย Vertex และ
ส่วนของเส้นตรงไปพร้อมกัน (มี Vertex ที่ถูกเคลื่อนย้าย 2 จุด) สามารถคลิกและลากส่วนของเส้นตรงไปยัง
ต าแหน่งใหม่ที่ต้องการ และ 3) การย้ายกลุ่มของ Vertex ที่มีมากกว่า 2 จุดไปพร้อมกับส่วนของเส้นตรง 
สามารถท าได้โดยคลิกเลือกกลุ่มของ Vertex ที่ต้องการ จากนั้นคลิกบน Vertex หรือส่วนของเส้นตรงและลาก
ไปวางยังต าแหน่งที่ต้องการ 

ในตัวอย่างนี้ จะสาธิตวิธีการย้ายกลุ่มของ Vertex ที่มีมากกว่า 2 จุด ซึ่งมีขั้นตอนดังนี ้
1) คลิกเลือกกลุ่มของ Vertex 
2) คลิกเมาส์บน Vertex หรอืส่วนของเส้นตรง และลากไปยังต าแหน่งที่ต้องการ 

 
 
 
 
 
 

คลิกบน Vertex และกดปุ่ม Delete 

Vertex ถูกลบออกไป 
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5. การตัด การคัดลอก และการวางฟีเจอร์ 
 การตัด การคัดลอก และการวางจัดเป็นขั้นตอนการแก้ไขข้อมูลที่มีความส าคัญ มักจะใช้ส าหรับการ

จัดเตรียมข้อมูลก่อนน าไปวิเคราะห์ ยกตัวอย่างเช่น ผู้ใช้มีชั้นข้อมูลขอบเขตจังหวัดของประเทศไทย (แต่ละ
ฟีเจอร์  คือ ขอบเขตจังหวัดแต่ละจังหวัด) แต่ต้องการคัดเลือกพื้นที่ เฉพาะจังหวัดสมุทรปราการ 
กรุงเทพมหานคร สมุทรสาคร และสมุทรสงคราม เพื่อน ามาศึกษาวิเคราะห์แนวชายฝั่ง ดังนั้น เพื่อให้การ
วิเคราะห์ข้อมูลมีประสิทธิภาพมากขึ้น (เนื่องจากการลดจ านวนจังหวัดลงจาก 77 จังหวัด เป็น 4 จังหวัด ท าให้
ปริมาณข้อมูลลดลง การประมวลผลจึงรวดเร็วขึ้น) ผู้ใช้อาจจะสร้างชั้นข้อมูลขึ้นใหม่ และคัดลอกและวาง
ฟีเจอร์ที่ต้องการไปในชั้นข้อมูลที่ต้องการ 

1. คลิกเลือกกลุ่มของ Vertex 

2. ลากไปยังต าแหน่งใหม ่

Vertex และส่วนของ
เสน้ตรงที่ถูกยา้ย 
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 ในตัวอย่างนี้ จะสาธิตการคัดลอกฟีเจอร์จากชั้นข้อมูลต้นฉบับ (Source layer) และวางฟีเจอร์ไปยัง
ชั้นข้อมูลที่ผู้ใช้ต้องการ (Target layer) ซึ่งมีขั้นตอนดังนี ้

 1) เพิ่มชั้นข้อมูลที่ต้องการคัดลอก (Source) และชั้นข้อมูลที่ต้องการน าฟีเจอร์ไปวาง (Target) บน
แผนที่ 

 2) คลิกขวาที่ชั้นข้อมูลที่ต้องการน าฟีเจอร์ไปวาง คลิกเลือก Toggle editing 
 3) คลิกชั้นข้อมูลที่ต้องการคัดลอกฟีเจอร์ (Source layer) เพื่อก าหนดให้โปรแกรมท างานกับชั้น

ข้อมูล (Active layer) 

 4) คลิกเครื่องมือ Select single feature (    ) บนแถบเครื่องมือ Attribute (หรือเครื่องมือ
การเลือกฟีเจอร์อ่ืน ๆ) 

5) คลิกเลือกฟีเจอร์ที่ต้องการคัดลอก 

 6) คลิกปุ่ม Copy Features (  ) 
 7) คลิกชั้นข้อมูลที่ต้องการวางฟีเจอร์ (Target layer) เพื่อก าหนดให้โปรแกรมท างานกับช้ันข้อมูล 

 8) คลิกปุ่ม Paste Features (  ) 
 9) คลิกปุ่ม Save edits 
 10) คลิกขวาที่ชั้นข้อมูลที่วางฟีเจอร์เสร็จแล้ว คลิกเลือก Toggle editing 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. เพิ่มชั้นข้อมูล 

 2. คลิกขวาที่ชั้นข้อมลูที่ต้องการวางฟีเจอร์ 
คลิกเลือก Toggle editing 

MAHID
OL



บทที่ 6 การน าเข้าและแก้ไขข้อมูลเวกเตอร์  หน้า 189 
 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. คลิกชั้นข้อมูลที่ต้องการคัดลอกฟีเจอร ์

6. คลิกปุ่ม Copy Features 

5. คลิกเลือกฟีเจอร์ที่
ต้องการคัดลอก 

4. คลิกปุ่ม Select single feature 
 

 

7. คลิกชัน้ข้อมูลที่ต้องการวางฟีเจอร ์

8. คลิกปุ่ม Paste Features 

ฟีเจอร์ที่ถูกวางบนชัน้ข้อมลู 
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9. คลิกปุ่ม Save edits 

10. คลิกขวาที่ชั้นข้อมลูที่วางฟเีจอร์เสร็จแล้ว 
คลิกเลือก Toggle editing 

ฟีเจอร์ที่ถูกวางบนชัน้ข้อมลู 
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 หมายเหตุ: การตัดและวางฟีเจอร์ (Cut and Paste) มีวิธีการคล้ายคลึงกับการคัดลอกและวางฟีเจอร์ 
(Copy and Paste) ยกเว้นต้องเปิดโหมดการแก้ไขข้อมูล (Editing mode) ให้แก่ชั้นข้อมูลที่ต้องการตัดฟีเจอร์ 
นอกจากนี้ ชั้นข้อมูลที่ต้องการตัด/คัดลอกและวางฟีเจอร์จะต้องมีโครงสร้างตารางข้อมูลลักษณะประจ า 
(Schema) เหมือนกัน (ทั้งชื่อของเขตข้อมูลและชนิดข้อมูลที่จัดเก็บในเขตข้อมูล) ในกรณีที่โครงสร้างแตกต่าง
กัน โปรแกรมจะไม่คัดลอกข้อมูลลักษณะประจ าไปวางในตารางข้อมูลของช้ันข้อมูล 

ในกรณีที่ชั้นขอ้มูลที่ต้องการตัด/คัดลอก และช้ันข้อมูลที่ต้องการวางฟีเจอร์ใช้ระบบพิกัดแตกต่างกัน 
อาจจะท าให้ข้อมูลเชิงต าแหน่งของฟีเจอร์ที่ถูกวางแตกต่างไปจากเดิม ดังนั้น จึงควรก าหนดระบบพิกัดของช้ัน
ข้อมูลให้เหมือนกัน 

6. การย้ายต าแหน่ง และการลบฟีเจอร์ 
 ในการกระบวนการน าเข้าหรือการแก้ไขข้อมูล อาจจะมีการน าเข้าข้อมูลผิดพลาดท าให้มีความ
จ าเป็นต้องย้ายต าแหน่ง หรือลบฟีเจอร์ออกจากชั้นข้อมูล ซึ่งมีขั้นตอนดังนี ้

 การย้ายต าแหน่งฟีเจอร ์
1) คลิกขวาที่ชั้นข้อมูลที่ต้องการย้ายต าแหน่งฟีเจอร์ คลิกเลือก Toggle editing 

2) คลิกปุ่ม Move Feature(s) (  ) แถบเครื่องมือ Digitizing 
3) คลิกฟีเจอร์ที่ต้องการย้ายต าแหน่งไปวางยังต าแหน่งใหม่ที่ต้องการ 
4) คลิกปุ่ม Save edits 
5) คลิกขวาที่ชั้นข้อมูล คลิกเลือก Toggle editing เพื่อปิดโหมดการแก้ไข 
 

 

1. คลิกขวาที่ชั้นข้อมลูที่ต้องการย้ายฟีเจอร์ 
คลิกเลือก Toggle editing 
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2. คลิกปุ่ม Move Feature(s) 
 

3. คลิกและลากฟีเจอร์ไป
ยังต าแหน่งใหม ่

4. คลิกปุ่ม Save edits 

5. คลิกขวาที่ชั้นข้อมลู คลกิเลือก Toggle editing MAHID
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 การลบฟีเจอร ์
1) คลิกขวาที่ชัน้ข้อมูลที่ต้องการลบฟีเจอร์ คลิกเลือก Toggle editing 

2) คลิกเครื่องมือ Select single feature (    ) บนแถบเครื่องมือ Attribute (หรือ
เครื่องมือการเลือกฟีเจอร์อื่น ๆ) 

3) คลิกเลือกฟเีจอร์ที่ต้องการลบ 

4) คลิกปุ่ม Delete Selected (  ) บนแถบเครื่องมอื Digitizing 
5) คลิกปุ่ม OK เพื่อยืนยันความต้องการลบฟีเจอร์ 
6) คลิกปุ่ม Save edits 
7) คลิกขวาที่ชัน้ข้อมูล คลิกเลือก Toggle editing เพื่อปิดโหมดการแก้ไข 

 

 
 

 
 
 

ฟีเจอร์ที่ย้ายไปยังต าแหน่ง
ใหม ่

1. คลิกขวาที่ชั้นข้อมลูที่ต้องการลบฟเีจอร์ 
คลิกเลือก Toggle editing MAHID
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2. คลิกปุ่ม Select single feature 

3. คลิกเลือกฟีเจอร์ 

4. คลิกปุ่ม Delete Selected 

5. คลิกปุ่ม OK 

6. คลิกปุ่ม Save edits 

7. คลิกขวาที่ชั้นข้อมลู คลกิเลือก Toggle editing 

ฟีเจอร์ถูกลบออกไป MAHID
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7. การน าเข้าหรือแก้ไขข้อมูลขั้นสูง 
 โปรแกรม QGIS มีการจัดเตรียมเครื่องมือที่ใช้ในการน าเข้าหรือแก้ไขข้อมูลขั้นสูงให้แก่ผู้ใช้ เพื่อช่วยให้
การน าเข้าข้อมูลที่มีความซับซ้อน เช่น การสร้างฟีเจอร์ย่อย (Multipart feature) หรือการสร้างรูปหลาย
เหลี่ยมแบบโดนัท (Doughnut polygon) หรือการแก้ไขฟีเจอร์ เช่น การลดความละเอียดของข้อมูลเชิง
ต าแหน่งของฟีเจอร์ (Simplify feature) การตัดแบ่งเส้นของฟีเจอร์ (Split features) การรวมฟีเจอร์เข้า
ด้วยกัน (Merge Selected Features และ Merge Attributes of Selected Features) การเปลี่ยนทิศทาง
ของฟีเจอร์ประเภทจุด (Rotate Point Symbols) หรือการเปลี่ยนรูปร่างของฟีเจอร์ประเภทรูปหลายเหลี่ยม 
(Reshape Features) รวมทั้งการยกเลิกค าสั่งและการท าค าสั่งซ้ า (Undo และ Redo) 

การน าเข้าหรือแก้ไขข้อมูลขั้นสูงมีรายละเอียดดังนี้ 

 การยกเลิกค าสั่ง (Undo) 
การยกเลิกค าสั่งเป็นการสั่งให้โปรแกรมย้อนกลับไปสถานะเดิม มักจะใช้เมื่อใช้ค าสั่งผิด หรือ

ต้องการยกเลิกข้อผิดพลาด เช่น การย้ายหรือลบฟีเจอร์โดยไม่ตั้งใจ ฯลฯ 
ในการยกเลิกค าสั่งมีเงื่อนไขว่าผู้ใช้จะต้องมีการใช้ค าสั่งก่อน จึงจะสามารถยกเลิกการใช้ค าสั่ง

ได ้ การยกเลิกค าสั่งสามารถท าได้ 4 วิธี ดังนี ้
o การใช้ปุ่ม Undo จากแถบเครื่องมือ Advanced Digitizing มีขั้นตอนดังนี ้

1) ผู้ใช้อยู่ในโหมดการแก้ไข และมีการใช้ค าสั่งในการน าเข้าหรือแก้ไข
ข้อมูลอย่างน้อย 1 ค าสั่ง ในตัวอย่างนี้ สมมุติว่าใช้ค าสั่งการย้ายต าแหน่ง Vertex 

2) คลิกปุ่ม Undo (    ) (ปุ่ม Undo จะสามารถใช้งานได้เมื่อมี
การใช้ค าสั่งในการน าเข้าหรือแก้ไขข้อมูลอย่างน้อย 1 ค าสั่ง) 

 

 
 

เปิดโหมดแก้ไข 

ต าแหน่งของ Vertex เดิม 

ปุ่ม Undo ไม่สามารถใช้ได ้

ปุ่ม Undo สามารถใช้ได ้

เครื่องมือ Node tool 

1. ย้าย Vertex 
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o การใช้หน้าต่าง History widget จะมีลักษณะของเงื่อนไขในการใช้งานค าสั่ง

เหมือนกับ การใช้ค าสั่ง Undo จากแถบเครื่องมือ Advanced Digitizing นั้นคือผู้ใช้อยู่ในโหมดการแก้ไข และ
มีการใช้ค าสั่งในการน าเข้าหรือแก้ไขข้อมูลอย่างน้อย 1 ค าสั่ง ในตัวอย่างนี้ สมมุติให้ผู้ใช้ได้ใช้ค าสั่งการย้าย
ต าแหน่ง Vertex 1 ครั้ง และต้องการยกเลิกค าสั่งด้วยหน้าต่าง History widget ซึ่งสามารถท าได้ดังนี ้

1) เปิดหน้าต่าง History widget โดยคลิกเมนู View > Panels > 
Undo/Redo 

2) คลิกรายการค าสั่งที่ต้องการย้อนกลับไป 
 

2. คลิกปุ่ม Undo 

ต าแหน่งของ Vertex ใหม ่

Vertex ย้ายกลับไปยังต าแหน่งเดิม 
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o การใช้เมนู โดยการคลิกเมนู Edit > Undo 

1. เปิดหน้าตา่ง History widget 

2. คลิกรายการค าสั่งที่ต้องการย้อนสถานะ 

Vertex ที่อยู่ในต าแหน่งปัจจุบัน 

Vertex ย้ายไปยังต าแหน่งเดิม 

รายการค าสั่งล่าสุด 
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o การใช้แป้นลัด โดยกดปุ่ม Ctrl + Z บนแผงแป้นอักขระ 

 การท าค าสั่งซ้ า (Redo) 
ค าสั่ง Redo เป็นค าสั่งส าหรับกระท าซ้ าค าสั่งที่ได้กระท าไป มีขั้นตอนการใช้งานเหมือนกับ

การใช้ค าสั่งยกเลิก สามารถท าได้ 4 วิธี ดังนี ้

o การใช้ปุ่ม Redo (  ) จากแถบเครื่องมือ Advanced Digitizing 
o การใช้หน้าต่าง History widget 
o การใช้เมนู โดยการคลิกเมนู Edit > Redo 
o การใช้แป้นลัด โดยกดปุ่ม Ctrl + Shift + Z บนแผงแป้นอักขระ 

 การสร้างฟีเจอร์ย่อยของช้ันข้อมูลประเภทรูปหลายเหลี่ยม (Add Part) 
ฟีเจอร์แบบ Multipart หมายถึง ฟีเจอร์ที่ประกอบด้วยส่วนย่อย ๆ (Geometrical part) 

มากกว่าหนึ่งส่วน เช่น ฟีเจอร์จังหวัดภูเก็ตจะประกอบเกาะภูเก็ตและเกาะต่าง ๆ ที่อยู่ในเขตการปกครองของ
จังหวัดภูเก็ต จึงท าใหฟ้ีเจอร์จังหวัดภูเก็ตจะประกอบด้วยรูปหลายเหลี่ยมมากกว่า 1 รูป แต่จะมีข้อมูลลักษณะ
ประจ าปรากฏเป็นแถวเดียว (Single record) ในตารางข้อมูลลักษณะประจ าของชั้นข้อมูล การสร้างฟีเจอร์
ย่อยมีขั้นตอนดังนี ้

1) เปิดโหมดการแก้ไขข้อมูลให้กับชั้นข้อมูล โดยการคลิกที่ชั้นข้อมูล จากนั้นคลิกปุ่ม Toggle 
editing 

2) สร้างฟีเจอรย์่อยรูปที่ 1 โดยใช้เครื่องมือ Capture Polygon 
3) เลือกฟีเจอรท์ี่ต้องการสร้างฟีเจอร์ย่อย 

4) คลิกปุ่ม Add Part (   ) 
5) สร้างฟีเจอรย์่อยรูปที่ 2 โดยใช้เครื่องมือ Capture Polygon 
6) คลิกปุ่ม Save edits 
7) ปิดโหมดการแก้ไขข้อมูล 
 
 

 
2. สร้างฟีเจอร์ย่อยรูปที่ 1 

1. เปิดโหมดการแก้ไขข้อมูล 
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3. เลือกฟีเจอร์ที่ต้องการ
เพิ่มฟีเจอร์ย่อย 

4. คลิกปุ่ม Add Part 

5. สร้างฟีเจอร์ย่อยรูปที่ 2 
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หมายเหตุ: การน าเข้าข้อมูลฟีเจอร์ย่อย (Part) ผู้ใช้จ าเป็นต้องเลือก (Select) ฟีเจอร์ที่

ต้องการสร้างฟีเจอร์ย่อยก่อน มิฉะนั้น โปรแกรมจะแสดงหน้าต่างแจ้งข้อความผิดพลาดดังภาพ  
 

 
 
นอกจากนี้ หลังจากการสร้างฟีเจอร์ย่อยแล้ว โปรแกรมจะแสดงหน้าต่างแจ้งข้อความ

ผิดพลาด ซึ่งเกิดจากจุดบกพร่อง (Bug) ของโปรแกรม และผู้ใช้ไม่สามารถแก้ไขไดด้้วยตนเอง จึงให้ผู้ใช้คลิกปุ่ม 
OK เพื่อปิดหน้าต่างเพียงเท่านั้น 

 

 

6. คลิกปุ่ม Save edits 

7. คลิกปุ่ม Toggle editing 

ข้อมูลในตารางมี 1 แถว แต่
มีฟีเจอร์ย่อย 2 รูปถูกเลือก 
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 การลบฟีเจอร์ย่อย (Delete Part) มีขั้นตอนดังนี ้
1) เปิดโหมดการแก้ไขข้อมูลให้กับชั้นข้อมูล โดยการคลิกที่ชั้นข้อมูล จากนั้นคลิกปุ่ม Toggle 

editing 
2) คลิกปุ่ม Delete Part 
3) คลิกบน Vertex ของฟีเจอร์ย่อยที่ต้องการลบ 
4) คลิกปุ่ม Save edits 
5) ปิดโหมดการแก้ไขข้อมูล 
 
 

 
 
 
 

 
 
 
 
 

1. คลิกปุ่ม Toggle editing 

2. คลิกปุ่ม Delete Part 

3. คลิกบน Vertex 

4. คลิกปุ่ม Save edits 

5. คลิกปุ่ม Toggle editing MAHID
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 การสร้างรูปหลายเหลี่ยมแบบโดนัท (Add Ring) 
รูปหลายเหลี่ยมแบบโดนัท หมายถึง รูปหลายเหลี่ยมที่มีช่องหรือรูอยู่ภายใน มักจะใช้งาน

ร่วมกับฟีเจอร์ย่อย (Multipart) เพื่อสร้างข้อมูลที่มีความซับซ้อน เช่น เกาะที่ตั้งอยู่ในทะเลสาบ เป็นต้น การ
สร้างรูปหลายเหลี่ยมแบบโดนัทมีขั้นตอนดังนี ้

1) เปิดโหมดการแก้ไขข้อมูลให้กับชั้นข้อมูล โดยการคลิกที่ชั้นข้อมูล จากนั้นคลิกปุ่ม Toggle 
editing  

2) สร้างฟีเจอร์ โดยใช้เครื่องมือ Capture Polygon 

3) คลิกปุ่ม Add Ring (   ) 
4) สร้างรูปหลายเหลี่ยมภายในรูปหลายเหลี่ยมที่สร้างขึ้นในขั้นตอนที่ 2 

5) สร้างฟีเจอร์ย่อย โดยใช้เครื่องมือ Add Part (    ) 
6) คลิกปุ่ม Save edits 
7) ปิดโหมดการแก้ไขข้อมูล โดยคลิกปุ่ม Toggle editing 
 
 
 

 
 
 
 

1. คลิกปุ่ม Toggle editing 

2. สร้างฟเีจอร์ MAHID
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3. คลิกปุ่ม Add Ring 

4. สร้างโดนัท 

5. สร้างฟเีจอร์ย่อยภายในโดนัท 

6. คลิกปุ่ม Save edits 

7. คลิกปุ่ม Toggle editing 
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 การลบรูปหลายเหลี่ยมแบบโดนัท (Delete Ring) 
1) เปิดโหมดการแก้ไขข้อมูลให้กับชั้นข้อมูล โดยการคลิกที่ชั้นข้อมูล จากนั้นคลิกปุ่ม Toggle 

editing  

2) คลิกปุ่ม Delete Ring (   ) 
3) คลิกบน Vertex ของโดนัท 
4) คลิกปุ่ม Save edits 
5) ปิดโหมดการแก้ไขข้อมูล โดยคลิกปุ่ม Toggle editing 

 
 
 

 
 
 
 
 

 
 

1. คลิกปุ่ม Toggle editing 

3. คลิก Vertex ของโดนัท 

2. คลิกปุ่ม Delete Ring 

4. คลิกปุ่ม Save edits 

5. คลิกปุ่ม Toggle editing MAHID
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 การลดความละเอียดของข้อมูลเชิงต าแหน่งของฟีเจอร์ (Simplify Feature) 
การจัดเก็บข้อมูลที่มีความละเอียดมากเกินความจ าเป็นจะท าให้ต้องใช้เนื้อที่ในการจัดเก็บ

ข้อมูลมาก และการแสดงและ/หรือการประมวลผลข้อมูลช้า ดังนั้น ผู้ใช้สามารถลดความละเอียดข้อมูลลง 
เพื่อให้การท างานมีประสิทธิภาพมากขึ้น ขั้นตอนการลดความละเอียดของข้อมูลเชิงต าแหน่งของฟีเจอรม์ีดังน้ี  

1) เปิดโหมดการแก้ไขข้อมูลให้กับชั้นข้อมูล โดยการคลิกที่ชั้นข้อมูล จากนั้นคลิกปุ่ม Toggle 
editing  

2) คลิกปุ่ม Simplify Feature (    ) 
3) คลิกบน Vertex ของฟีเจอร์ ในตัวอย่างนี้ เป็นชั้นข้อมูลประเภทเส้น แต่ค าสั่ง Simplify 

Feature สามารถใช้กับช้ันข้อมูลของฟีเจอร์รูปหลายเหลี่ยมได้เช่นเดียวกัน 
4) ในหน้าต่าง Simplify line tolerance ให้เลื่อนขีด Set tolerance เพื่อลดความละเอียด

ของข้อมูลเชิงต าแหน่งของฟีเจอร ์(ความละเอียดของฟีเจอร์จะลดลงมากขึ้น เมื่อเลื่อนขีดไปทางขวา) 
5) คลิกปุ่ม OK ในหน้าต่าง Simplify line tolerance 
6) คลิกปุ่ม Save edits 
7) ปิดโหมดการแก้ไขข้อมูล โดยคลิกปุ่ม Toggle editing 
 
 
 

 
 

1. คลิกปุ่ม Toggle editing 

3. คลิกบน Vertex 

2. คลิกปุ่ม Simplify Feature 
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4. เลื่อนขีด Tolerance 

ระดับรายละเอียดของฟเีจอร์เปลี่ยนแปลงไป 

6. คลิกปุ่ม Save edits 

7. คลิกปุ่ม Toggle editing 

ฟีเจอร์ที่มีความละเอียดลดลง 

5. คลิกปุ่ม OK 
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 การปรับเปลี่ยนรูปร่างของฟีเจอร์ (Reshape Features) 
ค าสั่งปรับเปลี่ยนรูปร่างของฟีเจอร์เป็นค าสั่งที่สามารถใช้ได้กับฟีเจอร์ประเภทเส้นและรูป

หลายเหลี่ยม การเปลี่ยนแปลงรูปร่างของฟีเจอร์เกิดจากผู้ใช้ดิจิไทซ์เส้น (Reshapeline) ให้ตัดกับฟีเจอร์ที่
ต้องการในชั้นข้อมูลอย่างน้อย 2 จุด โปรแกรมจะสร้างโหนด (Node) ที่จุดที่เส้นตัดกัน และรูปร่างของฟีเจอร์
จะเปลี่ยนแปลงไปตามเส้นที่ดิจิไทซ์ ทั้งนี้ ผู้ใช้ไม่สามารถดิจิไทซ์เส้นให้ตัดผ่านรูปหลายเหลี่ยมมากกว่า 1 รูป 
เพราะจะท าให้เกิดความผิดพลาดในการน าเข้าหรือแก้ไขข้อมูล 

การปรับเปลี่ยนรูปร่างของฟีเจอร์อาจจะใช้แก้ไขเส้นทางน้ า หรือแนวเขตการปกครอง เป็น
ต้น ในตัวอย่างนี้จะสาธิตการปรับเปลี่ยนรูปร่างของฟีเจอร์ประเภทเส้น ซึ่งมีขั้นตอนดังนี้ 

1) เปิดโหมดการแก้ไขข้อมูลให้กับชั้นข้อมูล โดยการคลิกที่ชั้นข้อมูล จากนั้นคลิกปุ่ม Toggle 
editing  

2) คลิกปุ่ม Reshape Features (    ) 
3) สร้างเส้น (Reshapeline) ให้ตัดกับฟีเจอร์ที่ต้องการเปลี่ยนแปลงรูปร่าง (เส้นต้องตัดผ่าน

ฟีเจอร์อย่างน้อย 2 จุด) 
4) คลิกปุ่ม Save edits 
5) ปิดโหมดการแก้ไขข้อมูล โดยคลิกปุ่ม Toggle editing 
 
 

 
 

1. คลิกปุ่ม Toggle editing 

3. สร้างเส้นให้ตัดกับฟีเจอร์ 

2. คลิกปุ่ม Reshape Features 

คลิกสร้าง Vertex ที ่1  

คลิกสร้าง Vertex ที ่2 

คลิกสร้าง Vertex ที ่3  

คลิกสร้าง Vertex ที ่4 
และคลิกขวาเพื่อสิน้สุด

การสร้างเสน้  MAHID
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 การตัดแบ่งฟีเจอร์ (Split Features) 
ค าสั่งตัดแบ่งฟีเจอร์เป็นค าสั่งที่ให้ผู้ใช้สร้างเส้นเพื่อตัดแบ่งฟีเจอร์ประเภทเส้นหรือรูปหลาย

เหลี่ยมออกเป็น 2 ฟีเจอร์ การตัดแบ่งฟีเจอร์อาจจะใช้ส าหรับตัดแบ่งถนน หรือการตัดแบ่งขอบเขตการ
ปกครองใหม่จากขอบเขตการปกครองที่มีอยู่เดิม เป็นต้น ในตัวอย่างนี้จะสาธิตการตัดแบ่งฟีเจอร์ประเภทเส้น 
ซึ่งมีขั้นตอนดังนี ้

1) เปิดโหมดการแก้ไขข้อมูลให้กับชั้นข้อมูล โดยการคลิกที่ชั้นข้อมูล จากนั้นคลิกปุ่ม Toggle 
editing  

2) คลิกปุ่ม Split Features (    ) 
3) สร้างเส้นให้ตัดกับฟีเจอร์ที่ต้องการตัดแบ่งฟีเจอร์ (ถ้าต้องการตัดแบ่งฟีเจอร์ประเภทเส้น

ต้องสร้างเส้นให้ตัดผ่านฟีเจอร์อย่างน้อย 1 จุด แต่ถ้าเป็นฟีเจอร์ประเภทรูปหลายเหลี่ยมต้องสร้างเส้นให้ตัด
ผ่านฟีเจอร์อย่างน้อย 2 จุด และต้องเป็นเส้นที่ตัดแบ่งรูปหลายเหลี่ยมออกเป็น 2 ส่วน) 

4) คลิกปุ่ม Save edits 
5) ปิดโหมดการแก้ไขข้อมูล โดยคลิกปุ่ม Toggle editing 

 
 

4. คลิกปุ่ม Save edits 

5. คลิกปุ่ม Toggle editing 

รูปร่างของฟีเจอร์ที่เปลี่ยนแปลงไป
ตามเส้นทีผู่้ใชด้ิจิไทซ์  
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1. คลิกปุ่ม Toggle editing 

ชั้นข้อมูลมี 1 ฟีเจอร ์

คลิกสร้าง Vertex ที ่1 

คลิกสร้าง Vertex ที ่2 
และคลิกขวาเพื่อสิน้สุด

การสร้างเสน้  

2. คลิกปุ่ม 
Split Features 

ชั้นข้อมูลมี 2 ฟีเจอร ์

3. สร้างเส้นให้ตัดกับฟีเจอร์ 

4. คลิกปุ่ม Save edits 5. คลิกปุ่ม Toggle editing 
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 การผสานฟีเจอร์เข้าด้วยกัน (Merge Selected Features) 
ค าสั่งผสานฟีเจอร์ใช้ส าหรับรวมข้อมูลเชิงพื้นที่และข้อมูลลักษณะประจ าของฟีเจอร์ที่อยู่

ติดกันเข้าด้วยกัน ในกรณีที่ใช้ค าสั่งผสานฟีเจอร์กับฟีเจอร์ไม่อยู่ติดกัน โปรแกรมจะสร้างฟีเจอร์แบบ 
Multipart แทน 

การผสานฟีเจอร์สามารถใช้ในการรวมฟีเจอร์ที่อยู่ในแผนที่ระวางติดกันเข้าด้วยกัน เช่น ถนน 
ขอบเขตการปกครอง เป็นต้น ในตัวอย่างนี้จะสาธิตการผสานฟีเจอร์ถนนที่เป็นถนนเส้นเดียวกันเข้าด้วยกัน ซึ่ง
มีขั้นตอนดังนี ้

1) เปิดโหมดการแก้ไขข้อมูลให้กับชั้นข้อมูล โดยการคลิกที่ชั้นข้อมูล จากนั้นคลิกปุ่ม Toggle 
editing  

2) คลิกเครื่องมือ Select single feature (    ) บนแถบเครื่องมือ Attribute (หรือ
เครื่องมือการเลือกฟีเจอร์อื่น ๆ) 

3) คลิกเลือกฟีเจอร์ที่ต้องการผสาน 

4) คลิกปุ่ม Merge selected features (    ) 
5) ในหน้าต่าง Merge feature attributes ให้ก าหนดวิธีการผสานค่าข้อมูลลักษณะประจ า

ของฟีเจอร์ โดยผู้ใช้สามารถก าหนดวิธีผสานค่าเป็นรายคอลัมน์ ซึ่งวิธีที่ใช้ในการผสานค่าข้อมูลจะแตกต่างกัน
ตามประเภทของเขตข้อมูล เช่น เขตข้อมูลประเภทจ านวนจริง (Real) จะสามารถค านวณค่าสูงสุด ค่าต่ าสุด 
ค่ามัธยฐาน และค่าเฉลี่ย  หรือเขตข้อมูลประเภทข้อความ (Text) จะสามารถต่อข้อความกันได ้
(Concatenate) เป็นต้น นอกจากนี้ ผู้ใช้สามารถใช้ค่าข้อมูลลักษณะประจ าทั้งหมดของฟีเจอร์ใดฟีเจอร์หนึ่ง
แทนค่าข้อมูลของฟีเจอร์ที่ได้จากการผสาน โดยการคลิกเลือกแถวของฟีเจอร์ที่ต้องการใช้ค่าข้อมูลลักษณะ
ประจ า จากนั้นคลิกปุ่ม Take attributes from selected feature 

6) คลิกปุ่ม OK 
7) คลิกปุ่ม Save edits 
8) ปิดโหมดการแก้ไขข้อมูล โดยคลิกปุ่ม Toggle editing 
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2. คลิกปุ่ม Select single feature 

4. คลิกปุ่ม Merge selected features 

3. คลิกเลือกฟีเจอร์ที่จะผสาน 

1. คลิกปุ่ม Toggle editing 

5. คลิกเลือกวธิีการผสาน
ข้อมูลลักษณะประจ า 

ผลลัพธ์ของการผสานค่าข้อมูล
แบบต่อข้อความ 

 

 

6. คลิกปุ่ม OK 
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ผลลัพธ์ของการผสานค่าข้อมูล
แบบค่าเฉลี่ย 

 

ตัวอย่างวิธีการผสาน
ค่าข้อมลูแบบค่าเฉลี่ย 

 

ฟีเจอร์ที่ถูกเลอืกใช้
ค่าข้อมลู 

ตัวอย่างวิธีการผสานค่าข้อมูล
โดยการใช้ค่าข้อมูลทั้งหมดจาก

ฟีเจอร์ใดฟเีจอร์หนึ่ง 

คลิกปุ่ม Take attributes 
from selected feature 
เพื่อใช้ค่าข้อมลูของฟีเจอรท์ี่

เลือก 
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 การผสานข้อมูลลักษณะประจ าของฟีเจอร์เข้าด้วยกัน (Merge Attributes of Selected 
Features) 

ค าสั่งผสานฟีเจอร์ใช้ส าหรับผสานข้อมูลลักษณะประจ าของฟีเจอร์เข้าด้วยกัน การผสาน
ข้อมูลลักษณะประจ าของฟีเจอร์เข้าด้วยกันมีขั้นตอนดังนี ้

1) เปิดโหมดการแก้ไขข้อมูลให้กับชั้นข้อมูล โดยการคลิกที่ชั้นข้อมูล จากนั้นคลิกปุ่ม Toggle 
editing  

2) คลิกเครื่องมือ Select single feature (    ) บนแถบเครื่องมือ Attribute (หรือ
เครื่องมือการเลือกฟีเจอร์อื่น ๆ) 

3) คลิกเลือกฟีเจอร์ที่ต้องการผสาน 

4) คลิกปุ่ม Merge attributes of selected features (   ) (หมายเหตุ: เครื่องมือ 
Merge selected features และ Merge attributes of selected features มีสัญรูปเหมือนกัน ซึ่งถือเป็น
จุดบกพร่องของโปรแกรม QGIS รุ่น 1.7.3) 

5) ในหน้าต่าง Merge feature attributes ให้ก าหนดวิธีการผสานค่าข้อมูลลักษณะประจ า
ของฟีเจอร์ ซึ่งมีวิธีการเหมือนกับการใช้เครื่องมือ Merge selected features 

6) คลิกปุ่ม OK 

7. คลิกปุ่ม Save edits 8. คลิกปุ่ม Toggle editing 

ฟีเจอร์ที่ถูกผสาน 

ข้อมูลลักษณะประจ าของฟีเจอร์ที่ถูกผสาน 
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7) คลิกปุ่ม Save edits 
8) ปิดโหมดการแก้ไขข้อมูล โดยคลิกปุ่ม Toggle editing 

 
 

 
 
 

 
 

2. คลิกปุ่ม Select single feature 

4. คลิกปุ่ม Merge attributes of 
selected features 

3. คลิกเลือกฟีเจอร์ที่จะผสาน 

1. คลิกปุ่ม Toggle editing 

5. ก าหนดวิธีการผสานค่าขอ้มูล 

 

6. คลิกปุ่ม OK 
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 การเปลี่ยนทิศทางของสัญลักษณ์ประเภทจุด (Rotate Point Symbols) 
เครื่องมือเปลี่ยนทิศทางของสัญลักษณ์ประเภทจุดใช้ส าหรับหมุนหรือปรับเปลี่ยนทิศทางของ

สญัลักษณ์ประเภทจุดบนแผนที่ ทั้งนี้ เครื่องมือนี้จะรองรับการท างานกับระบบก าหนดสัญลักษณ์ของช้ันข้อมูล
แบบเดิม (Old symbology) โดยชั้นข้อมูลที่ต้องการแก้ไขทิศทางของสัญลักษณจ์ะต้องมีการก าหนดค่าข้อมูล
ลักษณะประจ า (Rotation column) ทีใ่ช้ในการหมุน/เปลี่ยนทิศทางของสัญลักษณ์ ถา้ไม่มีการก าหนด จะไม่
สามารถใช้เครือ่งมือนี้ได้ 

การเปลี่ยนทิศทางของสัญลักษณ์ประเภทจุดมีขั้นตอนดังนี้ 
1) เปลี่ยนระบบก าหนดสัญลกัษณ์ของช้ันข้อมูลเป็นระบบเก่า (Old symbology) โดยคลิก

ปุ่ม Old symbology  
2) คลิกปุ่ม OK เพื่อยืนยันการใช้ระบบก าหนดสัญลักษณ์ของชั้นข้อมูลแบบเดิม 
3) ก าหนดเขตข้อมูลจากตารางข้อมูลลักษณะประจ า (Rotation column) ที่ใช้ในการหมุน/

เปลี่ยนทิศทางของสัญลักษณ ์
4) คลิกปุ่ม OK ในหน้าต่าง Layer Properties 
5) เปิดโหมดการแก้ไขข้อมูลให้กับชั้นข้อมูล โดยการคลิกที่ชั้นข้อมูล จากนั้นคลิกปุ่ม Toggle 

editing  

7. คลิกปุ่ม Save edits 8. คลิกปุ่ม Toggle editing 

ข้อมูลลักษณะประจ าของฟีเจอร์ที่ถูกผสาน 
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6) คลิกเครื่องมือ Rotate Point Symbols (    ) 
7) คลิกบนฟีเจอร์ที่ต้องการหมุนหรือปรับเปลี่ยนทิศทาง และลากหมุนตัวชี้ต าแหน่งเมาส์ไป

ยังทิศทางที่ต้องการ 
8) คลิกปุ่ม Save edits 
9) ปิดโหมดการแก้ไขข้อมลู โดยคลิกปุ่ม Toggle editing 
 
 

 

 
 
 

 
 

2. คลิกปุ่ม OK 

1. คลิกปุ่ม Old symbology 
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3. ก าหนดเขตข้อมูลที่ใช้ในการหมุน/
เปลีย่นทิศทางของสัญลักษณ์ 

 

4. คลิกปุ่ม OK 

สัญลักษณป์ระเภทจุดมีทิศทาง
ตามเขตข้อมลูทีก่ าหนด 
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8. คลิกปุ่ม Save edits 9. คลิกปุ่ม Toggle editing 

ข้อมูลลักษณะประจ าของ
ฟีเจอร์ที่เปลี่ยนแปลงไป 

5. คลิกปุ่ม Toggle editing 

6. คลิกเครื่องมือ Rotate 
Point Symbols 

7. คลิกและลากหมุนตัวชี้ต าแหน่ง
เมาส์ไปยังทศิทางที่ต้องการ 
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8. การน าเข้าข้อมูลจากแฟ้มข้อความ 
 ในการจัดท าฐานข้อมูลระบบสารสนเทศภูมิศาสตร์ ผู้ใช้อาจจะพบว่าข้อมูลที่ต้องการน ามาจัดเก็บใน
ฐานข้อมูลอาจจะเป็นข้อมูลในเอกสารหรือรายงานต่าง ๆ ข้อมูลประเภทนี้ส่วนใหญ่จะเป็นข้อมูลจุดส ารวจที่มี
การอ้างอิงต าแหน่งพิกัดและอยู่ในรูปของตารางข้อมูล ดังนั้น แต่ละแถวของตารางข้อมูลคือฟีเจอร์ และแต่ละ
สดมภ์ของตารางข้อมูลจะจัดเก็บข้อมูลลักษณะประจ าของฟีเจอร์ (โดยปกติ แต่ละแถวจะประกอบด้วยค่า
ข้อมูลอย่างน้อย 2 ค่า เนื่องจากการจัดเก็บฟีเจอร์ประเภทจุดจ าเป็นต้องมีค่าพิกัด X และ Y อย่างไรก็ตาม แต่
ละแถวอาจจะจัดเก็บข้อมูลอื่น ๆ ได้ เช่น ล าดับที่ของจุดส ารวจ ชื่อของจุดส ารวจ ฯลฯ) 
 ตารางข้อมูลสามารถจัดเก็บในรูปแบบของแฟ้มข้อความ (Text file) และสามารถน ามาสร้างเป็นชั้น
ข้อมูลในโปรแกรม QGIS ได้โดยใช้โปรแกรมเสริมที่ชื่อ Add Delimited Text Layer การน าเข้าข้อมูลจาก
แฟ้มข้อความมีขั้นตอนดังนี ้

1) คลิกเมนู Layer > Add Delimited Text Layer (ถ้าผู้ใช้ไม่พบค าสั่ง Add Delimited Text 
Layer ในเมนู Layer ผู้ใช้จ าเป็นต้องเปิดการใช้งานโปรแกรมเสริม โดยคลิกเมนู Plugins > Manage Plugins 
และให้คลิกกล่องตัวเลือก Add Delimited Text Layer ให้มีเครื่องหมายกากบาท) 

2) ในช่อง File Name ของหน้าต่าง Create a Layer from a Delimited Text File ให้ระบุแฟ้ม
ข้อความที่จัดเก็บในรูปแบบ *.txt หรือ *.csv ที่ต้องการน าเข้าข้อมูล 

3) ในช่อง Layer name ให้ก าหนดช่ือชั้นข้อมูลที่เป็นผลลัพธ์จากการน าเข้าข้อมูล 
4) ก าหนดประเภทของอักขระคั่น (Delimiter) ในตัวอย่างนี้แฟ้มข้อความใช้อักขระแท็บเป็นอักขระ

คั่น จึงให้คลิกตัวเลือก Selected delimiters คลิกกล่องตัวเลือก Tab (ในการจัดเก็บข้อมูลแบบแฟม้ข้อความ 
ค่าของข้อมูลในแต่ละแถวจะคั่นด้วยอักขระคั่น เช่น อักขระแท็บ (Tab), อักขระว่าง (Space), เครื่องหมาย
จุลภาค (Comma), เครื่องหมายอัฒภาค (Semicolon) หรือเครื่องหมายโคลอน (Colon) เป็นต้น ในกรณีที่
แฟ้มข้อความใช้อักขระคั่นอ่ืน ๆ ที่นอกเหนือจากตัวเลือกที่โปรแกรม QGIS จัดเตรียมไว้ให้ ผู้ใชส้ามารถใช้
ตัวเลือก Plain characters หรือ Regular expression เพื่อก าหนดอักขระคั่นเฉพาะได้ตามความต้องการของ
ผู้ใช ้

5) ในช่อง Start import at row ให้ผู้ใช้ก าหนดแถวข้อมลูที่เป็นจุดเริ่มต้นของการน าเข้าข้อมูล ถ้าตั้ง
การน าเข้าแถวข้อมูลทั้งหมดให้ระบุค่าเป็นศูนย์ ซึ่งเป็นค่าเริ่มต้นของโปรแกรม 

6) ระบเุขตข้อมูลทีใ่ช้จัดเก็บค่าพิกัดของฟีเจอร์ ในตัวอยา่งนี้ ค่าพิกัดของฟีเจอร์จัดเก็บเป็นเขตข้อมูล
แยกจากกัน และใช้ช่ือเขตข้อมูลว่า X และ Y เพื่อจัดเก็บค่าพิกัดตามแกน X และ Y ตามล าดับ จึงใช้ตัวเลือก 
X Y field และก าหนดค่า X field เท่ากับ X และ Y field เท่ากับ Y  ในกรณีที่จัดเกบ็ข้อมูลค่าพิกัด X,Y ใน
รูปแบบ Well-known text (WKT) ให้ใช้ตัวเลือก WKT field และระบุเขตข้อมูลที่จัดเก็บค่าพิกัด 

7) คลิกปุ่ม OK 
8X ในหน้าต่าง Coordinate Reference System Selector ให้เลือกระบบพิกัดของชั้นข้อมูล 
9) คลิกปุ่ม OK 
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3. ก าหนดชื่อชั้นข้อมูล 

1. คลิกเมนู Layer > Add Delimited Text Layer 

 

2. ระบุแฟ้มขอ้ความ
ที่ต้องการน าเข้า 

ตัวอย่างตารางข้อมูลที่
ได้จากการน าเข้า 

 

6. ระบุเขตข้อมูลที่จัดเก็บค่าพิกัด 

 

5. ก าหนดจุดเริ่มต้นของการน าเข้าข้อมูล 

7. คลิกปุ่ม OK 

4. ก าหนดประเภท
อักขระคั่น 
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8. ก าหนดระบบพิกัดของชัน้ข้อมูล 

ฟีเจอร์ที่ได้จากการน าเข้า
ข้อมูลจากแฟม้ข้อความ 

9. คลิกปุ่ม OK 

ชั้นข้อมูลที่ไดจ้ากการน าเขา้ข้อมูล 
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บทที่ 7 การท างานกับข้อมูลแรสเตอร์ 

ข้อมูลแรสเตอร์เป็นแบบจ ำลองข้อมูลที่จัดเก็บข้อมูลในรูปจุดภำพ (Pixel) ที่เรียงต่อเนื่องกันเป็นชั้น
ข้อมูล แต่ละจุดภำพจะจัดเก็บค่ำของข้อมูล ข้อมูลแรสเตอร์ เช่น รูปถ่ำยทำงอำกำศ หรือภำพจำกดำวเทียม
นับเป็นแหล่งข้อมูล (Data source) ที่นิยมใช้ในกำรน ำเข้ำข้อมูลสู่ฐำนข้อมูลระบบสำรสนเทศภูมิศำสตร์ 
นอกจำกนี้ ควำมง่ำยของโครงสร้ำงข้อมูล จึงท ำให้สำมำรถใช้ข้อมูลแรสเตอร์ในกำรท ำแบบจ ำลองที่มีควำม
ซับซ้อนได้ด ี

ในบทนี้ จะกล่ำวถึงกำรท ำงำนกับข้อมูลแรสเตอร์ในด้ำนกำรแสดงข้อมูล กำรก ำหนดพิกัดภำพของ
ข้อมูลแรสเตอร์ และกำรวิเครำะห์ข้อมูลแบบแรสเตอร ์ซึ่งมีรำยละเอียดดังนี ้

1. การก าหนดคุณสมบัติของชั้นข้อมูลแรสเตอร์ 
 ในกำรท ำงำนกับข้อมูลแรสเตอร์ ผู้ใช้จ ำเป็นต้องเพิ่มชั้นข้อมูลแรสเตอร์ด้วยกำรคลิกปุ่ม Add Raster 

Layer (  ) หรือคลิกเมนู Layer > Add Raster Layer หรือใช้แป้นลัดโดยกด Ctrl + Shift + R เพื่อ
แสดงข้อมูลในพื้นที่แสดงข้อมูลแผนที่ (Map View) ก่อน ซึ่งได้กล่ำวรำยละเอียดไว้แล้วในบทที่ 3 ภำยใต้
หัวข้อ “กำรเพิ่มชั้นข้อมูลแรสเตอร์” เมื่อผู้ใช้เพิ่มชั้นข้อมูลแล้ว ผู้ใช้จะสำมำรถก ำหนดคุณสมบัติของชั้นข้อมูล
ในลักษณะต่ำง ๆ เช่น กำรก ำหนดชื่อชั้นข้อมูล กำรก ำหนดช่วงของมำตรำส่วนที่ต้องกำรแสดงชั้นข้อมูล กำร
ก ำหนดลักษณะกำรแสดงข้อมูล กำรก ำหนดควำมโปร่งใสในกำรแสดงข้อมูล หรือกำรสร้ำงพีระมิดของชั้น
ข้อมูล เป็นต้น เพื่อให้กำรแสดงข้อมูลมีควำมถูกต้อง เหมำะสม และมีประสิทธิภำพ หรือจะสำมำรถศึกษำ 
ลักษณะของชั้นข้อมูล เช่น กำรดูข้อมูลฮิสโทแกรม เพื่อที่จะท ำให้กำรแสดง กำรประมวลผลหรือกำรวิเครำะห์
ข้อมูลเป็นไปอย่ำงถูกต้อง 

ผู้ใช้สำมำรถก ำหนดคุณสมบัติของชั้นข้อมูลแรสเตอร์ไดจ้ำกหน้ำต่ำง Layer Properties ทั้งนี้ กำรเปิด
หน้ำต่ำง Layer Properties ของชั้นข้อมูลแรสเตอร์จะมีวิธีกำรเหมือนกับชั้นข้อมูลเวกเตอร์ ซึ่งได้กล่ำว
รำยละเอียดไว้แล้วในบทที่ 4 ภำยใต้หัวข้อ “กำรเปิดหน้ำต่ำง Vector Properties” กำรก ำหนดคุณสมบัติของ
ชั้นข้อมูลแรสเตอร์มีรำยละเอียดดังนี ้

1.1 กำรก ำหนดคุณสมบัติของชั้นข้อมูลแรสเตอร์ในแท็บ General 
 แท็บ General ในหน้ำต่ำง Layer Properties มีไว้ส ำหรับกำรก ำหนดคุณสมบัติทั่ว ๆ ไป 

เช่น กำรก ำหนดชื่อชั้นข้อมูล หรือกำรก ำหนดช่วงของมำตรำส่วนที่ต้องกำรแสดงชั้นข้อมูล (Scale range) 
และยังแสดงข้อมูลเบื้องต้นเกี่ยวกับชั้นข้อมูล ได้แก่ สถำนที่จัดเก็บข้อมูล (Layer source) จ ำนวนแถวและ
คอลัมน์ของข้อมูล (Row and Column) และระบบพิกัด (Coordinate reference system) รวมทั้งภำพ
ตัวอย่ำง สัญลักษณ์ของช้ันข้อมูล และชุดสีส ำหรับแสดงผลข้อมูล 
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ผู้ใช้สำมำรถศึกษำรำยละเอียดวิธีกำรก ำหนดค่ำต่ำง ๆ ได้จำกบทที่ 4 ภำยใต้หัวข้อ “กำร
ก ำหนดชื่อช้ันข้อมูล” และ “กำรก ำหนดช่วงของมำตรำส่วนที่ต้องกำรแสดงช้ันข้อมูล” 

1.2 กำรดูข้อมูลเกี่ยวกับชั้นข้อมูลแรสเตอร์ในแท็บ Metedata 
แท็บ Metedata เป็นแท็บที่แสดงรำยละเอียดข้อมูลต่ำง ๆ เกี่ยวกับชั้นข้อมูล เช่น สถำนที่

จัดเก็บข้อมูล ประเภทและค่ำสถิติของแบนด์ข้อมูล จ ำนวนและขนำดจุดภำพ ค่ำพิกัดของจุดเริ่มต้นของชั้น
ข้อมูล ค่ำที่แสดงว่ำไม่มีข้อมูลในจุดภำพ (No data value) ชนิดข้อมูลในจุดภำพ ข้อมูลเกี่ยวกับพีระมิด ระบบ
พิกัด ขอบเขตพ้ืนที่ของช้ันข้อมูล (Layer extent) และข้อมูลสถิติของแบนดข์้อมูล 

กำรดูข้อมูลเกี่ยวกับชั้นข้อมูลแรสเตอร์สำมำรถท ำได้โดยกำรเปิดหน้ำต่ำง Layer Properties 
จำกนั้นคลิกแท็บ Metedata ทั้งนี้ ข้อมูลแท็บ Metedata เป็นข้อมูลที่ใช้ส ำหรับกำรแสดงผลเท่ำนั้น ไม่
สำมำรถแก้ไขข้อมูลได้ 

ก าหนดช่วงของมาตราส่วนที่
ต้องการแสดงชั้นข้อมูล 

 

จ านวนแถวและคอลัมน์ของข้อมูล 

ก าหนดชื่อชั้นข้อมูล 

 

ระบบพิกัดของชั้นข้อมูล 

 

ภาพตัวอย่าง สัญลักษณ์ของชั้นข้อมลู 
และชุดสีส าหรับแสดงผลขอ้มูล 

คลิกแท็บ General 
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ข้อมูลสถิติของชั้นข้อมูลที่แสดงในแท็บ Metedata จะมีเพียงข้อมูลเบื้องต้นเท่ำนั้น และ

อำจจะมีข้อมูลสถิติบำงส่วนที่ยังไม่ได้ค ำนวณและแสดงไว้ ทั้งนี้ ผู้ใช้สำมำรถใช้แท็บ Histogram ในหน้ำต่ำง 
Layer Properties เพื่อปรับข้อมูลสถิติให้ทันสมัย 

1.3 กำรก ำหนดลักษณะกำรแสดงข้อมูลของช้ันข้อมูลแรสเตอร์ในแท็บ Style 
  โปรแกรม QGIS สำมำรถแสดงข้อมูลแรสเตอร์ได้ 2 ลักษณะ คือ 

1. แบบแบนด์เดียว (Single band) ที่ใช้ส ำหรับกำรแสดงข้อมูลแบบ Grayscale แบบ 
Pseudocolor แบบ Freak out หรือแบบ Colormap 

2. แบบสีสำมแบนด์ (Three band color) ที่ใช้ส ำหรับกำรแสดงข้อมูลภำพสีแบบ RGB 
(Red, Green, Blue) 
  ทั้งนี้ กำรแสดงข้อมูลแรสเตอร์ทั้งสองลักษณะสำมำรถแปลงผลกำรแสดงสีแบบผกผัน โดย
กำรคลิกที่ช่องกำเครื่องหมำย Invert color map 

คลิกแท็บ Metadata 

 

ข้อมูลเกี่ยวกับชั้นข้อมูลแรสเตอร์ 
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 กำรแสดงข้อมูลแรสเตอร์แบบแบนด์เดียว 
 ข้อมูลแรสเตอร์อำจจะเป็นชั้นข้อมูลที่มีเพียงแบนด์เดียว (Single band หรือ Single 

layer) เช่น กำรใช้ที่ดิน ชนิดดิน ระดับควำมสูง เป็นต้น หรืออำจจะมีหลำยแบนด์ (Multiple band หรือ 
Multiple layer) เช่น ข้อมูลภำพจำกดำวเทียม ในกรณีที่แฟ้มข้อมูลแรสเตอร์มีหลำยแบนด์ และผู้ใช้ต้องกำร
แสดงข้อมูลแรสเตอร์แบบแบนด์เดียว ผู้ใช้จ ำเป็นต้องเลือกแบนด์ที่ต้องกำรแสดงจำกแบนด์ต่ำง ๆ ที่มีอยู่ 

 กำรแสดงข้อมูลแรสเตอร์แบบแบนด์เดียว มีขั้นตอนดังนี้ 
 1) เปิดหน้ำต่ำง Layer Properties ของช้ันข้อมูลแรสเตอร์ เลือกแท็บ Style 
 2) ในกรอบ Render as คลิกตัวเลือก Single band gray 
 3) ในช่อง Gray band ของกรอบ Single band properties ให้เลือกแบนด์ที่

ต้องกำรแสดงข้อมูล 
4) ในช่อง Color map ของกรอบ Single band properties ให้เลือกประเภทกำร

แสดงสัญลักษณ์สีในกำรแสดงข้อมูลแรสเตอร์แบบแบนด์เดียว ซึ่งสำมำรถแสดงข้อมูลได้ 4 ลักษณะ ดังนี ้

 Grayscale เป็นกำรแสดงข้อมูลด้วยสเกลสีเทำ ส ำหรับข้อมูลแบบ 
8 บิต จุดภำพที่มีค่ำเท่ำกับ 0 จะแสดงด้วยสีด ำ น้ ำหนักของสีด ำจะค่อย ๆ ลดลงไปเป็นสีเทำเข้มไปจนเป็นสี
เทำอ่อน และสีขำวในที่สุด เมื่อค่ำของจุดภำพเพิ่มขึ้นจนมีค่ำเท่ำกับ 255 

 Pseudocolor เป็นกำรแสดงข้อมูลด้วยสเกลสี (Color ramp) 
ตำมที่โปรแกรม QGIS ก ำหนดไว้ โดยที่สีแดงจะแสดงจุดภำพที่มีค่ำสูง สีเหลืองจะแสดงจุดภำพที่มีค่ำกลำง 
และสีน้ ำเงินจะแสดงจุดภำพที่มีค่ำต่ ำ ไลน่้ ำหนักสีต่อเนื่องกันไป (Continuous tone) 

 Freak out เป็นกำรแสดงข้อมูลด้วยสเกลสี ที่มีลักษณะคล้ำยกับ 
Pseudocolor แต่จะใชส้เกลสทีี่แตกต่ำงกัน กลุ่มชุดสีของ Freak out ประกอบด้วย สีเขียว สีฟ้ำอมเขียว และ
สแีดง ซึ่งแสดงลักษณะสทีี่แปลกและไม่กลมกลืนกัน 

 Colormap เป็นกำรแสดงข้อมูลด้วยสเกลสีผู้ใช้ก ำหนด เมื่อเลือก 
Color map ประเภทน้ี จะสำมำรถก ำหนดสเกลสีได้จำกแท็บ Colormap ในหน้ำต่ำง Layer Properties 

5) ปรับควำมเปรียบต่ำงของข้อมูล (Contrast enhancement) (ขั้นตอนนี้ ผู้ใช้
สำมำรถใช้ค่ำเริ่มต้น (Default) ของโปรแกรม ถ้ำข้อมูลภำพมีควำมเปรียบต่ำงสูงอยู่แล้ว) ในกรณีที่ข้อมูลภำพ
มีควำมเปรียบต่ำงต่ ำ หรืออำจจะมีค่ำผิดปกติ (Outlier) เช่น อำจจะมีจุดภำพเพียง 1 – 2 จุดภำพ ที่มีค่ำสูง
หรือต่ ำมำก ๆ จนส่งผลให้กำรแสดงข้อมูลไม่สื่อควำมหมำย กำรปรับควำมเปรียบต่ำงของข้อมูล สำมำรถท ำได้ 
2 ลักษณะ คือ 

 กำรใช้ค่ำต่ ำสุดและสูงสุด โดยคลิกที่ตัวเลือก Custom min / max 
values ผู้ใช้สำมำรถก ำหนดค่ำต่ ำสุดและสูงสุดเอง หรือใช้ค่ำที่ได้จำกตัวเลือกต่ำง ๆ ในกรอบ Load min / 
max values from band ซึ่งแต่ละตัวเลือกมีควำมหมำยดังนี้ 
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o Estimate (faster) ก ำหนดให้ใช้ค่ำต่ ำสุดและสูงสุดจำก
พีระมิดของช้ันข้อมูล (Overview) หรือข้อมูลตัวอย่ำงจำกชุดข้อมูลทั้งหมด (subset of image tiles) 

o Actual (slower) ก ำหนดให้ใช้ค่ำต่ ำสุดและสูงสุดจำกแบนด์
ข้อมูลจริง 

o Current extent ก ำหนดให้ใช้ค่ำต่ ำสุดและสูงสุดจำกจุดภำพ
ที่อยู่ในขอบเขตพื้นที่แสดงข้อมูลในปัจจุบัน 

กำรใช้ค่ำต่ ำสุดและสูงสุดในกำรเน้นควำมเปรียบต่ำง จะใช้ได้กับ 
Color map ประเภท Grayscale เท่ำนั้น และเมื่อผู้ใช้ก ำหนดต่ ำสุดและสูงสุดตำมที่ต้องกำรได้แล้ว จะ
สำมำรถเลือกวิธีเน้นควำมเปรียบต่ำงได้จำกกรอบ Contrast enhancement ซึ่งแต่ละตัวเลือกมีรำยละเอียด
ดังนี้ 

o No Stretch เป็นกำรก ำหนดให้ไม่ต้องเน้นควำมเปรียบต่ำง 
o Stretch To MinMax เป็นกำรปรับยืดค่ำสเกลสีให้เต็มช่วง   

0 – 255 โดยค ำนวณจำกค่ำต่ ำสุดและสูงสุดตำมที่ก ำหนดไว้ในตัวเลือก Custom min / max values 
o Stretch And Clip To MinMax เป็นกำรปรับยืดค่ำสเกลสีให้

เต็มช่วง 0 – 255 โดยค ำนวณจำกค่ำต่ ำสุดและสูงสุดตำมที่ก ำหนดไว้ในตัวเลือก Custom min / max 
values แต่ค่ำของจุดภำพที่ไม่อยู่ในช่วง (Range) ที่ก ำหนดจะถูกตัด (Truncate or clip) ให้ไปเป็นค่ำสูงสุด 
ซึ่งเมื่อมีกำรปรับยืดค่ำสเกลแล้ว จะให้ผลลัพธ์เป็นค่ำ 255 เสมอ ซึ่งเป็นจุดภำพที่แสดงด้วยสีขำว 

o Clip To MinMax เป็นกำรจ ำกัดหรือควบคุมกำรแสดง
จุดภำพโดยอำศัยค่ำต่ ำสุดและสูงสุดที่ก ำหนดไว้ในตัวเลือก Custom min / max values ค่ำของจุดภำพที่ไม่
อยู่ในช่วง (Range) ที่ก ำหนดจะถูกตัด (Truncate or clip) ให้ไปเป็นค่ำสูงสุด ซึ่งจะให้ผลลัพธ์เป็นค่ำ 255 
เสมอ และจุดภำพจะแสดงด้วยสีขำว 

 กำรใช้ค่ำเบี่ยงเบนมำตรฐำน โดยคลิกที่ตัวเลือก Use standard 
deviation จำกนั้นคลิกหรือพิมพ์ค่ำเบี่ยงเบนมำตรฐำนตำมที่ต้องกำร กำรเน้นควำมเปรียบต่ำงของข้อมูลโดย
ใช้ค่ำเบี่ยงเบนมำตรฐำนนี้ จะใช้ได้กับ Color map ประเภท Grayscale, Pseudocolor, และ Freak out 
เท่ำนั้น 

6) คลิกปุ่ม Apply 
7) คลิกปุ่ม OK 

 
 
 
 
 
 

MAHID
OL



บทที่ 7 การท างานกับข้อมูลแรสเตอร์  หน้า 227 
 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

 
 

 
  

 
 

 

  

ตัวอย่ำงกำรเน้นควำมเปรียบต่ำงของภำพ Grayscale 
ด้วย Stretch To MinMax 

 

ตัวอย่ำงกำรเน้นควำมเปรียบต่ำงของภำพ Grayscale 
โดยใชค้่ำเบี่ยงเบนมำตรฐำนที่ 2.5 

 

1. คลิกแท็บ Style 
2. คลิก Single band gray 

3. คลิกเลือกแบนด์ข้อมลู 

4. คลิกเลือกประเภทการแสดงสัญลักษณส์ี 

7. คลิกปุ่ม OK 6. คลิกปุ่ม Apply 

5. ปรับความเปรียบต่างของข้อมูล 
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ตัวอย่ำงกำรเน้นควำมเปรียบต่ำงของภำพ 
Pseudocolor โดยใชค้่ำเบี่ยงเบนมำตรฐำนที่ 2.5 

ตัวอย่ำงกำรเน้นควำมเปรียบต่ำงของภำพ Freak out 
โดยใชค้่ำเบี่ยงเบนมำตรฐำนที่ 2.5 

 

 กำรแสดงข้อมูลแรสเตอร์แบบสีสำมแบนด ์
  ข้อมูลแรสเตอร์ที่มีหลำยแบนด์ (อย่ำงน้อย 3 แบนด์) จะสำมำรถแสดงข้อมูลเป็น

ภำพสีได้ (Color image) โดยกำรระบุแบนด์ข้อมูลให้แสดงผ่ำนแม่สีแดง เขียว น้ ำเงิน (RGB) 
กำรเลือกใช้แบนด์ข้อมูลและกำรระบุแบนด์ข้อมูลให้แสดงผ่ำนแม่สี RGB จัดเป็นกำร

เน้นข้อมูลภำพมีควำมส ำคัญต่อกำรแสดงข้อมูล และกำรน ำเข้ำข้อมูลโดยกำรดิจิไทซ์ผ่ำนหน้ำจอคอมพิวเตอร์ 
(Head-up digitizing) ข้อมูลกำรรับรู้จำกระยะไกล เช่น รูปถ่ำยทำงอำกำศ หรือภำพดำวเทียม จะสำมำรถ
แปลตีควำมข้อมูลด้วยสำยตำ (Visual interpretation) ได้ง่ำยขึ้น ถ้ำมีกำรเลือกใช้และระบุแบนด์ข้อมูลให้
แสดงผ่ำนแม่สี RGB ได้อย่ำงเหมำะสม กำรแสดงข้อมูลแรสเตอร์แบบสีสำมแบนด์ มีขั้นตอนดังนี ้
   1) เปิดหน้ำต่ำง Layer Properties ของช้ันข้อมูลแรสเตอร์ เลือกแท็บ Style 
   2) ในกรอบ Render as คลิกตัวเลือก Three band color 
   3) ในช่อง Red band, Green band, Blue band ให้ระบุแบนด์ข้อมูลที่ต้องกำร
แสดงผ่ำนแม่สี RGB ตำมล ำดับ 

4) ปรับควำมเปรียบต่ำงของข้อมูล (ดูรำยละเอียดได้จำกหัวข้อ “กำรแสดงข้อมูล   
แรสเตอร์แบบแบนด์เดียว”) 

5) คลิกปุ่ม Apply 
6) คลิกปุ่ม OK 
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1.4 กำรก ำหนดสีของชั้นข้อมูลแรสเตอร์แบบแบนด์เด่ียวในแท็บ Colormap 
 เมื่อผู้ใช้ก ำหนดให้แสดงชั้นข้อมูลแรสเตอร์แบบแบนด์เดี่ยว (Single band) และใช้ Color 

map แบบ Colormap แล้ว ผู้ใช้สำมำรถก ำหนดสเกลสีของชั้นข้อมูลตำมที่ผู้ใช้ต้องกำรได้จำกแท็บ 
Colormap 

กำรใช้ Color map แบบ Colormap จะมีควำมยืดหยุ่นในกำรก ำหนดสเกลสีของข้อมูล ทั้ง
แบบต่อเนื่องและไม่ต่อเนื่อง (Continuous or discrete data) ผู้ใช้สำมำรถระบุสีให้แก่ค่ำข้อมูลโดยตรง 
(Exact) หรือกลุ่มข้อมูล (Class) รวมทั้งกำรก ำหนดให้โปรแกรมจัดกลุ่มข้อมูลและระบุสเกลสีให้อัตโนมัติ ใน
ตัวอย่ำงนีจ้ะสำธิตกำรก ำหนดสเกลสีให้กับช้ันข้อมูลควำมสูง ทั้งแบบอัตโนมัติและไม่อัตโนมัติ ซึ่งมีรำยละเอียด
ดังนี้ 

 

1. คลิกแท็บ Style 2. คลิก Three band color 

3. ระบุแบนดข์้อมูล 

6. คลิกปุ่ม OK 

 

5. คลิกปุ่ม Apply 

 

4. ปรับความเปรียบต่างของข้อมูล 
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 กำรก ำหนดสเกลสีด้วย Colormap แบบอัตโนมัต ิมีขั้นตอนดังนี ้
 1) เปิดหน้ำต่ำง Layer Properties จำกนั้นคลิกแท็บ Colormap 
 2) ก ำหนดจ ำนวนกลุ่ม/ชั้นข้อมูลที่ต้องกำรจำกช่อง Number of entries โดยกำร

พิมพ์ค่ำโดยตรงจำกแผงแป้นอักขระหรือกำรคลิกปุ่มลูกศรขึ้นลง (ส ำหรับวิธีกำรจ ำแนกข้อมูล (Classification 
mode) ของโปรแกรม QGIS รุ่น 1.7.3 Wroclaw นั้น จะมีวิธีกำรจ ำแนกข้อมูลแบบ Equal interval เท่ำนั้น 
ผู้ใช้จึงไม่จ ำเป็นต้องเลือกตัวเลือกนี้) 

 3) คลิกปุ่ม Classify โปรแกรมจะจ ำแนกกลุ่มข้อมูลและก ำหนดสีให้กับข้อมูลแต่ละ
กลุ่มโดยอัตโนมัต ิ

 4) คลิกปุ่ม Apply 
 5) คลิกปุ่ม OK 
 
 
 

 
 
 

1. คลิกแท็บ Colormap 

2. ก าหนดจ านวนชัน้ข้อมลู 

3. คลิกปุ่ม Classify 

5. คลิกปุ่ม OK 4. คลิกปุ่ม Apply 

MAHID
OL



บทที่ 7 การท างานกับข้อมูลแรสเตอร์  หน้า 231 
 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

 กำรก ำหนดสเกลสีด้วย Colormap แบบไม่อัตโนมัต ิมีขั้นตอนดังนี ้
 1) เปิดหน้ำต่ำง Layer Properties จำกนั้นคลิกแท็บ Colormap 
 2) คลิกปุ่ม Add entry 
 3) ดับเบิลคลิกที่ช่องข้อมูลในคอลัมน์ Value จำกนั้นพิมพ์ค่ำของข้อมูลที่ต้องกำร

ก ำหนดสัญลักษณ์สี (ในกรณีที่ชั้นข้อมูลแรสเตอร์จัดเก็บข้อมูลไม่ต่อเนื่อง เช่น ประเภทกำรใช้ที่ดิน ผู้ใช้จะระบุ
ค่ำรหัสของข้อมูลแต่ละประเภท แต่ถ้ำชั้นข้อมูลแรสเตอร์จัดเก็บข้อมูลต่อเนื่อง เช่น ระดับควำมสูง ค่ำที่ผู้ใช้
ระบุ จะเป็นค่ำที่ใช้ในกำรก ำหนดกลุ่มหรือชั้นข้อมูล (Class) โดยจุดภำพที่มีค่ำของข้อมูลน้อยกว่ำหรือเท่ำกับ
ค่ำที่ระบไุว ้จะก ำหนดให้จุดภำพน้ันเป็นสมำชิกในกลุ่มหรือชั้นข้อมูลดังกล่ำว) 

 4) ดับเบิลคลิกที่สีในคอลัมน์ Color เพื่อก ำหนดสีที่ต้องกำรจำกหน้ำต่ำง Select 
Color 

 5) ดับเบิลคลิกที่ช่องข้อมูลในคอลัมน์ Label จำกนั้นพิมพ์ค ำอธิบำยสัญลักษณ์ 
เพื่อให้ข้อมูลหรือชั้นข้อมูล สื่อควำมหมำยได้ดียิ่งขึ้น 

 6) ท ำซ้ ำขั้นตอนที่ 2 – 5 เพื่อก ำหนดสัญลักษณ์ข้อมูลให้กับข้อมูลหรือชั้นข้อมูลอื่น 
ๆ จนครบตำมต้องกำร (ถ้ำมีต้องกำรลบสัญลักษณ์ข้อมูล ให้คลิกเลือกแถวสัญลักษณ์ที่ต้องกำรลบ จำกนั้นคลิก
ปุ่ม Delete entry และถ้ำต้องกำรจัดเรียงล ำดับข้อมูลในคอลัมน์ Value ให้คลิกปุ่ม Sort) 

 7) คลิกปุ่ม Apply 
 8) คลิกปุ่ม OK 
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เมื่อผู้ใช้ก ำหนดสัญลักษณ์สีของชั้นข้อมูลได้ตำมต้องกำรแล้ว ผู้ใช้สำมำรถบันทึกกำร

ก ำหนดค่ำต่ำง ๆ ไว้เป็นแฟ้มข้อมูลด้วยกำรคลิกปุ่ม Export color map to file (   )     เพื่อน ำไปใช้
ก ำหนดสัญลักษณ์สีของชั้นข้อมูลอื่น ๆ ที่มีข้อมูลเหมือนกัน เช่น กำรใช้ที่ดินที่จัดเก็บข้อมูลในช่วงเวลำต่ำง ๆ 

กัน เป็นต้น และเมื่อต้องกำรใช้แฟ้มข้อมูลสัญลักษณ์สี ให้คลิกปุ่ม Load color map to file (  )  ทั้งนี้ 
ชั้นข้อมูลแรสเตอร์บำงแฟ้ม อำจจะมีกำรจัดเก็บสัญลักษณ์สีอยู่ในแฟ้มข้อมูล ซึ่งผู้ใช้สำมำรถใช้สัญลักษณ์สี

ดังกล่ำวได้โดยกำรคลิกปุ่ม Load color map from band (    ) 

1.5 กำรก ำหนดควำมโปร่งใสในกำรแสดงข้อมูลของช้ันข้อมูลแรสเตอร์ในแท็บ Transparency 
 ในกำรแสดงข้อมูลแรสเตอร์ร่วมกับชั้นข้อมูลอื่น ๆ มำกกว่ำ 1 ชั้นข้อมูล ผู้ใช้สำมำรถก ำหนด

ควำมโปร่งใสของชั้นข้อมูลแรสเตอร์ที่วำงซ้อนอยู่ด้ำนบน เพื่อให้มองเห็นชั้นข้อมูลอื่น ๆ ที่อยู่ด้ำนล่ำงได้ เช่น 

1. คลิกแท็บ Colormap 

2. คลิกปุ่ม Add entry 

8. คลิกปุ่ม OK 7. คลิกปุ่ม Apply 

3. พิมพ์ค่าข้อมูล 

4. ก าหนดสัญลักษณ์ส ี

5. พิมพ์ค าอธบิายสญัลักษณ์ 

6. ท าซ้ าขั้นตอน 2 - 5 

 

บันทึกและโหลดข้อมูลสัญลกัษ์ส ี
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กำรแสดงชั้นข้อมูลควำมสูง (Elevation) บนชั้นข้อมูลทรวดทรงแรเงำ (Shaded relief) หรือในกรณีที่แสดง
ชั้นข้อมูลแรสเตอร์เพียงชั้นข้อมูลเดียว ผู้ใช้ยังสำมำรถก ำหนดควำมโปรงใสให้กับจุดภำพที่ไม่มีค่ำข้อมูล (No 
data) ได้เช่นเดียวกัน เพื่อก ำหนดไม่ให้แสดงจุดภำพน้ันในแผนที่ 

กำรก ำหนดควำมโปร่งใสในกำรแสดงข้อมูลของช้ันข้อมูลแรสเตอร์ มีขั้นตอนดังนี้ 
1) เปิดหน้ำต่ำง Layer Properties จำกนั้นคลิกแท็บ Transparency 
2) ในกรอบ Global transparency ให้เลื่อนตัวชี้ไปยังระดับควำมโปร่งใสที่ต้องกำร โดยที่ 

0% หมำยถึง ไม่โปร่งใสหรือทึบ และ 100% หมำยถึง โปร่งใสทั้งหมดหรือไม่แสดงจุดภำพ ค่ำที่ก ำหนดนี้จะมี
ผลต่อทุก ๆ จุดภำพของช้ันข้อมูล 

3) คลิกปุ่ม Apply 
4) คลิกปุ่ม OK 
 
 
 

 
 
 

1. คลิกแท็บ Transparency 

4. คลิกปุ่ม OK 

2. คลิกเลื่อนตวัชี ้

3. คลิกปุ่ม Apply 

 

ค่าของจุดภาพที่แสดงว่า
ไม่มีข้อมูล (No data) 

ก าหนดระดับความโปร่งใสของ
จุดภาพเฉพาะ (Specific value) MAHID
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 โดยค่ำเริ่มต้นของโปรแกรม ค่ำข้อมูลของจุดภำพที่ไม่มีข้อมลู (No data) จะถูกน ำมำแสดง
ในกรอบ No data value และใช้เป็นค่ำที่ก ำหนดในตำรำง Transparent pixel list ซึ่งอยูใ่นกรอบ Custom 
transparency options เพื่อก ำหนดให้ไม่ต้องแสดงจุดภำพดังกล่ำวในแผนที่ อย่ำงไรก็ตำม ผู้ใช้สำมำรถแก้ไข
ค่ำในตำรำง Transparent pixel list ได้ โดยกำรระบุค่ำของจุดภำพทีต่้องกำรปรับระดับควำมโปร่งใสใน
คอลัมน์ Gray (เมื่อแสดงข้อมูลแบบแบนด์เด่ียว) หรือ Red Green Blue (เมื่อแสดงข้อมูลแบบสีสำมแบนด)์ 
และก ำหนดระดับควำมโปร่งใสที่ต้องกำรในคอลัมน์ Percent transparent 

ในกรณีที่ต้องกำรเพิ่มหรือลบรำยกำรในตำรำง Transparent pixel list ผู้ใช้สำมำรถใช้ปุ่ม 

Add values manually (        ) เพื่อเพิ่มแถวในตำรำงและก ำหนดค่ำของจุดภำพเอง  หรือใช้ปุ่ม Add 

values from display (      ) เพื่อเพิ่มแถวในตำรำงและก ำหนดค่ำของจุดภำพจำกกำรคลิกที่จุดภำพใน

แผนที่ หรือใชปุ้่ม Remove selected row (   ) เพื่อลบแถวในตำรำงออก 
เมื่อผู้ใช้ก ำหนดค่ำระดับควำมโปร่งใสต่ำง ๆ จนเป็นที่พอใจแล้ว สำมำรถบันทึกค่ำเป็น

แฟ้มข้อมูลด้วยปุ่ม Export to file (    ) และสำมำรถใช้แฟ้มข้อมูลที่บันทึกไว้ด้วยปุ่ม Import to file     

(  ) เพื่อช่วยให้กำรก ำหนดค่ำมีควำมรวดเร็วมำกยิ่งขึ้น 

1.6 กำรสร้ำงพีระมิดของช้ันข้อมูลแรสเตอร์ในแท็บ Pyramids 
 ชั้นข้อมูลแรสเตอร์ที่ครอบคลุมพื้นที่ขนำดใหญ่และมีจุดภำพที่มีควำมละเอียดสูง จะมี

แฟ้มข้อมูลขนำดใหญ่ ส่งผลให้แสดงข้อมูลได้ช้ำ ด้วยเหตุนี้ ผู้ใช้สำมำรถสร้ำงพีระมิดของชั้นข้อมูล (พีระมิด 
หมำยถึง ชั้นข้อมูลที่ถูกลดควำมละเอียดลงมำจำกชั้นข้อมูลต้นฉบับ) เพื่อเพิ่มประสิทธิภำพในกำรแสดงชั้น
ข้อมูลในแผนที่ กล่ำวคือ เมื่อผู้ใช้ดูภำพบริเวณกว้ำง โปรแกรมจะแสดงภำพที่มีรำยละเอียดต่ ำก่อน และเมื่อ
ผู้ใช้ขยำยภำพเข้ำ (Zoom in) โปรแกรมจะแสดงภำพที่มีรำยละเอียดสูงขึ้นตำมระดับกำรขยำยภำพ (Level 
of zoom) ส่งผลให้ควำมเร็วในกำรแสดงข้อมูลดีขึ้น อย่ำงไรก็ตำม ข้อมูลแรสเตอร์ที่มีกำรจัดเก็บข้อมูลพีระมิด 
จะมีขนำดของแฟ้มข้อมูลที่ใหญ่มำกขึ้น 

กำรสร้ำงพีระมิดของช้ันข้อมูลแรสเตอร์ในแท็บ Pyramids มีขั้นตอนดังนี ้
1) เปิดหน้ำต่ำง Layer Properties จำกนั้นคลิกแท็บ Pyramids 
2) ในกรอบ Pyramid resolutions ให้คลิกเลือกระดับพีระมิดของชั้นข้อมูลที่ต้องกำรสร้ำง 

ทั้งนี้ ผู้ใช้สำมำรถคลิกเลือกได้มำกกว่ำ 1 ระดับ (ถ้ำต้องกำรยกเลิกกำรเลือกให้คลิกที่ระดับพีรำมิดนั้นอีกครั้ง) 
3) คลิกที่กล่องหน้ำข้อควำม Build pyramids internally if possible เพื่อก ำหนดให้

โปรแกรมสร้ำงพีระมิดภำยในแฟ้มข้อมูล (Internal pyramid) ถ้ำเป็นรูปแบบแฟ้มข้อมูลที่รองรับกำรจัดเก็บ
ข้อมูลพีระมิดภำยใน (กำรสร้ำงพีรำมิดภำยในแฟ้มข้อมูลจะท ำให้เกิดกำรเปลี่ยนแปลงแฟ้มข้อมูลต้นฉบับ และ
โปรแกรม QGIS ไม่สำมำรถลบข้อมูลพีรำมิดออกได้ ดังนั้น จึงควรส ำรองข้อมูลก่อนกำรสร้ำงพีรำมิดทุกครั้ง) 
ในกรณีที่รูปแบบแฟ้มข้อมูลไม่รองรับกำรจัดเก็บข้อมูลพีระมิด โปรแกรมจะสร้ำงแฟ้มข้อมูลขึ้นใหม่ (External 
pyramid) เพื่อจัดเก็บข้อมูลพีรำมิดใหอ้ัตโนมัติ ทั้งนี ้แฟ้มข้อมูลบำงรูปแบบจะไม่สำมำรถพีรำมิดได้  
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4) ในช่อง Resampling method ให้คลิกเลือกวิธีกำรค ำนวณจุดภำพของพีรำมิด ซึ่ง
โปรแกรม QGIS มีให้เลือก 2 วิธี คือ 1) Average ที่ค ำนวณจุดภำพของพีรำมิดจำกค่ำเฉลี่ย วิธีนี้สำมำรถใช้ได้
กับข้อมูลต่อเนื่อง เช่น ข้อมูลภำพจำกดำวเทียม หรือรูปถ่ำยทำงอำกำศ และ 2) Nearest Neighbour ที่
ค ำนวณจุดภำพของพีรำมิดจำกจุดภำพของข้อมูลต้นฉบับที่อยู่ใกล้ที่สุด วิธีนี้สำมำรถใช้ได้กับข้อมูลต่อเนื่อง 
และไม่ต่อเนื่อง เช่น ข้อมูลกำรใช้ที่ดิน ในตัวอย่ำงนี้ เลือกวิธี Average 

5) คลิกปุ่ม Build pyramids เพื่อให้โปรแกรมค ำนวณพีระมิดของช้ันข้อมูล 
6) คลิกปุ่ม Apply 
7) คลิกปุ่ม OK 
 

 
 

 
 
 
 
 

4. คลิกเลือกวธิี Resampling 

7. คลิกปุ่ม OK 

3. คลิกสร้างพีรามิดในแฟ้มข้อมูล 

6. คลิกปุ่ม Apply 

1. คลิกแท็บ Pyramids 

2. คลิกเลือกระดับพีรามิด 

 

5. คลิกปุ่ม Build pyramids 
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1.7 กำรดูฮิสโทแกรมของชั้นข้อมูลแรสเตอร์ในแท็บ Histogram 
 ฮิสโทแกรม คือ กรำฟที่ใช้แสดงกำรกระจำยของข้อมูล โดยแนวแกน X คือ ค่ำข้อมูลของ

จุดภำพ และแนวแกน Y คือ จ ำนวนควำมถี่ของค่ำข้อมูลนั้น เมื่อผู้ใช้เปิดหน้ำต่ำง Layer Properties แล้วคลิก
แท็บ Histogram โปรแกรม QGIS จะสร้ำงฮิสโทแกรมของชั้นข้อมูลให้อัตโนมัติ ทั้งนี้ ข้อมูลในแท็บ 
Histogram เป็นข้อมูลที่ใช้ส ำหรับกำรแสดงผลเท่ำนั้น แต่ผู้ใช้สำมำรถเก็บบันทึกฮิสโทแกรมเป็นแฟ้ม

ข้อมูลภำพ (Image file format) ได้ด้วยกำรใช้ปุ่ม    
 
 

 
 
 

2. การก าหนดระบบพิกัดอ้างอิงเชิงพื้นที่ของข้อมูลแรสเตอร์ (Georeferencing) 
 ข้อมูลเชิงพื้นที่ที่ใช้ในระบบสำรสนเทศภูมิศำสตร์จ ำเป็นต้องมีกำรอ้ำงอิงเชิงต ำแหน่งกับระบบพิกัด
แผนที่ใด ๆ ระบบหนึ่ง เช่น ระบบพิกัดภูมิศำสตร์ หรือระบบพิกัดกริดยูทีเอ็ม โดยทั่ว ๆ ไป ข้อมูลภำพ       
แรสเตอร์ที่ได้จำกกำรกรำดภำพแผนที่กระดำษ (Scanned map) จะไม่มีกำรอ้ำงอิงเชิงต ำแหน่งกับระบบพิกัด
แผนที่ใด ๆ หรือข้อมูลภำพแรสเตอร์ประเภทรูปถ่ำยทำงอำกำศและภำพจำกดำวเทียมที่ผู้ใช้ได้รับหรือจัดหำมำ

คลิกแท็บ Histogram 

คลิกปุ่มเพื่อบันทึกภาพฮสิโทแกรม MAHID
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จำกผู้ให้บริกำรข้อมูล อำจจะมีหรือไม่มีกำรประมวลผลข้อมูลมำเบ้ืองต้น ถ้ำข้อมูลมีกำรประมวลผลมำเบื้องต้น 
ข้อมูลนั้นอำจจะมีกำรอ้ำงอิงเชิงต ำแหน่งกับระบบพิกัดแผนที่ไว้แล้ว แต่ข้อมูลอำจจะแสดงรำยละเอียดเชิง
ต ำแหน่งได้ไม่ตรงกับชั้นข้อมูลอื่น ๆ ในฐำนข้อมูลที่มีอยู่ ดังนั้น เพื่อให้ข้อมูลแรสเตอร์แสดงข้อมูลเชิงพื้นที่
ร่วมกับข้อมูลอื่น ๆ ได้อย่ำงถูกต้อง ผู้ใช้จ ำเป็นต้องก ำหนดระบบพิกัดอ้ำงอิงเชิงพื้นที่ (Georeferencing) 
ให้กับข้อมูล 
 ในทำงทฤษฎี กำรก ำหนดระบบพิกัดอ้ำงอิงเชิงพื้นที่ของข้อมูลแรสเตอร์ จะประกอบด้วย 4 ขั้นตอน 
คือ 1) กำรก ำหนดจุดควบคุมพื้นดิน (Ground control point: GCP) เพื่อสร้ำงควำมสัมพันธ์ระหว่ำงระบบ
พิกัดภำพ (Image coordinate system) กับระบบพิกัดแผนที่ (Map coordinate system) และ 2) กำร
ค ำนวณค่ำสัมประสิทธิ์ของสมกำรกำรแปลงพิกัด โดยใช้วิธีก ำลังสองน้อยสุด และกำรค ำนวณค่ำคลำดเคลื่อน
รำกก ำลังสองเฉลี่ย (Root mean square error: RMS error) 3) กำรแปลงพิกัด และ 4) กำรก ำหนดค่ำ
เชิงเลขให้กับจุดภำพ (Resampling) (ส ำหรับรำยละเอียดของขั้นตอนดังกล่ำว สำมำรถศึกษำเพิ่มเติมได้จำก
หัวข้อ “กำรปรับแก้ควำมคลำดเคลื่อนเชิงเรขำคณิต” ในบทที่ 1 เรื่องกำรรับรู้จำกระยะไกล) ผลลัพธ์จำกกำร
ก ำหนดระบบพิกัดภำพจะได้ข้อมูลแรสเตอร์ใหม่ที่มีกำรอ้ำงอิงกับระบบพิกัดแผนที่ที่สำมำรถน ำไปแสดง สืบค้น 
และวิเครำะห์ข้อมูลร่วมกับช้ันข้อมูลอื่น ๆ ได้อย่ำงถูกต้อง 
 โปรแกรม QGIS ใช้ซอฟต์แวร์เสริม (Plugin) ที่มีชื่อว่ำ Georeferencer ในกำรก ำหนดระบบพิกัด
อ้ำงอิงเชิงพื้นที่ของข้อมูลแรสเตอร์ ส ำหรับผลลัพธจ์ำกกำรก ำหนดระบบพิกัดภำพจะมีได ้2 ลักษณะ คือ 

 แฟ้มข้อมูล World file เป็นแฟ้มข้อควำม (Text file) ที่จัดเก็บข้อมูลเกี่ยวกับขนำดของ
จุดภำพ ค่ำพิกัดของจุดก ำเนิดของข้อมูลภำพ (จุดกึ่งกลำงของจุดภำพ ณ ต ำแหน่งซ้ำยบนข้องข้อมูลภำพ) และ
ข้อมูลกำรหมุนภำพ ( Rotation)  และจะสำมำรถสร้ ำง ได้ เมื่ อก ำหนดให้ สมกำรกำรแปลงพิกั ด 
(Transformation type) เป็นแบบ Linear  

ชื่อของแฟ้มข้อมูล World file จะมีชื่อเหมือนกับแฟ้มข้อมูลแรสเตอร์ และนิยมก ำหนดให้
มีนำมสกุล 3 ตัวอักษร ประกอบด้วย 1) อักษรตัวแรกของนำมสกุลเดิม 2) อักษรตัวสุดท้ำยของนำมสกุลเดิม 
และ 3) อักษร w ยกตัวอย่ำงเช่น แฟ้มข้อมูล image.tif จะมีแฟ้มข้อมูล World file ชื่อว่ำ image.tfw เป็น
ต้น อย่ำงไรก็ตำม แฟ้มข้อมูล World file ของข้อมูลแรสเตอร์บำงประเภท อำจจะก ำหนดให้เพิ่มอักษร w 
ต่อท้ำยนำมสกุลเดิมทันที เช่น แฟ้มข้อมูล image.jpg จะมีแฟ้มข้อมูล World file ชื่อว่ำ image.jpgw เป็นต้น 

แฟ้มข้อมูล World file ที่สร้ำงขึ้นจำกขั้นตอนกำรก ำหนดระบบพิกัดภำพ จะถูกน ำไปใช้
ในกำรแสดงข้อมูลภำพบนแผนที่ในซอฟต์แวรร์ะบบสำรสนเทศภูมิศำสตร ์

 แฟ้มข้อมูลแรสเตอร์ใหม่ในรูปแบบ GeoTiff ที่มีกำรอ้ำงอิงพิกัดภำพแล้ว 
ในตัวอย่ำงนี้ จะสำธิตกำรก ำหนดระบบพิกัดอ้ำงอิงเชิงพื้นที่ของข้อมูลแรสเตอร์ด้วยโปรแกรม QGIS 

ซึ่งมีขั้นตอนดังนี ้
 1) เปิดโปรแกรม QGIS จำกนั้นคลิกเมนู Plugins > Georeferencer > Georeferencer เพื่อเปิด
หน้ำต่ำง Georeferencer  
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 2) ในหน้ำต่ำง Georeferencer เพิ่มช้ันข้อมูลแรสเตอร์ที่ต้องกำรก ำหนดระบบพิกัดอ้ำงอิงเชิงพื้นที ่ 
 3) คลิกปุ่ม Cancel ในหน้ำต่ำง Coordinate Reference System Selector เนื่องจำกข้อมูลยังไม่มี
กำรอ้ำงอิงกับระบบพิกัดแผนที่ใด ๆ 

 4) คลิกปุ่ม Add Point (  )  
 5) คลิกจุดควบคุมพื้นดินบนภำพ 
 6) ในหน้ำต่ำง Enter map coordinates พิมพ์ค่ำพิกัดของจุดควบคุมพื้นดินลงในช่อง X: และ Y: (ใน
กรณีที่มีชั้นข้อมูลอ้ำงอิงที่สำมำรถใช้ในกำรก ำหนดจุดควบคุมพื้นดินได้ ให้ผู้ใช้คลิกปุ่ม From map canvas   

(  ) เพื่อเลือกจุดควบคุมพื้นดินจำกชั้นข้อมูลอ้ำงอิง หรือจะใช้ตัวเลือก Snap to 
background layer เพื่อก ำหนดให้มีกำร Snapping 
 7) คลิกปุ่ม OK ในหน้ำต่ำง Enter map coordinates 
 8) ท ำซ้ ำขั้นตอนที่ 4 – 6 จนสำมำรถก ำหนดจ ำนวนจุดควบคุมพื้นดินได้ครบตำมจ ำนวนจุดขั้นต่ ำที่
ต้องใช้ในสมกำรกำรแปลงพิกัด (Transformation equation) (แบบ Linear = 2 จุด, แบบ Helmert = 2 
จุด, แบบ Polynomial 1 = 3 จุด, แบบ Polynomial 2 = 6 จุด, แบบ Polynomial 3 = 10 จุด, แบบ Thin 
Plate Spline = 1 จุด, แบบ Projective = 4 จุด) ทั้งนี้ ผู้ใช้ควรจะต้องก ำหนดจุดให้มำกกว่ำจ ำนวนจุดขั้นต่ ำ
อย่ำงน้อย 1 จุด เพื่อที่จะให้โปรแกรมสำมำรถใช้วิธีก ำลังสองน้อยสุดค ำนวณค่ำคลำดเคลื่อนรำกก ำลังสอง
เฉลี่ยได้ และถ้ำต้องกำรให้ผลลัพธ์ของกำรแปลงพิกัดมีคุณภำพดีมำกขึ้น ควรจะก ำหนดจุดควบคุมให้มีจ ำนวน
มำกและมีกำรกระจำยตัวของจุดอย่ำงสม่ ำเสมอทั่วทั้งภำพ 

 9) คลิกเมนู Settings > Transformation settings หรือคลิกปุ่ม  
 10) ในหน้ำต่ำง Transformation settings ให้ก ำหนดค่ำต่ำง ๆ ดังนี้ 

 Transformation type: ให้เลือกวิธีกำรแปลงพิกัดที่ต้องกำร กำรเลือกใช้วิธีใดจะขึ้นอยู่
กับลักษณะควำมบิดเบ้ียวของข้อมูลภำพ ซึ่งแต่ละวิธีมีรำยละเอียดดังนี ้

o Linear เป็นวิธีที่ใช้ปรับแก้ข้อมูลที่มีควำมบิดเบี้ยวจำกกำรเลื่อนและมำตรำส่วน 
วิธีนี้จะใช้สร้ำงแฟ้มข้อมูล World file และมักจะใช้กับข้อมูลที่มีกำรก ำหนดระบบพิกัดภำพแล้ว เมื่อเลือก
ตัวเลือกนี้ จะต้องคลิกตัวเลือก Create world file ซึ่งส่งผลให้โปรแกรมจะปิดกำรท ำงำนในช่อง Output 
raster ไปโดยอัตโนมัต ิ

o Helmert หรืออำจจะเรียกว่ำ Similarity or Conformal transformation เป็น
วิธีที่ใช้ปรับแก้ข้อมูลที่มีควำมบิดเบี้ยวจำกกำรเลื่อน กำรหมุน และมำตรำส่วน แต่ผลของกำรปรับแก้จะยังคง
รักษำควำมสัมพันธ์ของมำตรำส่วนในแนวแกน X และ Y ไว้ ดังนั้น จึงเหมำะส ำหรับกำรปรับแก้ที่ต้องกำร
รักษำรูปร่ำงของวัตถุหรือสิ่งต่ำง ๆ ที่ปรำกฏบนภำพให้คงเดิม 

o Polynomial (1 2 และ 3 หมำยถึง อันดับของสมกำรพหุนำม) เป็นวิธีที่ใช้
ปรับแก้ข้อมูลที่ได้รับควำมนิยมใช้อย่ำงกว้ำงขวำง กำรแปลงพิกัดแบบ Polynomial 1 หรือ Affine นิยมใช้ใน
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กำรปรับแก้ควำมบิดเบี้ยวในมำตรำส่วน กำรเลื่อน และกำรหมุน ส ำหรับกำรแปลงพิกัดแบบ Polynomial 2 
และ 3 นิยมใช้ปรับแก้ควำมบิดเบี้ยวจำกควำมโค้ง อันดับของสมกำรพหุนำมยิ่งสูงมำก จะท ำให้สำมำรถ
ปรับแก้ควำมบิดเบ้ียวและควำมโค้งมำก ๆ ได้ 

o Thin plate spline (TPS) เป็นวิธีกำรปรับแก้แบบไม่เชิงเส้น (Non-linear 
transformation) ที่มักจะใช้ปรับแก้ข้อมูลที่มีควำมบิดเบี้ยวมำก ๆ ทั้งนี้ จุดควบคุมพื้นดินที่ใช้ในกำรปรับยึด
ข้อมูลภำพเดิมจะยังคงอยู่ในต ำแหน่งเดิมภำยหลังจำกกำรแปลงพิกัดเป็นภำพใหม่ เสมือนกับกำรใช้หมุดปักยึด
บนแผ่นยำง (Rubber sheeting method)  

o Projective เป็นวิธีที่ใช้ในกำรปรับแก้ข้อมูลที่มีควำมบิดเบี้ยวจำกกำรเอียง (Tilt) 
ของกล้องขณะถ่ำยภำพ วิธีกำรนีจ้ึงมักจะใช้ในกำรปรับแก้รูปถ่ำยทำงอำกำศ  

 Resampling method: ให้เลือกวิธีกำรก ำหนดค่ำเชิงเลขให้กับจุดภำพ กำรเลือกใช้วิธีใด
จะขึ้นอยู่กับลักษณะของข้อมูลแรสเตอร์ต้นฉบับ และแต่ละวิธีมีรำยละเอียดดังนี ้

o Nearest neighbor เป็นกำรก ำหนดค่ำของจุดภำพใหม่จำกค่ำของจุดภำพเดิมที่
อยู่ใกล้ที่สุดเพียงจุดเดียว ข้อดีของวิธีแบบ Nearest neighbor คือ ไม่มีกำรค ำนวณค่ำเชิงเลขใหม่ จึงเป็น
วิธีกำรที่เหมำะส ำหรับกำรน ำข้อมูลไปใช้ในกำรจ ำแนกประเภทข้อมูลด้วยคอมพิวเตอร์ (Classification) ใน
ภำยหลัง และเป็นวิธีที่สำมำรถใช้ได้กับข้อมูลเชิงคุณภำพ เช่น ข้อมูลกำรใช้ที่ดิน หรือข้อมูลเชิงปริมำณ เช่น 
ปริมำณน้ ำฝน รวมทั้งมีควำมรวดเร็วในกำรประมวลผล แต่ข้อด้อย คือ ภำพผลลัพธ์อำจจะไม่รำบเรียบ 
(Smooth) และค่ำข้อมูลบำงส่วนอำจขำดหำยไป 

o Linear (หรือ Bilinear interpolation) เป็นกำรก ำหนดค่ำของจุดภำพใหม่จำก
ค่ำเฉลี่ยถ่วงน้ ำหนักของจุดภำพเดิมที่อยู่ใกล้เคียงที่สุด จ ำนวน 4 จุดภำพ (2 x 2 kernel) โดยใช้ฟังก์ชันเชิง
เส้น (Linear function) ในกำรค ำนวณค่ำถ่วงน้ ำหนัก ข้อดีของวิธีนี้ คือ ภำพผลลัพธ์จะมีควำมถูกต้องเชิง
ต ำแหน่งของค่ำเชิงเลขและมีควำมเรียบมำกกว่ำวิธีแบบ Nearest neighbor แต่ข้อด้อย คือ ค่ำข้อมูลจะ
เปลี่ยนแปลงไป โดยเฉพำะบริเวณภำพที่มีควำมเปรียบต่ำงสูง ๆ จะมีกำรเปลี่ยนแปลงค่ำข้อมูลสูง เนื่องจำกมี
กำรเฉลี่ยค่ำเชิงเลขของจุดภำพข้ำงเคียง 

o Cubic (หรือ Bicubic interpolation) เป็นกำรก ำหนดค่ำของจุดภำพใหม่จำก
ค่ำเฉลี่ยถ่วงน้ ำหนักของจุดภำพเดิมที่อยู่ใกล้เคียงที่สุด จ ำนวน 16 จุดภำพ (4 x 4 kernel) โดยใช้ฟังก์ชัน   
พหุนำมก ำลังสำม (Cubic polynomial function) ค ำนวณค่ำถ่วงน้ ำหนักแทนกำรใช้ฟังก์ชันเชิงเส้นตำมวิธี
แบบ Nearest neighbor ข้อดีของวิธีนี้ คือ สำมำรถท ำให้ควำมคมชัดหรือปรับภำพให้รำบเรียบได้ แต่ข้อด้อย 
คือ ค่ำข้อมูลจะเปลี่ยนแปลง และใช้เวลำประมวลผลมำกกว่ำวิธีแบบ Nearest neighbor และ Bilinear 

o Cubic Spline เป็นกำรก ำหนดค่ำของจุดภำพใหม่จำกจำกค่ำเฉลี่ยถ่วงน้ ำหนัก
ของจุดภำพเดิมที่อยู่ใกล้เคียงที่สุด จ ำนวน 16 จุดภำพ (4 x 4 kernel) โดยใช้ฟังก์ชันเสมือนพหุนำมก ำลังสำม 
(Cubic B-Spline function) ในกำรค ำนวณค่ำถ่วงน้ ำหนัก ข้อดีของวิธีนี้ คือ ภำพผลลัพธ์จะมีควำมรำบเรียบ
มำก และข้อมูลเชิงเลขจะมีควำมถูกต้องทำงต ำแหน่งสูง นิยมใช้ในกำรเพิ่มอัตรำสุ่มของข้อมูล (Upsampling) 
ข้อด้อย คือ ค่ำข้อมูลจะเปลี่ยนแปลง และกำรค ำนวณมีควำมซับซ้อนมำก จึงใช้เวลำประมวลผลนำน 
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o Lanczos เป็นกำรก ำหนดค่ำของจุดภำพใหม่จำกจำกค่ำเฉลี่ยถ่วงน้ ำหนักของ
จุดภำพเดิมที่อยู่ใกล้เคียงที่สุด จ ำนวน 36 จุดภำพ (6 x 6 kernel) โดยใช้ฟังก์ชันไซน์ (Lanczos-windowed 
sine function) ในกำรค ำนวณค่ำถ่วงน้ ำหนัก ข้อดีของวิธีนี้ คือ ภำพผลลัพธ์มีควำมรำบเรียบและคมชัด แต่มี
ข้อด้อย คือ ค่ำข้อมูลจะเปลี่ยนแปลงไป และใช้เวลำประมวลผลนำน 

 Compression: ให้เลือกวิธีกำรบีบอัดข้อมูล 

 Output raster: ให้ก ำหนดชื่อและสถำนที่จัดเก็บชั้นข้อมูลผลลัพธ์ของกำรก ำหนดพิกัด
ภำพ 

 Target SRS: ให้ก ำหนดระบบพิกัดที่เป็นระบบพิกัดของจุดควบคุมพื้นดิน 

 Generate pdf map: ให้ก ำหนดช่ือและสถำนที่จัดเก็บแผนที่ในรูปแบบ pdf 

 Generate pdf report: ให้ก ำหนดชื่อและสถำนที่จัดเก็บรำยงำนกำรก ำหนดพิกัดภำพใน
รูปแบบ pdf ข้อมูลในรำยงำนประกอบด้วยพำรำมิเตอร์ที่ใช้ในกำรแปลงค่ำพิกัด ค่ำของจุดควบคุมพื้นดิน ค่ำ
ตกค้ำง (Residual) และค่ำคลำดเคลื่อนรำกก ำลังสองเฉลี่ย (RMS error) 

 Set Target Resolution: ใช้ส ำหรับก ำหนดขนำดของจุดภำพของช้ันข้อมูลผลลัพธ์ 

 Use 0 for transparency when needed: คลิกตัวเลือกนี้เมื่อต้องกำรก ำหนดให้จุดภำพ
ที่มีค่ำ 0 แสดงข้อมูลแบบโปร่งใส 

 Load in QGIS when done: คลิกตัวเลือกนี้เมื่อต้องกำรให้เพิ่มชั้นข้อมูลผลลัพธ์ในแผนที่
ทันที 

11) คลิกปุ่ม OK ในหน้ำต่ำง โปรแกรมจะค ำนวณค่ำตกค้ำง ค่ำสัมประสิทธิ์ของสมกำรกำรแปลงพิกัด 
และค่ำคลำดเคลื่อนรำกก ำลังสองเฉลี่ย และแสดงข้อมูลดังกล่ำวในตำรำงข้อมูลและแถบสถำนะของหน้ำต่ำง 
ในกรณีที่ค่ำตกค้ำงและค่ำคลำดเคลื่อนรำกก ำลังสองเฉลี่ยมีค่ำสูงเกินกว่ำที่ยอมรับได้ ผู้ใช้สำมำรถเพิ่ม ลบ 

หรือย้ำยจุดควบคุมพื้นดิน (โดยกำรคลิกปุ่ม Delete point    หรือปุ่ม Move GCP point   ) 
หรือคลิกที่กล่องตัวเลือกในช่อง on/off เพื่อไม่ใช้จุดควบคุมพื้นดินนั้นในกำรค ำนวณค่ำ ผู้ใช้ต้องปรับแก้จุด
ควบคุมพื้นดินจนกระทั่งค่ำตกค้ำงและค่ำคลำดเคลื่อนรำกก ำลังสองเฉลี่ยอยู่ในเกณฑท์ี่ยอมรับได้ 

12) เมื่อก ำหนดจุดควบคุมพื้นดิน และค่ำกำรแปลงพิกัดต่ำง ๆ เสร็จสิ้นแล้ว ให้คลิกเมนู File > Start 

georeferencing หรือ คลิกปุ่ม   หรือกดปุ่ม Ctrl + G บนแผงแป้นอักขระ เพื่อให้โปรแกรมก ำหนด
ระบบพิกัดภำพและสร้ำงข้อมูลแรสเตอร์ใหม่ 
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1. คลิกเมนู Plugins > Georeferencer 
> Georeferencer 

 หน้าต่าง Georeferencer 

2. เพิ่มชั้นข้อมูลแรสเตอร ์

3. คลิกปุ่ม Cancel MAHID
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5. คลิกบนภาพเพื่อก าหนดจุดควบคุมพื้นดิน 

 

6. พิมพ์ค่าพิกดัของจุดควบคุม
พื้นดินลงในชอ่ง X: และ Y: 

4. คลิกปุ่ม Add point 

7. คลิกปุ่ม Ok 

 

จุดควบคุมพื้นดินบนภาพ 

8. ท าซ้ าขั้นตอนที่ 4 – 7 เพื่อ
ก าหนดจุดควบคุมพื้นดินให้มีจ านวน

มากพอและครอบคลุมทั่วทัง้ภาพ 
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9. คลิกเมนู Settings > Transformation settings 

 

สถานะแสดงวา่ยังไม่ก าหนด
วิธีการแปลงพกิัด 

10. ก าหนดค่าการแปลงพิกดั 

11. คลิกปุ่ม OK 
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3. การใช้งาน Raster calculator 
 เครื่องมือ Raster calculator เป็นเครื่องมือหลัก (Core) ที่ใช้ในกำรค ำนวณข้อมูลของเซลล์ในชั้น
ข้อมูลแรสเตอร์ (Map algebra) ที่สำมำรถใช้ประมวลผลชั้นข้อมูลเพียงชั้นเดียว หรือหลำยชั้นข้อมูลได้ 
จัดเป็นเครื่องมือที่เหมำะกับกำรวิเครำะห์เพื่อท ำแบบจ ำลองทำงแผนที่ (Cartographic modeling) โดยจะได้
ผลลัพธ์ของกำรค ำนวณเป็นช้ันข้อมูลใหม่ กำรใช้งำนเครื่องมือ Raster calculator มีรำยละเอียดดังนี ้

 3.1 กำรเปิดใช้งำน Raster calculator 
  กำรใช้งำนเครื่องมือ Raster calculator สำมำรถท ำได้โดยคลิกเมนู Raster > Raster 
calculator  
  ส่วนต่อประสำนกรำฟิกกับผู้ใช้ (Graphical user interface) ในหน้ำต่ำง Raster 
calculator มีองค์ประกอบที่ส ำคัญดังนี ้
   

12. คลิกเมนู File > Start georeferencing 

 

ข้อมูลภาพผลลัพธ์ที่แสดง
บนแผนที่จะมรีะบบพิกัด 

สถานะแสดงวธิีการแปลงคา่พิกัดและ
ค่าคลาดเคลื่อนรากก าลังสองเฉลี่ย 

ค่าตกค้าง 
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 Raster bands เป็นช่องที่แสดงแบนด์ของชั้นข้อมูลแรสเตอร์ที่สำมำรถใช้ในกำรค ำนวณ 
โปรแกรมจะแสดงแบนด์ของชั้นข้อมูลด้วยรูปแบบ “ชื่อชั้นข้อมูล@หมำยเลขแบนด์ของชั้นข้อมูล” ยกตัวอย่ำง
เช่น Layer@1 เมื่อผู้ใช้ดับเบิลคลิกที่แบนด์ในช่อง Raster bands โปรแกรมจะแทรกแบนด์นั้นในช่องนิพจน์
ของกำรค ำนวณให้อัตโนมัติ 

 Operators เป็นกรอบที่แสดงตัวด ำเนินกำรที่สำมำรถใช้สร้ำงนิพจน์ของกำรค ำนวณ เช่น 
ตัวด ำเนินกำรทำงคณิตศำสตร์ (เช่น + , - , * , /) ตัวด ำเนินกำรสัมพันธ์ (เช่น > , < , = , => , <=) ตัว
ด ำเนินกำรตรรกะ (เช่น AND , OR) หรือฟังก์ชันตรีโกณมิติ (เช่น sin , cos , tan) เป็นต้น 

ตัวด าเนินการ 

ช่องแสดงนิพจน์ของ
การค านวณ 

คลิกเมนู Raster > Raster calculator 

  

 

 

กรอบแสดงชัน้ข้อมูลและแบนด์ข้อมลู 

กรอบส าหรับก าหนดค่า
ชั้นข้อมูลผลลพัธ์ 
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 Raster calculator expression  เป็นช่องแสดงนิพจน์ของกำรค ำนวณ โดยแบนด์ของชั้น
ข้อมูลแรสเตอร์จะเปรียบเสมือนเป็นตัวแปรในกำรค ำนวณ ทั้งนี้ ผู้ใช้สำมำรถใช้แผงแป้นอักขระเพื่อพิมพ์ค่ำ
ต่ำง ๆ ส ำหรับใช้ในกำรสร้ำงนิพจน์ได้ 

 Result layer เป็นกรอบที่ใช้ก ำหนดค่ำของชั้นข้อมูลผลลัพธ์ ซึ่งมีรำยละเอียดดังนี้ 
o Output layer เป็นช่องส ำหรับก ำหนดช่ือและสถำนที่จัดเก็บชั้นข้อมูลผลลัพธ์ 
o Current layer extent เป็นปุ่มที่ก ำหนดให้ขอบเขตของชั้นข้อมูลผลลัพธ์ให้มี

ขอบเขตเท่ำกับช้ันข้อมูลน ำเข้ำ 
o XMin , YMin , XMax , YMax เป็นช่องส ำหรับขอบเขตของชั้นข้อมูลผลลัพธ์

ตำมค่ำพิกัด X,Y 
o Columns , Rows เป็นช่องส ำหรับก ำหนดควำมละเอียดของข้อมูลแรสเตอร์จำก

จ ำนวนสดมภแ์ละแถว 
o Output format เป็นตัวเลือกที่ใช้ก ำหนดประเภทของช้ันข้อมูลผลลัพธ์ 
o Add result to project เป็นตัวเลือกที่ใช้แสดงชั้นข้อมูลผลลัพธ์ในแผนที่ทันที

หลังกำรประมวลผลข้อมูลเสร็จ 

3.2 ตัวอย่ำงกำรประยุกต์ใช้งำน 

 กำรปรับค่ำควำมสูง (Vertical exaggeration) เป็นกำรค ำนวณค่ำควำมสูงของชั้นข้อมูล
แรสเตอร์ขึ้นใหม่ โดยมีวัตถุประสงค์เพื่อเน้นให้เห็นถึงควำมแตกต่ำงหรือควำมเปลี่ยนแปลงของระดับควำมสูง
ได้ง่ำยมำกขึ้น มักจะใช้ในกรณีที่ขอบเขตทำงรำบ (Horizontal extent) กับขอบเขตทำงดิ่ง (Vertical 
extent) ของชั้นข้อมูลแตกต่ำงกันมำก ๆ กำรใช้ Raster calculator เพื่อปรับค่ำควำมสูงให้มำกขึ้น 2 เท่ำ มี
ขั้นตอนดังนี้ 

1) ในหน้ำต่ำง Raster calculator ให้ดับเบิลคลิกชั้นข้อมูลควำมสูง (Elevation@1) 
ในช่อง Raster bands  

2) คลิกตัวด ำเนินกำรคูณ ( * ) 
3) คลิกในช่อง Raster calculator expression จำกนั้นพิมพ์ 2 ซึ่งจะได้นิพจน์เป็น 

Elevation@1 * 2 (ถ้ำนิพจน์มีควำมถูกต้อง โปรแกรมจะแสดงข้อควำม Expression valid ที่บริเวณมุมล่ำง
ซ้ำยของหน้ำต่ำง Raster calculator) 

4) ก ำหนดค่ำต่ำง ๆ ของช้ันข้อมูลผลลัพธ ์
5) คลิกปุ่ม OK เพื่อให้โปรแกรมค ำนวณค่ำในกำรสร้ำงชั้นข้อมูลผลลัพธ์                                                                                                                                                                   
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สถิติของข้อมูลก่อนกำรค ำนวณ สถิติของข้อมูลหลังกำรค ำนวณ 
 

หมำยเหตุ:  ถ้ำผู้ใช้ต้องกำรแปลงหน่วยของขั้นข้อมูลควำมสูงที่มีหน่วยเป็นฟุตให้เป็นเมตร จะมีนิพจน์ของกำร
ค ำนวณ คือ elevation@1 * 0.3048) 

 

 กำรสร้ำงชั้นข้อมูลบังภำพ (Bitmap mask) เป็นกำรสร้ำงชั้นข้อมูลส ำหรับกำรบังภำพ 
(Masking) (กำรบังภำพในควำมหมำยของกำรวิเครำะห์ข้อมูลแบบแรสเตอร ์หมำยถึง กำรก ำหนดขอบเขตหรือ
พื้นที่ที่ต้องกำรใช้ในกำรวิเครำะห์ข้อมูล ค่ำของเซลล์ในชั้นข้อมูลนี้จะมีค่ำที่เป็นไปได้เพียง 2 ค่ำ คือ           
ค่ำ 1 = พื้นที่ที่ต้องกำรวิเครำะห์ และ ค่ำ 0 = พื้นที่ที่ไม่ต้องกำรวิเครำะห์ ชั้นข้อมูลที่ใช้ในลักษณะนี้จึงอำจจะ
เรียกว่ำ Analysis mask ได้เช่นกัน นอกจำกนี้ ชั้นข้อมูลบังภำพยังสำมำรถน ำไปใช้ในกำรแสดงข้อมูลแบบ   

1. ดับคลิกชั้นข้อมูล 

 

ข้อความแสดงความถูกต้องของนิพจน ์

2. คลิกเครื่องหมายคูณ 

5. คลิกปุ่ม OK 3. พิมพ์ค่า 2 

4. ก าหนดค่าของชั้นข้อมูลผลลัพธ ์
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แรสเตอร์ เช่น ค่ำ 1 = พื้นที่ที่ต้องกำรแสดงข้อมูล และ ค่ำ 0 = พื้นที่ที่ไม่ต้องกำรแสดงข้อมูล กำรใช้ชั้นข้อมูล
ในลักษณะนี้เรียกว่ำ Transparency mask) ในตัวอย่ำงนี้ จะสำธิตกำรสร้ำงชั้นข้อมูลบังภำพจำกชั้นข้อมูล
ควำมสูง โดยก ำหนดให้พื้นที่ที่มีควำมสูงมำกกว่ำหรือเท่ำกับ 800 เมตร เป็นพื้นที่ที่ต้องกำรใช้ในกำร
ประมวลผล  (ค่ำ = 1) และพื้นที่อื่น ๆ เป็นพื้นที่กันออก (ค่ำ = 0) กำรสร้ำงชั้นข้อมูลบังภำพดังกล่ำว มี
ขั้นตอนดังนี้ 

1) ในหน้ำต่ำง Raster calculator ให้คลิกในช่อง Raster calculator expression 
จำกนั้นพิมพ์ Elevation@1 >= 800 (ผลลัพธ์ของนิพจน์นี้จะก ำหนดให้พื้นที่ที่มีควำมสูงมำกกว่ำหรือเท่ำกับ 
800 เมตร มีค่ำ = 1 และพื้นที่อื่น ๆ มีค่ำ = 0) 

2) ก ำหนดค่ำต่ำง ๆ ของชั้นข้อมูลผลลัพธ์ในกรอบ Result layer 
3) คลิกปุ่ม OK เพื่อให้โปรแกรมค ำนวณค่ำในกำรสร้ำงช้ันข้อมูลผลลัพธ์ 

 

 
 
 
 
 

 
 

 

1. พิมพ์นิพจน์ Elevation@1 >= 800 

 

2. ก าหนดค่าของชั้นข้อมูลผลลัพธ ์

3. คลิกปุ่ม OK 

พื้นที่ที่มคีวามสูงมากกว่าหรอืเท่ากับ 800 เมตร 
คือ พื้นที่ที่ต้องการใช้วิเคราะห์ข้อมูล (Mask-in) 

และมีค่า = 1 
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 กำรวิเครำะห์แบบวำงซ้อน (Overlay operation) เป็นกำรวิเครำะห์ข้อมูลมำกกว่ำ 1 ชั้น
ข้อมูล ที่นิยมน ำไปประยุกต์ใช้กับกำรวิเครำะห์ศักยภำพพื้นที่ (Potential Surface Analysis: PSA) ใน
ตัวอย่ำงนี้ จะสำธิตกำรบวกช้ันข้อมูลแรสเตอร์จ ำนวน 2 ชั้น ซึ่งมีวิธีกำรดังนี ้

1) ในหน้ำต่ำง Raster calculator ให้ดับเบิลคลิกชั้นข้อมูลพื้นที่ชลประทำน 
(Irrigated area) ในช่อง Raster bands 

2) คลิกตัวด ำเนินกำรบวก ( + ) 
3) ดับเบิลคลิกชั้นข้อมูลแนวกันชนจำกแหล่งน้ ำ 500 เมตร (Stream buffer 

500m) ในช่อง Raster bands 
4) ก ำหนดค่ำต่ำง ๆ ของชั้นข้อมูลผลลัพธ์ในกรอบ Result layer 
5) คลิกปุ่ม OK เพื่อให้โปรแกรมค ำนวณค่ำในกำรสร้ำงช้ันข้อมูลผลลัพธ์ 

 
 
 

 
 
 
 

1. ดับเบิลคลกิ Input layer 1 

2. คลิกตัวด าเนินการบวก 

3. ดับเบิลคลกิ Input layer 2 

 

4. ก าหนดค่าของชั้นข้อมูลผลลัพธ ์

 
นิพจน์ของการค านวณ 

5. คลิกปุ่ม OK 
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 ชั้นข้อมูลผลลพัธ์ที่ได้จากการบวก
ชั้นข้อมูลน้ าเข้า 2 ชั้นข้อมูล 
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บทที่ 8 การวิเคราะห์ข้อมูลเบื้องต้น 

 ระบบสารสนเทศภูมิศาสตร์มีฟังก์ชันหรือค าสั่งจ านวนมากที่ใช้ในการวิเคราะห์ข้อมูลเพื่อแสวงหา
ค าตอบต่าง ๆ ที่เกี่ยวข้องกับปัญหาเชิงพื้นที่ โดยปกติแล้ว โปรแกรมระบบสารสนเทศภูมิศาสตร์ส่วนใหญ่
มักจะจัดแบ่งกลุ่มค าสั่งต่าง ๆ ออกเป็นหมวดหมู่ เช่น กลุ่มวิเคราะห์ข้อมูลพื้นฐาน กลุ่มวิเคราะห์ข้อมูลเชิง
พื้นที่ กลุ่มวิเคราะห์ข้อมูล 3 มิติ กลุ่มวิเคราะห์ข้อมูลโครงข่าย เป็นต้น ส าหรับโปรแกรม QGIS จะมีซอฟต์แวร์
เสริม (Plug in) ที่ชื่อว่า fTools Plugin ซึ่งจะมีฟังก์ชันส าหรับจัดการและวิเคราะห์ข้อมูลเวกเตอร์ จ านวน 5 
กลุ่ม ได้แก่ Data Management Tools, Analysis Tools, Research Tools, Geoprocessing Tools, และ 
Geometry Tools 

ในบทนี้  จะอธิบายถึงแนวคิดและขั้นตอนการใช้ฟังก์ชันการวิเคราะห์ข้อมูลพื้นฐานในกลุ่ม 
Geoprocessing Tools ซึ่งเป็นฟังก์ชันที่มีการใช้งานบ่อย ๆ รวมทั้งสาธิตตัวอย่างการประยุกต์ใช้ค าสั่งในการ
วิเคราะห์ข้อมูลแบบผสมผสานเพื่อตอบค าถามเชิงพื้นที ่ซึ่งมีรายละเอียดดังนี ้

1. ฟังก์ชัน Convex Hull 
ฟังก์ชัน Convex Hull เป็นค าสั่งที่ใช้ในการสร้างขอบเขตพื้นที่ล้อมรอบฟีเจอร์น าเข้า ซึ่งส่วนใหญ่จะ

เป็นข้อมูลประเภทจุด ขอบเขตหรือพื้นที่หรือรูปหลายเหลี่ยมที่สร้างขึ้นนี้ เรียกว่า Convex hull ซึ่งจะมีมุม
ภายในแต่ละมุมมีขนาดไม่เกิน 180 องศา ผลลัพธข์องฟังก์ชัน Convex Hull จะได้เป็นช้ันข้อมูลใหม่ที่มีฟีเจอร์
ประเภทรูปหลายเหลี่ยม (Polygon) ที่ล้อมรอบฟีเจอร์ของช้ันข้อมูลที่น าเข้า (Input layer) 

 

 
รูปที ่8.1 ฟังกช์ัน Convex Hull. จาก ArcGIS help library, โดย ESRI, Inc., 2012, ค้นเมื่อ 3 กันยายน 2556, 
จาก http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000003q000000.htm. 
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ฟังก์ชัน Convex Hull เป็นค าสั่งที่มักจะประยุกต์ใช้ในการศึกษาด้านนิเวศวิทยา เช่น การค านวณหา
พื้นที่อาศัย (Home range) หรือการศึกษาด้านอาชญากรรม เช่น การวิเคราะห์พื้นที่เสี่ยงต่อการเกิด
อาชญากรรมในปริมาณสูง (Hot Spot) เป็นต้น ในตัวอย่างนี้จะสาธิตการใช้งานฟังก์ชัน Convex Hull เพื่อหา
พื้นที่อาศัยของสัตว์โดยใช้ช้ันข้อมูลประเภทจุด ซึ่งสมมุติให้เป็นจุดที่พบเจอสัตว์ป่า โดยมีรายละเอียดดังนี ้

1) เพิ่มชั้นข้อมูลเวกเตอร์ประเภทจุดที่ต้องการสร้าง Convex Hull ในแผนที่ ในตัวอย่างนี้ คือ ชั้น
ข้อมูลจุดที่พบเจอสัตว์ป่า (ANIMAL) 

2) คลิกเมนู Vector > Geoprocessing Tools > Convex hull(s) 
 3) ในหน้าต่าง Convex hull(s) ให้เลือกชั้นข้อมูลจุดที่ต้องการสร้าง Convex hull ในช่อง Input 
vector layer ในตัวอย่างนี้เลือก ANIMAL (ถ้าต้องการสร้าง Convex hull จากเฉพาะฟีเจอร์ที่เลือก ให้ผู้ใช้
คลิกกล่องกาเครื่องหมาย Use only selected features) 

4) ในกรณีที่ต้องการสร้าง Convex hull เพียงรูปเดียวจากจุดข้อมูลทั้งหมด (หรือจากจุดข้อมูลที่
เลือก) ให้เลือกตัวเลือก Create single minimum convex hull แต่ถ้าต้องการสร้าง Convex hull หลายรูป
โดยอาศัยค่าของเขตข้อมูล ให้เลือกตัวเลือก Create convex hulls based on input field ในตัวอย่างนี้
ต้องการสร้าง Convex hull เพียงรูปเดียวจากจุดข้อมูลทั้งหมด ให้คลิกตัวเลือก Create single minimum 
convex hull  

5) ก าหนดสถานที่จัดเก็บและชื่อของชั้นข้อมูลผลลัพธ์ในช่อง Output shapefile 
6) คลิกปุ่ม OK 
 

 

1. เพิ่มชั้นข้อมูลที่ต้องการสร้าง Convex hull ในแผนที่ 

2. คลิกเมนู Vector > Geoprocessing 
Tools > Convex hull(s) MAHID
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3. เลือกชัน้ข้อมูลที่ต้องการสร้าง Convex hull(s) 

ก าหนดใหส้ร้าง Convex hull 
จากเฉพาะฟีเจอร์ที่เลือก 

5. ก าหนดชั้นข้อมูลผลลัพธ ์ 6. คลิกปุ่ม OK 

 

4. ก าหนดใหส้ร้าง Convex 
hull จากเฉพาะฟีเจอร์ทีเ่ลอืก 

ก าหนดใหส้ร้าง Convex hull 
จากค่าของเขตข้อมูล 

ชั้นข้อมูลผลลพัธ์ของ
ฟังก์ชัน Convex 

hull(s) 
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2. ฟังก์ชัน Buffer 
 ฟังก์ชัน Buffer เป็นค าสั่งที่ใช้ในการสร้างพื้นที่กันชนรอบฟีเจอรต์ามระยะทางที่ผู้ใช้ก าหนดหรือตาม
ค่าระยะทางในเขตข้อมูลจากตารางข้อมูลลักษณะประจ า ผลลัพธ์จะได้เป็นชั้นข้อมูลใหม่ที่มีฟีเจอร์ประเภทรูป
หลายเหลี่ยม (Polygon) 
 

 
 
รูปที่ 8.2 ฟังก์ชัน Buffer. จาก ArcGIS help library, โดย ESRI, Inc., 2012, ค้นเมื่อ 3 กันยายน 2556, จาก 

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//000800000019000000 
 

ฟังก์ชัน Buffer เป็นค าสั่งที่มีการประยุกต์ใช้อย่างกว้างขวาง โดยเฉพาะอย่างยิ่งการเลือกพื้นที่ที่
เหมาะสมหรือพื้นที่เสี่ยง เช่น การก าหนดพื้นที่เหมาะสมส าหรับการเพาะปลูก หรือการประเมินพื้นที่เสี่ยงภัย
ดินถล่ม เป็นต้น ฟังก์ชัน Buffer สามารถใช้ค านวณหาพื้นที่กันชนได้ทั้งฟีเจอร์ประเภทจุด เส้น และพื้นที่ เช่น 
การก าหนดพื้นที่เฝ้าระวังไข้หวัดนกจากโรงเลี้ยงสัตว์ปีก (ฟีเจอร์ประเภทจุด) การก าหนดแนวกันชนตามแนว
เส้นถนนเพื่อก าหนดพื้นที่เวนคืน (ฟีเจอร์ประเภทเส้น) หรือการก าหนดแนวกันชนรอบพื้นที่ป่าเพื่อก าหนด
พื้นที่อนุรักษ์ (ฟีเจอร์ประเภทพื้นที่) เป็นต้น ในตัวอย่างนี้จะสาธิตการใช้งานฟังก์ชัน Buffer เพื่อสร้างพื้นที่กัน
ชนของถนน เป็นระยะ 200 เมตร ซึ่งมีรายละเอียดดังนี ้

1) เพิ่มชั้นข้อมูลเวกเตอร์ที่ต้องการสร้างพื้นที่กันชนในแผนที่ ในตัวอย่างนี้ชั้นข้อมูลที่ต้องการสร้าง
พื้นที่กันชน (Input layer) คือ ชั้นข้อมูลถนน (ROAD) 
 2) คลิกเมน ูVector > Geoprocessing Tools > Buffer(s) 
 3) ในหน้าต่าง Buffer(s) ให้เลือกชั้นข้อมูลที่ต้องการสร้างพื้นที่กันชนในช่อง Input vector layer ใน
ตัวอย่างนี้เลือก ROAD (ถ้าต้องการสร้างพื้นที่กันชนเฉพาะฟีเจอร์ที่เลือก ให้ผู้ใช้คลิกกล่องกาเครื่องหมาย Use 
only selected features) 
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4) ในช่อง Segments to approximate ใช้ส าหรับก าหนดค่าความเรียบ (Smoothness) ของเส้น
โค้งแนวกันชน ถ้าค่ามากจะท าให้ส่วนโค้งของเส้นแนวกันชนมีความโค้งเรียบมาก ในตัวอย่างนี้ก าหนดค่าเป็น 
5 ซึ่งเป็นค่าเริ่มตน้ของโปรแกรม 

5) การก าหนดระยะกันชนในหน้าต่าง Buffer(s) สามารถก าหนดได้ 2 ลักษณะ คือ ผู้ใช้ก าหนดค่า
โดยตรง (Buffer distance) หรือผู้ใช้ก าหนดค่าจากเขตข้อมูลในตารางข้อมูลลักษณะประจ า (Buffer 
distance field) ในตัวอย่างนี้ผู้ใช้ก าหนดค่าโดยตรงเป็นระยะ 200 เมตร โดยการคลิกตัวเลือก Buffer 
distance พิมพ์ค่า 200 (ถ้าต้องการก าหนดระยะกันชนโดยใช้ก าหนดค่าจากเขตข้อมูล ให้ผู้ใช้คลิกตัวเลือก 
Buffer distance field และเลือกเขตข้อมูลที่ต้องการเพื่อใช้ในการก าหนดระยะกันชน) 

6) ในตัวเลือก Dissolve buffer results เป็นการก าหนดให้ผสานรวมพื้นที่กันชนที่ซ้อนทับกันเข้า
ด้วยกัน (Overlapping polygon) ส าหรับตัวอย่างนี้ต้องการให้ผสานรวมพื้นที่กันชนเข้าด้วยกันจึงคลิก
ตัวเลือก Dissolve buffer results 
 7) ก าหนดสถานที่จัดเก็บและชื่อของชั้นข้อมูลผลลัพธ์ในช่อง Output shapefile 

8) คลิกปุ่ม OK 
 
 
 

 
 

 

1. เพิ่มชั้นข้อมูลที่ต้องการสร้างพื้นที่กันชนในแผนที ่

2. คลิกเมนู Vector > Geoprocessing 
Tools > Buffer(s) MAHID
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3. เลือกชัน้ข้อมูลที่ต้องการสร้างพืน้ที่กันชน 

ก าหนดใหส้ร้างพื้นที่กนัชน
เฉพาะฟีเจอรท์ี่เลือก 

 
5. ก าหนดระยะกันชน 

7. ก าหนดชั้นข้อมูลผลลัพธ ์ 8. คลิกปุ่ม OK 

4. ก าหนดความเรียบของ
เสน้โค้งแนวกนัชน 

6. ผสานรวมพื้นที่กันชน 

ชั้นข้อมูลผลลพัธ์ของฟังก์ชนั Buffer 
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3. ฟังก์ชัน Intersect 
 ฟังก์ชัน Intersect เป็นค าสั่งการวิเคราะห์ข้อมูลแบบซ้อนทับ (Overlay) ที่ใช้ในการค้นหาพื้นที่ที่ทับ
ซ้อนกันระหว่างชั้นข้อมูล 2 ชั้น ผลลัพธ์จากการวิเคราะห์จะได้ชั้นข้อมูลใหม่ที่มีฟีเจอร์ของชั้นข้อมูลเป็นพื้นที่
ซ้อนทับร่วมกัน 
 

 
รูปที่ 8.3 ฟังก์ชัน Intersect. จาก ArcGIS help library, โดย ESRI, Inc., 2012, ค้นเมื่อ 3 กันยายน 2556, 
จาก http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00080000000p000000 

 
ฟังก์ชัน Intersect เป็นค าสั่งที่ใช้หาความสัมพันธ์เชิงพื้นที่ระหว่างชั้นข้อมูล 2 ชั้น จัดเป็นค าสั่งการ

วิเคราะห์ข้อมูลแบบซ้อนทับที่มีการใช้งานอย่างกว้างขวาง เช่น การหาพื้นที่ซ้อนทับระหว่างการใช้ที่ดินกับ
พื้นที่น้ าท่วมซ้ าซาก การหาพื้นที่ซ้อนทับระหว่างพื้นที่อุทยานแห่งชาติกับพื้นที่ออกเอกสารสิทธิ์ที่ดิน เป็นต้น 
ในตัวอย่างนี้จะสาธิตการใช้งานฟังก์ชัน Intersect ในการหาพื้นที่ทับซ้อนระหว่างพื้นที่เวนคืนในการสร้างถนน 
(พื้นกันชนของถนน ระยะ 200 เมตร) กับข้อมูลการใช้ที่ดิน เพื่อตอบค าถามว่าผลกระทบจากการสร้างถนนที่มี
ต่อการใช้ที่ดินแต่ละประเภทมีเนื้อที่เท่าใด ขั้นตอนการใชฟ้ังก์ชัน Intersect มีรายละเอียดดังนี ้

1) เพิ่มชั้นข้อมูลเวกเตอร์ที่ต้องการวิเคราะห์ข้อมูลแบบ Intersect ในแผนที่ ในตัวอย่างนี้ชั้นข้อมูล
พื้นที่เวนคืน (ROAD_BUFFER_200) และชั้นข้อมูลการใช้ที่ดิน (LU_2538) 
 2) คลิกเมน ูVector > Geoprocessing Tools > Intersect 
 3) ในหน้าต่าง Intersect ให้เลือกชั้นข้อมูลน าเข้าในช่อง Input vector layer ในตัวอย่างนี้เลือก 
LU_2538 (ถ้าต้องการวิเคราะห์ข้อมูลเฉพาะฟีเจอร์ที่เลือก ให้ผู้ใช้คลิกกล่องกาเครื่องหมาย Use only 
selected features) 

4) ในช่อง Intersect layer ให้ก าหนดชั้นข้อมูล Intersect ในตัวอย่างนี้เลือก ROAD_BUFFER_200  
(ถ้าต้องการวิเคราะห์ข้อมูลเฉพาะฟีเจอร์ที่เลือก ให้ผู้ใช้คลิกกล่องกาเครื่องหมาย Use only selected 
features) 

5) ก าหนดสถานที่จัดเก็บและชื่อของชั้นข้อมูลผลลัพธ์ในช่อง Output shapefile 
6) คลิกปุ่ม OK 
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1. เพิ่มชั้นข้อมูลที่ต้องการ Intersect ในแผนที ่

2. คลิกเมนู Vector > Geoprocessing 
Tools > Intersect 

3. เลือกชัน้ข้อมูลน าเข้า 

4. เลือกชัน้ข้อมูล Intersect 

ก าหนดให้วิเคราะห์ข้อมูล
เฉพาะฟีเจอรท์ี่เลือก 

5. ก าหนดชั้นข้อมูลผลลัพธ ์ 6. คลิกปุ่ม OK 
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4. ฟังก์ชัน Union 
ฟังก์ชัน Union เป็นค าสั่งการวิเคราะห์ข้อมูลแบบซ้อนทับ (Overlay) ที่ใช้ในการค้นหาพื้นที่ที่ทับ

ซ้อนกันระหว่างชั้นข้อมูล 2 ชั้น ผลลัพธ์จากการวิเคราะห์จะได้ชั้นข้อมูลใหม่ที่มีฟีเจอร์ของชั้นข้อมูลเกิดจาก
การซ้อนทับของฟีเจอร์ทั้งหมดของทั้ง 2 ชั้นข้อมูลเข้าด้วยกัน (ทั้งฟีเจอร์ที่ซ้อนทับและไม่ซ้อนทับกัน) และมี
ข้อมูลลักษณะประจ าของช้ันข้อมูลน าเข้า (Input layer) ผนวกรวมเข้าด้วยกันในชั้นข้อมูลผลลัพธ์ 

 
รูปที่ 8.4 ฟังก์ชัน Union. จาก ArcGIS help library, โดย ESRI, Inc., 2012, ค้นเมื่อ 3 กันยายน 2556, จาก 

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00080000000s000000 
 
ฟังก์ชัน Union เป็นค าสั่งการวิเคราะห์ข้อมูลแบบซ้อนทับที่มีความส าคัญ เพราะเป็นค าสั่งพื้นฐานที่

ต้องใช้งานบ่อยครั้ง คล้ายคลึงกับค าสั่ง Intersect แต่ให้ผลลัพธ์แตกต่างกัน คือ ค าสั่ง Intersect จะได้ผลลัพธ์

ชั้นข้อมูลผลลพัธ์ของ
ฟังก์ชัน Intersect 

 

 

ตารางข้อมูลลักษณะประจ าที่เป็น
ผลลัพธ์ของฟงัก์ชัน Intersect 
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ที่เกิดจากการตัดกันของชั้นข้อมูล แต่ค าสั่ง Union จะได้ผลลัพธ์ที่เกิดจากการรวมกันของชั้นข้อมูล ทั้งนี้ 
อาจจะกล่าวได้ว่า การวิเคราะห์หาพื้นที่เหมาะสมหรือพื้นที่เสี่ยงจะต้องมีการใช้งานฟังก์ชัน Union ทุกครั้ง  

ในตัวอย่างนี้จะสาธิตการใช้งานฟังก์ชัน Union ในการหาพื้นที่ทับซ้อนระหว่างขอบเขตอ าเภอกับ
ข้อมูลการใช้ที่ดิน เพื่อตอบค าถามว่าแต่ละอ าเภอมีการใช้ที่ดินแต่ละประเภทเป็นเนื้อที่เท่าใด ขั้นตอนการใช้
ฟังก์ชัน Union มีรายละเอียดดังนี ้

1) เพิ่มชั้นข้อมูลเวกเตอร์ที่ต้องการวิเคราะห์ข้อมูลแบบ Union ในแผนที่ ในตัวอย่างนี้ คือ ชั้นข้อมูล
ขอบเขตอ าเภอ (AMPHOE) และชั้นข้อมูลการใช้ที่ดิน (LU_2538) 
 2) คลิกเมน ูVector > Geoprocessing Tools > Union 
 3) ในหน้าต่าง Union ให้เลือกชั้นข้อมูลน าเข้าในช่อง Input vector layer ในตัวอย่างนี้เลือก 
AMPHOE 

4) ในช่อง Union layer ให้ก าหนดช้ันข้อมูล Union ในตัวอย่างนี้เลือก LU_2538 
5) ก าหนดสถานที่จัดเก็บและชื่อของชั้นข้อมูลผลลัพธ์ในช่อง Output shapefile 
6) คลิกปุ่ม OK 

 
 
 

 
 

 

1. เพิ่มชั้นข้อมูลที่ต้องการ Union ในแผนที ่

2. คลิกเมนู Vector > Geoprocessing 
Tools > Union MAHID
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3. เลือกชัน้ข้อมูลน าเข้า 

4. เลือกชัน้ข้อมูล Union 

5. ก าหนดชั้นข้อมูลผลลัพธ ์ 6. คลิกปุ่ม OK 

ชั้นข้อมูลผลลพัธ์ของ
ฟังก์ชัน Union 

 

 

ตารางข้อมูลลักษณะประจ าที่เป็น
ผลลัพธ์ของฟงัก์ชัน Union 
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5. ฟังก์ชัน Symmetrical difference 
 ฟังก์ชัน Symmetrical difference เป็นค าสั่งการวิเคราะห์ข้อมูลแบบซ้อนทับ (Overlay) ระหว่างชั้น
ข้อมูล 2 ชั้น ผลลัพธ์จากการวิเคราะห์จะได้ชั้นข้อมูลใหม่ที่เป็นพื้นที่ที่ไม่ซ้อนทับร่วมกันของทั้ง 2 ชั้นข้อมูล 
 

 
 

รูปที่ 8.5 ฟังก์ชัน Symmetrical difference. จาก ArcGIS help library, 
โดย ESRI, Inc., 2012, ค้นเมือ่ 3 กันยายน 2556, จาก 

http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00080000000r000000 
 

ในตัวอย่างนี้จะใช้ฟังก์ชัน Symmetrical difference เพื่อศึกษาวิเคราะห์ความเปลี่ยนแปลงของพื้นที่
เกษตรกรรมระหว่าง พ.ศ. 2537 กับ 2544 ผลลัพธ์ที่ได้จะเป็นชั้นข้อมูลใหม่ที่มีฟีเจอร์แสดงพื้นที่เกษตรกรรม
ที่เปลี่ยนแปลงไป ทั้งเนื้อที่ที่เคยเป็นพื้นที่เพาะปลูกเดิมและพื้นที่ที่ เป็นพื้นที่เพาะปลูกใหม่ ขั้นตอนการใช้
ฟังก์ชัน Symmetrical difference มีดังน้ี 

1) เพิ่มชั้นข้อมูลเวกเตอร์ที่ต้องการใช้ค าสั่ง Symmetrical difference ในแผนที่ ในตัวอย่างนี้ คือ 
ชั้นข้อมูลการใช้ที่ดิน พ.ศ. 2537 (LU_2537_AG) และชั้นข้อมูลการใช้ที่ดิน พ.ศ. 2544 (LU_2544_AG) 
 2) คลิกเมนู Vector > Geoprocessing Tools > Symmetrical difference 
 3) ในหน้าต่าง Symmetrical difference ให้เลือกชั้นข้อมูลน าเข้าในช่อง Input vector layer ใน
ตัวอย่างนี้เลือก LU_2537_AG 

4) ในหน้าต่าง Symmetrical difference ให้ก าหนดชั้นข้อมูล Difference ในตัวอย่างนี้เลือก 
LU_2544_AG 
 5) ก าหนดสถานที่จัดเก็บและชื่อของชั้นข้อมูลผลลัพธ์ในช่อง Output shapefile 

6) คลิกปุ่ม OK 
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1. เพิ่มชั้นข้อมูลที่ต้องการ Symmetrical difference ในแผนที ่

2. คลิกเมนู Vector > Geoprocessing 
Tools > Symmetrical difference 

3. เลือกชัน้ข้อมูลน าเข้า 

4. เลือกชัน้ข้อมูล Difference 

5. ก าหนดชั้นข้อมูลผลลัพธ ์ 6. คลิกปุ่ม OK 
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หมายเหตุ: ในโปรแกรม QGIS รุ่น 1.7.3 Wroclaw มีค าสั่ง Symmetrical difference ที่ปรากฏในเมนูและ
หน้าต่างของค าสั่งแสดงด้วยข้อความ Symetrical difference ซึ่งไม่ถูกต้อง ดังนั้น ในเอกสารฉบับนี้ จึงใช้
ข้อความ Symmetrical difference แทนข้อความค าสั่งที่ปรากฏในเมนูและหน้าต่างของโปรแกรม 

6. ฟังก์ชัน Clip 
ฟังก์ชัน Clip เป็นค าสั่งการวิเคราะห์ข้อมูลแบบซ้อนทับ (Overlay) ระหว่างชั้นข้อมูล 2 ชั้น ที่ใช้ใน

การตัดช้ันข้อมูล ผลลัพธ์จากการวิเคราะห์จะได้ชั้นข้อมูลใหม่ที่มีขอบเขตของชั้นข้อมูลเหมือนกับชั้นข้อมูลที่ใช้
ในการตัด (Clip layer) 

 

 
 

รูปที่ 8.6 ฟังก์ชัน Clip. จาก ArcGIS help library, โดย ESRI, Inc., 2012, ค้นเมื่อ 3 กันยายน 2556, จาก 
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//000800000004000000 

ชั้นข้อมูลผลลพัธ์ของฟังก์ชนั 
Symmetrical difference 
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ฟังก์ชัน Clip เป็นค าสั่งที่มักจะใช้ในการตัดชั้นข้อมูลตามพื้นที่ศึกษา เช่น การตัดชั้นข้อมูลการใช้ที่ดิน
ด้วยขอบเขตอ าเภอ เป็นต้น ในตัวอย่างนี้จะสาธิตการใช้งานฟังก์ชัน Clip เพื่อตัดข้อมูลขอบเขตการใช้ที่ดิน
ของจังหวัดกาญจนบุรีให้เหลือเฉพาะในอ าเภอเมือง ซึ่งมีรายละเอียดดังนี ้

1) เพิ่มชั้นข้อมูลเวกเตอร์ที่ต้องการตัดและใช้ตัดในแผนที่ ในตัวอย่างนี้ชั้นข้อมูลที่ต้องการตัด (Input 
layer) คือ ชั้นข้อมูลการใช้ที่ดิน (LU_2538) และชั้นข้อมูลที่ใช้ตัด (Clip layer) คือ ชั้นข้อมูลขอบเขตอ าเภอ 
(AMPHOE) 
 2) ในตัวอย่างนี้ชั้นข้อมูลขอบเขตอ าเภอมีฟีเจอร์อ าเภอทั้งหมดของจังหวัดกาญจนบุรี แต่เงื่อนไขที่
ก าหนดไว้คือ การตัดข้อมูลขอบเขตการใช้ที่ดินของจังหวัดกาญจนบุรีให้เหลือเฉพาะในอ าเภอเมือง ดังนั้น จึง
ต้องเลือกฟีเจอร์อ าเภอเมืองที่จะใช้ในการตัดโดยใช้เครื่องมือ Select single feature (ถ้าชั้นข้อมูลที่ใช้ตัดมี
เฉพาะข้อมูลฟีเจอร์ที่ต้องการใช้ตัดเท่าน้ัน ผู้ใช้ไม่มีความจ าเป็นต้องเลือกฟีเจอร์ และสามารถใช้ช้ันข้อมูลนั้นใน
การตัดได้ทันที) 
 3) คลิกเมนู Vector > Geoprocessing Tools > Clip 
 4) ในหน้าต่าง Clip ให้เลือกชั้นข้อมูลที่ต้องการตัดในช่อง Input vector layer ในตัวอย่างนี้เลือก 
LU_2538 

5) ในหน้าต่าง Clip ให้เลือกชั้นข้อมูลที่ใช้ตัดในช่อง Clip layer ในตัวอย่างนี้เลือก AMPHOE 
 6) คลิกกล่องกาเครื่องหมาย Use only selected features เพื่อก าหนดให้ใช้ฟีเจอร์ที่เลือกในการ
ตัดข้อมูล 

7) ก าหนดสถานที่จัดเก็บและชื่อของชั้นข้อมูลผลลัพธ์ในช่อง Output shapefile 
8) คลิกปุ่ม OK 
 

MAHID
OL



บทที่ 8 การวิเคราะห์ข้อมูลเบื้องต้น  หน้า 266 
 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

 
 

 
 

 

1. เพิ่มชั้นข้อมูลที่ต้องการตดัและใช้ตัดในแผนที ่

2. เลือกฟีเจอร์ที่ใช้ตัด 

3. คลิกเมนู Vector > 
Geoprocessing Tools > Clip MAHID
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4. เลือกชั้นข้อมูลที่ต้องการตดั
ที ่

5. เลือกชั้นข้อมูลที่ต้องการตดั
ที ่

6. ก าหนดใหใ้ช้ฟีเจอร์ที่ถูก
เลือกในการตัดชั้นข้อมูลที่

ต้องการตัดที ่

7. ก าหนดชั้นข้อมูลผลลัพธ ์ 8.คลิกปุ่ม OK 

ชั้นข้อมูลผลลพัธ์ของฟังก์ชนั Clip 
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7. ฟังก์ชัน Difference 
ฟังก์ชัน Difference เป็นค าสั่งการวิเคราะห์ข้อมูลแบบซ้อนทับ (Overlay) ระหว่างชั้นข้อมูล 2 ชั้น ที่

ใช้ในการตัดชั้นข้อมูล ค าสั่งนี้มีความคล้ายคลึงกับฟังก์ชัน Clip แต่จะให้ผลลัพธ์ที่ตรงกันข้าม ผลลัพธ์จากการ
วิเคราะห์จะได้ชั้นข้อมูลใหม่ที่มีฟีเจอร์ของช้ันข้อมูลไม่ซ้อนทับกับชั้นข้อมูลที่ใช้ในการตัด (Erase layer) 
 

 
 

รูปที่ 8.7 ฟังก์ชัน Difference. จาก ArcGIS help library, โดย ESRI, Inc., 2012, ค้นเมื่อ 3 กันยายน 2556, จาก 
http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#/Erase/00080000000m000000/ 

 
 ในตัวอย่างนี้จะตัดชั้นข้อมูลชุดดินออกด้วยชั้นข้อมูลแหล่งน้ า ผลลัพธ์ที่ได้จะเป็นชั้นข้อมูลใหม่ที่มี
ฟีเจอร์ชุดดนิที่ตัดส่วนของพ้ืนที่ซ้อนทับกับแหล่งน้ าออกไป ขั้นตอนการใช้ฟังก์ชัน Difference มีดังน้ี 

1) เพิ่มชั้นข้อมูลเวกเตอร์ที่ต้องการใช้ค าสั่ง Difference ในแผนที่ ในตัวอย่างนี้ชั้นข้อมูลที่ต้องการตัด
ออก (Input layer) คือ ชั้นข้อมูลดิน (SOIL) และชั้นข้อมูลที่ใช้ตัด (Difference layer) คือ ชั้นข้อมูลแหล่งน้ า 
(WTR_BODY) 
 2) คลิกเมนู Vector > Geoprocessing Tools > Difference 
 3) ในหน้าต่าง Difference ให้เลือกชั้นข้อมูลที่ต้องการตัดในช่อง Input vector layer ในตัวอย่างนี้
เลือก SOIL (ถ้าต้องการวิเคราะห์ข้อมูลเฉพาะฟีเจอร์ที่เลือก ให้ผู้ใช้คลิกกล่องกาเครื่องหมาย Use only 
selected features) 

4) ในหน้าต่าง Difference ให้เลือกชั้นข้อมูลที่ใช้ตัดในช่อง Difference layer ในตัวอย่างนี้เลือก 
WTR_BODY (ถ้าต้องการวิเคราะห์ข้อมูลเฉพาะฟีเจอร์ที่เลือก ให้ผู้ใช้คลิกกล่องกาเครื่องหมาย Use only 
selected features) 
 5) ก าหนดสถานที่จัดเก็บและชื่อของชั้นข้อมูลผลลัพธ์ในช่อง Output shapefile 

6) คลิกปุ่ม OK 
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3. เลือกชัน้ข้อมูลน าเข้า 

4. เลือกชัน้ข้อมูล Difference 

ก าหนดให้วิเคราะห์ข้อมูล
เฉพาะฟีเจอรท์ี่เลือก 

5. ก าหนดชั้นข้อมูลผลลัพธ ์ 6. คลิกปุ่ม OK 

 

1. เพิ่มชั้นข้อมูลที่ต้องการใช้ค าสั่ง Difference ในแผนที ่

2. คลิกเมนู Vector > Geoprocessing 
Tools > Difference 

ก าหนดให้วิเคราะห์ข้อมูล
เฉพาะฟีเจอรท์ี่เลือก MAHID
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8. ฟังก์ชัน Dissolve 
ฟังก์ชัน Dissolve เป็นค าสั่งที่ใช้ในการลดรายละเอียดข้อมูลโดยการรวมฟีเจอร์ที่มีข้อมูลลักษณะ

ประจ าเหมือนกันเข้าด้วยกัน ผลลัพธ์จะได้ช้ันข้อมูลใหม่ที่มีฟีเจอร์ที่เกิดจากการรวมฟีเจอร์ที่มีค่าข้อมูลลักษณะ
ประจ าเหมือนกันเข้าด้วยกัน 

 

 
 

รูปที่ 8.8 ฟังก์ชัน Dissolve. จาก ArcGIS help library, โดย ESRI, Inc., 2012, ค้นเมื่อ 3 กันยายน 2556, 
จาก http://help.arcgis.com/en/arcgisdesktop/10.0/help/index.html#//00170000005n000000 

 
ฟังก์ชัน Dissolve สามารถประยุกต์ใช้ในการลดรายละเอียดข้อมูลได้หลากหลาย เช่น การลด

รายละเอียดขอบเขตการปกครองจากระดับอ าเภอเป็นระดับจังหวัด หรือการจัดกลุ่มข้อมูลชุดดินตามลักษณะ
การระบายน้ า เป็นต้น ในตัวอย่างนี้จะใช้ฟังก์ชัน Dissolve เพื่อรวมกลุ่มข้อมูลการใช้ที่ดินจากเดิมที่มี

ชั้นข้อมูลผลลพัธ์ของฟังก์ชนั Difference 
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รายละเอียดการจ าแนกประเภทข้อมูลระดับ 3 (Level 3) ให้มีรายละเอียดลดลงเป็นระดับ 1 (Level 3) ซึ่งมี
ขั้นตอนดังนี้ 

1) เพิ่มชั้นข้อมูลเวกเตอร์ที่ต้องการใช้ค าสั่ง Dissolve ในแผนที่ ในตัวอย่างนี้ชั้นข้อมูลที่ต้องการลด
รายละเอียดข้อมูล (Input layer) คือ ชั้นข้อมูลการใช้ที่ดิน (LU_2538_JOIN) 
 2) คลิกเมนู Vector > Geoprocessing Tools > Dissolve 
 3) ในหน้าต่าง Dissolve ให้เลือกชั้นข้อมูลที่ต้องการลดรายละเอียดข้อมูลในช่อง Input vector 
layer ในตัวอย่างนี้เลือก LU_2538_JOIN (ถ้าต้องการวิเคราะห์ข้อมูลเฉพาะฟีเจอร์ที่เลือก ให้ผู้ใช้คลิกกล่อง
กาเครื่องหมาย Use only selected features) 

4) ในช่อง Dissolve field ให้เลือกเขตข้อมูลที่ใช้ในการลดรายละเอียดข้อมูล ฟีเจอร์ที่อยู่ติดกันและมี
ค่าของข้อมูลในเขตข้อมูลนี้เหมือนกันจะถูกยุบรวมกัน ในตัวอย่างนี้เลือก MLU_NAME_T 
 5) ก าหนดสถานที่จัดเก็บและชื่อของชั้นข้อมูลผลลัพธ์ในช่อง Output shapefile 

6) คลิกปุ่ม OK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. เพิ่มชั้นข้อมูลที่ต้องการใช้ค าสั่ง Dissolve ในแผนที ่

2. คลิกเมนู Vector > Geoprocessing 
Tools > Dissolve 

 

เขตข้อมลูที่ใช ้Dissolve 
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3. เลือกชัน้ข้อมูลน าเข้า 

4. เลือกเขตขอ้มูลที่ใช้ Dissolve 

ก าหนดให้วิเคราะห์ข้อมูล
เฉพาะฟีเจอรท์ี่เลือก 

5. ก าหนดชั้นข้อมูลผลลัพธ ์ 6. คลิกปุ่ม OK 

ชั้นข้อมูลผลลพัธ์ของฟังก์ชนั Dissolve 
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การแสดงผลข้อมูลเป็นขั้นตอนที่มีความส าคัญในกระบวนงานด้านระบบสารสนเทศภูมิศาสตร์ ข้อมูล
ที่ได้จากการส ารวจและน าเข้าสู่ระบบสารสนเทศภูมิศาสตร์ หรือข้อมูลที่เป็นผลลัพธ์จากการวิเคราะห์ข้อมูลใน
ระบบสารสนเทศภูมิศาสตร์สามารถแสดงผลได้ทั้งในรูปของแผนที่และตารางที่เป็นสิ่งพิมพ์ออก (Printout) 
หรืออาจจะเป็นแฟ้มข้อมูล (File) ที่สามารถน าไปใช้งานกับโปรแกรมคอมพิวเตอร์อื่น ๆ ได้โดยตรง โดยปกติ
แล้ว ข้อมูลเชิงพื้นที่จะแสดงในรูปแผนที่ และข้อมูลลักษณะประจ าจะแสดงในรูปตาราง 

ในแผนที่จะมีองค์ประกอบ (Element) ต่าง ๆ ที่แสดงให้ผู้ใช้แผนที่ทราบข้อมูลต่าง ๆ เพื่อใช้ในการ
อ่านแผนที่ องค์ประกอบแผนที่ที่ส าคัญและมักจะต้องแสดงไว้ในแผนที่ประกอบด้วย 1) ชื่อแผนที่ (Title)  2) 
ส่วนข้อมูลแผนที่ (Map body)  3) ค าอธิบายสัญลักษณ์ (Legend)  4) มาตราส่วนแผนที่ (Scale)  5) ทิศ
เหนือ (North arrow)  6) ระบบพิกัด (Coordinate system)  7) แหล่งที่มาของข้อมูล (Source)  และ 8) ชื่อ
หรือหน่วยงานผู้จัดท า (Cartographer or organization’s name) อย่างไรก็ตาม ผู้จัดท าแผนที่อาจจะตัด
ทอนองค์ประกอบข้างต้น หรือเพิ่มองค์ประกอบหรือรายละเอียดข้อมูลอื่น ๆ ได้ตามความเหมาะสม โดย
พิจารณาจากความต้องการใช้งานแผนที่เป็นส าคัญ  

ในบทนี้ จะอธิบายการใช้งานโปรแกรม QGIS เพื่อการจัดท าและพิมพ์ผลแผนที่ในระดับเบื้องต้น ซึ่งมี
รายละเอียดดังนี ้

1. การสร้าง Print Composer 
 Print Composer เป็นส่วนประกอบของโปรแกรม QGIS ที่ใช้ในการจัดท าและพิมพ์แผนที่ ผู้ใช้
สามารถเพิ่มองค์ประกอบของแผนที่ต่าง ๆ ได้แก่ ส่วนข้อมูลแผนที่ ค าอธิบายสัญลักษณ์ มาตราส่วนแผนที่ ทิศ
เหนือ รูปภาพ ลายเส้นกราฟิก และข้อความต่าง ๆ ลงในพื้นที่จัดวางหน้า (Layout) ที่เปรียบเสมือน
แผ่นกระดาษส าหรับจัดท าแผนที่ แผนที่ที่จัดวางองค์ประกอบต่าง ๆ เสร็จสิ้นแล้ว สามารถพิมพ์ผลออกเป็น
แผนที่แผ่นกระดาษ (Hard copy) หรือส่งออกเป็นแฟ้มข้อมูลในรูปแบบต่าง ๆ เช่น แฟ้มข้อมูลภาพ (Image), 
Postscript, PDF, หรือ SVG นอกจากนี้ ผู้ใช้สามารถบันทึกลักษณะการจัดวางองค์ประกอบแผนที่ต่าง ๆ เป็น
แม่แบบหรือเทมเพล็ต (Template) เพื่อน ากลับมาใช้ในการจัดท าแผนที่อื่น ๆ ได้ในครั้งต่อไป 

เนื่องจาก Print Composer เป็นส่วนที่ใช้ในการจัดวางองค์ประกอบแผนที่ต่าง ๆ เท่านั้น ดังนั้น 
ผู้จัดท าแผนที่จึงควรจัดเตรียมชั้นข้อมูลและก าหนดสัญลักษณ์ต่าง ๆ ให้เสร็จสิ้นก่อนการท างานกับ Print 
Composer อย่างไรก็ตาม ผู้ใช้สามารถเพิ่มหรือลบชั้นข้อมูล รวมทั้งเปลี่ยนแปลงสัญลักษณ์ของชั้นข้อมูลได้
ตลอดเวลาขณะที่จัดท าแผนที่ใน Print Composer 

การสร้าง Print Composer สามารถท าได้ 3 วิธี คือ 

 การใช้เมนู โดยการคลิกเมนู File > New Print Composer 

 การใช้แถบเครื่องมือ File โดยการคลิกปุ่ม New Print Composer (  ) 

 การใช้แป้นลัด โดยการกดปุ่ม Ctrl + P  
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โดยปกติแล้ว เมื่อผู้จัดท าแผนที่ใช้ค าสั่งสร้าง Print Composer โปรแกรมจะก าหนดชื่อ Composer 
ให้มีชื่อ Composer 1 และถ้ามีการสร้าง Composer อื่น ๆ ขึ้นใหม่ โปรแกรม QGIS จะสร้างและตั้งชื่อ 
Composer ให้อัตโนมัติโดยการเรียงล าดับตัวเลขต่อท้ายเพ่ิมขึ้นครั้งละ 1 ค่า เช่น Composer 2, Composer 
3, Composer 4 เป็นต้น ทั้งนี้ ผู้ใช้สามารถเปลี่ยนชื่อได้โดยใช้ค าสั่ง Composer manager จากเมนู File 
หรือจากปุ่มค าสั่งบนแถบเครื่องมือ File 

2. GUIs ของ Printer Composer  
 เมื่อผู้ใช้สร้าง Print Composer ขึ้น จะปรากฏหน้าต่าง Composer ซึ่งส่วนต่อประสานกราฟิกกับ
ผู้ใช้ (Graphical User Interface: GUI) ดังนี้ 
 
 

 
 

 แถบรายการเลือกหรือแถบเมนู (Menu Bar) เป็นแถบที่เก็บค าสั่งของ Print Composer 
แถบเมนูหลักของ Print Composer ประกอบด้วยเมนู File, View, และ Layout 

 แถบเครื่องมือ (Toolbar) เป็นค าสั่งของ Print Composer ที่อยู่ในรูปของไอคอน ซึ่งช่วย
ให้ผู้ใช้งานสามารถเข้าถึงค าสั่งต่าง ๆ ได้สะดวกมากขึ้น แถบเครื่องมือ Print Composer มีรายละเอียดดังนี ้
 

 

 

 
 

แถบเมนู (Menu bar) แถบเครื่องมือ (Tool bar) 

แท็บ (Tab) 

 

พื้นที่จัดท าแผนที่ (Canvas) MAHID
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สัญรูป ชือ่ค าสั่ง ค าอธิบาย 

 
Load From template โหลดแม่แบบหรือเทมเพล็ต 

 
Save as template บันทึกแม่แบบหรือเทมเพล็ต 

 
Export as Image ส่งออกแผนที่เป็นแฟ้มข้อมูลภาพ 

 
Export as PDF ส่งออกแผนที่เป็นแฟ้มข้อมูล PDF 

 
Export as SVG ส่งออกแผนที่เป็นแฟ้มข้อมูล SVG 

 
Print พิมพ์แผนที่จากเครื่องพิมพ ์

 
Zoom Full ขยายเต็มแผนที่ 

 
Zoom In ขยายแผนที ่

 
Zoom Out ย่อแผนที ่

 
Refresh view ปรับการแสดงผลแผนทีใ่ห้ทันสมัย 

 
Revert last change ยกเลิกค าสั่งทีด่ าเนินการแล้ว 

 
Restore last change ท าซ้ าค าสั่งที่ด าเนินการแล้ว 

 
Add new map เพิ่ม/แทรกส่วนข้อมูลแผนที ่

 
Add Image เพิ่ม/แทรกภาพ 

 
Add new label เพิ่ม/แทรกข้อความ 

 
Add new vector legend เพิ่ม/แทรกค าอธิบายสัญลักษณ ์

 
Add new scalebar เพิ่ม/แทรกมาตราส่วนรูปแทง่ 

 
Add Basic Shape เพิ่ม/แทรกรูปกราฟิก 

 
Add arrow เพิม่/แทรกลูกศร 

 
Add attribute table เพิ่ม/แทรกตารางข้อมูลลักษณะประจ า 

 
Select/Move item เลือก/ย้ายองค์ประกอบแผนที่ 

 
Move item content ย้ายส่วนข้อมูลแผนที ่

 
Group items รวมกลุ่มองค์ประกอบแผนที่ 

 
Ungroup items แยกกลุ่มองค์ประกอบแผนที่ 

 
Raise selected items จัดล าดับองค์ประกอบแผนที่ 

 
Align selected items left จัดเรียงองค์ประกอบแผนที่ 
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หมายเหตุ: เครื่องมือที่ใช้จัดล าดับ (Reorder) และจัดเรียง (Align) องค์ประกอบแผนที่ จะมีปุ่มเมนูเครื่องมือ 
(Tool palette) ที่สามารถคลิกเพื่อแสดงปุ่มค าสั่งอื่น ๆ ได้ ในกรณีที่ผู้ใช้ต้องการใช้งานปุ่มค าสั่งในกลุ่ม
ดังกล่าวสามารถท าได้โดยการคลิกปุ่มเมนูเครื่องมือและคลิกเลือกปุ่มค าสั่งที่ผู้ใช้ต้องการใช้งาน   

 พื้นที่จัดท าแผนที่ (Canvas) เป็นพ้ืนที่ที่ใช้ในการจัดวาง (Layout) องค์ประกอบแผนที่ 

 แท็บ (Tab) เป็นส่วนที่ใช้ในการตั้งค่าคุณสมบัติทั่วไป (General tab) ของแผนที่ หรือตั้ง
ค่าคุณสมบัติเฉพาะ (Item tab) ขององค์ประกอบแผนที่ นอกจากนี้ ยังมีการเก็บบันทึกข้อมูลการใช้งานค าสั่ง
ต่าง ๆ ที่ผ่านมา (Command history tab) เพื่อให้ผู้จัดท าแผนที่สามารถย้อนกลับไปยังค าสั่ง ณ ขณะนั้นได้ 
ซึ่งท าให้การแก้ไขแผนที่มีความสะดวกมากขึ้น 

3. การใช้งาน Composer manager 
Composer manager เป็นกลุ่มค าสั่งที่ใช้ในการจัดการ Print Composer ได้แก่ การเพิ่ม การลบ 

การแก้ไขชื่อ และการเปิด Print Composer ขั้นตอนการใช้ค าสั่งต่าง ๆ ใน Composer manager มี
รายละเอียดดังนี ้

3.1 การเปิด Composer manager สามารถท าได้ 2 วิธี คือ 

 การใช้เมนู โดยการคลิกเมนู File > Composer manager 

 การใช้แถบเครื่องมือ File โดยการคลิกปุ่ม Composer manager (  ) 

 

คลิกปุ่ม Composer manager 
 
 

 

หน้าต่าง Composer Manager 
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3.2 การเปิด/แสดง Composer 
 โดยปกติแล้ว การจัดท าแผนที่อาจจะไม่สามารถด าเนินการให้แล้วเสร็จทั้งหมด หรืออาจจะ

ต้องมีการเปลี่ยนแปลงแก้ไขข้อมูลภายหลังจากที่ได้จัดท าแผนที่แล้ว หรือในบางโครงการที่อาจจะมีแผนที่ที่
ต้องจัดท ามากกว่า 1 แผนที่ (จึงมี Composer มีมากกว่า 1 รายการในหน้าต่าง Composer manager) ท าให้
ผู้ใช้จ าเป็นต้องเลือกเปิด Composer ที่ต้องการมาใช้งาน ซึ่งมีขั้นตอนดังนี้ 

 1) ในหน้าต่าง Composer manager ให้คลิกเลือก Composer ที่ต้องการเปิด/แสดง 
 2) คลิกปุ่ม Show โปรแกรมจะแสดงหน้าต่าง Composer ที่เลือก 
 

 
 

3.3 การเพ่ิม Composer  
 ในกรณีที่ผู้ใช้ต้องเพิ่ม Composer เนื่องจากต้องจัดท าแผนที่มากกว่า 1 แผนที่ จะมีขั้นตอน

ดังนี้   
 1) ในหน้าต่าง Composer manager ให้คลิกเลือก Empty composer 
 2) คลิกปุ่ม Add โปรแกรมจะแสดงหน้าต่าง Composer ที่สร้างขึ้น 
 

 

คลิกเลือก Composer 

คลิกปุ่ม Show 

1. คลิกเลือก Empty composer 

2. คลิกปุ่ม Add MAHID
OL



บทที่ 9 การจัดท าแผนที่  หน้า 278 
 

คู่มือการใช้งานซอฟต์แวร์ Quantum GIS รุ่น 1.7.3 เบื้องต้น  หน่วยภูมิสารสนเทศ งานสารสนเทศ 

 
 

3.4 เปลี่ยนช่ือ Composer 
 ในการจัดท าแผนที่ ผู้ใช้ควรตั้งชื่อแผนที่ที่สื่อความหมาย เพื่อป้องกันความสับสนและช่วยให้

ผู้ปฏิบัติงานแทนสามารถเข้าใจและท างานแทนได้ทันที ขั้นต้องการเปลี่ยนชื่อ Composer มีดังน้ี 
1) ในหน้าต่าง Composer manager ให้คลิกเลือก Composer ที่ต้องการเปลี่ยนชื่อ 

 2) คลิกปุ่ม Rename โปรแกรมจะแสดงหน้าต่าง Composer ที่สร้างขึ้น 
 3) ในช่อง Title ให้พิมพ์ชื่อ Composer ใหม่ที่ต้องการ 
 4) คลิกปุ่ม OK 
 

 

Composer ที่สร้างขึ้นใหม ่

หน้าต่าง Composer ที่สร้างขึ้น
ใหม ่

1. คลิกเลือก Composer 

2. คลิกปุ่ม Rename 
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3.5 การลบ Composer 
เมื่อผู้ใช้ไม่ต้องการใช้งาน Composer ใด ๆ สามารถลบออกได้ โดยมีขั้นตอนดังนี้ 
1) ในหน้าต่าง Composer manager ให้คลิกเลือก Composer ที่ต้องการลบ 
2) คลิกปุ่ม Remove 
3) คลิกปุ่ม OK ในหน้าต่าง Remove composer เพื่อยืนยันการลบ 
 

 
 

ชื่อ Composer เดิม 

3. พิมพ์ชื่อใหม่ 

4. คลิกปุ่ม OK 

ชื่อ Composer ใหม่ที่
ปรากฏใน Composer 

Manager 

1. คลิกเลือก Composer 

2. คลิกปุ่ม Remove 
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3.6 การปิด Composer manager 
 การปิด Composer manager เมื่อผู้ใช้ไม่ต้องการใช้งาน สามารถท าได้ 2 วิธี คือ 

 การคลิกปุ่ม Close ที่มุมขวาบนของหน้าต่าง Composer manager 

 การคลิกปุ่ม Close ที่มุมขวาล่างของหน้าต่าง Composer manager 
 

 
 
 
 

4. การก าหนดคุณสมบัติของ Composer 
 ในการจัดท าแผนที่ ผู้ใช้ควรก าหนดขนาดแลทิศทางการจัดวางหน้า (Size and orientation) ของ
แผนที่ และก าหนดสภาพแวดล้อมในการท างานกับโปรแกรมเพื่อให้การจัดท าแผนที่มีความสะดวกรวดเร็วมาก
ขึ้น การก าหนดคุณสมบัติของ Composer จัดเป็นขั้นตอนพื้นฐานของกระบวนการออกแบบและจัดท าแผนที่ 
และควรปฏิบัตใิห้แล้วเสร็จก่อนการด าเนินงานอื่น ๆ 
 การก าหนดคุณสมบัติของ Composer สามารถท าได้โดยคลิกที่แท็บ General ซึ่งจะมีรายละเอียด
ส าหรับการต้ังค่าต่าง ๆ ดังนี ้
 

3. คลิกปุ่ม OK 

คลิกปุ่ม Close 

คลิกปุ่ม Close 
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 Paper and quality เป็นส่วนที่ใช้ก าหนดขนาดกระดาษและคุณภาพของผลลัพธแ์ผนที่ 
o Size: ก าหนดขนาดของแผนที่ตามขนาดมาตรฐานต่าง ๆ 
o Unit: ก าหนดหน่วย ความกว้าง และความยาวของขนาดแผนที่ตามที่ผู้ใช้ก าหนด ซึ่งผู้ใช้

จะสามารถก าหนดตัวเลือกน้ีได้ก็ต่อเมื่อเลือก Custom ในช่อง Size (Custom size หมายถึง ผู้จัดท าแผนที่จะ
ก าหนดขนาดของแผนที่เอง)  

o Orientation: ก าหนดทิศทางการจัดวางแผนที่แบบแนวต้ังหรือแนวนอน 
o Quality: ก าหนดความละเอียดของข้อมูลแผนที่ 
o Print as raster: ก าหนดให้องค์ประกอบแผนที่ต่าง ๆ ถูกแปลงเป็นข้อมูลแรสเตอร์ก่อนที่

จะถูกพิมพ์หรือบันทึกเป็นแฟ้มข้อมูล PDF หรือ Postscript 

 Snapping เป็นส่วนที่ก าหนดให้มีการจัดวางองค์ประกอบแผนที่หรือกราฟิกบนแผนที่ เป็นแบบ
อัตโนมัติโดยอ้างอิงกับเส้นกริด 

o Snap to grid: คลิกตัวเลือกให้มีเครื่องหมายถูก จะมีผลให้การจัดวางองค์ประกอบแผนที่
และกราฟิกต่าง ๆ ตรงกับกริดแบบอัตโนมัต ิ

o Spacing: ก าหนดระยะห่างของเส้นกริด 
o X offset: ก าหนดระยะเยื้องของกริดตามแนวแกน X (จุดก าเนิดอยู่ที่มุมล่างซ้าย) 
o Y offset: ก าหนดระยะเยื้องของกริดตามแนวแกน Y (จุดก าเนิดอยู่ที่มุมล่างซ้าย) 

 

 

คลิกแท็บ General 

กรอบ Print and quality 

กรอบ Snapping 
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o Pen width: ก าหนดขนาดของกริด 
o Grid color: ก าหนดสีของกริด 
o Grid style: ก าหนดแบบรูปของกริด 

5. การเพิ่มองค์ประกอบแผนที่และการก าหนดคุณสมบัติต่าง ๆ 
ในการจัดท าแผนที่ ผู้ใช้จ าเป็นต้องเพิ่มองค์ประกอบแผนที่และก าหนดคุณสมบัติต่าง ๆ ให้เหมาะสม 

เพื่อช่วยให้ผู้ใช้แผนที่สามารถน าแผนที่ใช้ได้อย่างถูกต้อง การเพิ่มและการก าหนดคุณสมบัติต่ าง ๆ ของ
องค์ประกอบแผนที่มีรายละเอียดดังนี้ 

5.1 การเพ่ิมและก าหนดคุณสมบัติของส่วนข้อมูลแผนที่ 
 ส่วนข้อมูลแผนที่ (Map body) เป็นองค์ประกอบแผนที่ที่แสดงรายละเอียดของชั้นข้อมูลต่าง 

ๆ ที่ผู้จัดท าแผนที่ต้องการแสดงแก่ผู้ใช้แผนที่ 
การเพ่ิมและก าหนดคุณสมบัติของส่วนข้อมูลแผนที่มีขั้นตอนดังนี้ 

 การเพ่ิมส่วนข้อมูลแผนที่ 

 1) ในหน้าต่าง Composer คลิกปุ่ม  
 2) คลิกลากเป็นพ้ืนที่สี่เหลี่ยมมุมฉากแล้วปล่อยเพื่อก าหนดส่วนข้อมูลแผนที่ 

 

 
 

1. คลิกปุ่ม Add new 
map 

2. คลิกลากแล้วปล่อย 
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 การก าหนดคุณสมบัติของส่วนข้อมูลแผนที่ 
 1) คลิกปุ่ม Select/Move item 
 2) คลิกที่ส่วนข้อมูลแผนที่ เพื่อก าหนดให้โปรแกรมท างานกับองค์ประกอบแผนที่

หรือวัตถุนั้น ซึ่งจะมีเครื่องหมายปรากฏที่มุมทั้งสี่ของส่วนข้อมูลแผนที่หรือวัตถุที่ถูกเลือก 
 3) คลิกแท็บ Item เพื่อก าหนดคุณสมบัติของส่วนข้อมูลแผนที่ไดด้ังนี ้

 
 

 
 

 Map 
o Preview: ก าหนดวิธีการแสดงผลส่วนของแผนที่ 
o Map 

 Width: ก าหนดความกว้างของกรอบข้อมูลแผนที่ (ค่าที่
ระบุ เป็นหน่วยเดียวกับการระบุขนาดกระดาษในแท็บ 
General) 
 Height: ก าหนดความสูงของกรอบข้อมูลแผนที่ (ค่าที่ระบุ
เป็นหน่วยเดียวกับการระบุขนาดกระดาษในแท็บ General) 
 Scale: ก าหนดมาตราส่วนของข้อมูลแผนที่ 

2. คลิกส่วนขอ้มูลแผนที ่

1. คลิกปุ่ม Select/Move item 

3. คลิกแท็บ Item 
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 Ratation: ก าหนดการหมุนข้อมูลแผนที่ 
 Lock layers for map item: ก าหนดให้ล็อกการแสดงผล
ชั้นข้อมูลในแผนที่ ดังนั้น ถ้ามีการเปลี่ยนแปลงสัญลักษณ์หรือ
ล าดับชั้นข้อมูลในแผนที่จะไม่มีผลต่อการแสดงผลข้อมูลแผน
ที่ใน Composer (แม้ว่าจะคลิกปุ่ม Refresh) 
 Draw map canvas items: ก าหนดให้แสดง/ไม่แสดง
ข้อความ (Annotation) ในแผนที่ที่อยู่ในหน้าต่างหลักของ
โปรแกรม QGIS (Main QGIS window)  

 Extents 
o X min: ก าหนดขอบเขตซ้ายตามแนวแกน X ของพื้นที่แสดงผลแผนที่ 
o X max: ก าหนดขอบเขตขวาตามแนวแกน X ของพื้นที่แสดงผลแผนที่ 
o Y min: ก าหนดขอบเขตล่างตามแนวแกน Y ของพื้นที่แสดงผลแผนที่ 
o Y max: ก าหนดขอบเขตบนตามแนวแกน Y ของพื้นที่แสดงผลแผนที่ 

 Grid 
o Show grid: ใช้ก าหนดให้แสดงกริดในส่วนของแผนที่ (ผู้ใช้ต้อง
คลิกตัวเลือก Show grid จึงจะสามารถก าหนดค่าตัวเลือกอื่น ๆ ได้) 
o Grid type: ก าหนดประเภทของกริด ซึ่งมี 2 ชนิด คือ แบบเส้น 
(Solid) และแบบกากบาท (Cross) 
o Interval X: ก าหนดระยะห่างของเส้นกริดตามแกน X 
o Interval Y: ก าหนดระยะห่างของเส้นกริดตามแกน Y 
o Offset X: ก าหนดระยะเยื้องของกริดตามแนวแกน X 
o Offset Y: ก าหนดระยะเยื้องของกริดตามแนวแกน Y 
o Cross width: ก าหนดขนาดของกริดแบบกากบาท 
o Line width: ก าหนดขนาดของกริดแบบเส้น 
o Line color: ก าหนดสีของกริด 
o Draw annotation: ใช้ก าหนดให้แสดงค่าพิกัดก ากับกริด 
o Annotation position: ก าหนดให้แสดงค่าพิกัดกริดภายในหรือ
ภายนอกกรอบของแผนที่ 
o Annotation direction: ก าหนดทิศทางแสดงค่าพิกัดก ากับกริด 
o Font: ก าหนดคุณสมบัตขิองข้อความที่แสดงค่าพิกัดก ากับกริด 
o Distance to map frame: ก าหนดระยะห่างระหว่างค่าพิกัด
ก ากับกริดกับเส้นกรอบของแผนที่ 
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o Coordinate precision: ก าหนดจ านวนจุดทศนิยมของค่าพิกัด
ก ากับกริด 

 General options 
o Frame color: ก าหนดสีของเส้นกรอบส่วนข้อมูลแผนที่ 
o Background color: ก าหนดสีพื้นหลังของส่วนข้อมูลแผนที่ 
o Opacity: ก าหนดความทึบแสงของสีพื้นหลังในส่วนของแผนที่ 
o Outline width: ก าหนดขนาดของเส้นกรอบส่วนข้อมูลแผนที่ 
o Position and Size: ก าหนดขนาดและต าแหน่งของส่วนข้อมูลแผนที่ 
o Show Frame: ก าหนดให้แสดง/ไม่แสดงเส้นกรอบส่วนข้อมูลแผนที่ 

5.2 การเพ่ิมและก าหนดคุณสมบัติของข้อความ (Label) 

 การเพ่ิมข้อความ 
1) ในหน้าต่าง Composer คลิกปุ่ม Add new label 
2) คลิกบนพื้นที่จัดท าแผนที่ (Canvas) ที่ต้องการเพิ่มข้อความ โดยโปรแกรมจะเพิ่ม

ข้อความที่เป็นค่าโดยปริยาย (Default)  คือ Quantum GIS 
 

 
  

1. คลิกปุ่ม Add new label 

2. คลิกบนพื้นที่จัดท าแผนที ่
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 การก าหนดคุณสมบัติของข้อความ 
1) คลิกปุ่ม Select/Move item 
2) คลิกที่ข้อความ 
3) คลิกแท็บ Item เพื่อก าหนดคุณสมบัติของข้อความได้ดังนี ้

 
 

 
 

 Label 
o Label: ข้อความที่ต้องการเพ่ิมในแผนที่ 
o Font: ก าหนดคุณสมบัติของข้อความ 
o Font color: ก าหนดสีของข้อความ 
o Horizontal Alignment: ก าหนดการจัดเรียงข้อความตาม
แนวนอน 
o Vertical Alignment: ก าหนดการจัดเรียงข้อความตามแนวดิ่ง 
o Margin (mm): ก าหนดขนาดเส้นกรอบข้อความ 
o Label id: ก าหนดชื่อ/หมายเลขประจ าให้กับข้อความ 

 General options 

2. คลิกข้อความ 

1. คลิกปุ่ม Select/Move item 

3. คลิกแท็บ Item 
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o Frame color: ก าหนดสีของเส้นกรอบข้อความ 
o Background color: ก าหนดสีพื้นหลังของข้อความ 
o Opacity: ก าหนดความทึบแสงสีพื้นหลังของข้อความ 
o Outline width: ก าหนดขนาดของเส้นกรอบข้อความ 
o Position and Size: ก าหนดขนาดและต าแหน่งของข้อความ 
o Show Frame: ก าหนดให้แสดง/ไม่แสดงเส้นกรอบข้อความ 

 5.3 การเพ่ิมและก าหนดคุณสมบัติของรูปภาพ (Image) 

 การเพ่ิมรูปภาพ 
1) ในหน้าต่าง Composer คลิกปุ่ม Add image 
2) คลิกบนพื้นที่จัดท าแผนที่ 

 
 

 
 

 การก าหนดคุณสมบัติของรูปภาพ 
 1) คลิกปุ่ม Select/Move item 
 2) คลิกที่รูปภาพ 

1. คลิกปุ่ม Add image 

2. คลิกบนพื้นที่จัดท าแผนที ่MAHID
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 3) คลิกแท็บ Item เพื่อก าหนดคุณสมบัติของรูปภาพได้ดังนี ้
 
 

 
 

 Picture options 
o Search directories: ก าหนดโฟลเดอร์หรือไดเร็คทอรีที่จัดเก็บ
ข้อมูลรูปภาพ 
o Preview: แสดงรูปภาพตัวอย่างเพื่อให้ผู้ใช้คลิกเลือก รูปภาพที่ผู้ใช้
คลิกเป็นรูปภาพที่ปรากฏในช่อง Load 
o Options 

 Load: ก าหนดรูปภาพทีต่้องการแสดงผล 
 Width: ขนาดความกว้างของรูปภาพ 
 Height: ขนาดความสูงของรูปภาพ 
 Rotation: ก าหนดการหมุนรูปภาพ 
 Sync with map: ก าหนดให้รูปภาพ (เช่น รูปลูกศรแสดง
ทิศเหนือ)  ปรับหมุนสอดคล้องกับทิศทางการหมุนกับ
ส่วนข้อมูลแผนที่ (Map body) 

2. คลิกรูปภาพ 

1. คลิกปุ่ม Select/Move item 

3. คลิกแท็บ Item 
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 General options 
o Frame color: ก าหนดสีของเส้นกรอบรูปภาพ 
o Background color: ก าหนดสีพื้นหลังของรูปภาพ 
o Opacity: ก าหนดความทึบแสงของสีพื้นหลังของรูปภาพ 
o Outline width: ก าหนดขนาดของเส้นกรอบรูปภาพ 
o Position and Size: ก าหนดขนาดและต าแหน่งของรูปภาพ 
o Show Frame: ก าหนดให้แสดง/ไม่แสดงเส้นกรอบรูปภาพ 

5.4 การเพ่ิมและก าหนดคุณสมบัติของค าอธิบายสัญลักษณ์ (Legend) 

 การเพ่ิมค าอธิบายสัญลักษณ์ 
1) ในหน้าต่าง Composer คลิกปุ่ม 
2) คลิกบนพื้นที่จัดท าแผนที่ 
 

 
 

 
 
 

2. คลิกบนพื้นที่จัดท าแผนที ่

1. คลิกปุ่ม Add new vector legend 
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 การก าหนดคุณสมบัติของค าอธิบายสัญลักษณ์ 
1) คลิกปุ่ม Select/Move item 
2) คลิกที่ค าอธิบายสัญลักษณ์ 
3) คลิกแท็บ Item เพื่อก าหนดคุณสมบัติของค าอธิบายสัญลักษณ์ได้ดังนี ้

 
 
 

 
 

 General 
o Title: ก าหนดหรือระบุชื่อข้อความอธิบายสัญลักษณ์ 
o Title font: ก าหนดคุณสมบัติของข้อความที่แสดงชื่อค าอธิบาย
สัญลักษณ์ 
o Group font: ก าหนดคุณสมบัติของข้อความที่แสดงชื่อกลุ่มชั้น
ข้อมูล 
o Layer font: ก าหนดคุณสมบัติของข้อความที่แสดงชื่อช้ันข้อมูล 
o Item font: ก าหนดคุณสมบัติของข้อความที่แสดงชื่อสัญลักษณ์ 
o Symbol width: ก าหนดขนาดความกว้างของสัญลักษณ์ 

2. คลิกค าอธบิายสญัลักษณ์ 

1. คลิกปุ่ม Select/Move item 

3. คลิกแท็บ Item 
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o Symbol height: ก าหนดขนาดความยาวของสัญลักษณ์ 
o Layer space: ก าหนดระยะห่างระหว่างแต่ละกลุ่มสัญลักษณ์ของ
ชั้นข้อมูล 
o Symbol space: ก าหนดระยะห่างระหว่างแต่ละสัญลักษณ์ภายใน
ชั้นข้อมูล 
o Icon label space: ก าหนดระยะห่างระหว่างสัญลักษณ์กับ
ข้อความอธิบายสัญลักษณ์ 
o Box space: ก าหนดระยะห่างระหว่างกรอบ (Frame) กับข้อมูลใน
ค าอธิบายสัญลักษณ์ (Content) 
o Map: ก าหนดให้ค าอธิบายสัญลักษณ์อ้างอิงกับส่วนข้อมูลแผนที่ 

 Legend items 
o Auto Update: ก าหนดให้ปรับข้อมูลค าอธิบายสัญลักษณ์อัตโนมัติ
เมื่อมีการเปลี่ยนแปลงแก้ไข 

o : เลื่อนล าดับสัญลักษณ์ของชั้นข้อมูลลง 

o : เลื่อนล าดับสัญลักษณ์ของชั้นข้อมูลขึ้น 

o : เพิ่มสัญลักษณ์ของชั้นข้อมูล 

o : ลบสัญลักษณ์ของช้ันข้อมูล 

o : แก้ไขข้อความค าอธิบายของชั้นข้อมูลหรือสัญลักษณ์ 

o : ปรับข้อมูลค าอธิบายสัญลักษณ์ในแผนที่ให้เป็นปัจจุบัน 

o : เพิ่มชั้นข้อมูลทั้งหมดที่อยู่ในแผนที่แสดงในค าอธิบาย
สัญลักษณ์ 

o : สร้างกลุ่มชั้นข้อมูล 
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 Item Options 
o Frame color: ก าหนดสีของเส้นกรอบค าอธิบายสัญลักษณ์ 
o Background color: ก าหนดสีพื้นหลังของค าอธิบายสัญลักษณ์ 
o Opacity: ก าหนดความทึบแสงของสีพื้นหลังของค าอธิบาย
สัญลักษณ์ 
o Outline width: ก าหนดขนาดของเส้นกรอบค าอธิบายสัญลักษณ์ 
o Position and Size: ก าหนดขนาดและต าแหน่งของค าอธิบาย
สัญลักษณ์ 
o Show Frame: ก าหนดให้แสดง/ไม่แสดงเส้นกรอบค าอธิบาย
สัญลักษณ์ 

5.5 การเพ่ิมและก าหนดคุณสมบัติของมาตราส่วนแผนที่ Scalebar 

 การเพ่ิมมาตราส่วนแผนที่ 
1) ในหน้าต่าง Composer คลิกปุ่ม 
2) คลิกลากเป็นพ้ืนที่สี่เหลี่ยมมุมฉากแล้วปล่อยเพื่อก าหนดส่วนข้อมูลแผนที่ 

 
 

 
2. คลิกบนพื้นที่จัดท าแผนที ่

1. คลิกปุ่ม Add new scalebar 
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 การก าหนดคุณสมบัติของมาตราส่วนแผนที่ 
1) คลิกปุ่ม Select/Move item 
2) คลิกที่มาตราส่วนแผนที่ 
3) คลิกแท็บ Item เพื่อก าหนดคุณสมบัติของมาตราส่วนแผนที่ได้ดังนี ้

 
 

 
 

 Scale bar 
o Segment size: ก าหนดขนาดของช่องแต่ละช่องส าหรับมาตรา
ส่วนกราฟิก ค่าที่ระบุมหีน่วยเป็นหน่วยของแผนที่ 
o Map unit per bar unit: ก าหนดตัวประกอบแปลงผัน 
(Conversion factor) ระหว่างหน่วยแผนที่กับหน่วยมาตราส่วน
กราฟิก เช่น ถ้าผู้ใช้ต้องการหน่วยมาตราส่วนกราฟิกเป็นกิโลเมตร แต่
หน่วยของแผนที่เป็นเมตร ผู้ใช้ต้องระบุค่าในช่องนี้เป็น 1000 เป็นต้น  
o Right segment: ก าหนดจ านวนช่องทางด้านขวาถัดจากค่าศูนย์
ของมาตราส่วนกราฟิก 

2. คลิกค าอธิบายสญัลักษณ์ 

1. คลิกปุ่ม Select/Move item 

3. คลิกแท็บ Item 
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o Left segment: ก าหนดจ านวนช่องทางด้านซ้ายถัดจากค่าศูนย์
ของมาตราส่วนกราฟิก 
o Style: ก าหนดประเภทหรือรูปแบบของมาตราส่วน 
o Map: ก าหนดให้มาตราส่วนอ้างอิงกับส่วนข้อมูลแผนที่ 
o Height: ก าหนดขนาดความสูงของมาตราส่วนรูปกราฟิก 
o Line width: ก าหนดขนาดของเส้นรูปกราฟิกประเภท Line Ticks 
Middle, Line Ticks Down, และ Line Ticks Up 
o Label space: ก าหนดขนาดระยะห่างระหว่างค่าตัวเลขกับรูป
กราฟิก 
o Box space: ก าหนดขนาดระยะกรอบของมาตราส่วน 
o Unit label 

 Text box: ช่องพิมพ์ข้อความระบุหน่วยของมาตราส่วน 
 Font: ก าหนดคุณสมบัติของข้อความที่แสดงหน่วยของ
มาตราส่วน 
 Color: ก าหนดสีพื้นหลังของมาตราส่วนประเภท Single 
box และ Double box 

 General options 
o Frame color: ก าหนดสีของเส้นกรอบมาตราส่วน 
o Background color: ก าหนดสีพื้นหลังของมาตราส่วน 
o Opacity: ก าหนดความทึบแสงของสีพื้นหลังของมาตราส่วน 
o Outline width: ก าหนดขนาดของเส้นกรอบมาตราส่วน 
o Position and Size: ก าหนดขนาดและต าแหน่งของมาตราส่วน 
o Show Frame: ก าหนดให้แสดง/ไม่แสดงเส้นกรอบมาตราส่วน 

6. การเพิ่มและก าหนดคุณสมบัติของกราฟิกในแผนที่ 
 นอกเหนือจากการเพิ่มองค์ประกอบแผนที่ต่าง ๆ แล้ว โปรแกรม QGIS ยังมีเครื่องมือที่ใช้เพิ่มกราฟิก
ต่าง ๆ เพื่อช่วยให้การออกแบบและจัดท าแผนที่มีความสวยงามมากขึ้น การเพ่ิมกราฟิกมีขั้นตอนดังนี ้

6.1 การเพ่ิมกราฟิกในแผนที่ 
1) ในหน้าต่าง Composer คลิกปุ่ม Add Basic Shape 
 2) คลิกลากแล้วปล่อยเพื่อเพิ่มกราฟิกบนแผนที่ 
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6.2 การก าหนดคุณสมบัติของกราฟิกในแผนที่ 
1) คลิกปุ่ม Select/Move item 
2) คลิกที่มาตราส่วนแผนที่ 
 3) คลิกแท็บ Item เพื่อก าหนดคุณสมบัติของมาตราส่วนแผนที่ได้ดังนี้ 

 
 
 
 
 
 
 
 
 

2. คลิกแล้วลากแผนที ่

1. คลิกปุ่ม Add Basic Shape 
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 Shape 
o Ellipse: ก าหนดประเภทรูปกราฟิก ซึ่งมีทั้งหมด 3 ประเภท คือ 1) วงรี 

(Ellipse)  2) สี่เหลี่ยมมุมฉาก (Rectangle)  และ 3) สามเหลี่ยม (Triangle) ค่าโดยปริยายของโปรแกรมคือ 
รูปวงรี 

o Shape outline color: ก าหนดสีของเส้นกราฟิก 
o Outline width: ก าหนดขนาดของเส้นกราฟิก 
o Transparent fill: ก าหนดความโปร่งใสของพื้นหลังรูปกราฟิก 
o Shape fill color: ก าหนดสีพื้นหลังของรูปกราฟิก 
o Rotation: ก าหนดการหมุนรูปกราฟิก 

 General options 
o Frame color: ก าหนดสีของเส้นกรอบรูปกราฟิก 
o Background color: ก าหนดสีพื้นหลังของรูปกราฟิก 
o Opacity: ก าหนดความทึบแสงของสีพื้นหลังของรูปกราฟิก 
o Outline width: ก าหนดขนาดของเส้นกรอบรูปกราฟิก 

2. คลิกที่กราฟิก 

1. คลิกปุ่ม Select/Move item 

3. คลิกแท็บ Item 
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o Position and Size: ก าหนดขนาดและต าแหน่งของรูปกราฟิก 
o Show Frame: ก าหนดให้แสดง/ไม่แสดงเส้นกรอบรูปกราฟิก 

7. การเพิ่มและก าหนดคุณสมบัติตารางข้อมูลลักษณะประจ าในแผนที่ 
 ผู้จัดท าแผนที่สามารถเพิ่มตารางข้อมูลลักษณะประจ าลงในแผนที่ได้เช่นเดียวกับการเพิ่มองค์ประกอบ
แผนที่หรือรูปกราฟิก โดยมีขั้นตอนดังนี้ 

7.1 การเพ่ิมตารางข้อมูลลักษณะประจ าในแผนที่ 
1) ในหน้าต่าง Composer คลิกปุ่ม Add attribute table 
2) คลิกบนพื้นที่จัดท าแผนที่ 

 
 

 
 

7.2 การก าหนดคุณสมบัติของตารางข้อมูลลักษณะประจ าในแผนที่ 
1) คลิกปุ่ม Select/Move item 
2) คลิกที่ตารางข้อมูลลักษณะประจ า 
3) คลิกแท็บ Item เพื่อก าหนดคุณสมบัติของตารางข้อมูลลักษณะประจ าได้ดังนี ้

 

2. คลิกบนแผนที ่

1. คลิกปุ่ม Add attribute table 
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 Table 
o Layer: ก าหนดชั้นข้อมูลที่ต้องการแสดงข้อมูลลักษณะประจ า 
o Attributes: ก าหนดเขตข้อมูลที่ต้องการแสดงผลในตาราง รวมทั้งการ
ก าหนดชื่อเขตข้อมูล (Alias) และการจัดเรียงข้อมูล 
o Show only visible features: ก าหนดให้แสดงข้อมูลเฉพาะฟีเจอร์ที่
มองเห็นบนแผนที่ 
o Composer map: ก าหนดการอ้างอิงกับส่วนของแผนที่ 
o Maximum rows: ก าหนดจ านวนแถวข้อมูลสูงสุดที่จะแสดงผลใน
ตารางข้อมูลลักษณะประจ า 
o Margin: ก าหนดระยะขอบของตารางข้อมูลลักษณะประจ า 
o Show grid: ก าหนดให้แสดง/ไม่แสดงกริดของตารางข้อมูลลักษณะ
ประจ า 
o Grid stroke width: ก าหนดขนาดเส้นกริดของตารางข้อมูลลักษณะ
ประจ า 

2. คลิกทีต่ารางข้อมูลลักษณะประจ า 

1. คลิกปุ่ม Select/Move item 

3. คลิกแท็บ Item 
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o Grid color: ก าหนดสีของเส้นกริดของตารางข้อมูลลักษณะประจ า 
o Header Font: ก าหนดคุณสมบัติของข้อความที่เป็นชื่อเขตข้อมูลของ
ตารางข้อมูลลักษณะประจ า 
o Content Font: ก าหนดคุณสมบัติของข้อความที่เป็นค่าข้อมูลใน
ตารางข้อมูลลักษณะประจ า 

 General options 
o Frame color: ก าหนดสีของเส้นกรอบตารางข้อมูลลักษณะประจ า 
o Background color: ก าหนดสีพื้นหลังของตารางข้อมูลลักษณะประจ า 
o Opacity: ก าหนดความทึบแสงของสีพื้นหลังตารางข้อมูลลักษณะประจ า 
o Outline width: ก าหนดขนาดของเส้นกรอบตารางข้อมูลลักษณะประจ า 
o Position and Size: ก าหนดขนาดและต าแหน่งของตารางข้อมูลลักษณะประจ า 
o Show Frame: ก าหนดให้แสดง/ไม่แสดงเส้นกรอบตารางข้อมูลลักษณะประจ า 

8. การย้ายต าแหน่งของวัตถุบนแผนที่ 
 การย้ายต าแหน่งของวัตถุต่าง ๆ บนแผนที่ เช่น องค์ประกอบแผนที่  รูปกราฟิก และตารางข้อมูล
ลักษณะประจ า เพื่อจัดวางให้อยู่ในต าแหน่งที่ต้องการ จัดเป็นงานที่ผู้จัดท าแผนที่ทุกคนต้องปฏิบัติตลอดเวลา
ในการออกแบบและจัดท าแผนที่ 
 นอกจากการก าหนดต าแหน่งของวัตถุโดยอาศัยการก าหนดคุณสมบัติจากแท็บ Items แล้ว ผู้จัดท า
แผนที่ยังสามารถเคลื่อนย้ายต าแหน่งของวัตถุได้อีก 2 วิธี ดังนี ้

 การใช้ปุ่มลูกศรขึ้น/ลง และขวา/ซ้ายบนแผงแป้นอักขระ 

 การใช้เมาส์คลิกและลากวัตถุไปยังต าแหน่งที่ต้องการ 
ทั้งนี้ ผู้ใช้จ าเป็นต้องคลิกเลือกวัตถุที่ต้องการเคลื่อนย้ายโดยใช้เครื่องมือ Select/Move item          

(   ) ก่อนการเคลื่อนย้ายต าแหน่งของวัตถุด้วยวิธีการข้างต้น 

9. การจัดเรียงวัตถุบนแผนที่ 
 การจัดเรียงวัตถุบนแผนที่แบ่งออกเป็น  2 ลักษณะ คือ การจัดเรียงวัตถุ ในแนวดิ่ง (Vertical 
alignment) และการจัดเรียงวัตถุในแนวระดับ (Horizontal alignment) การจัดเรียงวัตถุบนแผนที่แต่ละ
ประเภทมีรายละเอียดดังนี้ 

9.1 การจัดเรียงวัตถุในแนวดิ่ง 
 การจัดเรียงวัตถุในแนวดิ่งเป็นการจัดเรียงวัตถุแบบก่อน-หลัง หรือแบบบน-ล่าง การจัดเรียง

ลักษณะนี้มีผลต่อการแสดงผลของวัตถุ เช่น วัตถุที่มีสีพื้นหลังและวางซ้อนทับอยู่บนวัตถุอื่น ๆ อาจจะท าให้
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เกิดการบดบังวัตถุด้านล่างได้ ด้วยเหตุนี้ ผู้จัดท าแผนที่อาจจะต้องมีการจัดเรียงวัตถุในแนวดิ่งใหม่ โดยมี
ขั้นตอนดังนี้ 

 1) คลิกปุ่ม Select/Move item 
 2) คลิกเลือกวัตถุที่ต้องการจัดเรียง 

 3) คลิกปุ่ม Raise selected items (    ) ค้างไว้ จากนั้นคลิกเลือกปุ่มค าสั่งที่ต้องการ 
ซึ่งปุ่มค าสั่งการจัดเรียงต่าง ๆ มีความหมายดังนี ้

 Raise: จัดเรียงล าดับขึ้นด้านบน 1 ระดับ 

 Lower: จัดเรียงล าดับลงด้านล่าง 1 ระดับ 

 Bring to Front: จัดเรียงล าดับขึ้นด้านบนสุด 

 Send to back: จัดเรียงล าดับลงด้านล่างสุด 
 
 
 

 
 
 
 

2. คลิกวัตถ ุ

1. คลิกปุ่ม Select/Move item 

3. คลิกเลือกปุม่ค าสัง่จัดเรียง 
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9.2 การจัดเรียงวัตถุในแนวระดับ 
การจัดเรียงวัตถุในแนวระดับเป็นการจัดเรียงวัตถุให้ชิดขวา-ซ้าย บน-ล่าง หรือกึ่งกลาง โดย

พิจารณาจากต าแหน่งของวัตถุที่ก าลังถูกเลือกอยู่ ณ ปัจจุบัน วัตถุประสงค์ของการจัดเรียงวัตถุลักษณะนี้คือ
ความต้องการจัดวางต าแหน่งของวัตถุให้เป็นระเบียบ สวยงาม การจัดเรียงวัตถุในแนวระดับมีขั้นตอนดังนี ้

 1) คลิกปุ่ม Select/Move item 
 2) คลิกเลือกวัตถุที่ต้องการจัดเรียง (อย่างน้อย 2 วัตถุ) 

 3) คลิกปุ่ม Align selected items left (        ) ค้างไว้ จากนั้นคลิกเลือกปุ่มค าสั่งที่
ต้องการ ซึ่งปุ่มค าสั่งการจัดเรียงต่าง ๆ มีความหมายดังนี้ 

 Align left: จัดเรียงวัตถุชิดซ้าย 

 Align center: จัดเรียงวัตถุกึ่งกลาง (อ้างอิงตามแนวนอน) 

 Align right: จัดเรียงวัตถุชิดขวา 

 Align top: จัดเรียงวัตถุชิดบน 

 Align center vertical: จัดเรียงวัตถุกึ่งกลาง (อ้างอิงตามแนวตั้ง) 

 Align bottom: จัดเรียงวัตถุชิดล่าง 
 
 

 
2. คลิกวัตถุอย่างน้อย 2 วตัถ ุ

1. คลิกปุ่ม Select/Move item 

3. คลิกเลือกปุม่ค าสัง่จัดเรียง 
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10. การจัดกลุ่ม/แยกกลุ่มวัตถุบนแผนที่ 

10.1 การจัดกลุ่มวัตถุ 
การจัดกลุ่มวัตถุบนแผนที่สามารถใช้ในการรวมกลุ่มวัตถุต่าง ๆ บนแผนที่ เพื่อให้การจัดเรียง 

(Align) หรือการเคลื่อนย้าย (Move) วัตถุมีความสะดวกรวดเร็วมากขึ้น การจัดกลุ่มวัตถุบนแผนที่มีขั้นตอน
ดังนี้ 

 1) คลิกปุ่ม Select/Move item 
 2) คลิกเลือกวัตถุที่ต้องการจัดกลุ่ม (อย่างน้อย 2 วัตถุ) 

 3) คลิกปุ่ม Group items (  ) 
 
 
 

 
  

หมายเหตุ: เมื่อใช้ค าสั่งการจัดกลุ่มวัตถุ โปรแกรมจะสร้างกรอบ (Frame) ล้อมรอบกลุ่มวัตถุให้
อัตโนมัติ และไม่สามารถปิดการแสดงได ้

 
 

2. คลิกวัตถุอย่างน้อย 2 วตัถ ุ

1. คลิกปุ่ม Select/Move item 

3. คลิกเลือกปุม่ค าสัง่จัดกลุม่ 
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10.2 การแยกกลุ่มวัตถ ุ
การแยกกลุ่มวัตถุบนแผนที่มีขั้นตอนดังนี ้

 1) คลิกปุ่ม Select/Move item 
 2) คลิกเลือกกลุ่มวัตถุที่ต้องการแยกกลุ่ม 

 3) คลิกปุ่ม Ungroup items (  ) 
 
 
 

 
 

11. การพิมพ์หรือส่งออกแผนที่ 
 เมื่อผู้ใช้จัดท าแผนที่เสร็จสิ้นแล้ว สามารถส่งออกแผนที่ในรูปแบบต่าง ๆ (Output format) ได้ด้วย
วิธีการดังนี้ 

 Export as Image: ก าหนดให้ส่งออกแผนที่เป็นแฟ้มข้อมูลภาพ เช่น PNG, JPG, TIF เป็นต้น โดย

การใช้ค าสั่งจากเมนู File หรือคลิกปุ่ม   

2. คลิกกลุ่มวตัถ ุ

1. คลิกปุ่ม Select/Move item 

3. คลิกเลือกปุม่ค าสัง่แยกกลุ่ม 
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 Export as PDF: ก าหนดให้ส่งออกแผนที่เป็นแฟ้มข้อมูล PDF โดยการใช้ค าสั่งจากเมนู File หรือ

คลิกปุ่ม  

 Export as SVG: ก าหนดให้ส่งออกแผนที่เป็นแฟ้มข้อมูล SVG โดยการใช้ค าสั่งจากเมนู File หรือ

คลิกปุ่ม  

 Print: ก าหนดให้ส่งออกแผนที่ไปยังเครื่องพิมพ์ผล โดยการใช้ค าสั่งจากเมนู File หรือคลิกปุ่ม 

 

12. การบันทึกและโหลดเทมเพล็ตหรือแม่แบบแผนที่ 
 โดยปกติแล้ว บุคคลหรือหน่วยงานใด ๆ ที่ต้องจัดท าแผนที่จ านวนมากกว่า 1 ระวาง มักจะต้อง
ออกแบบและจัดวางองค์ประกอบแผนที่ให้มีรูปแบบเหมือนกัน เช่น ชื่อระวาง ค าอธิบายสัญลักษณ์ มาตรา
ส่วน ฯลฯ  ดังนั้น การบันทึกหรือจัดเก็บแผนที่ที่ได้ออกแบบและจัดวางองค์ประกอบแผนที่ต่าง ๆ ได้อย่าง
ถูกต้องเหมาะสม เพื่อใช้เป็นเทมเพล็ตหรือแม่แบบแผนที่ (Template) ส าหรับการจัดท าแผ่นที่จ านวนมาก ๆ 
จึงมีประโยชน์อย่างยิ่ง เนื่องจากช่วยลดเวลาในการท างานลง และยังท าให้แผนที่ระวางต่าง ๆ เป็นรูปแบบ
เดียวกัน การบันทึกและโหลดเทมเพล็ตแผนที่ มีวิธีการดังนี ้

 การบันทึกเทมเพล็ต 
1) คลิกปุ่ม Save as template 
2) ก าหนดสถานที่จัดเก็บและตั้งช่ือเทมเพล็ต 
3) คลิกปุ่ม Save 

 

  

1. คลิกปุ่ม Save as template 

3. คลิกปุ่ม Save 

2. ก าหนดสถานที่จัดเก็บและตั้งชื่อเทมเพล็ต 
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 การโหลดเทมเพล็ต 
1) คลิกปุ่ม Load From template 
2) คลิกเลือกเทมเพล็ตที่ต้องการใช้งาน 
3) คลิกปุ่ม Open 

  
 

 
 

 
 

1. คลิกปุ่ม Load From template 

3. คลิกปุ่ม Open 

2. คลิกเลือกเทมเพล็ต 
 

ผลลัพธ์ของการใชเ้ทมเพล็ต 
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